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Welcome to Axiom Contract
Management

Syntellis’s contract modeling and analytics tool helps organizations better predict and manage
payments, and leverage a data-driven approach for improved payer negotiations. With this software,
you can estimate net revenue by patient, and better manage contracts, claims, and payments across
your organization from both managed care and government payers.

Syntellis’s Axiom Contract Management solution helps healthcare organizations:

¢ Inform payer contract negotiations using empirical and modeled data
¢ Understand the financial impact of proposed changes to contract terms

¢ Optimize estimation of net patient revenue across inpatient and outpatient populations
THE COMPONENTS OF CONTRACT MANAGEMENT

Contract Modeling Payer Compliance

Develop accurate expected revenue Proactively measure and monitor
across IP & OP populations. actual versus expected payments.

Contract Simulations Denials Management

Perform “what-if” modeling against Report on denials, identify root
proposed changes in contract terms. cause and direct collective action.

What is covered in this document

This guide is for Axiom Contract Management administrators. System administration involves basic
configuration and maintenance tasks, some that you perform only once, and some that you need to
perform regularly. You perform most admin tasks from the Axiom Contract Management Web Client.
Any tasks that are performed from the Desktop Client are noted as such.

System administrators model contracts that other users view and use in processing claims and creating
and viewing reports.

Administrator's Guide Axiom Contract Management | 6



This guide includes the following administrations features and tasks:

e Importing data — Building claim formats and other import formats, importing files to the system,
and viewing import activity
e Managing attributes — Creating, editing, enabling /disabling, and deleting attributes

e Modeling contracts— Including adding contracts (adding versions, provisions, attributes, clauses
and terms, thresholds and limits; attaching files and importing rates; copying contracts; and
more)

¢ Managing simulations — Creating, editing, and copying simulations; mapping simulations to drill-
down reporting

e Security — Application security roles and their associated access rights
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What’s new

Welcome to Version 2022.2 of Axiom Contract Management!
Enhancements in this release include:
New Winning Detail report links

New links from contract clauses and terms pages enable you to quickly understand where your
reimbursement comes from. You can view the entire Winning Detail report for the contract or just the
report data for a specific clause or term.

CMS DRG Factors page improvements

The following improvements have been made to the CMS DRG Factors page:

¢ Operating Adjustments Codes — An Operating Adjustments Code tab was added for calculating
the Medicare outlier for the COVID add-on. Use this tab to add the matching code for an
adjustment.

e DRG Weight Adjustment — A DRG Weight Adjustment field was added to the Settings tab. Enter a
percentage multiplier if a code on a claim matches the value on the Operating Adjustments Code
tab.

e Post Acute hover tip — To view an explanation of how selecting the Post Acute checkbox affects a
calculation, on the Transfer Codes tab, hover your cursor over the question mark to the right of
the Post Acute column heading.

Payer code and insurance plan code descriptions visibility

e The ability to include an organization-specific payer code or insurance plan code description
library file is now available as part of the standard import. Previously, you had to contact
Customer Support to update descriptions. Now you only need to contact Customer Support to
help with the initial setup. After setup, updated Org Code/Payer Code descriptions will be
incorporated into the nightly import process. The file must include OrgCode, PayerCode, and
Description.

¢ Use the added OrgCode/PayerCode description to view code descriptions that are assigned to a
contract version.
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New Winning Detail report links

» Why use this feature

New links from contract clauses and terms pages enable you to quickly understand where your
reimbursement comes from. You can view the entire Winning Detail report for the contract or just the
report data for a specific clause or term.

» How this feature works

What: A Winning Detail button added to clauses and terms pages opens the Winning Detail report in a
new tab for the associated contract. A new trophy icon in the icon column on clauses and terms pages
opens a dialog that displays the Expected Payment, Winning Payment, and Total Loss amounts for the
clause or term, and the number of claims associated with the data. If no data is associated with the
clause or term, the dialog reads “No results” and displays zeros in the fields.

Where: This change applies to contract Clauses and Terms pages.

Who: Only Axiom Contract Management administrators and analysts can access the report or the
summary of report results.

How:

On the Clauses or Terms page of a contract for which there is a Winning Detail report, do any of the
following:

¢ |f needed, click Recalculate to get the latest claims data for the report.

e To view the Winning Detail report for the contract, click the Winning Detail button. The report
opens in a new tab.
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e To view the impact of a specific clause or term, in the icon column for that row, click the Trophy

icon (T). A pop-up dialog displays the Expected Payment, Winning Payment, and Total Loss
amounts for the clause or term, and the number of associated claims.

NOTE: Clauses and terms with no associated report data display a “No results” dialog.

Clauses

+Add a New Clause
Clause Description
1> TRANSFER
HOSPICE
REHAB
ONE DAY STAY
SToPLOSS

BARIATRIC SURGERY

FALSE LABOR
8 MATERNITY C-SECTION
9 MATERNITY

10 NURSERY

n CARDIAC CATH

Calc Basis
Discharge Status
RevCode

RevCode

Any and All Services
Any and All Services

DRG

RevCode

Calc Type
Dollar Rate
Dollar Rate
Dollar Rate
Dollar Rate
% Charges

Dollar Rate

Doll

Dollar Rate

Dollar Rate

Dollar Rate

Dollar Rate

Calc Measure
Per Claim
Per Line Item Qty.
Per Line Item Qty.
Per Diem
Per Claim
Per Claim
Per Diem
Per Diem
Per Diem
Per Diem

Per Diem

Terminal?

Attributes Rates Threshold Limits

z

z

=
] z B[E]w
e

z

z

z

=z

=z

=z

» Where to find more information

4

Expected Payment: $3816.90
Winning Payment: $12600.00
Total Loss: $8783.10

ONE DAY STAY

Claim Count: 3

The following topics in the online help have been added or updated with information and instructions

for using this feature:

¢ Run the Winning Detail report

e Working with reimbursement detail reports

Administrator's Guide
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Understanding the Axiom Contract Management system

Axiom Contract Management is a web application backed by an SQL database that stores contract
terms, patient claims, and payment information. The system uses the contract payment terms and the
patient claim information to calculate an expected payment for every claim submitted by the provider.

Understanding the flow of data

From billing to Axiom Contract Management

Axiom Contract Management requires many pieces of data to function properly. It is important to
understand the entire process of how data comes into, and moves through, the system.

As shown in the following diagram, when billable procedures are performed at a hospital, services data
is entered directly into the hospital’s information systems (HIS). Patient Accounting generates claim data
from this information and sends a bill in the form of an 837i 5010 for institutional claims, and as an 837p
5010 for professional claims, to the payer.

Client Data & Integration
Reference Tables
Electronic Claims y Electronic Claim
837 5010 Institutional V’ == Remittance Advice
837 5010 Professional \ l / = 8355010
—
=
t
(1 1) Axiom Contract Management
‘- |
Reporting & Analysis '.'.*.‘ Underpayments & Denials

Improve payer performance
reporting, leverage in
contract negotiations

Modeled Expected Payment vs.
Actual Payments and 835

Modeling, Simulations & oy .
Denial information

Payer Negotiations

KaufmanHall axiomsoftware

As these claims are sent out each day, a copy also goes to the Axiom Contract Management system.

NOTE: These claims should be collected after they have been sent through a claim scrubber so that
they reflect exactly what the payer receives.
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After import to Axiom Contract Management, claims are matched to the associated payer contracts
modeled in the system. These contracts can be very sophisticated and may contain combinations of
services being paid at fee schedules, per diem payments, lesser of terms, thresholds, stop losses, and
various other reimbursement methodologies. Ultimately, an expected payment is generated for each
claim that has a matching contract.

In addition, 835 remittance responses, along with posted payments and payer adjustments, flow into
Axiom Contract Management on a daily basis. With these five pieces of information (i.e., contract terms,
claim data, payments, adjustments, and remittance responses), the expected payment/contractual
generated by Axiom Contract Management allows you to identify which claims have or have not been
paid correctly.

Administrator's Guide Axiom Contract Management | 12



Managing data

This section provides information about importing data to Axiom Contract Management and integrating
data from the Contract Management system with other Axiom systems, as those integrations become
available in future releases.

About accessing data in the Axiom Desktop Client

Key Axiom Contract Management assets are available in the Axiom platform so that Axiom Contract
Management system administrators can pull and synchronize key contract, claim, and calculated claim-
level estimated payment details for use in the Desktop Client. This integration allows users to take
advantage of Axiom tools like the Axiom Scheduler Jobs Library and Axiom Reports.

During Contract Management installation, data is pulled from Axiom Contract Management and stored
in the following Axiom tables in the Table Library:

e CM Claim level estimated payment
e CM ClaimNumbers

e CM ContractDetails

e CM Last Import

In addition to the tables, an Axiom job, called Import Claim Level Estimated Payment, is created in the
Axiom Scheduler Library under Contract Management. This job helps share data from Axiom DSS with
Axiom Contract Management.

A] Axiom Explorer ? x
Q 4 |\Axiom\Scheduler Jobs Library\Contract Management o
Filew  View~ Open ~
My Files Name Modified Locked By Size Type Modified By ~ Descrip
Favorites [E5 CMA 5010 Importer 3/26/2020 7:51 AM 2B AXJFile  admin
* ElRecent [£2 CMA Full Import 6/24/2020 12:38 PM 3KB AXJFile  admin
My Documents o 3
[E5 CMA Posting Import 3/26/2020 7:51 AM 4kB AXJFile  admin
File Groups [E2 CMA QL Import 3/26/2020 7:51 AM 2k8 AXIFile  admin
Libraries [ES ConfigUCRNMap 5/1/2020 8:52 AM 2kB AXJFile  admin
» ) Reports Library [E5 EAPG Group and Price - Live 3/26/2020 7:51 AM 1KB AXJFile  admin
» [ Table Library [ES GPCS APG Group and Price 3/26/2020 7:51 AM 1KB AXJFile  admin
f‘ Ribbon Tabs Library [E3 GPCS EAPG Group and Price 3/26/2020 7:51 AM 1KB AXJ File admin
~ [ seheduler Jobs Library [F2 GroupAndPrice_83_1 3/26/2020 7:51 AM 1KB AXJFile  admin
Contract Management =
2 [E3 Import Claim Level Estimated Payment 4/29/2020 824 AM 6KB AXJFile  admin
» & Imports Library »
» Sl Exports Library [E5 Map Provider Name 5/1/2020 8:52 AM 2B AXJFile  admin
[E5 Parameters 5/1/2020 8:52 AM 2kB AXJFile  admin
[E5 Recalc_88_1 3/26/2020 7:51 AM 1KB AXJFile  admin
[F% RePopulate Cma Cubes 5/1/2020 8:52 AM 1KB AXJFile admin
=) Import Claim Level Estimated Payment  Description: _ _
) AXJFile Size: 6KB Date modified: 4/29/2020 8:24 AM Locked by: m
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When this job runs, it retrieves all of the contract detail, claim-level expected payments, and claim
detail, and uses it to update the four CM tables and keep the data in sync. Whenever users import new
claims, modify claims, calculate a payer, and so on, this job captures these changes when it runs.
Generally, this job would be set to run with the full nightly import (CMA Full Import job).

Importing data to Axiom Contract Management

Axiom Contract Management imports data in different formats depending on the type of data file the
system is attempting to access. Generally, data provided for import into the system can be categorized
into four types:

e Claims data — Claim files, both institutional and professional.
¢ Financial data — Payments and adjustments, both institutional and professional.

e Additional data — Primary Insurance Plan Codes, claim number mapping files, user-defined field
data, Professional Primary Insurance Plan Codes, and other contract terms.

¢ Remittance data — Institutional and Professional 835 files.

Claims and Financial data files must meet certain requirements before importing to Axiom Contract
Management, and they must also be in specific formats. Additional data and Remittance data files also
have format requirements. For details, see Client file specifications and Understanding data formats.

Currently, flat text files (Financial data and Additional data) can be imported using the Kreg Unified
Importer or the Axiom ETL Importer.

NOTE: The Kreg Unified Importer will eventually be phased out.

In general, the import process consists of the following main steps, depending on which importer you
use.

If using the Kreg Unified Importer... If using the Axiom ETL Importer...
1. Build fixed-width import format files 1. Set up Axiom ETL import for flat
(for payments and adjustments). files.
2. Create an import batch. (See also: 2. Ensure files are in the correct
About import batches) format.
3. Add files to the Import Task List. 3. Drop the files in the appropriate

folders that were set up in step 1,
where they will be picked up by the
importer during the nightly import.

4. Files are auto-imported to the system during the nightly import. An Import
Summary Report is created after each successful nightly import. You can also view
import activity in Axiom Contract Management.

Administrator's Guide Axiom Contract Management | 14



Understanding data formats

All formats are built during system implementation; however, the system administrator is responsible
for ensuring that any format changes are reflected in Axiom Contract Management for importing to
continue smoothly.

IMPORTANT: If you do not maintain data formats in the system, you run the risk of inaccuracies in
your database.

» About formatting claim files for import

NOTE: UB and 1500 files are no longer accepted as import file types.

The Axiom Contract Management claim dataset is populated mainly by 837i and 837p files, which are
typically provided to the server on a scheduled basis for import and recalculation. These files must
adhere strictly to the 5010 standards and should be the “scrubbed” claims from the claims
clearinghouse.

» About formatting financial data files for import

Financial information such as payments and adjustments are imported using a format as well; however,
these file types are inherently different from the 837i/837p 5010 claim files. Typically, they are provided
to the Axiom Contract Management server as flat ASCII text files. Users with a Support license can build
fixed-width import formats if using the Kreg Unified Importer. For more information, see About
importing data to Axiom Contract Management.

Client file specifications

Client files imported to Axiom Contract Management must meet the specifications detailed in the
following tables for each file type.

» Claim data

Institutional Description

claims 837i
(required)

Format 837i files must adhere strictly to the 5010 standards. All
claims must be “scrubbed.” Scrubbed claims typically
come from a claims clearinghouse (E-Premis, Emdeon,
WebMD, CareMedic, etc.).
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Institutional Description

claims 837i
(required)

Frequency Daily. Claim files are dropped to predetermined import
folder locations on the Axiom Contract Management
server on a daily basis for the previous day’s billing cycle.
The folder should be named
\\servername\KHData\Hospital\837i5010.

Naming Institutional files must be unique text files and must not

convention have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDD837i.txt).

Professional Description

claims 837p

(optional)

Format 837p files must adhere strictly to the 5010 format
standards.

Frequency Daily. Claim files are dropped to predetermined import

folder locations on the Axiom Contract Management
server on a daily basis for the previous day’s billing cycle.
The folder should be named
\\servername\KHData\Hospital\837p5010.

Naming Professional files must be unique text files and must not

convention have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDD837p.txt).

» Financial data

Institutional Description

Payments
(required)

Format Flat ASCII text file or Pipe (|) Delimited. Payments should
be positive values, reversals would be negative values.
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Institutional Description

Payments
(required)

Requested fields Required:

e Account #

e Posting Date

e Payment Amount
Optional:

¢ UCRN/Claim Number
* Payer Code

e Payment Date

e Posting Code/Transaction Code

Filter All records excluding payments received for professional
services (services billed on 837p).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s actual posted payments.
The folder should be named
\\servername\KHData\Hospital\Pay.

Naming Institutional Payment files must be unique text files and

convention must not have any spaces or special characters in the
name. Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayl.txt).

Institutional Description

Adjustments

(required)

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments
should be positive values, reversals should be negative
values.
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Institutional Description

Adjustments
(required)

Requested fields Required:

e Account #
¢ Posting Date
¢ Adjustment Amount

Optional:

¢ UCRN/Claim Number
¢ Payer Code
e Payment Date

* Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for professional services (services billed on
837p).

Frequency Daily. Files are dropped to predetermined import folder

locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder
should be named \\servername\KHData\Hospital\Adj.

Naming Institutional Contractual (adjustment) files must be

convention unique text files and must not have any spaces or special
characters in the name. Syntellis requires that each file
have a unique name concatenated with a date stamp for
the day it was created (example: YYYYMMDDAd]l.txt).

Professional Description

Payments
(optional)

Format Flat ASCII text file or Pipe (|) Delimited. Payments should
be positive values, reversals would be negative values.
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Professional Description

Payments
(optional)

Requested fields Required:

e Account #
e Posting Date
e Payment Amount

Optional:

¢ UCRN/Claim Number
¢ Payer Code
e Payment Date

* Posting Code/Transaction Code

Filter All records excluding payments received for institutional
services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder
should be named \\servername\KHData\Hospital\Payp.

Naming Professional Payment files must be unique text files and

convention must not have any spaces or special characters in the
name. Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayP.txt).

Professional Description

Adjustments

(optional)

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments
should be positive values, reversals should be negative
values.

Administrator's Guide Axiom Contract Management | 19



Professional Description

Adjustments
(optional)

Requested fields Required:

e Account #
¢ Posting Date
¢ Adjustment Amount

Optional:

¢ UCRN/Claim Number
¢ Payer Code
e Payment Date

* Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for institutional services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder
should be named \\servername\KHData\Hospital\Adjp.

Naming Professional Contractual (adjustment) files must be

convention unique text files and must not have any spaces or special
characters in the name. Syntellis requires that each file
have a unique name concatenated with a date stamp for
the day it was created (Example: YYYYMMDDAJ]P.txt).

» Additional data

Institutional Description
Primary

Insurance Plan
Code
(required)

Format Flat ASCII text file or Pipe (|) Delimited.
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Institutional Description
Primary

Insurance Plan
Code
(required)

Requested fields Required:

e Account#

e Primary Insurance Plan Code

Optional:
¢ UCRN/Claim number

Filter e Primary Insurance Only

e Date criteria based on 6 - 12 month sliding window
(today minus 6 months)

Frequency Daily. To be dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Ins.

Naming Files must be unique text files and must not have any

convention spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a
date stamp for the day it was created (Example:
YYYYMMDDPIlanl.txt).

Institutional Description

Primary

Insurance DRG

Code

(required)

Format Flat ASCII text file or Pipe (|) Delimited. DRG codes should
be zero filled to 3 characters. For example, DRG 57 should
be 057.
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Institutional
Primary

Insurance DRG
Code
(required)

Requested fields

Description

Required:
e Account#

e Primary Insurance DRG Code

Optional:
e UCRN/Claim Number

Filter

e Exclude Professional Accounts
e Primary Insurance Only

e Date criteria based on 6 - 12 month sliding window
(today minus 6 months)

Frequency

Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\DRG.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a
date stamp for the day it was created (example:
YYYYMMDDdrg.txt).

Claim Number

Mapping File
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.
Requested This file is needed if the claim number on the claim does
fields not match the posting files from the hospital system.
Required:
e Account #
¢ UCRN/Claim Number
Filter Date criteria based on 6 month sliding window (today

minus 6 months).

Administrator's Guide
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Claim Number  Description

Mapping File
(optional)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Map.

Naming Files must be unique text files and must not have any

convention spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDUCRN.txt).

User Defined Description

Fields

(optional)

Format Flat ASCII text file or Pipe (|) Delimited.
Requested Required:

fields e Account #

e User Defined Field (UDF)

Filter Date criteria based on 6 - 12 month sliding window (today
minus 6 months)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. Each user
defined field feed needs a unique folder. These folders
should be named \\servername\KHData\Hospital\UDF#
where # is the number of the UDF.

Naming Files must be unique text files and must not have any

convention spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDudf1.txt).
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Professional Description
Primary

Insurance Plan
Code (optional)

Format Flat ASCII text file or Pipe (|) Delimited.

Requested fields Required:
e Account #
¢ Primary Insurance Plan Code

Optional:
e UCRN/Claim Number

Filter e Exclude Institutional Accounts

e Primary payor only

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\InsP.

Naming Files must be unique text files and must not have any

convention spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a
date stamp for the day it was created (example:
YYYYMMDDPIanP.txt).

» Remittance data

Institutional Description
and

Professional
835 (optional)

Format 835 files must adhere strictly to the 5010 standards. These
files should come from the payer and not be edited.

Frequency Daily. 835 files are dropped to predetermined import
folder locations on the Axiom Contract Management
server on a daily basis for the previous day’s billing cycle.
The folder should be named
\\servername\KHData\Hospital\8355010.
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Institutional Description

and

Professional
835 (optional)

Naming Institutional files must be unique text files and must not
convention have any spaces or special characters in the name.

Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDA835.txt).

Build a fixed-width import format

Fixed-width import formats are generally used for importing payments and adjustments data to Axiom
Contract Management in fixed-width ASCII text files. To get the information from these downloads into
the system, you need to build a format for them. Their formats are different from a claim format in that
the data is provided in fixed columns instead of floating fields like on a claim file.

To create a file format:

1.

2
3
4.
5
6

Run Unifiedimport.exe.
From the menu bar, select Import Setup > Spec Imports.
In the System drop-down, select CMA.

From the Import Type drop-down, select Fixed.

. Select Folder Based Import.

From the Table Name drop-down, select the name of the Import Table. In the following example,
a format is being defined to import to the CMA Postings table.

agl
St
O File
fmeort Type: ® Folder
Table Name:
|CMA Postings vl

Axiom Contract Management Flat File Tables are categorized as follows:

¢ CMA Postings — Payments, Adjustments
¢ CMA Library Tables — Library APC, DRG, etc.
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10.

11.

e Additional Data Upload — DRG, User-Defined Data, Payer Code, etc.

By selecting CMA as the System, and in this example, CMA Postings, you are setting up the system
to create a CMA Postings format.

Select the Import Folder Location. You need to select a sample file to build flat file formats.
Click the ellipsis button next to Import Folder and select the folder where your sample file is
located.

IMPORTANT: This sample must be free of print characters, headers and footers, and must
reside in a subfolder with the file path: \\YOURSERVERNAME\Data\Import.

Create a new format: Click New to open the format building window with the sample data for
selection, as shown in the following example.

L Flat Files Format |L|E-

Format Name: ‘New Format | Description: ]

Table Name: CMA Postings Import Fle:  E:\KregData\EVCMA\Imported\UD1LIE\20140708092348_UD1Lib ta

Selected Import File

|Q:L Blood and Blood-Forming Organs A
02 Circulatory System

03 Conditions in the Perinatal Pe

04 Congenital Anomalies

05 Diagnostic and Nonsurgical Pro

07 Endocrine, Nutrional, Metaboli

08 Genitourinary System

09 Infectious and Parasitic Disea v

Feld Selection

01 Blood and Blood-Forming Organs

Felds (Felds in "Bold™ are required fields) Accept/Cancel FHeld Selection
 CO Gl D e i
UCRN Column Start 1 s L] to [—
PostPayerCode
PostDate Column Length 0 5
PayDate
PostCode
Amount 1=Nomal
Post Category
Post Prof Indicator L=Left
0=Don' do anything
| Accept || Qear Cear Al | [ Skip Header Row

[ Cancel |

In the fields at the top of the window, enter a format name and description.

On the lower left, in the Fields box, select the field to specify, and then select the data location in
the Field Selection box.

Click Accept to save the values to the database.
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NOTE: Fields in bold are considered required fields and must be specified. Fields in italics
have already been specified.

12. After completing the format for your flat file, click Save.

» Advanced flat file import options

When building an Axiom Contract Management Postings format, set up Advanced Options for the
following fields:

Advanced Options

Decimal FunctionlD: | 1=Normal o
NegPlacement : L=Left v
Reverse Sign 0=Dont do anything v

Amount Field

e Decimal Settings — Use this option to set whether the amount field in your file uses a space
decimal, implied decimal, or normal decimal. Depending on the way the amount field is provided,
you must select the appropriate DecimalFunctionID. Following are examples of each:

Space Decimal: 100 00 - 100.00
Implied Decimal: 10000 - 100.00
Normal Decimal: 100.00 - 100.00

¢ Negative placement — In some cases, negative signs (-) are attached to the front of the amount,
and in others, they are attached at the end.

IMPORTANT: For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any
accounts.

e Reverse sign — For the amount to populate correctly, payments and adjustments must be positive
values. Negative values are acceptable, but they will appear as a credit on any accounts.

¢ Post Category — Adjustment vs. Payment

¢ Post Prof Indicator — Professional vs. Institutional
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About import batches

Import batches are groups of tasks that tell Axiom Contract Management where to look for files, and
once found, which formats to apply to them. After you have the file to import, the next step in
importing data to the system using the Kreg Unified Importer (KUI) is creating import batches. When
using the KUI, you must create an import batch to get data into the system.

You need to create batches for claim files and any flat files that you want to import.

The setup for importing data is folder-based: a format is joined with a folder location, and upon import,
any file residing in that folder is brought in using the set format code.

IMPORTANT: All import folders must be subfolders of \\YOURSERVERNAME\Data\Import, and must
not have any spaces in the folder or file name.

After importation, the file is date-time stamped and moved into a mirrored IMPORTED folder for later
reference if needed.

Create an import batch

NOTE: This topic applies to the Kreg Unified Importer.

Before creating an import batch, you need to understand the following different types of batches used
in Axiom Contract Management:

e Claims should import from the 837i or 837p 5010 format files (claims are imported using the 5010
 Flat-file import — Folder and File based

To create an import batch:
1. Select the import type. An import batch can be created for each of the import types. Select the
appropriate import type from the drop-down menu.

2. Name and create your batch. Click Create to create a blank batch for the import type selected in
step 1.

Create New Batch

Batch Name: |Example Batch|

Create Cancel
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Import Setup
Batch Name: |Example Batch v Create
Table Descnpbion Format Name Import File

3. Select files/folders to import and the target table to import to. On the left side of the screen,
from Table Name drop-down, select the target table.

4. Click the ellipsis button next to Import Folder and then select the import folder or file location.

5. Inthe Format box, select the format to apply to the folder.

NOTE: Only one format can be applied to a folder.

import Folder | . |

|E:\Temp\ Testing\UBO4\COMM

Forma: [ New |
Format Name Format Descripion  Edit A
ADJ Institutional Adjustm | Edit
ADJP Professional Adjust | Edit

» 53 Institutional Paymen =3

PAYP Professional Payme | Edit
geqrg sfdadf Edit =
BRFAd AdjustmentDatalmp | Edit E
test format brandonl Edit
bhAdjustments | bhAdjustments Edit
bhadjTest bhadjTest Edit
bhpayTest bhpayTest ~ Edit
bhrefiest bhreflest _ Edit |
CMA-Ady CMA-Ad) Edit
CMA-Payments | CMA-Payments Edit
KDTestinstADJ | KDTestinstADJ Fdit h

6. Add your item to the batch. Click the right arrows button to add your item to the batch selected
in the drop-down on the right side of the window. To remove an item from the list, select it and
press the Delete key.

IMPORTANT: Do NOT click the Delete button. Clicking the Delete button will not remove an
item from the list, but instead will delete your whole batch.

7. Next, add the import batch to the Import Task List.
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Add import batches to the Import Task List

After creating import batches, to process them during the import, you must add them to the Import
Task List import queue. Simply creating the batches does not cause the files and folders in those batches
to import automatically.

To add or remove items from the Import Task List:

1. Inthe Unified Importer, from the menu bar, select Import > Manage Tasks.

ag Unified Importer

File  Import Setup Impcrt. Reports

Manage Tasks

2. Create and define a Task Group:
a. Atthe top right, click the Create New button.

b. From the Batch Types drop-down, select the batch type, and then click the arrow buttons
to add the batch types to the Task Group on the right.

In the example below, the Task Group “Example Task Group” is defined with a number of
batch imports of various types. These will all run when the Task Group is called by the
import process.

az Task List =0 -
System: [cMA | Task Group: | Example Task Group v| | create New

Batch Type: [UBfiebsich v Selected Task Group ID: 1038 [ | Default Task Group

[CMA UBS2batcht | Batch Name BatchType  SystemName

» | CMA_UB92 batch| UB file balch CMA
Grriffin Testl UBO4 filebaich | CMA
E CMA-Fixed Fiatfile batch CMA

Example Baich | Flat folder baich | CMA
El Example Baich | Flat file baich CMA
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Set up Axiom ETL import for flat files

Use these instructions to set up folder and file options for importing flat files using the Axiom ETL
importer. These instructions are for system implementers setting up new systems and for support

technicians setting up import folders for additional flat file types.

IMPORTANT: When copying an existing flat import file, you must add an underscore (_) and a
a copy of a file named CM_TempXXX
would be named CM_TempXXX_y; so a copy of the file CM_TempClaimAddDRG could be named

number or other character to the end of the copied file name:

CM_TempClaimAddDRG_2.

To set up import file and folder options:

1. Inthe Axiom Windows Client, from the Axiom ribbon tab,

[desired flat file import type] > Edit.
2. In the Flat File Import dialog, click the Source tab.
3. For Import Type, select File.

4. In File Import Options, select the following:

a. For File type, select Delimited file.

b. For Source path, select Use specified path.

c. Inthe Source folder field, enter the path to the folder in which the client will place files.

click Imports > Contract Management>

This is also the folder from which the importer picks up the files.

NOTE: This path is provided by the client. For requirements, see Client file

specifications.

d. For Import from, select Multiple files.

A CM_TempClaimAddDRG - Flat File Import - CM_TempClaimAddDRG Table

General | Source | Variables | Mapping | Transforms | Execute

Import Type | File ¥

File Import Options

\WPOBPAPOT\C$\CMA1\Kreg Data\EVCMA\Import\AddDRG

5. In the File Options section, select the following:

a. If the first row of data in your file has column headers, select the option First row has

column names.

Administrator's Guide

File type: (@) Delimited file Source path: @) Use specified path
) Excel file (xls or xlsx) () Prompt for path during execution
Source folder & The file is accessible to the Axio

Import from: - O Single file
® Multiple files

om application server

¥
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b. For Delimiter character, select the pipe delimiter (]).

c. For Text qualifier character, the default is quote marks. If your file uses a different
qualifier character, enter it in this field.

File Options
First row has column names Delimiter character |
[] Import file has multi-line values Text qualifier character |"

6. Inthe Multiple File Options section, select the following:

a. For Import order, select Creation date.

b. For Archive folder, this is the same path as the Source folder except that instead of a
folder named “Import” the folder is named “Imported,” as shown in the following
example.

Multiple File Options

Import order: (O Alphabetical ~ (® Creation date

File filter

Archive folder (for archiving successful imports)& The archive folder is writable by the Axiom application sen

Y\POBPAPOT\CS\CMA1\KregData\EVCMA\Imported\AddDRG =
Add timestamp prefix to file names when archiving successful import files
C Ay | [ ok [ [ Cancel |

c. Ensure that the option Add timestamp prefix to file names when archiving successful
import files is selected.

7. If the client is using column header names in the file, click the Mapping tab and then verify that
the information displayed in the Temp Table Column and Destination Column is correct.

A CM_TempClaimAddDRG - Flat File Import - CM_TempClaimAddDRG Table ? X

General | Source | Variables | Mapping | Transforms | Execute

Map the imported columns and extra work columns to the destination table columns. The destination table and column
names can reference variables using {variable}.

Destination table |CM_TempClaimAddDRG| [T  create destination table : ¥ a v X
Source Column Temp Table Column Type Nulls Destination Column
Cmabillid String (40) - 4 Cmaillid &
2 UCRN String (40) [] UCRN
3 DRG String (30) [] DRrG

8. If the information is not correct, select the line in the column and then type the correct heading.

9. Click Apply and then click OK.
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View import activity
To view your import activity:
1. Log in to the Axiom Contract Management Web Client.

2. In the main menu header, click Import Data and select View Batches.

Launch Page Contracts Claims Import Data Reports Admin Help

| View Batches |<—

Manage CARC Mappings
Contracts Manage RARC Mappings

|Live v ‘ =z

+ Add a New Contract
Contract Name

AETNA ¥

The Manage Import Batches page opens.

Launch Page Contracts Claims Import Data Reports Admin Help Logout Queued Tasks: 0 ?
Manage Import Batches
Select Import Type: | Claims 2 Import Date: ~ Start: | 1/2/2019 B3| End: | 913072019 E]

Import Date + Type Y Batch# Y Claims Submitted # Rejected # Accepted # Exceptions # Calculated Total Charges  Notes

09/03/2019 8371 2796 9 0 9 0 0 $6,180.18 8371 2

09/03/2019 8371 2795 9 0 9 0 0 $6,180.18 8371

08/30/2019 8371 2794 9 0 9 0 0 $6,180.18 8371

08/30/2019 8371 2793 9 0 9 0 0 $6,180.18 8371

08/27/2019 8371 2792 9 0 9 0 0 $6,180.18 8371

08/27/2019 8371 2791 9 0 9 0 0 $6,180.18 8371

08/26/2019 8371 2790 9 0 9 0 0 $6,180.18 8371

08/26/2019 8371 2789 9 0 9 0 0 $6,180.18 8371

08/26/2019 8371 2788 9 0 9 0 0 $6,180.18 8371

08/22/2019 837P 7061 0 0 0 0 0 $0.00  Incorrect Type - Not Imported

08/22/2019 837P 7060 0 0 0 0 0 $0.00  Incorrect Type - Not Imported

08/22/2019 837P 7059 1 0 1 0 0 $766.50  837P

08/22/2019 837P 7058 1 0 1 0 0 $14550  837P .

Manage Import Batches page example

On the Manage Import Batches page, you can view all data entered in the system, organized by
batch (1 file = 1 batch). This is useful when looking at the View a Claim Summary tab, where the
batch number is provided and you want to locate more information about that batch.

Each claim batch has the following information columns:

e |Import Date

¢ Type (type of claim)

e Batch #

¢ Claims Submitted (number of claims)
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e # Rejected

e # Accepted

e # Exceptions

e # Calculated

e Total Charges

e Notes — This column contains notes about the imported file; for example, if a file was not
imported because it is a duplicate, that is noted here.

3. To view batch information for Postings and other file imports, from the Select Import Type drop-
down, select Flat File Imports.

Flat file imports include payments and adjustments, as well as any additional data files you
submit, such as DRG or plan code files.

Some information is not available if the batch was imported as part of a historical data import.

TIP: In every view, the bottom left corner contains page navigation options. Click the arrows
to move to the next/previous page:

IMPORTANT: Do NOT delete batches unless instructed to do so by a member of the CMA
Support Team. If the batch information is deleted, it cannot be recreated.

About the Import Summary Report

All data entering the system runs through Syntellis’s auto-importer, which generally runs four to seven
days per week. It usually runs late at night or early in the morning so that it does not interfere with work
being done by users. When the import completes, if successful, you will receive an email confirming the
import and detailing the contents. The following is a list of terms and fields, with accompanying
definitions, found on the report.

» Import Summary Report definitions — CLAIMFILES

Field Definition

Batch Number System # assigned to each import file.

Import File Name Name and import location of file.
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Field Definition

# of Claims Read into In Axiom Contract Management, all claims are loaded to a temporary

Temp staging area before being transferred into the Live environment. This
allows us to run validation processes on the data to ensure the data is
correct. This number should tie to the number of billed claims in the

import file.
# of Late Charge Records Details how many late charges were in the import file.
# of Claims Rejected to In cases where bad data is provided, the system removes the records
Bad associated to the bad claim and moves them into a separate area. For

details, see About problem file processing. You can run the Bad
Records report to check why any claims were moved there. Reasons
vary as to why a claim would be moved to bad, but most of the time it
is related to missing required data elements (e.g., account #), a
number that has a character in it and the system cannot convert it
correctly, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, run the Rejected Records
report (available in Reports > Reports) or contact info@syntellis.com.

Valid Claim Total Charges Provides the total charges of the claims that were successfully
imported to the Live environment.

# Claims Transferred to This field indicates how many of the temp records were imported to
Live the Live environment. It should be in line with the # of claims read
into temp column (unless records were moved to bad).
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Field Definition

# Claim Exceptions In some cases, imported claims are marked as exceptions. Following
are reasons for exception records:

e Trying to insert a series bill over an existing non-series bill claim

e Trying to insert a late charge onto a series bill

e Trying to insert a void over a series

e Trying to insert a non-series bill over an existing series bill

¢ Invalid Medicare Part B Type of Bill

e Trying to insert a zero payment bill into the system

e Trying to insert over higher charge claim

e Voided Claim

¢ Invalid Late Charge Bill (Incompatible Bill was imported after this
record)

The second sheet of the import summary report details all the
exceptions from the import, including the Bill ID (Patient Account
Number) linked to the claim in the system. In addition to Bill ID, the
supplementary details include: Batch Number, Import File Name,
Exception Reason, Bill Code, # of Claims, and Total Charges.

# of Claims Grouped Axiom Contract Management groups all outpatient claims into their
corresponding APCs based on the date of the episode of care and its
corresponding version of the Medicare APC schedule.

# of Claims Priced Any Medicare-based outpatient claim will price against the 3M pricer
if factors have been provided to Syntellis and a corresponding
calculation schedule has been built and assigned to the contract
provision. Please email your factors to info@syntellis.com.

# of Claims Calculated This field indicates the number of claims that found a contract and
calculated accordingly.

» Import Summary Report definitions — POSTINGS

Field Definition

Batch Number System assigned # to each import file.

Import File Name Name and import location of file.

Administrator's Guide Axiom Contract Management | 36



Field Definition

# of Postings Read into In Axiom Contract Management, all claims are loaded into a temporary

Temp staging area before they get transferred into the Live environment.
This allows us to run validation processes on the data to ensure the
data is correct. This # should tie to the # of posting records in the

import file.
# of Postings Rejected to In cases where the data is bad, the system removes the records
Bad associated with the bad claim and moves them to a separate area for

review by support staff. Reasons vary as to why a posting would be
moved to bad, but most of the time it is related to a missing required
field value, a number that has a character in it and the system cannot
convert it, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, please contact
support@KaufmanHall.com.

# of BilllDs Imported Provides the number of unique account numbers in the posting file
being imported.

# of Matching BilllDs Provides the number of matching billlDs found in the Live environment
for the postings being imported.

Total Valid Postings Provides a summary of the valid posting records being imported.

Amount . .
NOTE: If any records are rejected to bad, their amounts are not

reflected in the Total Valid Postings Amount.

About problem file processing

When claims and remits are read into the system during the Axiom Contract Management Full Import
job, occasionally problem files occur. Problem files include duplicate files, files with invalid formats, and
files that cannot be read because of structural or other issues.

The system handles them as described in the following sections.

» Duplicate files

The system:

e Date-time stamps and copies the file to a Duplicate file folder under the EVCMA folder location
from which the file is read. If the Duplicate folder does not exist, the system creates it.

e Logs the attempt as a duplicate.

* Inserts the file entry into the TemplimportBatches table without a file hash and with a status of
Duplicate.
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Updates the import report to show that the file is a duplicate and was skipped.

Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Duplicate - Not Imported.

» Invalid format files

The system:

Date-time stamps and copies the file to an Invalid file folder under the EVCMA folder location
from which the file is read. If the folder does not exist, the system creates it.

Logs the attempt as an invalid format file

Inserts the file entry into the TemplimportBatches table without a file hash and with a status of
Invalid Format

Updates the import report to show that the file is an Invalid Format and was skipped

Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Invalid Type - Not Imported

» Unreadable files

The system:

Date-time stamps and copies the file to an Unreadable folder under the EVCMA folder location
from which the file is read. If the Unreadable folder does not exist, the system creates it.

Logs the attempt as an unreadable file

Inserts the file entry into the TemplimportBatches table without a file hash and with a status of
Unreadable

Updates the import report to show that the file is Unreadable and was skipped

Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Unreadable - Not Imported

View SQL importer log

The SQL importer log available to administrators provides better visibility into the nightly import
process. The SQL importer log records details about the last import that took place, including any errors,
in an easy-to-view format. Administrators can use this log as a diagnostic tool when errors occur
because it is more descriptive than the Axiom log.

The log records the following:

SQL Import run ID number
Task group ID
Message — A brief description of the activity during each phase of the process

Log Date/Time

Administrator's Guide Axiom Contract Management | 38



¢ Exception — Error and associated information

e Error— Error flag True or False; True indicates an error

To view the SQL Importer log:

In the main menu header, click Admin > SQL Importer log.

Launch Page Contracts Claims Import Data Reports Admin Help Logout Queued Tasks: 0 ?

SQL Importer Log

SQLImp...  TaskGr... Message Log Date/Time Exception Error

316 0 Beginning SQL Importer Job 2020-12-16 2234 PM False -
316 0 No files or folders are configured for TaskGrouplD 0 2020-12-16 2:34 PM True

316 0 Completed SQL Importer Job 2020-12-16 2:34 PM False
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Managing attributes

Attributes are custom tags that allow you to extend contract data models. Attributes allow you to add
information to a contract that exists on the physical contract but for which there may not be room in

the modeled version.

e Attributes can be applied to claim and line-level reporting to enhance understanding of contracts

and calculation performance.

e Attributes provide a way for you to define, organize, and categorize all levels of a contract model.

e Attributes are used to indicate which clauses and terms to include in the Calculation Detail report.

e Attributes enhance the reporting and analysis of contract calculations.

Only users who have permissions to model contracts can add attributes to contracts.

As a system administrator, you create and manage system attributes on the Attributes page, accessible

from the Admin menu on the main toolbar.

| Launch Page Contracts Claims Import Data Reports Admin Help Logout ‘Queued Tasks: 0
Attributes Click to create a Create New Recorc
new attribute
Attribute Name T Atiribute Description T Atiribute Data Type T  tiributeType T Enable
Delete Text Delete Text Test Text Provision @
FinClass FinClass Library Contracf . . \
Click to edit the —
Hierachy Ranking Hierarchy Ranking Integer ClauseT . . . IC.20 |
E attribute in this row
nterger nteger Test nteger Contrach \
Medicare Part A Medicare Part A versions Text Version @ Click to delete
Medicare part B Provision with Medicare Part B Text Provision (@) the attribute in
Money Money format Money Contract @ thIS row
Percent Percent format Percent Contract @
Percent of copay Percentage of copay Percent Version @
Percent of Medicare Adjustment from percemt of Medicare Percent Version @
Plan Copay Dollar amount copay per visit Money Provision @
nclude this contract in price transparency
Price Transparency Include Library Contract @ -

Overview of Attributes page

Administrator's Guide
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Create an attribute

Attributes available to you depend on the contract level you are at when you add the attribute. If you
are adding an attribute at the version level, the only attributes available to select will be version type
attributes. This means that when you create attributes, think about what kind of data the attribute
should hold, and at what level of the contract the attribute should be applied.

NOTE: Only system administrators can create attributes.

Use these instructions to create attributes that do not contain libraries (i.e., a selection list).

To create a non-Library data type attribute:
1. Inthe main menu header, click Admin > Manage Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

3. Onthe Create New Attribute page, in the Attribute Name field, type a name for the attribute.
4. Inthe Attribute Description field, type a description for the attribute.
5

From the Attribute Data Type drop-down, select one of the following:

NOTE: You cannot change an attribute’s Data Type after saving the attribute.

* Integer — Creates a field that accepts a number

e Money — Creates a field that accepts dollar and cent amounts
e Decimal — Creates a field that accepts decimal values

¢ Percent — Creates a numerical field that accepts percentages
e Text — Creates a text field for the user to enter text

e Library — Creates a list from which a user can select values. To create this type of attribute,
see Create a Library attribute.

6. From the Attribute Type drop-down, select which part of a contract the attribute should be
applied to:

NOTE: You cannot change an attribute’s Type after saving the attribute.

e Contract
e Version
¢ Provision

e ClauseTerm

7. (Optional) By default, the attribute is enabled. To disable this attribute after creation, clear the
Enabled check box.

8. If you selected the Library attribute data type, click Save. When the page refreshes, click the Edit
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Library button to the right of the grayed out Attribute Data Type field.

9. Do one of the following:
e To save but remain on this page, click Save.
e To save and exit this page, click Save and Close.

e To save and create another attribute, click Save and New.

Create a library attribute

Library data type attributes allow you to create a list users can select from when applying the attribute.

To create a Library data type attribute:
1. In the main menu header, click Admin > Manage Attributes.

2. On the Attributes page, in the upper right, click Create New Record.
3. Onthe Create New Attribute page, in the Attribute name field, type a name for the attribute.
In the Attribute Description field, type a description for the attribute.

From the Attribute Data Type drop-down, select Library.

o v &

From the Attribute Type drop-down, select the contract part the attribute should be applied to.

NOTE: You cannot change an attribute’s Type after saving the attribute.

7. (Optional) By default, the attribute is enabled. To disable this attribute after creation, clear the
Enabled check box.

8. Click Save.
The page refreshes to display the Edit Attribute page with your new attribute in the dialog.
9. Click the Library button.
10. Inthe Edit Library dialog, click +Add new record.
11. Inthe Library Value field, enter the first item for the pick list in the field provided, then click Save.
12. Repeat step 11 until all the items in the pick list are added.
13. Click the X in the upper right corner to close the dialog.

14. On the Edit Attribute page, click Save and Close to save and exit the page, or click Save and New
to save and then create another attribute.

Edit or delete an attribute

Only System administrators can edit or delete attributes.

Administrator's Guide Axiom Contract Management | 42



Editing includes:

e Changing attribute names and values,
e Disabling or enabling attributes
¢ Deleting attributes

NOTE: You cannot change an attribute’s Data Type or Type. However, you can edit pick list entries
for Library data type attributes.

To edit an attribute:

1. In the main menu header, click Admin > Manage Attributes.

2. On the Attributes page, to edit an attribute, click the Edit icon ([#") at the end of the attribute’s
row and then do any of the following:
e To disable the attribute so that it cannot be used, clear the Enabled check box.
e To change the name, in the Attribute Name field, edit the name.
e To change the description, in the Attribute Description field, edit the description.
e To change the pick list selections for a Library data type attribute:
a. To the right of the Attribute Data Type field, click the Library button.

b. To edit an entry, click the Edit button for the entry, make desired changes, and then
click Update.

c. To add a new entry, click Add new record, and then enter a value, then click Save.

d. To delete an entry, click the Delete button for the entry, and then click Delete in the
confirmation dialog.

NOTE: If the library entry you are deleting is currently in use by a contract level,
a warning displays informing you that you need to remove that entry from all
contracts to which it is applied before you can delete it.

e. Close the Edit Library dialog.
3. Click Close.

To delete an attribute:

NOTE: The recommended best practice is to disable an attribute rather than deleting it.

1. Verify that the Enabled column displays an empty circle icon: (). If it does not, then click the
Edit button and clear the Enabled check box, then save the attribute.

2. Verify that the attribute is not currently attached to any contract level.

3. Atthe end of the attribute’s row, click the Delete icon ().

4. Inthe Delete confirmation dialog, click Delete.
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5. Click Save.
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Managing insurance plan codes

As an administrator, you can manage insurance plan codes in your Axiom Contract Management
systems. Managing codes include creating new codes, searching for existing codes, and adding codes to
contracts.

Insurance plan codes are assigned to contract versions to determine which payers and procedures on
incoming claims apply to that version. New codes coming in on claims are automatically added to the
OrgCode PayerCode library. However, the new code will not cause the claim to trigger a contract until
the code is added to a contract version. As an administrator, you can assign a new insurance plan code
to a contract as soon as you become aware of it so that incoming claims calculate upon import instead
of waiting until the new payer code is assigned. Then, when the new code imports from a claim or an
AddPayer file, it is recognized as existing and not duplicated.

On the Insurance Plan Codes page, you can do the following:

¢ Add a new insurance plan code to the system

e Search for existing insurance plan codes using a variety of criteria

Create an insurance plan code

Use these instructions to add a new insurance plan code to your system if you know the payer code and
the associated organization.

To create a new insurance plan code:

1. Inthe main menu header, click Admin > Manage Insurance Plan Codes.

| Launch Page Contracts Claims Import Data Reports Admin Help Logout
Manage Attributes
Live b | = I Manage Insurance Plan Codes I
Contracts Simulation Mapping
Recalc History
+ Add a New Contract SQL Importer Log
Contract Name T LatestE provider Org Code Mapping Attributes
AETNA 2 12/31/20 Manage Clause/Term Descriptions ()
ANTHEM OHAS 3 12/31/2026

2. On the Insurance Plan Codes page, in the upper right, click Create New Payer Code.
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3. On the Create New Payer Code page, from the Organization drop-down, select the applicable
organization.

4. Inthe Payer Code field, enter the code for the payer.

5. In the Payer Description field, type a description for the payer.

] Launch Page Contracts Claims Import Data Reports Admin Help Queued Tasks: 0 ? |Logout
Create New Payer Code Back to Insurance Plan Codes
Organization

JONES HOSPITAL - JONES HOSPITAL v
Payer Code*

Payer Description*

E Save and Close

6. Do one of the following:
e To save and close the page, click Save and Close.

e To save the new code and continue working on the page, click Save.

NOTE: If you see a red line across the bottom of the page when you save, it means that payer
code is already in use in the system. You will need to use a different payer code.

The new code is now available for assigning to a version.

NOTE: Currently there is no delete function for removing an insurance plan code from the system. If
you create a code in error, assign it to a dummy contract to remove it from the available code listing.

Search for an existing insurance plan code

If you do not see the insurance plan code you want to use in a selection menu, you can search for the
code to see if it exists. You can search on the following main parameters:

e Orgcode
e QOrganization
e Payer code

e Payer description

To search for an insurance plan code:

1. Navigate to the Insurance Plan Codes page:
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¢ From the Admin menu, select Manage Insurance Plan Codes.

¢ From the Edit Version window, in the Insurance Plan codes tab, click the Search icon (Q).

2. Onthe Insurance Plan Codes page, in the header of the column to search on, click the filter icon (
Y) at the right end of the column.

3. Inthe filter dialog, select the criteria to search on, and then click Filter.

Contains v

And v

Contains v
Clear

The list is filtered to items that fit your search parameters.

4. If your search returned no results, try broadening the search criteria; for example, instead of “Is
equal to” try selecting “contains.”

5. To clear the search, click the filter icon again, and in the search dialog, click Clear.

6. If you have verified that the insurance plan code is not in the system, you can add it if you have
administrative rights.

Map provider names to Org codes

Contract Management administrators can manage provider name mappings to organizational codes
using the Provider Org Code Mapping feature.

When a claim enters the system, the provider name on it is checked against the existing list of names. If
the name is different in any way from the names already in the list (for example, spelling or word order),
it is added to the list. Administrators can then map the new provider names or the name variances to
the correct Org codes.

By default, new provider names come in with the default code. You can select the desired name from
the Org Code drop-down or, if needed, you can create a new Org code.
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Contracts

Launch Page

Provider Org Code

‘Warning: Changes to Org Code Mapp
Provider Name
A
AAA AMBULANCE SERVICE
Associates in Medicine
BEN KILDWARE SERVICE
CHRIS GOOD HEALTH HOSPITAL - Dikemb
EMERGENCY PHYSICIANS GROUP
GOOD HEALTH HOSPITAL
GREENE
HALL OF FAME MEMORIAL HOSPITAL

HAPPY DOCTORS GROUP PRACTICE

Add New Org Code

Org Code*

Claims

When a unique provider name
enters the system from a claim, it
is listed here

Description®

Imnort Nata

Admin Help

h the Provider Name

Org Code

Logout Queued Tasks: 0 ?

Select the desired Org Code to
map the provider name to

| 07 - KREG MEDICAL CTR ORG1

[ bla bla-123 bla bla

| 01 - KREG MEDICAL CTR ORG1

| 01 - KREG MEDICAL CTR ORG1

| 01 - KREG MEDICAL CTR ORG1

| 01 - KREG MEDICAL CTR ORG1

| 07 - KREG MEDICAL CTR ORG1

| 03 - CHRIS TEST ORG

| 01 - KREG MEDICAL CTR ORG1

| JONES HOSPITAL - JONES HOSPITAL

]

-

1-100of 57 items

Codes to the selection lists

Use this section to add new Orgj

To map a provider name to an Org code:

1.
2.

In the main menu header, from the Admin menu, select Provider Org Code Mapping.
Locate the provider name in the list on the left. Names are listed in alphabetical order.

In the Org Code column, from the Org code drop-down for the corresponding provider name,
select the desired Org code. The change is saved automatically. If the needed Org code does not
exist, you can add it using the following instructions.

To propagate the provider name and Org code association to existing claims, recalculate the
claims.

To add a new Org code:

In the main menu header, from the Admin menu, select Provider Org Code Mapping.

In the Add New Org Code section, in the Org Code field, type the number to associate with the

In the Description field, type the Org code description.

1.
2.
Org code.
3.
4. Click Save.
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Modeling contracts

Axiom Contract Management stores contract terms, patient claims, and payment information. The
system uses the contract payment terms and the patient claim information to calculate an expected
payment for every claim submitted by the provider. After the claim is paid by the primary payer, it can
be compared to the expected payment and/or the expected contractual to see if the claim was
reimbursed according to the agreed upon contract terms.

Navigating in contracts

This section covers how to navigate to different contract levels, access hidden icons, and use some
general links in the main menu header.

» Navigate to contract levels

Contract pages in Axiom Contract Management are laid out in a simulation-to-term hierarchy, with the
simulation name at the highest level, and terms (unless the final clause has no terms) at the most
granular:

e Simulation >
° Contract >
© Versions >
° Provisions >
° Clauses >

° Terms

Drill through each level to reach the one below it. As you move through the contract levels,
breadcrumbs display at the top of the page.
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To navigate to different contract levels:

e To navigate to versions, from the Contracts page, for the desired contract, hover your cursor in
the contract row, and then click Go to Versions.

Contract Name

Aetna > Go to Versions

e To navigate to provisions, from the Versions page, for the desired version, click Go to Provisions.
e To navigate to clauses, from the Provisions page, for the desired provision, click Go to Clauses.
e To navigate to terms, from the Clauses page, for the desired clause, click Go to Terms.
¢ Onthe Terms page, or any page in between, you can backtrack to previous pages using the linked
breadcrumbs at the top of the page. Click the link to go back to the desired page.
Launch Page Contracts | Claims | ImportData | Reports | Admin | Help

DocuSim > Ore Medicaid > Version 1 (1/1/2019 - 12/31/2019) > Hospital Inpatient (Including Medicare Part A) (1/1/2019 - 12/31/2019) > Clause 2

Simulation  Contract Version Provision Clause

Terms

+ Add a New Term

Terms Description Calc Basis Calc Type Calc Measure

1 DETOX All Other Line ltems Dollar Rate Per Line ltem

When you backtrack, the page you backtracked from is removed from the breadcrumb trail.

» Viewing hidden icons

Certain icons are hidden until needed at the end of each row. Your user role determines which icons are
available to you. For example, Edit, Clone, and Delete icons are not displayed for non administrators.

To view hidden icons:

1. Hover your cursor over the row to view the icons.

2. Click the desired icon.

Versions

+ Add a New Version %)

Version Start Date Y  Expiration Date Y calculation Date Ins. Plan ... Attached ... Attributes

1 > [Gotoprovisions 1/1/2008 2/2/2008 Discharge @ ZEeE
4

2> r 7/1/2009 12/31/2017 Discharge ® ©® *
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» Accessing quick links

Axiom Contract Management’s main menu header has links that provide quick access to context-level
help pages, software version and copyright information, a queued tasks indicator, and logout.

To use quick links:
¢ To access the software version and copyright information, from the main menu header, select
Help > About Contract Management.

¢ To log out of the system, on the right side of the header after your username, click Logout.

e To view the number and type of your queued tasks, on the right side of the header, Queued
Tasks: # displays the number of tasks you have in the queue. To view a drop-down list of your
gueued tasks, hover your cursor over the Queued Tasks text.

e To view the online help topic for the specific Axiom Contract Management page you are on, on
the far-right side of the main menu header, click the Context Help icon (H).

NOTE: Not all pages in the Axiom Contract Management system have context-level help. For
pages that do not, clicking the Context Help icon takes you to the main help page.

Click for context-level
Click to log out help (where available)

| Launch Page Contracts Claims Import Data Queued Tasks: 0

Contract Management Help
Live v

Click for version number About Contract Management Hover for list of queued items by
and copyright/legal info Priority, Task Type, Queued By,
Contracts and Total Claims

&)

Searching lists and filtering contract columns

Along with improved navigation, the updated Ul for contract pages and dialogs provides new sort and
filter functionality for contract table grids, and search functionality for some dialog fields.

Many contract grid columns can be sorted and filtered. In most contract dialogs, if a drop-down field has
a long list of entries, you can search the list.

To sort and filter table columns:
1. To sort a column, click the header. A sort up (%) or sort down arrow (+) displays in the column
header if the column can be sorted.

2. Tofilter a column:

a. In the column header, click the filter icon (T ).

b. Inthe filter dialog, from the first drop-down, select the parameter to use, and then type
the word into the field provided. If desired, add another filter parameter.
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c. Click Filter. The list filters to display results that meet the filter parameters.

d. To clear the filter, click the icon again and then, in the filter dialog, click Clear.

To search a long list of entries in a dialog drop-down field:

1. Click the drop-down, and then start typing a search word or letter.

2. The list changes to begin with the search word or letter. A small red triangle displays at the upper
left corner of the field to show that the entry has changed. However, if you decide not to select a
different item from the list, your original selection displays and the red triangle disappears. Select
the desired option from the list.

Calc Basis

(Multi—Channel Discount v

Line ltem Code Bundle
| Line ltem Code Incidental
Line ltem Code Modifier

Line ltem Code MPR

Line [tem Code Plus RevCode
Line ltem Code POS

Multi-Channel Discount - ‘

Filter contracts on the Contracts page

You can filter the list of contracts on the main Contracts page by contract name or by the latest
expiration date.

To filter contracts:
1. If the desired simulation is not currently selected, select it from the simulation drop-down:

A] Launch Page Contracts Claims Import Data Reports Admin Help
Live VQL
2017 Simulations
2020 2nd Quarter Modifications
A ChgAdj Base Y Latest Expiration Date Y  Attributes

A ChgAdj Base 2
A ChgAdj Overall
i

A ChgAdj Overall 2
PP 12/31/2028

12/31/2024

12/31/2024

ANTHEM OHAS 12/31/2026
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2. Inthe Contract Name column header on the right, click the Filter icon (Y).

NOTE: To filter by expiration date, click the filter icon in the Latest Expiration Data column
header.

3. In thefilter dialog, from the drop-down, select the desired filter criteria. The default criteria is
“Contains.”

4. Inthe input field, type the item on which to search. For example, if you selected Contains as the
criteria, type the word or phrase contained in the contract name you are searching for.

5. Click Filter.
| Launch Page Contracts Claims Import Data Reports Admin Help
Live v Ed
Contracts
+ Add a New Contract
Contract Name Latest Expiration Date b
AETNA > Contains E

ANTHEM OHAS >
Medicaid|

aTest Voucher >
And v
CIGNA HMO >
CIGNAPPO > Contains v
KHA MANAGED CARE )
KHAMEDICAID >

KHAMEDICARE > Clear Filter

KHAFPPO > 12/31/2021

The filtered list displays contract names based on the criteria you specified.

6. To clear the filter, click the Filter icon again, and then click Clear.

Contract data requirements

For expected payments to be modeled accurately, the contract terms must be entered correctly in
Axiom Contract Management. To accomplish this, you need a thorough understanding of the contract
language and terms as well as access to electronic fee schedules, and any other data relevant to building
a model of the signed contract. For Medicare-based contracts, you need hospital-specific factors
provided to the hospital by either the Fiscal Intermediary (FI) or by CMS directly. Often this requires
direct contact with the payer representative.

You then need to interpret these terms into Axiom Contract Management, with the understanding that
Axiom Contract Management uses specific logic to calculate a claim. This logic is discussed in the rest of
this section on building contracts.
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Add a new contract

The following instructions are for creating a new contract from scratch.

To add a contract:

1. Onthe Contracts page, verify that you are in the correct simulation. If you are not, then from the
simulation drop-down, select the desired simulation.

2. Under the Contracts page title, click Add a New Contract.

NOTE: The Add a New Contract option is displayed only if you have administrative access.

3. Inthe Add a New Contract dialog, in the Contract Name field, type a name for the contract (e.g.,
Medicare Blue Cross). Do not use special characters.

4. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

NOTE: You do not need to enter the latest expiration date because that is defined by the
versions built under the contract.

5. (Optional) If desired, add an attribute to the contract.

6. Next, add a version to the contract.

Edit or delete a contract

Use these instructions to change contract settings at the contract level. You can make the following
changes:

* Change a contract name
e Change attribute values

¢ Delete a contract

To edit a contract:

1. Navigate to the contract.

2. At the end of the contract row, click the Edit icon ([#).

3. Inthe Edit Contract dialog, do any of the following:
¢ To change the contract name, in the Settings tab, in the Contract Name field, type the new
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name.

e To change the contract’s attribute values, in the Attributes tab, make the desired changes
to the listed attributes. For more information, see Edit or remove an attribute from a
contract.

e To import attributes, see Import an attribute to a contract.

4. Do one of the following:
e To keep the dialog open so you can work on another tab, after saving, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

To delete a contract:

1. Verify that the contract and its versions are not being used or do not need to be retained as
records; for example, if you created a duplicate contract by mistake and want to delete it.

2. Atthe end of the contract’s row, click the Delete icon (i).

3. Inthe confirmation dialog, click Delete.

Assign an insurance plan code to a version

For a claim to calculate on a contract, Axiom Contract Management must know which payers calculate
against the version. Use these instructions to assign an insurance plan code to a contract version or to
change the assigned code.

1. Navigate to the contract version.

2. At the end of the version row, hover your cursor and then click the Edit icon ([#).

3. Inthe Edit Version dialog, click the Insurance Plan Codes tab.

4. Do one of the following:
e Import insurance plan codes from another version.

e Continue to step 5 to add codes from the list of unassigned codes.

5. Inthe Unassigned list, select the insurance plan codes (org code - payer code combinations) to
add to the version by clicking the Assign icon (#) on the right end of the row, as shown in the

following example.
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Unassigned Import

Viewing: | 01 - KREG MEDICAL CTR ORG1 v |

Organization Y  Payer Code Y  Payer Description BT

01 - KREG MEDICAL CTR ORG1 05440 NO DESCRIPTION -
01 - KREG MEDICAL CTR ORG1 070007 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 091 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 1 1

01 - KREG MEDICAL CTR ORG1 100000233 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 100000237 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 100000247 NO DESCRIPTION -

1 2 3 4 5 6 7 8 9 » w 1-250f 215 items

Close

m Save and Close

¢ [f there are multiple organizations, then before selecting codes, click the Viewing drop-
down and select the organization from which to select codes.

NOTE: You can assign codes from multiple organizations, but the list is filtered by
organization. Before saving, change the organization to add more codes.

e If you cannot locate the desired insurance plan code, search for it in the system: at the top
right of the Edit Version dialog, click the search icon, as shown in the following example,
and then search for the desired code.

Edit Version

Version 1 | Insurance Plan Codes

Settings  Insurance Plan Codes  Attributes Documents E
Assigned T
Organization T PayerCode T Payer Description T
01 - KREG MEDICAL CTR ORG1 00123 NO DESCRIPTION

NOTE: Administrators can add new insurance plan codes to the system. For more
information, see Managing insurance plan codes.

6. When finished adding codes, do one of the following:
e To save changes and keep working in the dialog, click Save.

* To close the dialog after saving, click Save and Close.
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¢ To cancel your unsaved changes and close the dialog, click Close.

DocuSim > Medicare
Versions
+ Add a New Version %)

Version Start Date T Expiration Date T Calculation Date Ins. Plan ... Attached ... Attributes

o> 10/1/2018 9/30/2019 Discharge @

2 > 10/1/2019 9/30/2020 Discharge
1 1-20f 2items

Checked circle indicates this version has assigned insurance plan codes

7. If you are building a contract, the next step is to add a provision.

Copying contracts

After a set of contracts is built into Axiom Contract Management, you can use the contract parts as the
basis for new contracts. You have a number of options when copying contracts:

e Copy a version to the same or different contract

e Copy a version to a different contract (using the import version feature)
e Copy a version from a file (using the import file feature)

e Copy a provision to the same version

e Copy a provision to a different version in the same or different contract
e Copy a clause or aterm

Modeling versions

A version is a defined time frame during which the contract as a whole is valid and the terms are
consistent. It can represent the fiscal year, the calendar year, or some other defined period. In the
Axiom Contract Management contract hierarchy, versions reside directly under contracts but above
provisions.

Add a version

After creating a contract, the next step is adding a version. Instead of names, versions are identified by
their active period, which is the time frame defined by their start and expiration dates. Versions are
assigned numbers that correlate to the version’s original start and expiration date period. Generally, the
older a version, the lower the number used to identify it. So, for example, version 1 would be older than
version 2, and so on.
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Use these instructions to add a new version to a contract. You can also copy a version by importing it
from another contract, or you can import a version from an external file.

To add a new version:

1. On the Contracts page, hover your cursor over the desired contract row to view the Go to
Versions link, then click the link.

TIP: If the list of contracts is long, find the desired contract by filtering the list.

2. On the Versions page, click Add a New Version.

3. Inthe Add a New Version dialog, in the Start Date field, type in the date or click the calendar

icon (ﬁ) and select the date on which the version takes affect.

» About Start Date / Expiration Date

In Axiom Contract Management, a version represents a defined time frame for the contract. The
time frame used can be from the time period on a certain contract where the terms remain
consistent. It can represent the fiscal year, or it can represent the calendar year. To minimize the
number of contracts built, we recommend that you build versions defined by contract periods
where terms remain unaltered.

4. Inthe Expiration Date field, type in the date or click the calendar icon (ﬁ) and select the date on
which the version’s active period ends.

5. In the Calculation Date field, select the calculation date for the version—either the date of
discharge or the date of admission.

» About Contract Calculation Date

You have two options when calculating claims: you can choose to calculate them by the date they
were admitted (Admit), or by the discharge date (Discharge).

The one you use depends on the payer, which you should confirm with them. The default is by
discharge date.

6. Do one of the following:

e To keep the dialog open after saving, click Save.

e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.
7. (Optional) If desired, add an attribute to the version.
8. (Optional) If desired, attach a document to the version.

9. Next, assign an insurance plan code to the version.
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10. Add a provision to the version.

Assign an insurance plan code to a version

For a claim to calculate on a contract, Axiom Contract Management must know which payers calculate
against the version. Use these instructions to assign an insurance plan code to a contract version or to
change the assigned code.

1. Navigate to the contract version.

2. At the end of the version row, hover your cursor and then click the Edit icon (E,I‘).

3. Inthe Edit Version dialog, click the Insurance Plan Codes tab.

4. Do one of the following:
e Import insurance plan codes from another version.
e Continue to step 5 to add codes from the list of unassigned codes.
5. Inthe Unassigned list, select the insurance plan codes (org code - payer code combinations) to
add to the version by clicking the Assign icon (#) on the right end of the row, as shown in the

following example.

Unassigned Import Viewing: | 01 - KREG MEDICAL CTR ORG1 v
Organization Y  Payer Code Y  Payer Description BT

01 - KREG MEDICAL CTR ORG1 05440 NO DESCRIPTION -
01 - KREG MEDICAL CTR ORG1 070007 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 091 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 1 1

01 - KREG MEDICAL CTR ORG1 100000233 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 100000237 NO DESCRIPTION

01 - KREG MEDICAL CTR ORG1 100000247 NO DESCRIPTION -
1 2 3 4 5 6 7 8 9 » » 1-250f 215 items

m Save and Close Close

e If there are multiple organizations, then before selecting codes, click the Viewing drop-
down and select the organization from which to select codes.

NOTE: You can assign codes from multiple organizations, but the list is filtered by
organization. Before saving, change the organization to add more codes.
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e If you cannot locate the desired insurance plan code, search for it in the system: at the top
right of the Edit Version dialog, click the search icon, as shown in the following example,

and then search for the desired code.

Edit Version

ViE

Version 1 | Insurance Plan Codes

Settings Insurance Plan Codes  Attributes Documents
Assigned 1
Organization Y Payer Code Y Payer Description Y
01 - KREG MEDICAL CTR ORG1 00123 NO DESCRIPTION

[a]

NOTE: Administrators can add new insurance plan codes to the system. For more

information, see Managing insurance plan codes.

6. When finished adding codes, do one of the following:

¢ To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

DocuSim > Medicare

Versions
+ Add a New Version %)

Version

10/1/2018

> 10/1/2019

Start Date T

Expiration Date

9/30/2020

Y calculation Date Ins. Plan . Attached .. Attributes

Discharge

Discharge T

1-20f 2items

Checked circle indicates this version has assigned insurance plan codes

7. If you are building a contract, the next step is to add a provision.

Import insurance plan codes to a version

When creating or editing a contract version, you can import insurance plan codes from another version.

The import feature imports copies of the insurance plan codes.

To import insurance plan codes to a version:
1. Navigate to the version to which you want to add codes.

2. At the end of the version row, hover your cursor and click the Edit icon ([#).
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3. Inthe Edit Version dialog, click the Insurance Plan Codes tab.
4. Inthe lower half of the dialog, click the Import tab.

5. (Optional) If you want to import codes from a different simulation than the one you are in, from
the Simulation drop-down, select a simulation.

6. Inthe list of contracts, locate and expand the version that has the codes you want. To import a
code, click the arrow icon at the end of the code row, as shown in the following example:

Unassigned Import Simulation: | Live v
Contract Name @ T
+  AETNA

= ANTHEM OHAS

Version Start Date Expiration Date Calculation Date
+ 1 1/1/2007 12/31/2007 Admit
+ 2 1/1/2008 12/31/2008 Admit

+  ATestofZeroOutClaims
+ CIGNA HMO -

4 4 1 2 3 ] - 25 of 39 items

Close

The code is copied to the Assigned section of the dialog.
7. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

NOTE: If you copy a code you do not want, before saving, you can remove it by clicking
the Cancel icon (€). To remove after saving, from the Assigned section, click the

Unassign icon (@) for that code.

Remove an insurance plan code from a version

Use these instructions to remove an assigned insurance plan code from a contract version.
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To remove an insurance plan code:

1. Navigate to the contract version.

2. At the end of the version row, click the Edit icon ([#).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. Inthe Assigned section of the dialog, for the code to remove, at the end of the code row, click the
Unassign icon (3‘).

Edit Version

Version 11 | Insurance Plan Codes

Settings  Insurance Plan Codes  Attributes  Documents

Assigned
Organization Y  Payer Code Y  Payer Description h g l
01- KREG MEDICAL CTR ORG1 0002 Medicaid

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

Edit or delete a version

After copying or importing a version from another contract, you may want to make some changes to it.
You can do the following:

e Change the start/expiration dates

e Change the calculation basis

e Add or remove insurance plan codes

¢ Add or remove attributes or change attribute values
e Add documents or remove attached documents

You can also delete a version if it is not in use and does not contain historical data that needs to be
preserved.

To edit a version:
1. Navigate to the contract and then click Go to Versions.
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: Launch e A

DocuSim v B

Contracts

+ Add a New Contract
Contract Name
Aetna > Go to Versions

Aetna Medicare >

2. At the end of the desired version row, click the Edit icon (|:1’~).

3. Inthe Edit Version dialog, do any of the following as needed:

To change the Start Date or Expiration Date, in the Settings tab, type in the dates, or click
the Calendar icon (ﬁ) and select the desired dates.

NOTE: You cannot change the dates to any time period that would cause an overlap
with another version on the contract. Also, if any provisions are attached to this
version, you cannot change the version time frame to be inside of the provision time
frames.

To change whether the calculation is based on the discharge or admit date, in the Settings
tab, in the Calculation Date field, select the desired option.

Add or remove an assigned insurance plan code.
Add, edit, or remove attributes.
Attach or remove a document.

4. Do one of the following:

To save changes and keep working in the dialog, click Save.
To close the dialog after saving, click Save and Close.

To cancel your unsaved changes and close the dialog, click Close.

To delete a version:

1. Navigate to the version.

2. Verify that the version and its provision, clauses, terms, etc., are not in use and do not contain
data that needs to be preserved as records.

3. At the end of the version row, click the Delete icon ().

4. Inthe conformation dialog, click Delete.
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Copy a version

Use these instructions to copy a version to the same contract. To copy a version to a different contract,
use the Import Version feature.

To copy a version:
1. Navigate to the version to be copied.

2. Atthe end of the version row, hover your cursor and click the Clone icon (lj).

3. Inthe Clone Version dialog, on the Settings tab, note that the Start Date and the Expiration Date
have been set one year ahead of the Start and Expiration dates of the most recent previous
version in the version list (not necessarily the one you copied). You can change these dates from
the Edit Version dialog if needed; however, if the changed dates conflict with any provisions that
were copied over with the version, a conflict message displays in the dialog, as shown in the
following example:

Edit Version

Version 3 | Settings

Settings  Insurance Plan Codes  Attributes  Documents
Start Date

1/1/2022 &l
Expiration Date

9/30/2022 &l

Calculation Date
Discharge v

A\ Conflict with provision date range

4. By default, any provisions, insurance plan codes, attributes, and attached documents are included
in the copy. However, if you do not want to copy everything, clear the check boxes for the items
that you do not want included in the copy.
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Clone Version x

Version 1 | Settings
Settings  Insurance Plan Codes  Documents  Attributes
Start Date
Expiration Date
Calculation Date
Include Provisions
Include Insurance Plan Codes

Include Attributes

Include Documents

Settings, Insurance Plan Codes, Attributes and Documents will not be editable until the new
version is saved. The checkboxes above may be used to include or exclude associated
sections of data when cloned.

m Save and Close Close

NOTE: You cannot make changes to the other tabs in the Clone Version dialog. Save the
version and then make changes in the Edit Version dialog.

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
¢ To close the dialog after saving, click Save and Close.
¢ To cancel your unsaved changes and close the dialog, click Close.

6. (Optional) Edit the version.
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Import a version from a contract

Use these instructions to import a copy of a version from another contract. You can also import a
version from a file.

To import a version from one contract to another:

1. Navigate to the contract needing the version.

2. Inthe contract row, click Go to Versions.

) e A

DocuSim v B

Contracts

+ Add a New Contract

Contract Name

Aetna Medicare >

3. On the Versions page, click the Import Version icon (%)) and select Import from another

contract.

DocuSim > Aetna

Versions

+Add a New Version =) Import from another contract
Version Import from a file Y
> 1/1/2020

4. Inthe Import a New Version dialog, if you need to switch to a different simulation, then from the
Simulation drop-down, select the simulation.

5. Inthe Select a version to import section, expand the listed contract that contains the desired
version to copy, and then click the version row. The row does not stay selected, but the name of
the selected row displays at the bottom left of the dialog.

6. By default, the check boxes to include any provisions, insurance plan codes, attributes, or
documents attached to the version, are selected. Clear the check boxes for those items that you
do not want to include.
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Import A New Version x
New Version | Import from Contract
Select a version to import simulation:
Contract Name T
+  ORG1-MedCost “
- ORG1 - Medicaid
Version Start Date Expiration Date Calculation Date
10/01/2008 09/30/2009 Discharge
3 10/01/201 Discharge
4 10/01/2011 Discharge
5 0/01/2012 Discharge
6 0/01/2013
7 10/01/2014 09/30/2015
I &8 09/30/2016 I
9 09/30/2017
ORG1 - Medicaid SNF
ORG1 - Medicare
+ ORG1 - Medicare Contract
1 2 » M 1-25 of 41 items
nclude Provisions
nclude Insurance Plan Codes
nclude Attributes
nclude Documents
Selected:|ORGT - Medicaid Versio

7. Click Import.
8. (Optional) If desired, add an attribute to the version.
9. (Optional) If desired, attach a document to the version.

10. If needed, assign an insurance plan code to the version.

Import a version from a file

Use these instructions to import a copy of a version from a file. You can also import a copy of a version
from another contract.

To import a version from a file:

1. Navigate to the contract that needs the version.

2. Inthe contract row, click Go to Versions.
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| Launch Page Contracts Claims Import Data Reports Admin He|
DocuSim v Bl

Contracts

+ Add a New Contract

Contract Name

Aetna Medicare >

3. On the Versions page, click the Import Version icon (%)) and select Import from a file.

Launch Page Contracts Claims Import Data Repor
DocuSim > Aetna
Versions
+ Add a New Version =) Import from another contract
Version Import from a file ) ¢
LR 1/1/2020

4. Inthe Import a New Version dialog, in the Select a version file to import list, do any of the
following:

« Toview the version file before importing it, click the Download icon (-+u) for the version,

and then click the downloaded file to view it. (The file downloads in .xml format.)
e To select a version file, click it.
¢ |f the version file you want is not listed, upload the file:
a. Inthe Upload a file to the list section, do one of the following:

° Drag and drop a version .xml file to the gray area marked Drop files here to
upload.

° Click Select files and select a file to upload.

b. Click Upload.
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Upload a file to the list

Select files...

75_Percent_with_IP_Implants.xml v

Clear [MVsLED]

c. Locate the uploaded file in the list and select it.
5. Click Import.

6. If desired, edit the version.

Export a version
Export a version when you want to create an importable file of the version or if you want to create a
backup.

IMPORTANT: Export/Import Provisions is not a preferred tool to copy contracts into Live. It should
be done as a time-saving safety net in case a contract is irreversibly altered incorrectly.

We recommend that you maintain your own contract backups in case of an irreversible error. You can
create backups using the Export Version feature.

To export a version:
1. On the Contracts page, navigate to the desired contract version.

2. At the end of the version row, click the Export icon ().

3. Inthe Export Version dialog, type a name for the exported version file or leave the default.
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Export Version X

Version 1 | Export Version

Enter a file name:

Medicare_Version1

Existing files:
100_Percent_with_IP_Implants.xml
57471_Test_Contract_1_Version1.xml
63287 _Test_Contract_1_Version1.xml
63287 _Test_Contract_1_Version2.xml
63287_Test_Contract_1_Version3.xml
63287_Test_Contract_1_Versiond.xml
63287_Test_Contract_1_Version5.xml
75_Percent_with_IP_Implants.xml
762_Percent_with_stop_loss.xml
796_Percent_with_stop_loss.xml -

4. Click Export.

The exported version file will be available in the Import Version dialog when you select to import
a version from a file.

Attaching supporting documents to a contract

NOTE: This topic applies to supporting documents attached to versions. Other file types such as rate
files, fee schedules, translation tables, thresholds, and adjustments are added to contracts at the
clause or term level. For information on managing these files, see Using Rates.

When modeling contracts, you may need to attach documents to support the contract. You attach these
kinds of files to contracts at the version level. You can attach files such as images, PDFs, Excel
worksheets, or any other document supporting the contract. Users can download, open and view the
documents as long as they have access rights to do so. Keep in mind that to view attached files, users
must also have an application installed that can read the file type. Only system administrators can
delete documents from contract versions.

Versions with attached files display a circle with check mark icon (@) in their Attached Docs column.

Upload a document to a contract version

Use this method to attach an external file to a contract version. You can also import a copy of a
document attached to another contract.
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To attach a file to a contract:
1. Navigate to the desired contract version.

2. Atthe end of the version row, click the Edit icon:

Attributes

AL NC A |

3. Inthe Edit Version dialog, click the Documents tab.

4. Inthe Upload a document tab in the lower half of the dialog, do one of the following:
* Click Select files, and then navigate to and select the desired document.
e Drag and drop a document file into the shaded area that reads “Drop files here to upload.”

5. When you see the document listed in the dialog, note that in green text under the document
name, it reads “File successfully uploaded.” You do not need to do anything else.

Upload a document = Copy a document

Select files

Denials Trending by Month_1063 (1).xlsx X
—

Close

6. Click Close. When you open the Edit Version dialog again, the uploaded document is listed in the
Attached Docs section of the Documents tab.

Copy an attached document to another version

Use these instructions to copy a file attached to one version of a contract to another version of the same
or different contract.

You can download, open and view the documents as long as you have access rights to do so.

NOTE: To view attached files, you must have an application that can read the file type installed on
your computer. Keep this in mind when attaching files.

Administrator's Guide Axiom Contract Management | 71



To copy an attached file from one version to another:

1. Navigate to the contract version to add a file to.

2. Atthe end of the version row, click the Edit icon:

Attributes

AL NC A |

3. Inthe Edit Version dialog, click the Documents tab.
4. Inthe lower half of the tab, click the Copy a document tab.

5. Inthe list of contracts, expand the desired contract name and version that contains the file to
copy.
6. Do one of the following:

« To copy all documents attached to the source version, click the up arrow icon (;l;) at the

end of the version row.

e To copy selected documents attached to the version, click the up arrow icon(s) for the
desired document(s).

Upload a document  Copy a document

Contract Name
Medicare

Version Start Date Expiration Date Calculation Date

- 1 10/01/2018 09/30/2019 Discharge
Attached Docs T

Denials Trending by Bill ID_1063 (1) xIsx
Select here to copy

Denials Trending by Month_1063 {1).xIsx . )
individual files

|d-case-counts-by-county-00-15.csv

Cancel

7. Do one of the following:
e To save changes and keep working in the dialog, click Save.
¢ To close the dialog after saving, click Save and Close.
e To cancel your unsaved changes and close the dialog, click Close.

When you open the Edit Version dialog again, the copied documents are listed in the Attached
Docs section.
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View a file attached to a version

When calculations are off, or there is a discrepancy in the contract data, it may be helpful to view the
actual contract to compare it against the modeled one. If the actual contract is attached to the modeled
contract as a file or files, you can view it as long as you have permissions to view attached files.

NOTE: If you do not have the application required for viewing the document installed on your
computer, you will not be able to open and view the file.

To view an attached contract file:

1.
2.

Navigate to the contract version with the attached document.

At the end of the version row, click the Edit icon ([#)

In the Edit Version dialog, click the Documents tab.

In the Attached documents section, locate the document to view and then click the download
icon (‘*ﬂ) at the end of the row. A copy of the document downloads to the bottom of your

screen.

Click the document file to open and view the document.

Delete a file attached to a version

System administrators can delete files attached to contract versions.

To delete a file attached to a version:

1.
2.

Navigate to the contract version.

At the end of the version row, click the Edit icon (I:,l‘).

In the Edit Version dialog, click the Documents tab.

In the Attached Docs section, for the desired document, click the Delete icon () at the end of

the row.

Modeling provisions

A provision defines the type of bill for which services are provided: Inpatient, Outpatient, Skilled
Nursing, etc. As a component of the version, multiple provisions may exist within a version to
differentiate contract rates for a given timeframe.

Administrator's Guide Axiom Contract Management | 73



Add a provision

You can add a provision to a contract by creating a new one, by copying and editing an existing one, or
by importing one. Use the following instructions to create a new provision.

TIP: Use this option when there is no similar provision to copy or import.

To create a new provision:

1. Navigate to the desired contract version.

2. In the desired version row, click Go to Provisions.

) LaunCh Page Import pata

DocuSim > Medicare

Versions

+ Add a New Version =)

Version Start Date Y  Expiration Date
102 10/1/2018 9/30/2019
2 > 10/1/2019 9/30/2020

3. On the Provisions page above the table of provisions, click Add a New Provision.
4. Inthe Add a New Provision dialog, the Start Date and Expiration Date of the provision are
automatically set to match that of the version the provision is under. If you need to change the

dates, type in new dates or click the calendar icon (5) and select the dates.
5. Click the Type of Bill tab.

Use this tab to select the Type of Bills that should calculate under the provision. For example, if
both the inpatient and outpatient contracts pay 75% of charge, you can create one contract
provision to handle both bill types. The provision’s purpose is to select the bill types that calculate
similarly under a specific date range.

6. Inthe Available section of the tab, click the plus icon to the left of the desired Type of Bill to
expand its codes, then select the bill codes to apply by clicking the Assign icon (#) at the end of

the row for each desired bill code.
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Available
Type of Bill
+  1XX- Hospital
+  2XX- Skilled Nursing

= 3XX-Home Healln view bill code options

Expand the Type of Bill toJ

Type of Bill

32X - Home Health - Inpatient (Including Part B only)

+ 4X¥ - Religious Non-Medical Health Care Inst - Hospital Inpatient

Available bill
33X - Home Health - Qutpatient
codes
34X - Home Health - Other

Close

NOTE: You cannot add attributes to the provision until you save it.

7. Do one of the following:
e To keep the dialog open after saving, click Save.

e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

8. (Optional) If desired, add an attribute to the provision.
9. (Optional) If needed, add a schedule to the provision.
10. (Optional) If needed, assign a modifier to the provision.

11. (Optional) If needed, add a global limit to the provision.

12. If needed, enter provision factors manually or import factors from a file or other provision.

13. Next, add a clause to the provision.

About Type of Bill (bill types)

The bill type, or Type of Bill (TOB), is a three-digit numeric code on a claim that identifies the specific
type of bill being sent to the payer. The first digit represents Type of Facility (Hospital, Skilled Nursing,
etc.), the second digit represents the Bill Classification (Inpatient, Outpatient, etc.), and the third digit

represents the Frequency (Admit/Discharge, Late Charges, Series, etc.).

The TOB submitted on the claim is important not only for determining the provision on which the claim
will calculate, but also for how the claim is handled during import. For every patient account, the
importing logic first checks whether the account already exists in the system. If it does, the system
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applies a series of logical statements and the instance of the claim is brought in as Active, an Exception,
or a Voided Record. All claims are brought in as the Active claim if no other instance of the claim exists,
and as long as the claim is not a Late Charge (e.g., TOB XX5) or a Voided Record (i.e., TOB XX8).

A Late Charge is always brought into the system as an Exception Record. If an active record exists for
that patient account, the late charge is attached to the active claim and the line items from the late
charge are appended to the active record. If no active record exists, the late charge claim sits idle as an
Exception until an active record is brought in for that particular account number. At that time, it
appends to the newly imported active claim.

Series TOBs (e.g., XX2, XX3 and XX4) are handled differently. If a Series Start bill (e.g., XX2) already exists
in the system and another is imported, the imported one becomes the new Active claim and the
previous instance is considered Replaced. The same applies to a Series End TOB (e.g., XX4). Multiple
Series Interim bills can exist on a claim; however, if an XX3 comes in and has the same admit and
discharge dates as a previous XX3 as well as the same total charges, it will replace the matching
instance.

The standard Admit/Discharge claim (e.g., XX1) always comes in as active, and replaces the existing
active record as long as the charges are equal to or greater than the current record. The claim comes in
as an Exception if total charges are less than the existing claim. A Replacement claim (e.g., XX7) always
replaces the existing active record no matter what the total charges are for the claim, and regardless of
whether or not there are late charges appended to the current record.

Replacement and Late Charge claims are not allowed with Series claims. Both come in as Exception
records if a series TOB exists on the account. The reverse is true as well: Series claims are not allowed on
non-series accounts.

About provision factors

Provision factors are used in various CMS calculations. Certain factors, along with other contract rules
related to modifiers, are required for APC and eAPG contracts.

Some of the factors are considered National Factors (e.g., Labor Related Standard Amount, Federal
Capital Rate, etc.), which means that they are the same across the nation. Some factors are Hospital
Specific and can only be answered by the hospital’s Medicare Specialist to whom notices are sent when
the factors are changed, or when a new fiscal year begins and all factors have changed. Any field labeled
“Release” cannot receive a manual entry; instead, it will be updated when rates are attached to the
clause or term.

To use any CMS-related calculation basis (e.g., CMS DRG, CMS Psych, CMS CMG, or Schedules related to
CMS), you must complete the factor forms. You can add the following types of provision factors:

e CMS DRG — Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient services that are paid using a code called a DRG.

e CMS CMG — Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Rehab services.
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e CMS Psych — Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Psych services.

¢ Schedules — Select 3M schedules for outpatient services that are paid with APC or eAPG. These
schedules contain the hospital-specific and federal values appropriate for the date range of the
provision.

e Modifiers — Enter modifier values used in line-level calculations within the provision. Lines with
modifier codes are calculated using these values. Four functions are allowed with modifiers:
addition, subtraction, multiplication, and division.

For instructions on adding CMS factors to provisions, see the following:
e Manually enter CMS DRG provision factors
e Manually enter CMS CMG provision factors
¢ Manually enter CMS Psych provision factors

e Import and export provision factors
Manually enter CMS DRG provision factors

Use these instructions to add CMS DRG provision factors used when calculating Medicare Inpatient
services.

To add CMS DRG factors to a provision:
1. Navigate to the desired provision.

>

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon ([#
).

3. Inthe Edit Factors dialog, in the Settings tab, enter amounts in the fields provided, as needed.

NOTE: Fields with names in blue indicate they are required for calculated payment. Fields
with names preceded by a red percent sign (%) require you to enter the percentage amounts
as decimals.

4. If needed, assign transfer codes:
a. Click the Transfer Codes tab.

b. In the Available Codes section, locate the desired code in the list.

c. On the right end of the list, click the Assign icon () to move the selected code to the

Assigned Transfer Codes section.
5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.
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6. If needed, add outlier exclusions.

Manually enter CMS CMG provision factors

Use these instructions to add CMS CMG provision factors used when calculating inpatient rehab
services.

You can also import provision factors.

To add CMS CMG factors to a provision:

1. Navigate to the desired provision.
2. On the Provisions page, in the CMS CMG column for the desired provision, click the Edit icon ([#
).

3. Inthe Edit Factors dialog, in the Settings tab, enter amounts in the fields provided, as needed.

NOTE: Fields with names in blue indicate they are required for calculated payment. Fields
with names preceded by a red percent sign (%) require you to enter the percentage amounts
as decimals.

4. If needed, assign transfer codes:
a. Click the Transfer Codes tab.

b. Inthe Available Codes section, locate the desired code in the list.

c. On the right end of the list, click the Assign icon () to move the selected code to the

Assigned Transfer Codes section.
5. Do one of the following:
e To save changes and keep working in the dialog, click Save.
¢ To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

Manually enter CMS Psych provision factors

Use these instructions to add CMS Psych provision factors used when calculating Inpatient psych
services.

NOTE: Before adding a CMS Psych provision factor, the provision must have a completed CMS DRG
with a DRG Release named in the DRG Release field. The DRG Release comes from the DRG Weight
file uploaded at the clause/term level.

To add CMS Psych factors to a provision:

1. Navigate to the desired provision.
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2. On the Provisions page, in the CMS Psych column for the desired provision, click the Edit icon (

)

3. In the Edit Factors dialog, do one of the following:
e Import CMS psych factors from another provision or a file.

* In the Settings tab, enter amounts in the fields provided, as needed.

4. To add ECT codes, do the following:
a. Click the ECT Codes tab.

b. In the Available Codes section, to add a code, click the code’s up Assign icon (#). The code
displays in the Assigned ECT Codes section.
5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.
Select outlier exclusions

» About modeling changes to the inpatient CMS DRG calculation

To accurately model changes made to the Inpatient CMS DRG calculation, you may need to determine
the high-dollar outlier exclusion amount. To exclude high-dollar charges like transplant acquisition
charges or coagulation factors from the CMS DRG outlier determination, you can specify the Line Item
Codes or Rev Codes associated with these charges to exclude them from the outlier determination
within the CMS DRG calculation. Use the Exclusions tab when defining a provision for Medicare and
Medicare-like contracts.

After selecting the exclusions, you add a clause or term with the CMS DRG calc basis, and then attach
DRGs and other required DRG-related elements. When incoming claims are processed against the CMS
DRG calculation, if a claim has any CMS DRG items that match the clause or term on the provision, the
system inspects the lines on the claim for the selected exclusion codes. The system totals any claim
items that match the exclusion codes and then subtracts this amount from the total charges when
determining the outlier portion of the CMS DRG calculation.

To specify outlier exclusions:

1. Navigate to the desired provision.

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon ([#
).

3. In the Edit Factors dialog, click the Outlier Exclusions tab.

4. At the top of the tab, select the exclude option:
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Import and export provision factors

e Rev Code — Select exclusion items by revenue code.

e Line Item Code — Select exclusion items by line item code.

Edit Factors
CMS DRG Factors | Outli

Settings  Import  Outlier Exclusions ~ Transfer Codes

er Exclusions

Excludeby:  © Rev Code

O Line ltem Code

Assigned Exclusions
Rev Code

No records available.

Available Codes
Rev Code hd
002

0020
0021
0022
0023

0024

1 2 3 4 5

Description

Description

NO DESCRIPTION
Health Ins PPS.

Reserved

Health Ins - Snf PPS (RUG)
Health Ins - Hh PPS (HHRG)

Health Ins - IRF PPS

6 7 8 9 10 .. » ¥

1-50 0f 2081 items

Close

In the lower half of the tab, locate the item(s) to exclude, and then click the Assign icon (#) to

the right of each item to move that item to the top half of the tab.

Do one of the following:

e To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

* To cancel your unsaved changes and close the dialog, click Close.

When copying or creating contract provisions, you can import CMS DRG, CMS CMG, or CMS Psych
factors from a file or from another provision instead of populating the factors fields manually.

Additionally, you can export factors to an Excel file.

» Import provision factors from another provision

To import provision factors from another provision:
1.

2.

W

Navigate to the provision needing factors.

In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon (IZ‘).

In the Edit Factors dialog, click the Import tab.

In the Import tab, do the following:
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a. If needed, from the Simulation drop-down, select the desired simulation.
b. Expand the contract and version with the desired provision and factors.

c. Inthe Provision list, for the desired provision, click the import factors icon ().

Edit Factors

CMS DRG Factors | Import
Settings  Import  Outlier Exclusions  Transfer Codes
From Provision  Import From File
Select a provision from which to import settings Simulation: | Live =

Contract Name

o

o
09/30/2013
o

o

B

Provision Start Date Expiration Date

Hospital Inpatient (Including Medicare Part A 0/01/2020 2/31/2020
+ ORG2 - Medicare HMO
+ ORG4 - Medicare HMO Other

The Factors dialog opens, displaying the imported factors.

5. Inthe Factors dialog, do one of the following:
e To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

* To cancel your unsaved changes and close the dialog, click Close.

» Import provision factors from a file

NOTE: Excel files used to import factors need to adhere to a specific format. To ensure your file is
formatted correctly, download the template and enter or copy the desired factor information to it,
then save and import it using the following instructions.

To import provision factors from a file:

1. Navigate to the provision needing factors.

2. Inthe factor type column (e.g., DRG, CMG, Psych), click the Edit icon (|:,I').

w

In the Edit Factors dialog, click the Import tab.

E

In the Import tab, do the following:
a. Click the Import From File tab.
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NOTE: The imported factors file must adhere to the factors template.

b. If needed, on the right side of the dialog just above the Import button, click the download
icon (E) to download the template. Complete the information in the template, then

name and save it. Or, you can import factors that you exported from another provision to
an Excel file provided the file matches the factors template layout.

c. On the left of the dialog, do one of the following:
¢ Click Select files... and then select a file or files to import.
e Drag and drop the desired files to the gray area marked Drop files here to upload.

d. Click Save.
The factors display in the corresponding CMS tabs for the type(s) of factor(s) imported.

5. Inthe Factors dialog, do one of the following:
¢ To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close

» Export provision factors to an Excel file

To export provision factors:
1. Navigate to the provision with the factors to export.

2. Inthe factor type column (e.g., DRG, CMG, Psych), click the Edit icon (|:,I’).

3. Inthe Factors dialog, at the bottom, click Export.

The data is exported to an Excel file at the bottom of your screen. Data is exported from all three
CMS tabs. If no data exists for a particular column, then in the Excel file, that tab displays with
headings only but no data. The file is automatically formatted correctly for importing to another

provision.

A B C D E F G~
1 BlendedRate CapitalCCR COLAAdj DSHCapital DSHOperating FederalCapitalRate FixedLossT
2 [6549.51 "0.0390000000  "1.00000000000.0000000000 0.0812000000 "494.9000000000 "21821.000000000
3
4
5
6
7
8 hd
" CMS DRG | CMS CMG | CMS Psych @ F v

4. If desired, click the file to open and view it.
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Edit or delete provision factors

You can edit provision factors manually in the Factors dialog, or you can export the factors to a file, edit
the file, and then re-import the file.

To manually edit provision factors:

1. Navigate to the desired provision.

2. Inthe factor type column (e.g., DRG, CMG, Psych), click the Edit icon (Df).
3. In the Edit Factors dialog, make changes as needed to the desired fields.

4. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

To delete provision factors:

IMPORTANT: This option deletes all saved settings and any outlier exclusions and transfer codes in
addition to the factors.

1. Navigate to the desired provision.

»
2. Inthe factor type column (e.g., DRG, CMG, Psych), click the Edit icon (D' ).
3. In the Edit Factors dialog, at the bottom, click Delete.

4. Inthe confirmation dialog, click Delete.

Assign a modifier to a provision

Modifiers are used for line-level calculations within a provision. Line items with modifier codes are
calculated using modifier values. Set up modifier values in the Modifiers dialog by listing the possible
modifiers on a provision and configuring their adjustments.

» About adding modifiers for reimbursement

Only one of the modifiers on a provision is allowed to affect reimbursement. Modifiers that affect
reimbursement can be in any of the four modifier positions on a claim; for instance, if the first modifier
after the line item code does not change the reimbursement but the second modifier does, then the
second modifier will be used for that purpose. Claims processing will use the first reimbursement
modifier it comes across, so if any modifiers that follow also affect reimbursement, they will be ignored.
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Modifiers added to line items appear on the Line Items tab of the Claim Details page in the Line ltems
Code column. The modifier codes begin after the fifth digit of the line item on the claim, as shown in the
following example:

Claim Details

Summary Codes Demographics Insurance Lineltems  Physici

Line Items For: C921475393 --

Rev Code Line Item Code APC
0250
0270
0360 29806@ noo4z
0360 29804RT5921 00042
0360 20823RT592122 noo4z
0370

The first code listed in the Line Item Code column has only one modifier: RT. The second line item code listed has three modifiers:
RT, 59, and 21. The third line item code has the maximum, four: RT, 59, 21, and 22.

When a claim that has a Line Item Code with a modifier is processed, the line item is handled according
to the Modifier settings in the corresponding contract provision.

To add a modifier to a provision:
1. Navigate to the desired provision.

2. Inthe Modifiers column for the provision, click the Edit icon (|:,I'b ).

3. In the Edit Modifiers dialog, in the Available Codes section, locate the desired code and then click
the Assign icon () to move it to the Assigned Modifiers section.
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Available Codes

Code T Description T
-
21 Prolonged Evaluation And Management Services
22 Unusual Procedural Services
23 Unusual Anesthesia
24 Unrelated Evaluation And Management Service By The Same Physician During Postoperative Per.
25 Significant, Sep Ident Eval And Mgmt Sve By The Same Phys On The Same Day Of The Proc Or Ot...
27 Multiple Outpatient Hospital e/m Encounters On The Same Date G

4 « 1 2 3 4 5 6 7 » w 1-25of 159 items

m Save and Close Close

In the Assigned Modifiers section, in the Sign column, the multiplication operator is the only
option currently available from the drop-down.

Edit Modifiers *
Modifiers
Assigned Modifiers

Code Description Sign Value

50 Bilateral Procedure b .

52 Reduced Services ® 0.5

4. Inthe Value column, use the up and down arrows in the field to set the value, or just type in the
value.

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

Assign a schedule to a provision

Use these instructions to assign a schedule to a contract provision. A schedule is a reference from the
3M Grouper that is used for calculating outpatient APCs and eAPGs for a variety of contracts. Schedules
are required when you model contracts having APC or eAPG reimbursement for outpatient services.

To assign a schedule to a provision:

1. Navigate to the desired provision.
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2. Inthe Schedule column for the provision, click the Edit icon (IZ,I’).

3. Inthe View Schedule dialog, from the Select an Organization drop-down, select the entity
associated with this contract’s schedules.

4. From the Select a Reimbursement Type drop-down, select the kind of reimbursement the
provision uses. This selection determines the schedules available in the next drop-down.

5. From the Select a Schedule drop-down, select the desired schedule.
6. Do one of the following:

e To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

Copy a provision

If an existing contract is similar to the one you are working on and needs only slight modifications, you
can copy that provision instead of re-building it from scratch, then edit the copy. Use the following
instructions to copy a provision within a version. To copy a provision from a different version, use the
Import Provision feature.

To copy a provision within the same version:

1. Navigate to the provision to be copied.

2. At the end of the provision row, click the Clone icon (@).

3. Inthe Clone Provision dialog, in the Settings tab, type in dates or click the calendar icons (f5)

and select a Start Date and Expiration Date for the provision.

NOTE: The system will not allow you to select dates that are outside of the associated
version’s active period. You also cannot create a provision with dates that overlap another
provision that has the same bill type.
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Clone Provision

New Provision | Settings
Settings  Type of Bill  Attributes

Start Date

2
Expiration Date
| ir] |

Type of Bill
« Hospital Inpatient (Including Medicare Part A)

Include Attributes

Start/Expiration Date and Type of Bill must be set for thy
Attributes will not be editable until the new provision is

Close

4. By default, any attributes are included in the copy. However, if you do not want to copy them,
clear the Include Attributes check box before saving. You can add other attributes after you save
the new provision.

NOTE: You cannot add or remove bill types from the Clone Provision dialog. You must save
the copy and then make changes through the Edit Provision dialog.

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.
e To cancel your unsaved changes and close the dialog, click Close.

6. (Optional) Edit the provision as desired.

Import a provision

Use these instructions to copy a provision from one contract to another. The Import Provisions feature
allows you to bring in provisions from a contract in any simulation.

To import a provision:
1. Navigate to the desired contract version.

2. In the version row after the version number, click Go to Provisions.
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3. On the Provisions page, note the date range of the version displayed at the top of the page. The
provision you select to copy must fall within that date range. If it does not, you can change the
date range on the copy before importing it.

4. On the Provisions page above the table of provisions, place your cursor over the arrow, and then
click Import from another contract.

Provisions

+ Add New Provision "=

Import from another contract

Provision

t

5. Inthe Import a New Provision dialog, from the Simulation drop-down, select the simulation
containing the provision you want to copy.

6. Inthe Select a provision to import list of contracts, expand the desired contract and version to

locate the provision to import.

7. If any of the Start or Expiration dates are red for the provision you want to import, click in the
Start Date and Expiration Date fields and select dates that match the Start and Expiration dates
of the version to which you are importing the provision. When updated successfully, the dates
turn black and the provision check boxes are enabled.

Import a New Provision
Select a provision to import
Contract Name
+ CIGNA PPO

- MANAGED CARE

Version

Description

Hospital Other

Hospital Qutpatient

Py

ofessional Centracts

Hospital Other

Hospital Qutpatient

P

Hospital Other

ofessional Contracts

Hospital Outpatient

Start Date

- 2 01/01/2012

Hospital Inpatient (Including Medicare Part A)

Expiration Date

12/31/2017
Start Date
1/1/2019

1/1/2019

/1/2019

Expiration Date

Simulation: | Live M “

Calculation Date

Discharge

5

8. Select the check box for the desired provision (you can import more than one).

9. (Optional) If applicable, select to import associated attributes or other attachments by selecting
the corresponding check box below the list of contracts.

10. Click Import.

Administrator's Guide

Axiom Contract Management | 88



Edit or delete a provision
After copying a provision, you may want to make some changes to it. You can do the following from the

Edit Provision dialog:

e Change the start/expiration dates
e Change the Type of Bill
e Add or remove attributes or change attribute values

You can also delete a provision after verifying that the provision and its clauses/terms, etc., are not in
use and do not contain data that need to be preserved as records.

To edit a provision:
1. Navigate to the desired provision.
2. At the end of the provision row, hover your cursor to view the icons and then click the Edit icon (

)

3. In the Edit Provision dialog, do any of the following as needed:

e To change the Start Date or Expiration Date, in the Settings tab, click the Calendar icon (
3l) and select the desired date.

NOTE: The system will not allow you to select dates that are outside of the associated
version’s active period or that overlap with another provision that has the same bill
type(s).

e To change the bill codes or type of bill, click the Type of Bill tab and do any of the
following:

°o To remove a bill code, in the Assigned section, click the Cancel icon (a) for the type
of hill.

° To add a bill code, in the lower half of the tab, in the Available section, click the plus
icon to the left of the desired Type of Bill to expand its codes, and then select the
bill code by clicking its Assign icon ().

e Add, edit or remove attributes.

4. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

To delete a provision:

1. Navigate to the provision to be deleted.

2. Verify that the provision and its clauses, terms, etc., are not in use and do not contain data that
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need to be preserved as records.

3. At the end of the provision row, click the Delete icon (| ).

4. Inthe conformation dialog, review the information and then click Delete.

Modeling clauses and terms

Clauses and terms are provision building blocks; they are the vehicle that defines contract terms, rates,
and limits. A clause and term are interchangeable in how they calculate; however, a term always resides
beneath a clause. The clause is considered the parent of the term. A clause can have no terms or it can
have multiple terms. A term always has the one clause under which it resides. The order and the
selections made on a clause/term determine how the claims filter through the calculation criteria.

» Clause and term order significance

Axiom Contract Management calculates claims in a top-down manner for both clauses and terms. This
means that a claim initially tries to match to the first clause listed in the provision. If there is no match, it
continues on to the next clause, regardless of whether or not a term exists on clause 1. If, on clause 2,
the claim matches the defined criteria, it stops and makes the calculation. Then it continues on to the
first term of the clause (if it exists), and then the second term (again, if it exists) before moving on to
clause 3, and so on. The only way to stop a claim from moving to the next clause (or term) is to set it as
terminal. For information on changing the order of a clause or term, see Edit or delete a clause or term.

» Clause or term Calc Basis

The following example shows some of the possible selections for the clause/term calculation basis. You
cannot edit these. The calculation basis is used in conjunction with the calculation type and measure to
determine a specific reimbursement method.

The Calc Basis paired with the rates loaded for the clause or term determine whether a claim will
qualify. For example, if you select Admit Diagnosis Code, Axiom Contract Management only finds claims
for which the defined clause/term codes match the admitting diagnosis code on a claim.

The CMS-based options include specially built calculation rules that are used with the defined factors for
the provision.

Certain calc basis options are considered claim level and some are considered line item level. Selecting
one or the other determines the options available for Calc Type and Calc Measure. For example, DRG is
considered claim level, whereas RevCode is considered a line item level calculation basis.
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Launch Page Contracts Claims Import Data Reports. Admin Help
Docusim > United > Version 1(1/1/2020 - 12/31/2020) > Hospital Outpatient*Hospital Other (1/1/2020 - 12/31/2020)
Clauses

+ Add a New Clause

Clause Description Calc Basis Calc Type Calc Measure Terminal? Attributes Rates
1> SURGICAL RevCode Dollar Rate Per Claim ves =
2> OBSERVATION RevCode Dollar Rate Per Claim Yes =
3 ER RevCode Dallar Rate Per Claim Ve =
4> URGENT CARE RevCode Dollar Rate Per Claim Yes =
> SLEEP STUDIES Line ltem Code Plus RevCode Dollar Rate Per Line ltem No =
> CYBER KNIFE Line Item Code Plus RevCode Dollar Rate Per Date No =
73 THERAPY RevCode Incidental Dollar Rate Per Date No =
8 > PER DATE RevCode Incidental Dollar Rate Per Date No
> FEE SCHEDULE RADIOLOGY Line ltem Code Dollar Rate Per Line Item Qty. No
0 > FEE SCHEDULE LAB Line item Code Dollar Rate Per Line Item Qty. No =

Example of Calc Basis column in list of clauses

» Calc Type

There are three possible selections for the Calc Type field. Either the clause/term will be paid at a Dollar
Rate, a % of Charge, or a % of Cost, with the first two selections being the most commonly used. The
calc types available for selection are determined by the Calc Basis selected.

» Calc Measure

The five possible selections for the Calc Measure field are: Per Claim, Per Diem, Per Date, Per Line ltem,
and Per Line Item Qty. These options are limited based on the calc basis selected for the clause/term.
For example, if DRG is selected as the calc basis, the option for Per Date, Per Line Item, and Per Line
ltem Qty are not applicable because those are used with line item level parameters only.

» Terminal vs. Non-terminal

Setting a clause or term as terminal or non-terminal (the default) determines if a claim will continue
calculating on the clause or term below it.

Setting a clause to Terminal (i.e., Yes) stops the claim from progressing to the next clause; it does not
stop it from moving through all of the terms (if any) below that clause.

Setting a term to Terminal stops it from progressing to the next term under the same clause; it does not
stop it from moving through any clauses (if any) below it. For the terminal logic to apply to a claim, it
must qualify on the defined calculation criterion for the clause or term.

For example, if a claim has an implant revenue code, a certain dollar amount will apply to that rev code
line item for all claims, and even if a claim qualifies for this payment, it will continue down to the next
clause. If the claim qualifies for Orthopedics, it stops there, and Orthopedics will be the only other
possible payment method on the claim, as that is a terminal clause. If it is not an Orthopedic claim
(based on the defined DRG), it will continue on. If a claim qualifies on Clause 8 Med/Surg, it could also
qualify and reimburse on Clause 9 ICU, as that is a non-terminal clause.
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Launch Page Contracts Claims Import Data Reports Admin Help
DocusSim > United > Version 1 (1/1/2020 - 12/31/2020) > Hospital Outpatient*Hospital Other (1/1/2020 - 12/31/2020)
Clauses

+ Add a New Clause

Clause Description Calc Basis Calc Type Calc Measure Terminal? Attributes Rates Threshold Limits
1 SURGICAL Dolar Rate Per Claim Yes =

2> OBSERVATION Dolar Rate ]
73
=
73
=
=

® Dolar Rate

4 URGENT CARE Dollar Rate

SLEEP STUDIES Dolar Rate

CYBERKNIFE Dollar Rate

THERAPY Dollar Rate Per Date

PER DATE Dollar Rate PerDate

Example Clauses/Terms page with Terminal column outlined in red

Managing clause and term descriptions

The description is the first criterion that you need to define for a clause or term. A few standardized

descriptions are already included with the initial Axiom Contract Management installation, but you can
add, edit, and delete descriptions at any time.

Clause and term descriptions are available in all simulations.

» Add a new clause or term description
To add a new description:

1. In the main menu header, click Admin > Manage Clause/Term Descriptions.
The Clause/Term Descriptions page opens.
2. Inthe upper right corner of the page, click Create New Record.

3. Onthe Create New Clause/Term Descriptions page, in the Description field, type the description.
The field has a 50-character limit.

4. Do one of the following:

e To save and return to the main Clause/Term Descriptions page, click Save, and then, in the
upper right corner of the page, click Back to Descriptions.

e To save and close the page, click Save and Close.

The new description is now available from the Description drop-down when you or others are adding or
editing clauses and terms.

» Edit or delete a clause or term description

IMPORTANT: If you change a description, the change will be reflected in all accounts and data where
the description is used.
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To edit a description:
1. In the main menu header, click Admin > Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. Inthe list of descriptions, locate the desired description. If needed, click the Filter icon (Y) and

filter the list.

3. At the end of the description row, click the Edit icon ([#).

4. On the Edit Clause/Term Descriptions page, in the Description field, make the desired change.

5. Do one of the following:
e To save and return to the main Clause/Term Descriptions page, click Save, and then, in the
upper right corner of the page, click Back to Descriptions.

e To save and close the page, click Save and Close.

To delete a description:
1. In the main menu header, click Admin > Manage Clause/Term Descriptions.
The Clause/Term Descriptions page opens.
2. Inthe list of descriptions, locate the desired description. If needed, click the Filter icon (Y) and

filter the list.

3. Atthe end of the description row, click the Delete icon (i).

4. In the confirmation dialog, click OK.

About multiple-procedure payment reduction line item calculations

When modeling contracts, you can include multiple-procedure payment reduction calculations by
percentage to handle contracts with multi-procedure payment reduction (MPR) line items in excess of
three reimbursement rates. This calculation handles dollar and percentage rates. The Line Item Code
MPR calculation basis calculates claims that are reimbursed based on multiple rate tiers. This calculation
basis is available in the Calc Basis menu for clauses and terms, as shown in the following example:
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Edit Clause

Clause 1 | Settings

Seftings ~ Attributes  Exclusions

Clause

K |
Description

(MPR Mk
Calc Basis

(Line Item Code MPR - | x

Itemized Charge Code
Line Item Code

Line Item Code ASC

Line Item Code Bundle
Line Item Code Incidental
Line Item Code Modifier

Line ltem Code MPR

Rate

Include clause in Global Limit

m Save and Close

Close

Line Iltem MPR uses translation tables similar to Line Item ASC. Translation tables consist of columns of
line item codes and their associated Group column. (Descriptions are not needed in the table because
they are automatically populated based on the existing Line Item Code library entries.)

IMPORTANT: When adding translation tables and rates to a line item MPR clause, you must add the
translation table file before you add the rates file, or else the rates will not load.
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Edit Rates X
Clause 1 | Translation Data
Translation Data  Category Assignment  Import  Files

+ Add a New Row

Line ltem Code Y  Description *t T Group T
93005 Electrocardiogram, tracing 1
25076 Removal forearm lesion deep 1
25075 Removal forearm lesion subcu 2
26115 Removal hand lesion subcut 1
26116 Removal hand lesion, deep 1
73130 ¥-ray exam of hand 1
List of possible line items on Line items on incoming claims
an incoming daim are matched and grouped
based on data in this table

T p—

Cancel

The Rates dialog for Line ltem MPR has a ten-tier procedure reduction calculation consisting of nine rate
columns and one sub rate column on the Category Assignment tab (see following image example) to
handle procedure reduction logic in contracts. You do not need to specify all ten tiers, but at minimum
you must specify one rate and the Subrate column. You can enter rates manually or upload translation
and rates tables. For more information, see Import rates for a clause or term.

With Line Item MPR, rates may be either percentages (loaded as decimals) or dollars.

When loading rates using an Excel file, the subrate must be defined. The subrate is the last payable rate.
Therefore, if a contract says all services are reimbursed at 100/50/25/25, then program 100% of the
given rate in Rate 1, 50% of the given rate in Rate 2, and 25% of the given rate in the Subrate. This will
calculate all services found in the translation table.

If reimbursement is limited to a set number of services, use the rate columns and subrate to limit
reimbursement. For example, if only three services are payable, program Rate 1-3 with the appropriate
value and subrate with SO. This prevents any services from calculating after the third procedure.

As with Line Item ASC, reimbursement order is determined by rate, assessing the services with the
highest reimbursable amount, and paying those first.

NOTE: In the case of professional contracts with services that are always payable, you can ensure

that these are calculated first regardless of highest reimbursable amount. For details, see Add an
exclusion to a professional Line Item MPR calculation.
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Edit Rates x
Clause 1 | Category Assignment

Translation Data  Category Assignment  Import  Files

+ Add a New Row

Group Y Rate 1 Rate 2 Rate3 Rate 4 Rate 5 Rate 6 Rate 7 Rate 8 Rate 9 SubRate
1 100.00 5000 25.00 000 000 000 15.00

7000 5400 25.00 10.00

1 -20f2items

Cancel

When a qualifying claim comes in and triggers the Line Item MPR clause, the system determines the
group it belongs to based on the translation table. After all qualifying line items are grouped, the system
assigns the rates to each group based on the Day of Service and rates set for the clause/term.

For more information, see the following:

¢ Add a clause to a provision
e Add aterm to a clause
e Add a unit max limit to a Line Item MPR

e Modeling clauses and terms

» Claim voucher reports display Line Iltem Code MPR calculation details

When reconciling an MPR calculation on a claim, you can use the voucher report to see which line items
on the claim triggered Line Item Code MPR on a contract and were paid based on that calculation logic.
You can use this detail to track down under or over payments and to justify proper payment from the

payer.

In the following example, a claim voucher report displays the following details for a Line ltem MPR
calculation on a claim:

e The service codes on the claim that matched those on the Line ltem MPR clause
e The service date detail, line item code with description, and the group, units, and qualified level
¢ Payment amount for each

Create a Line Item MPR clause or term

Use these instructions to create Line Item MPR calculations on a clause or term. Line Item MPRs
calculate claims that are reimbursed based on multiple rate tiers.
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To create a line item MPR clause or term:

1. Navigate to the Clauses or Terms page for the desired provision.
Click +Add a New Clause (or +Add a New Term).
In the Add a New Clause (or Term) dialog, from the description field, select a description.

From the Calc Basis drop-down, select Line Item Code MPR.

LA

From the Calc Type drop-down, select either Dollar Rate or % Charges, whichever applies.

The Calc Measure drop-down is set automatically to Per Line Item, which is required for this
calculation basis.

6. For Terminal? select either Yes or No.
7. Do one of the following:
* To save changes and keep working in the dialog, click Save.
¢ To close the dialog after saving, click Save and Close.
e To cancel your unsaved changes and close the dialog, click Close.

8. Import translation tables and then import rates.

About volume discount calculation line items

Users modeling contracts can include multi-channel discount calculations to handle volume discount
pricing on claim line items. The line item code Multi-Channel Discount calculation basis calculates claims
against contract line items that are reimbursed based on volume tiers. This calculation basis is available
in the Calc Basis menu for clauses and terms, as shown in the following example of the Edit Clause
dialog:
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Edit Clause x
Clause 1| Settings

Settings  Attributes

Clause

1

Description

[AMBULANCE - LAND v | x
Calc Basis

"Multi-Channel Discount v x

Line Item Code Bundle

Line Item Code Incidental
Line Item Code Modifier

Line ltem Code MPR

Line Item Code Plus RevCode
Line Iltem Code POS

Multi-Channel Discount v

Rate

Include clause in Global Limit

m Save and Close Close

This calculation basis pays a set amount based on the number of units found for a set of procedures on a
claim.

Multi-Channel Discount line items use translation tables similar to the way Line Item ASC does.
Translation data consists of a column of line item codes and a Category column. The description does
not need to be in the translation table because it automatically populates with the description in the
Line Item Code Library.

Edit Rates x

Clause 1| Translation Data
Translation Data ~ Category Assignment  Import  Files

+ Add a New Row

[J  Linelitem Code Y | Description + T | category T
D 82450 NO DESCRIPTION
D 844478 NO DESCRIPTION
D 82247 Bilirubin, total
O Bilirubin, direct
D 82374 blood carbon dioxide
D 82465 bld/serum cholesterol
[0 82040 albumin
O 310 m
D 435 lood chioride
O 8440 Alanine amino (ak) (sgpt)
-100f 10 items
Cancel
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The Rates dialog for this type of line item contains multiple lines for specifying categories, number of
units, rates, and the effective range of those rates based on unit volume. You can enter rates manually
or upload translation and rates tables. For more information, see Import rates for a clause or term and
Import translation tables.

For each category, claims are paid based on a volume discount of tiered pricing. The following example
shows items for categories 1 and 2. If an incoming claim fits Category 1 and has three units, the rate
paid is $4.00 because the Effective Range is 3 <= Units < 4. If the claim has four units, the rate paid is
$5.00 because the Effective Range is 4 <= Units < 5. Any claim with eight units or more is paid at the
$11.00 rate.

dit Rates *

Clause 1| Category Assignment
Translation Data ~ Category Assignment  Import  Files
+ Add a New Row

Category T Unit Rate  Effective Range
3.00 400  3.00<=Units <400
400 500  4.00<=Units<500
5.00 6.00  5.00<=Units<6.00
6.00 7.00 6.00 <= Units < 7.00
7.00 9.00  7.00<=Units < 8.00
8.00 11.00 8.00 <= Units

2 2.00 400  2.00<=Units < 3.00

2 3.00 500  3.00<=Units <400

2 4.00 6.00  4.00<=Units <500

2 5.00 7.00 5.00 <= Units < 6.00

1-120f 12 items

For more information, see the following:

¢ Modeling clauses and terms
e Add a clause to a provision

e Add aterm to a clause

» Claim voucher reports display Volume Discount calc details

When reconciling a multi-channel discount payment calculation on a claim, you can use the voucher
report to see which line items on the claim triggered a Line-Item Code Multi-Channel Discount
calculation on the claim, and were paid based on that calculation logic. You can use this detail to track
down under or over payments, and to justify proper payment from the payer.

In the following example, a claim voucher report displays the following details for a multi-channel
discount calculation on a claim:

¢ The Line item Multi-Channel Discount codes on the claim that matched those on the clause
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e The service date detail and the category

e Payment amount for each

Add a clause to a provision

When creating a clause, you need to define the services being reimbursed and their contracted rates.
For this, you select the calculation criteria. (For information on Calc Basis, Calc Type, Calc Measures, and
Terminal vs. Non-terminal, see Modeling clauses and terms.) You can also add attributes to a clause.

To add a new clause:

1.
2.
3.

10.

Navigate to the desired provision.
On the Provisions page, in the desired provision row, click Go to Clauses.
On the Clauses page above the table of clauses, click Add a New Clause.

The Add a New Clause dialog opens.

NOTE: The clause number is assigned by the system and cannot be edited initially, but after
creating the clause and saving it, you can move it to a different position in a group of two or
more clauses on a provision.

From the Description drop-down, do one of the following:

e Select a description for the clause.

TIP: In drop-downs with numerous results, like Description, you can search for a
specific result: click in the Description field and begin typing a search word. Matches
display in the drop-down results; click a description to select it.

e Add a new description: click the Description field name, which is linked to the Clause/Term
Descriptions page where you can add a new description if you are an administrator.

From the Calc Basis drop-down, select the basis for calculation.

If applicable (depends on the selected Calc Basis), from the Calc Type drop-down, select the
calculation type.

If applicable, from the Calc Measure drop-down, select the measure on which the calculation is
made (for example, Per Claim, Per Line Item, Per Diem).

From the Terminal? drop-down, select Yes for Terminal or No for non-terminal.

Do one of the following:
e To add rates, continue to step 10.
e To add thresholds, skip to step 11.

To add rates, do one of the following:
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11.

12.

13.
14.

e For asingle rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates or rates from an uploaded file. When this occurs, the Rate field is
inactive.

e For multiple rates, enter rates manually or import rates from a file.

NOTE: The Include clause in Global Limit check box is enabled automatically if the parent
provision contains a global limit.

To add thresholds, do one of the following:
e Add thresholds manually.

e Import thresholds.

NOTE: Not all calculation bases allow thresholds. For more information, see About
Thresholds.

Do one of the following:

¢ To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.
(Optional) Add an attribute.

If needed, add a limit.

Add a term to a clause

A term always resides beneath a clause. The clause is considered the parent of the term.

When creating terms, you need to select the calculation criteria. For information on Calc Basis, Calc
Type, Calc Measures, and Terminal vs. Non-terminal, see Modeling clauses and terms.

To add a new term:

1.
2.
3.

Navigate to the desired clause.
In the row for the desired clause, click Go to Terms.
On the Terms page, above the table of clauses, click Add a New Term.

The Add a New Term dialog opens.
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NOTE: The term number is assigned by the system and cannot be edited initially, but after
creating the term and saving it, you can move it to a different position in a group of two or
more terms on a clause.

4. Inthe Description drop-down, do one of the following:

e Select a description for the term.

TIP: In drop-downs with numerous results, like Description, you can search for a
specific result: click in the Description field and begin typing a search word. Matches
display in the drop-down results; click a description to select it.

e Add a new description: click the Description field name, which is linked to the Clause/Term
Descriptions page where you can add a new description if you are an administrator.

5. From the Calc Basis drop-down, select the basis for calculation.
6. From the Calc Type drop-down, select the calculation type.

7. If applicable, from the Calc Measure drop-down, select the measure on which the calculation is
made.

8. From the Terminal? drop-down, select Yes for Terminal or No for non-terminal.
9. To add rates, do one of the following:

e For a single rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates. When this occurs, the Rate field is inactive.

e For multiple rates, enter rates manually or import rates from a file.
10. Do one of the following:

* To save changes and keep working in the dialog, click Save.

* To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

Using rates

Rates are entered at the clause or term level of a contract. Once the clause or term is added, you need
to define the services being reimbursed and their contracted rates.

There are two kinds of rates: rates and thresholds. This topic is about rates. For information on
thresholds, see Using thresholds.

You can add rates or thresholds to a clause/term but not both.
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» Rate requirements

Rates require the following:

Code — The code for the procedure or service that appears on claims.

Description — Populated from the code description library for the code being used, but if the code
is not in the library, you can add it manually.

Rate — Contracted charge for the procedure or service.

The following calculation bases require information additional to a code and rate, and therefore require
uploaded rate files and additional uploaded files as listed:

Line Item Code ASC — Excel upload only; translation file and rate file

Line Item Code Bundle — Requires two codes and a rate

Line Item Code Incidental — Excel upload only; translation file and rate file

Line Item Code Modifier — Requires additional field for modifier associated with the code
Line Item Code MPR — Excel upload only; translation file and rate file

Line Item Code Plus Rev Code — Requires combination of codes: Line Item and Revenue Code
Line Item Code POS — Requires additional field for Place of Service

Multi-Channel Discount — Two files needed: translation file and rates/units

RevCode Incidental — Excel upload only; translation file and rate file

DRG Cost Outlier — Requires Code, RCC, Threshold, Reduction Percent and Reduction Amount

CMS Outpateint — Ability to adjust 3M output by Overall Adjustment, APC Status Indicator, APC or
Line Item

CMS Psych, CMS DRG, CMS CMG — Require detailed Excel file uploads that work with the
provision factors

When setting rates, a rate code may exist only once per clause/term, with one exception as noted:

A code may only exist once per clause/term. For example: DRG 775 may be added at $5000.00. If
you try to add code 775 again, a message displays indicating that this code already exists.

The exception is Line Item plus RevCode. In this case, the code combination may only exist once.
For example: Line Item Code 36415 with RevCode 0301 may exist along with Line Item Code
36415 with RevCode 0302 because the combination of codes is unique.

» Entering rates

Rates can be either dollar amounts or percentages.

If the calculation type is Dollar Rate, then the rate should be a monetary value with two decimal
places (13000 = 13,000.00).

If the calculation type is % Charges or % Costs, then the rate needs to display four decimal places
(70% = .7000 or 74.25% = .7425).

Admin users can manually enter rates, edit the rates, and delete the rates.
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e Admin users can edit and delete multiple rates at a time.

Multiple rates entered manually or uploaded from a file display in the Edit Rates dialog. Admin users
need to be able to check any combination of lines and have the “Set Rate To” or “Factor Rate By”
applied to those selected. Admin users also need the option to Select/De-Select All entries across pages
of rates.

* In the Edit Rates dialog, rates can be filtered by the Code and Description columns.
Manually add rates to a clause or term

Use these instructions when you need to manually enter rates on a clause or term. You can also import
the rates from a file if you prefer or if you have a page or more of rates.

To manually enter rates for a clause/term:
1. Navigate to the desired clause or term.
2. Inthe Rates column, click the Edit icon (IZ‘) (if no rates are attached, the icon will be grayed
out).

3. Inthe Edit Rates dialog, click Add a New Row. A new row displays in the Rates tab on the left, as
shown in the following example:

Edit Rates x

Clause 1 | Rates Discharge Status / Dollar Rate / Per Claim Calc Basis / Calc Type / Calc Measure J

Rates  Import  Files
+ Add a New Row
[J code YT  Description T Rate

O |o \

[ oz Discharged To Another Acute Hospital 2.00

D 03 Discharged To SNF With Medicare Certification 200

D 05 Discharged To Non-Medicare PPS Children’s Hospitat 2.00

4. Inthe code field, type a code associated with the chosen calc basis for the clause/term. The calc
basis name displays near the top of the dialog, along with the calc type and calc measure to assist
you in selecting and entering data.

The code description will auto populate if a description is associated with the entered code. If the
code has no description, that field will read “NO DESCRIPTION,” and will be selected so you can
enter a description.

IMPORTANT: Once you save the description, you cannot change it. To associate a different
description with the code, delete the entry and start over.

5. Inthe Rate field, type a corresponding rate.
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TIP: When you move off the new row, a small red triangle displays in the upper left corner of
the row to indicate that the row has not been saved. Until you save, you can cancel this row
by clicking the Cancel icon (€3) that displays at the end of the row when you hover your
cursor over the row. The Cancel icon acts like an undo button.

6. Add more rate rows as needed. To apply the same rate to multiple codes, see the following.

» Apply the same rate to multiple codes
Use these instructions to apply the same rate to some or all of the entered codes, or to adjust
some or all of the rates by a specific factor.
a. On the left, select check boxes for the rate rows to affect.
b. At the bottom of the dialog, from the Adjust selected rows drop-down, do one of the
following:

e Set rate equal to — To set all checked rows to the same rate, in the field to the right
of the drop-down, enter the desired rate.

e Factor rate by — To adjust all checked rows by an entered value, enter the
adjustment percentage as a decimal value (for example, enter 1.02 to increase the
set rate 2%),

c. Click Apply.

7. Do one of the following:

a. To save changes and keep working in the dialog, click Save.
b. To close the dialog after saving, click Save and Close.

c. To cancel your unsaved changes and close the dialog, click Close.
Import rates for a clause or term

When working with large fee schedules, or when working with certain calculation bases, manually
entering rates may not be feasible or allowed. In such situations, you can import the fee schedule or
rates table from an Excel file.

4 )
IMPORTANT: If you are also importing translation tables, you need to import those before you

import rates, or else the rates will not load.
. J/

( N\

IMPORTANT: There are many types of rate files (DRG, Line Item Code, Rev Code, etc.). When
importing rates, make sure the rate file you upload matches the specific type of calculation basis
used by the clause or term. For example, if the clause or term uses CMS DRG, then a DRG rate file
that has a dollar rate would use these options: Calc Basis = DRG; Calc Type = Dolar Rate; Calc

Measure = Per Claim.
. J

When importing rates, you first upload the rate file to the server, and then you attach it to the contract.

Administrator's Guide Axiom Contract Management | 105



To import the rates:

1. Navigate to the clause or term needing rates.

2. In the Rates column of the clause/term row, click the Edit icon (|:,l’).

3.
4.

In the Edit Rates dialog, click the Files tab.

On the left side of the dialog, under the listed calculation basis for the clause/term, the Rates
folder should be selected as the rates file destination. If it is not, select it.

On the right side of the dialog, in the Upload files to a selected folder area, do one of the

following:

e Drag and drop the rates file.

e Click Select files and then select a rates file. The file name displays below the Select Files

button as shown in the following example:

Edit Rates
Clause 2 | Files Line Item Code ASC
Translation Data  Rates Import  Files
Show all folders (] Upload ecify
D 'S
Rates Library Rename a selected file
v 03 Docusim
v O Aetna
v DV 1
ersion Upload files to a selected folder
3 Al Other Line Items
+ Select files...
» C31CD10 Procedure Primary

x

Specified File
Unspecified File ()

Upload

v 3 Line Item Code ASC | Line Item ASC_UHC ASC Rates xIsx

O3 Translation Tables

Drag/Drop Copy [ Move

Close

Click Upload. The uploaded file displays on the left under the destination folder, as shown in the

following example:

v 3 Line ltem Code ASC

-

[3 Line Item ASC_UHC ASC Rates.xisx |

Select the uploaded file. The file name also displays in the Rename a selected file field in case

you want to rename it.
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Edit Rates

Clause 2 | Files Line Item Code ASC

Translation Data Rates Import  Files

¥ [0 Rates Library

» [J DocuSim
v 3 Aetna
v O3 Version 1
O3 All Other Line Items
+ Select files...
» [31CD10 Procedure Primary

v [ Line Item Code ASC

v 3 Rates

[ Line ltem ASC_UHC ASC Rates.xIsx

O3 Translation Tables

Show all folders [] Upload = Specify

Rename a selected file
Line Item ASC_UHC ASC Rates.xlsx

Upload files to a selecied folder

specified File i
Unspecified File )

Rename

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the
Rename a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image

corresponding to the data in the uploaded file.

10. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, Code corresponds to column A in the Rates file. Do this for each field in the

Rates Column that needs to be mapped.
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11.
12.
13.
14.

A

0

Rates Column

Group

Rate 1

Rate 2

Rate 3

Sub Rate

Upload  Specify

515

1435

1854

2402

ATAE

maps to

maps to

maps to

maps to

maps to

Sample data: Line Item ASC_UHC ASC Rates.xlIsx

C

257.3

7175

9z7

1201

17

Excel data has column headers? No [] Yes

specified File W
Unspecified File ()

D E
0 0 -
0 D
0 0
0 D

m n

3

Sheet1 Sheet2 Sheet3

Excel Column

(A ] -
E "]

| Not Mapped |

| Mot Mapped
| Mot Mapped

Save specifications

m Save and Close Close

For Excel data has column headers?, select the appropriate option if not already selected.

Click Save specifications.

Click the Import tab.

If needed, from the File Type drop-down, select Rates.

The file you uploaded displays under Specified Rates Files.
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15. On the right side of the dialog, click Attach. When the file is attached, the check box displays
checked:

Edit Rates

Clause 2 | Import Line ltem Code ASC
Translation Data  Rates  Import  Files

File Type: | Rates ¥

Specified Rates Files

Line ltem ASC_UHC ASC Rates xlsx

16. To view the imported rates, click the Rates tab.

17. Close the Edit Rates dialog.

View rates for a clause or term

A clause or term may have a single rate, multiple pages of rates, or a set of tiered rates, depending on

the service or procedure; or group or combination of services/procedures, contract type, provision, and
so on.

If a clause or term has a single rate, the rate displays in the Rate field of the Edit Clause (or Edit Term)
dialog.

If a clause or term has multiple rates or a set of tired rates, the Rates are displayed in the Edit Rates
dialog. The Edit Rates dialog also displays associated information and any attached files, if applicable.

To view the rates associated with a clause or term:

1. Navigate to the desired clause or term.
2. On the Clauses/Terms page, look in the Rates column.

o If the clause/term has a single rate, the Edit icon is grayed out (). To view the single rate,
at the end of the row, click the Edit icon (I:,I$ ), and then, in the Edit Clause/Edit Term
dialog, look in the Rate field.

» If the clause/term has multiple or tired rates, the Edit icon is not grayed out. Click the Edit
icon. In the Edit Rates dialog, rates are displayed in the Rates tab.
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Edit Rates X
Clause 11 | Rates

Rates Import Files

+ Add a New Row

[0 code Y Description Rate

O o HEART TRANSPLANT OR IMPLANT OF HEART ASSIST SYSTEM W M 303,72.90

O No Description 303,872.90

0 =z No Description 154,150.70

D 002 HEART TRANSPLANT OR IMPLANT OF HEART ASSIST SYSTEM W/0 MCC 154,150.70

O oos ECMO OR TRACH W MV 36+ HRS OR PDX EXC FACE, MOUTH & NECK W MAJ O 208,492.90

0 s No Description 208,492.90

O ¢ No Description 126,981.80

D 004 TRACH W MV 96+ HRS OR PDX EXC FACE, MOUTH & NECK W/O MAJO.R. 126,981.80

O oos LIVER TRANSPLANT W MCC OR INTESTINAL TRANSPLANT

0 s No Description

O = No Description 53,590.90

D 006 LIVER TRANSPLANT W/Q MCC 53,590.90 -

1 2 3 4 5 6 7 8 9 » » 1-100 of 845 items
Adjust selected rows | SetRateequaltoe ¥ m
Cancel

Example of Rates dialog for a clause with multiple procedures and rates

Delete rates

Use these instructions to delete one or more rate rows from a clause or term.

To delete a rates row:

1. Navigate to the desired clause or term.

2. Inthe Rates column, click the Edit icon (E,l‘).

3. Hover your cursor over the row to be deleted and then click the Delete icon ('i) at the end of the

row. The row displays with a red line through the content:

Edit Rates x

Clause 1 | Rates Discharge Status / Dollar Rate / Per Claim
Rates  Import  Files

+ Add a New Row

[] code Y  Description T Rate
'D a2 Discharged T ther Aewte Hespits 200 ©Q
D 03 Discharged To SNF With Medicare Certification 200
D 05 Discharged To Non-Medicare PPS Children’s Hospital 2.00
D 06 Discharged To Home Under Care of HHS 2.00

4. Do one of the following:
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« If you do not want to delete the row, click the Cancel icon (€3) at the end of the row.

e To delete the row, click Save.
e To delete the row and exit the dialog, click Save and Close.
To delete multiple rows:
1. Select the check boxes for the rows to delete.
2. At the bottom right of the dialog, click Delete Selected.
3. Inthe confirmation dialog, click OK.

4. Do one of the following:
* To save changes and keep working in the dialog, click Save.

¢ To close the dialog after saving, click Save and Close.

Import translation tables

Translation tables are crosswalk code tables that map equivalent, identical, or similar information across
two or more distinct data sets. Most crosswalking is done between a newer version and an older, out-of-
date version of the same code set. Certain Contract Management calculation bases, such as the
following, all require translation tables:

 Line Item Code Incidental
e RevCode Incidental

e Line Item Code MPR

e Line Item Code ASC

e Multi-Channel Discount

If you select any of these calculation bases, the Edit Rates dialog will contain a Translation Data tab in
addition to the other tabs.

IMPORTANT: When adding translation tables and rates to a line item MPR clause, you must add the
translation table file before you add the rates file, or else the rates will not load.

Importing translation tables follows the same basic process as importing rate files.

To import a translation table:
1. Navigate to the clause or term.
2. In the Rates column, click the Edit icon ([# ) (if no rates are attached, the icon will be grayed
out).
3. In the Edit Rates dialog, click the Files tab.

4. On the left side of the dialog, under the calculation basis for the clause/term, the Translation
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Tables folder should be selected. If it is not, select it.

5. On the right side of the dialog, in the Upload files to a selected folder area, either drag and drop
a translation table file to this area or click Select files and select the file to upload.

6. Click Upload. The name of the file displays under the folder on the left side of the dialog.
7. Select the uploaded file.

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the
Rename a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image
corresponding to the columns and rows in the uploaded file.

10. Inthe lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, column A corresponds to the Line Item Code column in the translation tables
file, and column B corresponds to ASC. Do this for each field in the Rates Column that needs to be

mapped.
Edit Rates x
Clause 2 | Files Line Item Code ASC
Specified File |
Translation Data  Rates Import  Files Unspecified File ()
Show all folders [] Upload  Specify

[} S .
M Rates Library Sample data: Line Item ASC_UHC ASC Trans.xlsx
» [ DocuSim

A B Cc D
v [ Aetna
G0453 CONT IO NEUROPHYS..
v 3 Version 1
50448 INEPL PERM CAR

O3 All Other Line ltems

» 3ICD10 Procedure Primary 60428
v O Line ltem Code ASC 60415
v O Rates -

B Line ltem ASC_UHC ASC Rates.xlsx

v [ Translation Tables

(3 Line Item ASC_UHC ASC Trans.xlsx
Rates Column Excel Column
Line ltem Code maps to A v
Group maps to Not Mapped v
Drag/Drop Copy [ Move Delete Download | Excel data has column headers? No [] Yes Save specifications

Close

11. For Excel data has column headers?, select the appropriate option if not already selected.

12. Click Save Specifications.
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13. Click the Import tab. If needed, from the File Type drop-down, select Translation Tables.
The translation table file should display under Specified Translations Files.

14. On the right side of the dialog, click Attach. When attached, the check box to the left of the listed
file displays as checked.

Edit Rates x

Clause 2 | Import

Translation Data ~ Category Assignment ~ Import  Files

File Type: | Translation Tables

Specified Translations Files

ASC Trans Table_2021.xisx

15. To view the uploaded data, click the Translation Data tab.

16. Close the Edit Rates window.

Attach or re-attach a file

Sometimes you need to attach multiple files; for example, if a clause or term has multiple Rev Code
calculation bases. While you can upload more than one file of a kind (e.g., rates, translation, etc.), only
one of those file types can be attached to the clause or term at a time. So, if a clause has a calculation
basis that requires a rates file and a translation data file, you can attach only one of each kind to the
clause at a time. When you attach a different file of the same type, the data in the new file replaces
previous data stored in the clause/term.

If you accidentally attach the wrong schedule or other file, or want to use a previously uploaded file, do
the following:

1. In the Edit Rates dialog, after uploading the desired file, click the Import tab.

2. If needed, from the File Type drop-down, select the file type.

Edit Rates x

Clause 2 | Import

Translation Data  Category Assignment  Import  Files

File Type: | Translation Tables v

Specified Translations Files

ASC Trans Table_2021.xIsx Reattach

HG ASC TransTable xisx Attach

3. Inthe Specified [type] Files section, do one:
e To use the original file, click Reattach.
¢ To use the newly uploaded file, click Attach.
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NOTE: To add additional rates, there are two options: 1) Upload, specify and attach a new file that
includes all rates required for the clause/term, or 2) manually add the new codes and rates.

IMPORTANT: Be aware that if a rate file is re-attached, any rate codes added manually will be
replaced by what is in the file.

Copy, move, delete, or download attached files

Use these instructions to manage attached files residing in system folders. If there are schedules, rate
files, and translation table files you can use from other contract version(s), you can either move a file or
make a copy from another folder location by dragging and dropping from the Files tab of Edit dialogs for
attached files. You can also download a file, make changes to it and then upload it.

NOTE: These instructions apply to files attached at the clause and term levels.

To move, copy, download, or delete a file:

1. Navigate to the desired clause or term and then, in the applicable open the Edit dialog for the
attachment. For example, if working with a rates file, then in the Rates column, click the Edit icon

().
2. Inthe Edit dialog, click the Files tab.

The left side of the tab displays the Rates Library and the folder system leading to the attached
file.

NOTE: To see the folder structure for all simulations, above the folder structure, select the
Show all folders option.
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Edit Rates X

Clause 2 | Files Line Item Code ASC
File |egend. A Specified File W

Translation Data Rates Import Files Applies to files in Unspecified File (1
Show all folders [] Upload = Specify folder tree

'I [ Rates Library I< Top folder

¥ [0 DocuSim

Rename a selected file

¥ O Aetna

¥ [ Version 1
Upload files to a selected folder
» [ All Other Line hems

+ Select files...
* [0 Any and All Services _

* [ 1CD9 Procedure Any

3 ICD10 Procedure Primary

» [J hemized Charge Code

This file is a duplicate of

¥ [3Line Item Code ASC

M = rares | the file directly above it

B 2021_MPR_Rates.xlsx

[ 2021_MPR_Rates1.xlsx

[ HEG ASC TransTable. xlsx This file is in the wrong
[ Translation Tables folder

* [ Version2

Drag/Orop @ G 0w Use these buttons to delete
rag/ L 0 ove Delete Download
» or download a selected file

Use these options to copy or
move files by drag-and-drop

3. Drill down through the clause/term calculation basis to the desired document, select the file, and
then do any of the following:

IMPORTANT: Although information imported from files is retained when you delete or move
a specified file, if you import another file and attach it to the clause or term, the previous
information is replaced with the new information.

» Copy the file to another folder

a. Below the folder tree, in the Drag/Drop section, select the Copy check box.

b. Drag the file to the destination folder. The original file stays in the source folder.

» Move the file to another folder

a. Below the folder tree, in the Drag/Drop section, select the Move check box.

b. Drag the file to the destination folder.
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» Delete the file

NOTE: If the file is in use (the file icon to the left of the name is solid), you can delete it
without removing the information from the clause or term as long as the imported file was
the last one attached. You can also reattach a file before deleting it from the server.

a. Select the file, and then click the Delete button below the folder tree.

» [3Itemized Charge Code
v (3 Line Item Code ASC
v [0 Rates
B 2021_MPR_Rates.xlsx

v [3 Translation Tables

B ASC Trans Table_2021.xlsx

B HG ASC TransTable.xlsx

» [ Version 2

Drag/Drop Copy [ Move Delete Download

b. Click Delete in the confirmation dialog.

» Download the file
a. Select the file.
b. Click the Download button below the folder tree. The downloaded file displays at the top
of the page, as in the following example:

B - 2

Downloads

UHC CAPD Percent Rates.xlsx

Open file

See more
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From here, you can open the file, make changes, move the file elsewhere on your
computer, or upload the file to the Axiom Contract Management system.

4. Close the Edit dialog.

Edit or delete a clause or term

You can make the following changes to a clause or term:

¢ Change the description

e Change the calculation basis, calculation type, and calculation measure, where applicable
e Change the terminal setting

¢ Add or remove attributes or change attribute values

e Add or remove attached rates

To edit a clause or term:

1. Navigate to the desired clause or term.

2. At the right end of the clause or term row, hover your cursor and click the Edit icon (|:,.i"b ).
3. Do any of the following as needed:

NOTE: The term number is assigned by the system and cannot be changed.

e To change the description, from the Description drop-down, select a different description.

NOTE: Administrators can add a new description.

¢ To change the calculation basis, type, and measure, select from the corresponding drop-
downs. Calculation type and measure may or may not be changeable depending on the
calculation basis selected.

e To change the terminal setting, select from the Terminal drop-down.
e To change the rates, in the Rate field, type a new rate. If needed, import a rates file.
e To change attributes, click the Attributes tab and add, import, edit, or remove attributes.

4. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

To delete a clause or term:

1. Navigate to the desired clause or term.
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2. Atthe end of the row for the clause or term, hover your cursor and click the Delete icon (i).

3. In the Confirmation dialog, click OK.

Copy a clause or term

Use these instructions to copy a clause or term to the same contract. To copy a clause or term to a
different contract, you need to copy the provision it is attached to.

To copy a clause or term:
1. Navigate to the clause or term to be copied.

2. At the end of the row, hover your cursor and click the Clone icon ().

The Clone Clause or Clone Term dialog opens.

3. At the bottom of the dialog, clear any check boxes for items that you do not want to copy from
the original clause or term.

Include clause in Global Limit

Include Rates Settings, Attributes and Exclusions will not be editable until the clause is
saved. The checkboxes may be used to include or exclude sections of

data when cloned.

Include Terms

Include Attributes

m Save and Close Close

NOTE: As stated at the bottom of the dialog, you must save the copy before you can edit the
rest of the settings.

4. Click Save.

5. (Optional) Edit the new copy as desired. For example, you may want to give the copy a different
description.

Set up post-grouper custom pricing

Some state Medicaid and commercial APC plans use Medicare grouping methodologies but then
override some of the reimbursement rules for certain status indicators or APC codes. Or, they simply
pay at a percentage above Medicare. For claims reimbursement, you need to be able to model these
kinds of adjustments.
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NOTE: This information does not apply to actual Medicare contracts, only Medicare-like contracts
from commercial plans.

When modeling contracts for commercial APC plans that use customized Medicare grouping
methodologies, you can include adjustments to the CMS Outpatient calculation. For example, you can
set rates for clauses and terms that use the CMS Outpatient calc basis and adjust those rates as needed.

During the CMS Outpatient calculation, the system receives the results from the 3M grouping and
pricing process and pulls the results into the voucher. You can adjust the voucher results as necessary
for payment in the following ways:

¢ Adjust the CMS Outpatient calculation basis in the Rates window:

° No Adjustment — No adjustment is made to the rates coming from the grouping and
pricing process. This is the default selection

° OQverall Percentage — Adjust the post-grouping and pricing rate by a specified percentage
©  APC Status Indicator — Adjust the calc basis based on the S|

° APC - Adjust the calc basis based on the APC code

° Revenue Code — Adjust the calc basis percentage by specific revenue codes

° Line-item code adjustment — Adjust the calc basis based on the line-item code

Adjust rates for a CMS Outpatient calculation

Use these instructions to modify rates for a CMS Outpatient calc basis on a commercial contract clause
or term, as part of modeling post grouper custom pricing.

To set up post-grouper custom pricing on a contract:

1. Navigate to the desired clause or term with a CMS Outpatient calculation basis.

2. In the Rates column for the clause/term, click the Edit icon ([# ).

3. Inthe Edit Rates dialog’s Adjustments tab, in the Adjust By row, select the type of adjustment.
Refer to the following set of instructions for the type of adjustment you selected.

» No Adjustment
No adjustment is made to the rates coming from the grouping and pricing process. This is

the default selection.

» Overall Percentage
Adjust the post-grouping and pricing rate by a specified percentage.
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In the Adjustment field, enter the adjustment percentage amount as a decimal
value. For example, for a decrease, enter a decimal value less than 1: 0.95, 0.55, .07,
etc. For an increase, enter a decimal value greater than 1: 1.05, 1.25, 1.75, etc.

Click Save.

» APC Status Indicator, APC, Revenue Code, or Line Item Code

o

o

e}

(e)

APC Status indicator — Adjust the calc basis percentage based on the Status
Indicator.

APC — Adjust the calc basis percentage based on the APC groupings.
Revenue Code — Adjust the calc basis percentage by specific revenue codes.
Line Item Code — Adjust the calc basis percentage by specific line items on a claim.

For these adjustment types, import an adjustment file:

a. Click the Files tab.

Administrator's Guide

On the left side of the dialog, the folder corresponding to the selected adjustment
type is selected as the destination, as shown in the following example:

Edit Rates x

Clause 5| Files

CMS Outpatient

Specified File i

Adjustments  Import  Files Unspecified File (3

Show all folders [] Upload

¥ [3 Rates Library
: Rename a selected file
¥ [0 Docusim

¥ 3 Medicare

¥ O Version1
Upload files to a selected folder
» [ Any and All Services
» [JCMSDRG + Select files...

¥ [ CMS Outpatient
3 APC Code Adjustment

[3 APC Status Indicator Adjustment

O Line Item Code Adjustment
[3 Revenue Code Adjustment

» 3 Discharge Status

On the right side of the dialog, in the Upload files to a selected folder area, do one
of the following:

° Drag and drop the rates file to the field.
© Click Select files, and then select the desired file.

Click Upload. The uploaded file displays under the folder on the left side of the
dialog:
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Edit Rates
Clause 5| Files CMS Outpatient

Specified File B
Adjustments  Import  Files Unspecified File )
Show all folders (] Upload
¥ [ Rates Library
: Rename a selected file
¥ [ DocuSim
¥ [3 Medicare

¥ [3 Version 1
) Upload files to a selected folder
» [3 Any and All Services

» [JCMS DRG + Select files...

¥ [3 CMS Qutpatient
3 APC Code Adjustment
[ APC Status Indicator Adjustment

3 Line Item Code Adjustment

M 0 Revenue Code Adjustment
[) CMS OF Ad) Rev Code xlsx | <

» [ Discharge Status

d. On the left, select the uploaded file. On the right side of the dialog, click the Specify

tab.
Edit Rates X
Clause 5| Files CMS Outpatient
Specified File B

Adjustments  Import = Files Unspecified File (3

Show all folders [ Upload h

v [3J Rates Library
: Rename a selected file
¥ [3 DocuSim
CMS OP Adj Rev Code.xlsx Rename
¥ [ Medicare

¥ [ Version 1
Upload files to a selected folder
» [3 Any and All Services

» [JCMSDRG + selectfiles...

¥ [3 CMS Outpatient
3 APC Code Adjustment
[ APC Status Indicater Adjustment
[3 Line Item Code Adjustment
¥ [ Revenue Code Adjustment

[) cMS OP Adj Rev Code:xlsx

» [3 Discharge Status

The Specify tab displays two tables: the top table corresponds to the data columns
and headers (if any) found in the imported file. The second table is used to map the
data in the file to the table in the Edit Rate’s Adjustments tab.

e. Inthe second table, for each row in the Rates Column, from the drop-down, select
the letter that corresponds to the column in the top table. In the following example,
Revenue Code corresponds to column A in the Rates file. Do this for each field in the
Rates Column that needs to be mapped.
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Upload  Specify

Sample data: CMS OP Adj Rev Code.xIsx
A B

0250 General
0251
0252
0253

0254 Drugs incident to Oth_..

Rates Column

Revenue Code maps to
Description maps to

Adjustrment maps to

Excel data has column headers? No [] Yes

D
3
Final
Excel Column
A L4
|Not Mapped x |
|Not Mapped x |

Save specifications

NOTE: Some files may contain fields that do not need to be mapped or may not
contain data for an optional field; however, if you try to save the file without
mapping a critical field, the save will not work. For example, “Description” is not
considered a critical field, so saving without mapping this field works.

At the bottom of the tab, for Excel data has column headers? select the

appropriate option.

Click Save specifications.

Click the Import tab. From the File Type drop-down, select the type of adjustment,

and then click Attach.
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Edit Rates

Adjustments  Import  Files

Clause 5 | Import CMS Outpatient

File Type:| Revenue Code Adjustment

Revenue Code Adjustment Files

CMS OP Adj Rev Code xlsx

i. Click the Adjustments tab and then verify that the rates imported correctly.

Edit Rates

Adjustments | Import  Files

AdjustBy: (O No Adjustment

RevenueCode Y  Description
Pharmacy - General
Pharmacy - Generic
Pharmacy - NorGeneric
Pharmacy - Takeout Drugs
Pharmacy - Diag/Limit
Phamacy -Red/Limit

Prarmacy - Experimental

Pharmacy - Non- Rx
Pharmacy -u Solution
Pharmacy - Other

v Therapy - General

v Therapy - Infusi

Iv Therapy - Pharmacy
v Therapy - Drg/S

Iv Therapy - Supplies

v Therapy - Other
Med/Surg - General

1 2 3 4 5 » »

Clause 5 | Adjustments CMS Outpatient

Q Overall Percentage

x

QO APC status Indicator Q apc © Revenue Code Q Line Item Code

\s Adjustment
101000
101000
101000
101000
1.01000
101000
101000
101000
101000
1.01000
101000
101000
101000
101000
1.01000

1070001

1010001

-1000f 408 items

Close

The rates are saved when you click Attach, so you do not need to save again.

4. Close the Edit Rates dialog.

Using thresholds

A threshold is a type of rate; it is a specific type of calculation that can be placed on either a clause or a
term within a contract. Thresholds are used in situations where additional criteria, not just the code, is
needed to qualify the service for reimbursement. For example, the payor may require that the Total
Charges of the claim exceed a certain amount in order to qualify for additional reimbursement. Or, there
may be different rates payable depending upon how many days a patient is in the hospital.

NOTE: Clauses and terms can have either rates or thresholds, but not both.

A threshold’s parameters are defined by a Thresh Basis. A Thresh Basis a type of measurement used to
define the tiers or levels of reimbursement within a threshold calculation. It is used in conjunction with
both a Lower Bound and an Upper Bound to make a claim qualify for the clause/term. A Thresh Basis
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can be either claim-based (for example, Total Claim Days or Total Claim Charges), or line item-based
(Total Line Charges/Units or Total Daily Line Charges/Units). Not all calculation bases allow thresholds.
For example, Line Item ASC and Line Item MPR do not allow thresholds.

» Using calculation bases, measures, and types in thresholds

The Calc Basis, Calc Measure, and Calc Type, selected based on standard contract modeling rules, define
how the claim pays on the clause or term if the Thresh Basis Lower Bound and Upper Bound criteria are
met. As in normal contract modeling rules, the Calc Basis is used to determine if a claim qualifies for the
clause or term. The Calc Measure and Calc Type combined define how the claim is paid.

The following table provides a list of the possible combinations that can be used with Thresholds. Notice
that the first four are claim level, while the remaining three are line item based. These three calculation
options are used to apply a rate on the claim, but the rate will be held within the limits of the Apply to
Start and Apply to End fields that are set in the Threshold form.

Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate Per Diem

DRG, CPT4, Rev Code, etc. Dollar Rate or % Charge Per Claim

Any and All Services Dollar Rate Per Diem

Any and All Services Dollar Rate or % Charge Per Claim

CPT4 or Rev Code Dollar Rate or % Charge Per Date

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item
CPT4 or Rev Code Dollar Rate or % Charge Per Line Item Qty

» Threshold examples

The following examples illustrate two situations for using thresholds.

NOTE: Regarding Lower Bounds — The Total Charges or Total Covered Days needs to fall within the
bounds. On the second tier, you may repeat the Low Bound or you may use the given start for the
next tier. The result will be the same as the Apply Start comes into consideration and will only apply
the rate on the excess.

It is important for the first tier to have bounds that capture the full range from 1 to infinite, as that will
ensure the lower tier is also calculated in these examples.
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» Charges

A payer might state that inpatient services are paid at 50% of charges but any inpatient claim that has
charges in excess of $100k will pay “Tiered Reimbursement” for which there would be varying
reimbursement rates depending upon the charges. In this example, you need to define a couple of key
terms:

e The Thresh Basis is Total Charges because we are paid a different rate based on the charges on
the claim (after we exceed $100k on a claim reimbursement changes)

¢ Two Rates need to be modeled. As an example:
°© 50% for the all claims up to $100k
°© 75% on all claims exceeding $100k

e The bounds capture the Total Charges from the claim. For the 50% Rate, the Lower Bound would
be $1 and the Upper Bound would be infinite (599,999,999). The next fields control the
application of the rate. The Apply to Start would be $1 and the Apply to End would be $99,999k
because we want the 50% to apply to all charges up to $100k.

» For the 75% Rate, the Lower Bound could again be $1 or change to $100k and the Upper Bound
would be $99,999,999. Remember, the Total Charges need to fall within the bounds. However,
the Apply to Start would now be $100k and the Apply to End would be $99,999,999 because we
want the 75% to apply only to the charges over $100k.

» Days

A popular example of Day Thresholds is Maternity Cases. Often Maternity pays a Case Rate for a set
number of days and then adds reimbursement for days in excess.

e The Thresh Basis is Per Diem because we are paid a different rate based on the Covered Days on
the claim

e Two Rates need to be modeled. As an example:
° The Case Rate for Days 1-3
° The Per Diem Rate for Days greater than 3

e The bounds capture the Total Covered Days from the claim. For the Case Rate, the Lower Bound
would be 1 and the Upper Bound would be infinite (999). The next fields control the application
of the rate. The Apply to Start would be 1 and the Apply to End would be 1, because we want the
Case Rate to only calculate once. So we will have it calculate on the first day (eliminate claim
variability).

e For the Per Diem Rate, the Lower Bound could again be 1 or it could be 4 and the Upper Bound
999. Remember, the Total Covered Days need to fall within the bounds, but the Apply columns
control applying the rate. So the Apply to Start would be 4 and the Apply to End would be 999
because we want the Per Diem Rate to apply only to days exceeding the defined parameters of
the case rate.
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Manually add a threshold to a clause or term

Use these instructions to add a simple threshold to a clause or term. For adding more complicated
thresholds, see Import a threshold for a clause or term.

To import a threshold file:

1.
2.

Navigate to the desired clause/term.

In the Threshold column, click the Edit icon (E,I’). If you are adding a threshold for the first time,

the icon is grayed out.
In the Edit Thresholds dialog, in the Thresholds tab, click Add a New Row.

Enter information in the following column fields: Code, Description, Rate, Thresh Basis, Lower
Boundary, and Upper Boundary, and Apply to Start and Apply to End, as desired. For information
on these fields, see Using calculation bases, measures, and types in thresholds and Threshold file
requirements. To locate codes, use the look up option.

To add another threshold, repeat steps 3 and 4.

(Optional) If you need to add multiple rows that will have the same information for each code,
you can copy the rows instead of adding each manually.

Do one of the following:
e To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.

Copy threshold rows

When entering thresholds manually, often the Thresh Basis, upper bound, lower bound, etc., will be the
same for every code. If a threshold entry exists that can be copied to other codes, you can use the
Duplicate selected row option.

To copy threshold codes:

1.

Navigate to the clause or term with the desired threshold record. In the Threshold column, click
the Edit icon ([#).

In the Thresholds tab, do one of the following:

e Click Add a New Row and then manually enter the information for the first record to
duplicate, then select the row’s check box.

e For an existing row, select the row’s check box.

On the bottom right, select the Duplicate selected rows check box, and then click the Look up
codes button.
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Edit Thresholds

Clause 1] Thresholds
Thresholds ~ Look Up

+ Add a New Row

[] code T  Description
038 Medicare2011
O e Medicare2011
O s=e Medicare2011
039 Medicare2011

Adjust selected rows | Setrate equalto +

uplicate selected rows | Look up codes

Import  Files

T Rate  Thresh Basis Lower Bound
000 Line Charges 000
000 Line Chargss 000
000 Line Charges 000
000 Line Charges 000

Upper Bound
0.00
0.00

000

Apply to Start

Apply to End

0.00 0.00

0.00 0.00

0.00 000

0.00 0.00
-4of 4items

Delete Selected

Cancel

4. Inthe Look Up tab, find the code to add to the row, select the check box to the left of the code,
and then click Create Threshold Record.

Edit Thresholds
Term 1| Look Up

0000000 OooODOoooOleA®e0O O

Thresholds  LookUp  Import
+ Add a New Row
Code T

Files

Description
No Description

TRACHEDSTOMY FOR FACEMOUTH & NECK DIAGNOSES W CC
TRACHEDSTOMY FOR FACEMOUTH & NECK DIAGNOSES W/0 CC/MCC
No Description

Severity 3 Liver Transplant

Severity 4 Liver Transplant

ALLOGENEIC BONE MARROW TRANSPLANT

NO DESCRIPTION

NO DESCRIPTION

NO DESCRIPTION

NO DESCRIPTION

AUTOLOGOUS BONE MARROW TRANSPLANT W CC/MCC

NO DE!

PTION

AUTOLOGOUS BONE MARROW TRANSPLANT W/0 CC/MCC

NO DESCRIPTION

NO DESCRIPTION

eate Threshold Records

51-75 of 4425 items

Cancel

The selected codes are added to the Threshold tab as records.

5. Do one of the following:

e To save changes and keep working in the dialog, click Save.
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e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

Look up threshold codes

Use this feature to find threshold codes and add them as threshold records to clauses and terms.

To find codes to add as threshold entries:
1. In the Edit Thresholds dialog for the clause/term, click the Look Up tab.

2. Verify that the Duplicate selected rows option is NOT selected.

3. Locate and select the desired codes, and then, at the bottom right of the dialog, click Create
Threshold Records.

The record is added to the list of threshold codes in the Thresholds tab.
4. Do one of the following:
a. To save changes and keep working in the dialog, click Save.
b. To close the dialog after saving, click Save and Close.

c. To cancel your unsaved changes and close the dialog, click Close.

Import a threshold for a clause or term

When adding a threshold to a clause or term, you select the method of payment for the clause or term.

You can add thresholds to a clause or term manually; however, you can add more complicated
thresholds using the attach thresholds option. With this option, you build your threshold requirements
in Excel and upload them to the system instead of entering them manually one at a time. This is the
preferred method for more complex thresholds. For information on threshold files, see the following
Threshold file requirements.

Before attaching threshold files, review the file requirements:

» Threshold file requirements

Unlike regular rate files, threshold files require a minimum of the following fields:

¢ Code — Code used for match (DRG, CPT4, etc.)

* Rate — The rate to reimburse if claim/line matches the threshold conditions (Percentage or Dollar
Rate). Percentages must be represented as decimal values. For example, 100% - 1. 99% - .99
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* Thresh Basis — The thresh basis controls which piece of information on the claim/line is analyzed

by the calculation engine to determine if there is a match. Enter the corresponding number below
in the Excel file. For example, if calculating Per Diem, enter 1 for each entry in the file.

° Claim Level Based

© (1) Total Days (Per Diem)

© (2) Total Charges (Per Claim)
° Line Item Based

© (3) Line Charges (Per Line Item),

© (4) Line Units (Per Line Item Qty),

° (5) Total Daily Units (Per Date Units),

© (6) Total Daily Charges (Per Date Charges)

e Lower Bound / Upper Bound — The lower bound represents the lowest value for your thresh

basis trap. The upper bound represents the highest value for your thresh basis trap. Anything
greater than or equal to the lower bound, and less than or equal to the upper bound, will be
considered a match.

Apply to Start / Apply to End — In some cases, you may only want to apply a percentage (%) to a
range of your charges, or only apply a per diem on certain days. If this is the case, you would set
your “apply to start” and “apply to end” to the range of days or charges to which you want to
apply your rate.

A Description is not needed in the file because it will populate from the corresponding library. Codes
that are in the file but do not have a library entry will get a default description of NO DESCRIPTION.

To import threshold files to a clause or term:

1.
2.

Navigate to the desired clause/term.

In the Threshold column, click the Edit icon (IZ,I’). If you are adding a threshold for the first time,

the icon is grayed out.
Click the Files tab.

In the Upload tab on the right, drag the threshold file to the Upload files to a selected folder
area or click Select files and select the threshold file.

Click Upload. The file name displays under the Thresholds folder on the left.

Select the file, and then click the Specify tab on the right. The top part of the tab displays an
image corresponding to the data in the uploaded file.

Define the columns of your file (refer to Threshold file requirements if needed):
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a. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column,
select from the drop-down the letter that corresponds to the column in the image above.
In the following example, Code corresponds to column A in the threshold file. Do this for
each field in the Rates Column that needs to be mapped.

Edit Thresholds x
Clause 1| Files

Specified File |

Thresholds LookUp Import Files Unspecified File[(
Show all folders (] Upload  Specify
¥ [ Rates Library
v D DocuSim Sample data: OR Medical Outpatient Thresholds.xlsx
¥ [ Aetna
A B c D
¥ [ Version1
765 5000
» 3 All Other Line Items :
» [3 Any and All Services 765 5000 1 5
» [31CD10 Procedure Primary 766 5000
» [3J1CD9 Procedure Any 766 5000 1 5

¥ [3 ltemized Charge Code
[ Rates >

Sheet V)
v [ Thresholds Sheet1 Sheet2 Sheet3

[3 OR Medical Outpatient Thresholds.xlsx

» [ Line ltem Code ASC Rates Column Excel Column
» 3 Version 2 Code maps to A hd
Rate maps to B K
Thresh Basis maps to Not Mapped
Lower Bound maps to Not Mapped
Upper Bound mans to Not Manned M
Excel data has column headers? No [] Yes Save specifications
Drag/Drop Copy [J Move Delete Download

Cancel

b. For Excel data has column headers? select the appropriate option.
8. Under the mapping table on the right, click Save Specifications.

9. At the top of the dialog, click the Import tab. The file you uploaded displays under Specified
Thresholds Files.

10. On the right side of the dialog, click Attach. When the file is attached, the file’s check box displays
as checked.

11. To view the imported thresholds, click the Thresholds tab.

12. Close the Edit Thresholds dialog.

Using limits

Axiom Contract Management gives you the ability to model “lesser of” and/or “greater of” language
common among many payers. These are known as limits because they limit reimbursement for a
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particular case, and can be added to any clause, term, or provision in a contract. In the contract level
hierarchy, limits sit on top of clauses and terms, which means they belong to the particular clause or
term they reside on. Global limits belong to the provision that they reside on.

» Limit restrictions

In Axiom Contract Management, you do not need to worry that your limit may not be compatible with
the parent clause or term that you are adding it to because the system handles it automatically. The
type of limit you can set on a particular clause or term depends on its parent type. For example, if you
are creating a limit on a case rate type clause, the type of limits available when you build it are restricted
to case rate calculation bases and types. If you are creating a limit on a line item clause or term, the limit
selections will be for line item calculation bases and types.

» Whatis a Maximum?

A Maximum sets a limitation on the particular clause or term it sits on, restricting it to a specified
amount that it can receive at most. For example, if you would like to limit reimbursement to the lesser
of 100% of charges on a DRG Case rate clause, you would set a max on that clause paying 100% of
Any/All Services. When the claim is calculated, the calculation will create a record for the DRG Case rate,
a record for the Maximum, and then compare the two and pay whichever is less.

» Whatis a Minimum?

A minimum sets a limitation on the particular clause or term it sits on, restricting it to a specified

amount that it must receive at a bare minimum. For example, if you have a percent of charge clause that
pays 50% of charges but your contract states that you will receive at least $500 for every claim, then you
would create a minimum on your % of charge clause, setting it to pay $500 of Any/All Services per claim.

» Limit hierarchies

In many cases, you will be creating contracts for which there are terms attached to clauses and you
would like to limit both the clause and its attached terms. You can do this by setting limits on both terms
and their corresponding parent clause; however, there is a hierarchy involved when doing so.

After all applicable terms are calculated, the clause limit is applied as a final step to determine if the
limit(s) applies or not. Remember, terms report their reimbursement back to their parent clause, so if a
limit exists on the clause, all terms attached to it are subject to that limit.

There are cases in which you will not want to include a particular term’s reimbursement when applying
the limit. The system allows for this by enabling you to toggle a term’s Include option. When you set a
limit on a term, a check box becomes enabled on the term, allowing you to include its reimbursement or
to exclude its reimbursement from reporting back to the parent clause’s limit. In Axiom Contract
Management, these are known as “carve-out” terms. Their reimbursement does not count toward the
parent clause limit and is added to the result after the limit winner is determined. The Include option
can be located on terms for normal limits and clauses for global limits.
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Creating limits
Limits are defined generally as Maximums and Minimums, and they either cap or raise reimbursement.
You can create limits on the following contract levels:

* Provisions
¢ Clauses

e Terms

NOTE: Limits on provisions are called global limits because they apply to all clauses and terms under
the provision.

To create a limit:

1. Navigate to the desired clause or term.

2. To add alimit to a clause or term, do one of the following:
e Add a line item limit.

¢ Add a maximum and/or minimum limit.
3. To add a limit to a provision, add a global limit.
After setting a limit, the Edit icon is no longer grayed out.
Create a maximum or minimum limit
Adding a minimum or maximum limit to a clause or term restricts the reimbursement to a specified

amount that it can receive at most or at least.

NOTE: You can create only one maximum and one minimum per clause or term.

To create a maximum or minimum:

1. Navigate to the desired clause or term.

2. In the Limits column, click the Limit icon ((£).

3. On the Limits page, do one of the following:
e To create a maximum, select the Maximum check box.

¢ To create a minimum, select the Minimum check box.
4. Inthe Description field, select a description from the drop-down.
5. In the Calc Basis field, select a calc basis from the drop-down.

6. Select a Calc Type and a Calc Measure.
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NOTE: Depending on which calc basis you selected, you may or may not need to, or be able
to, select a calculation type and calculation measure.

7. Do one of the following:
e To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.
e To cancel your unsaved changes and close the dialog, click Close.

8. To set rates, do one of the following:
e For asingle rate, type the rate into the Rate field.

¢ When multiple rates are required, a Rates button displays below the grayed-out Rates
field. To add multiple rates, click the Rates button and then add rates manually or import
rates.

9. If you are creating both a maximum and a minimum, select the Minimum check box and then
complete the fields as you did for the maximum limit. You will need to save your selections
before you can enter a rate.

10. Do one of the following:
e To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.
e To cancel your unsaved changes and close the dialog, click Close.

11. (Optional) If desired, set an exclusion for the limit(s).

Create a global limit

Global limits allow you to set a maximum and a minimum amount for reimbursement on a claim. Global
Limits are applied at the provision level and apply to all clauses and terms under the provision. To apply
a limit to a specific clause or term only, see Creating limits.

To create a global limit:
1. Navigate to the desire clause or term.

2. In the Global Limit column, click the In the Global Limits column, click the Limit icon ().

3. On the Global Limits page, add a maximum or a minimum, or both, as desired. The steps for
setting both are identical:

a. Select the Global Maximum (or Global Minimum) check box. Below the check box,
settings fields display populated with defaults.

b. Inthe Description and the Calc Basis fields, select from the drop-down. You can search the
lists in these drop-downs by clicking the field and then typing the description or calculation
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basis to search for. The list filters to the first letter or word you typed.

c. For Calc Type and Calc Measure fields, either leave the default or change the selection as

needed.

NOTE: In some cases, you will not be able to select an option different from the default
if the field is dependent on another field. For example, the selected Calc Type can limit

the Calc Measure you can select.

Global Limits
Global Maximum

Description
78

Calc Basis
Any and All Services

Calc Type
Dollar Rate

Calc Measure
Per Claim

Rate

Exclusions

Global Minimum

Description

78 s
Calc Basis

Any and All Services A
Calc Type

Dollar Rate b

Calc Measure
Per Claim b

Rate

Exclusions

NOTE: You cannot set a rate or an exclusion until you save your selections for the other

e When multiple rates are required, a Rates button displays below the grayed-out Rates
field. To add multiple rates, click the Rates button and then add rates manually or import

fields.
4. Click Save.
5. Do one of the following:
e For single rates, in the Rate field, enter a rate.
rates.
6. (Optional) Set an exclusion.
7. Click Save.

Create a line-item limit

When a limit is defined on a line-item clause or term, it no longer compares the final reimbursement for
that clause or term to the limit, but instead compares the reimbursement to the limit on a line-by-line
basis. The most common way to use the line-item limit is by capping fee schedules at the charge
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amount. The capping of fee schedules is language common to several managed care contracts, which
typically would state that all fees are paid the lesser of charges or the pre-determined fee scheduled
amount.

To create a line item limit for a clause or term:

1. Create the clause or term, or navigate to an existing clause or term that has a line item calculation
basis.

2. In the Limits column, click the Limit icon ().

On the Limits page, select either the Maximum or Minimum check box.
From the Description drop-down, select a description.

From the Calc Basis drop-down, select Line Item Code.

From the Calc Type drop-down, select Dollar Rate.

From the Calc Measure drop-down, select Per Line Item.

Click Save.

L ©® N oo U B~ W

Below the Rates field, click the Rates button and attach your fee schedule to the clause/term. See
Import rates for a clause or term for detailed instructions on attaching fee schedules.

Set a limit exclusion

NOTE: Exclusions can be set in two places depending on the calculation basis. When the Calc Basis
for a clause or term is either Itemized Charge Code or LI MPR, exclusions are set from the
clause/term Edit dialog. When the Calc Basis is Any and All services, exclusions are set from the
Limits/Global Limits dialog.

You can set exclusions on limits placed on clauses or terms and on global limits placed on provisions.
Exclusions are available only when the calculation basis for the provision, clause, or term is Any and All
Services. Rates are entered manually.

¢ Manual entry is used to enter codes into the grid
e Services are excluded by either Date of Service or Total Charges
° There are before or after, less than or greater than selections
° Numeric values are entered for days or dollars
e Exclude by Service Code drop-down list determines which Code library you are validating against

— Charge Code or Rev Code. The functionality will always be the same, whether in clauses, terms,
limits, or global limits. Only the context changes.

To set exclusions on a limit:

1. Navigate to the provision, clause, or term with the limit needing an exclusion.

2. Inthe provision/clause/term row, in the Limits column (Global Limits if a provision), click the
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Limit icon ().
3. On the Limits page, under the Maximum limit fields, click Exclusions.

4. In the Edit Exclusions dialog, on the right side, from the Exclude by Service Type drop-down,
select the service type: Line Item Code or Rev Code.

5. On the left side of the dialog, click +Add a New Row.

6. Enter the following information in the new row:
a. Inthe Code field, type the code.

b. If the code is in the system, the description displays in the Description field and cannot be
edited. If the code is new to the system, type a description into the field.

c. Enter a rate in the Rate field.

NOTE: You can enter negative rates as well as positive ones. To enter a negative rate,
put a minus sign (or hyphen) before the number.

7. To add another exclusion, repeat step 6.

8. Click Save.

Add a unit max limit to a Line Item MPR

Use these instructions to add a Unit Max limit on a contract clause or term that uses the Line ltem MPR
calculation basis. Setting a unit max limit puts a cap on how many units are paid. The unit max acts as a
counter; when the limit is reached, additional claims for that item that are eligible are not reimbursed
(they are paid at S0).

NOTE: The Unit Max limit used on an MPR calculation applies to professional claims only.

To add a unit max limit to a Line Item MPR calculation:

1. Navigate to the clause or term that has the Line ltem MPR calculation method.

NOTE: Be sure you have added translation tables and rates to the clause before setting a
limit.

2. In the Limits column of the clause/term row, click the Limit icon ().

3. On the Limits page, click the Maximum check box.

4. From the Description drop-down, select a description.

5. From the Calc Basis drop-down, select Unit Max.

Notice that you cannot change the selected Calc Type.
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6. From the Calc Measure drop-down, select whether the max should be applied per claim, per
date, or per line item.

NOTE: When creating a unit max limit, you cannot change the default Calc Type or Calc
Measure after selecting Unit Max as the Calc Basis.

Limits

Maximum

Description

11123 ¥
Calc Basis

Unit Max A
Calc Type

Dollar Rate A

Calc Measure
Per Claim A

Rate
4,00

7. Inthe Rates field, enter the unit limit. For example, if the unit is the number of therapy sessions
and the contract stops paying after the 6th visit, enter 6.

8. Click Save.

The voucher report for claims that are run against this limit will display the limits and a payment
of 0 once the rate cap is met.

Add an exclusion to a unit max limit Line Item MPR calculation

Use these instructions to add an exclusion to a unit max limit on a Line Item MPR calculation for
professional contracts. The exclusion allows always-payable services to calculate separately from the
items in the reduction calculation while still being counted in the unit max limit.
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To add an exclusion to a Unit Max Limit Line Item MPR calculation:
1. If not already set up, create a clause for the always-payable services with the following selections
(do not forget to select the calculation type):

a. For Calc Basis, select Line Item Code.
b. For Calc Measure, select Per Line Item.
c. For Terminal?, select one:

* No - Select to allow a claim to continue calculating on the clauses/terms below this
one.

* Yes— Select to prevent a claim from calculating on any clauses/terms below this
one.

d. Click Save.
2. Add a unit max limit to the Line Item MPR calculation.
3. Exclude the always-payable services from the Line Item MPR:

a. Atthe end of the Line Item MPR row, hover your cursor and click the Edit icon (E,I’).

b. Inthe Edit Clause (or Edit Term) dialog, click the Exclusions tab.
c. Click +Add a New Row.
d. Inthe Code column, type the code for an always-payable service. Repeat for any additional

codes needing to be excluded.
e. Click Save.

4. To ensure that the always-payable services are included in the Unit Max Limit count and that they
process first, drag the clause row to the top of the table if it is not already there: select the row
and hold down your mouse button while dragging the row to the top of the table. The Unit Max
limit Line Item MPR clause does not need to be directly below it as long as it is lower in the table
than the one for always-payable services.

Launch Page Contracts Claims Import Data Reports Admin Help Logout Queued Tasks: 0 ?

DocuSim > Aetna Professional > Version 1( 31/2021) > Professional Comracts (1/1/2021 - 12/31/2021

Always payable clause
should be at the top

Clauses

+ Add a New Clause

Calc Basis Cale Type Calc Measure Terminal? Attributes Rates Threshold Limits.

Clause Description
Dollar Rete Per Line ftem No =

= Z

13 Line lem Code

Ling lrem Code MPR Dallzr Rate

All Other Line ltems

ALL OTHER CHARSA

u ez
Dollar Rate Per Line ftem Yes
u ez

>
a4 11123 temized Charge Code Dollar Rate

Unit Max limit line item |
MPR clause
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Using attributes

Users who have permissions to model contracts can add attributes to contracts.

Attributes are custom tags that you add to contracts and contract levels (i.e., versions, provisions, and
clauses/terms) to:

Extend the contract data model — Attributes allow you to add information to a contract that exists
on the physical contract but for which there may not be room in the modeled version.

Organize key aspects of payer contracts
Enhance reporting across contracts and payers

Augment reporting for current calculations and modeling detail using the Reporting Category
attribute

Ensure key details are collected during contract building

Attributes can be applied at all contract levels: contract, version, provision, clause and term. You can
apply an attribute from the list of attributes for that contract level or you can import an attribute from
another contract at the same level. Contract levels with applied attributes display a circled with check

mark icon (@) in their Attributes column.

Attribute data:

Name — Attribute name
Description — Explanatory information about the attribute

Data Type — The format of the attribute’s data value (e.g., text, integer, percent, etc.). For
example, if the Data Type is text, then the attribute’s value field accepts only text entries. The
following are the data types for attributes:

° Integer — Accepts a number

° Money — Accepts dollar and cents amounts

° Decimal — Accepts decimal values

© Percent — Accepts percentages

© Text — Accept text

° Library — A drop-down list from which you select a value for the attribute
Attribute Type — The contract level at which the attributed can be used (i.e., contract, version,
provision, clause/term)

Enabled— Whether or not the attribute is available for use. If an attribute is disabled by the
system administrator, it will not display in any attribute selection lists.

Add an attribute to a contract level

You can add attributes to contracts at each level: contract, version, provision, and clause/term. When
adding attributes, you can add only attributes of the type that corresponds to the contract level. For
example, you can add only version attributes to versions, and clause/term attributes to clauses or terms.
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To add an attribute to a contract level:

1. Navigate to the desired contract level.

2. Atthe end of the contract/version/provision/clause or term row, hover your cursor, and then

click the Edit icon ([#).

3. Inthe Edit [contract level] dialog, click the Attributes tab.

4. In the Attributes section, for the desired attribute, select the attribute value from the Attribute

Value field.

Attribute values depend on the attribute’s data type (e.g., text, integer, percent, etc.).

Attribute Data

Type

Selection process

Library Select from a drop-down list of options

Text Input the desired text

Decimal Click the arrows to indicate the number of decimals
Integer Click the arrows to indicate the number of integers
Money Click the arrows to indicate the amount of money
Percent Click the arrows to indicate the percentage.

In the following example, to add the contract attribute Color, select the desired color from the

drop-down.

Edit Contract
Aetna | Attributes

Settings  Attributes

Attributes

Attribute Name
Color
Decimal
FinClass
Interger

Money

Attribute Value

5. Do one of the following:

¢ To save changes and keep working in the dialog, click Save.

¢ To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.
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Import an attribute to a contract level

Use these instructions to add attributes to contracts by importing them from other contracts. When you
import an attribute, the system copies the attribute from the source and applies the copy to the target
contract level.

» Import an attribute to a contract

1.

2.

3.

6.

7.

Navigate to the contract that needs the attribute.

»
At the end of the contract row, hover your cursor, and click the Edit icon (D" ).
In the Edit Contract window, click the Attributes tab.

In the Import Attributes section, verify that displayed simulation is the one with an attribute you
want to use. If not, then from the Simulation drop-down, select the desired simulation.

In the list of contracts, locate and expand the level that has the attribute you want.

NOTE: Only contract-level attributes will be included in the list to choose from.

Import Attributes Simulation: | DAP A
Contract Name T
-
Contractual Export
DAPAttribute Purple x
Delete Text Test
Medicare part B
Plan Copay
QA Test Attribute 4
QA Test Attribute AA -
1 1-10of 1items
Close

To import the attribute, click the Assign icon (3 ).

Do one of the following:
e To save changes and keep working in the dialog, click Save.
¢ To close the dialog after saving, click Save and Close.

e To cancel your unsaved changes and close the dialog, click Close.
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» Import an attribute to a version, provision, clause, or term

1. Navigate to the contract level needing the attribute.

2. Atthe end of the version/provision/clause/term row, hover your cursor and click the Edit icon (
.
3. Inthe Edit [contract level] dialog, click the Attributes tab.

4. Across from the Import Attributes section title, from the Simulation drop-down, select the
desired simulation.

5. In the list of contracts, expand the desired contract levels to reach the desired level and then
expand that level item. For example, if you are importing attributes for a clause, navigate to the
desired clause and then expand the clause to view its attributes.

6. Do one of the following:

* To import all of the [contract level]’s attributes, click the Assign icon (E) at the end of the
row.

* To import selected attributes, click the Assign icon (3) for the desired attributes.

Import Attributes Simulation: | Live v
Contract Name ) i T
4 CIGNA PPO Click to import all .
. o attributes in this version
Version Start Date Expiration Date
—
4 9 01/01/2020 12/31/2020 Discharge
Attribute Name Attribute Value
Comments

Select individual
attributes to import

Days Retro

Percent of copay
-

4 4 O 1-100f 10 items

Example of version-level attribute list

7. Do one of the following:
a. To save changes and keep working in the dialog, click Save.
b. To close the dialog after saving, click Save and Close.

c. To cancel your unsaved changes and close the dialog, click Close.
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Edit or remove an attribute from a contract

Use these instructions to change an assigned attributes value or to remove the attribute from the
contract level.

To edit or remove an attribute:
1. Navigate to the desired contract level.

»
2. At the end of the contract/version/provision/clause or term row, click the Edit icon (El" ).
3. Inthe Edit [contract level] dialog, click the Attributes tab.

4. Do any of the following:

e To change an assigned attribute’s value, select the value from a drop-down or, if an
integer, money, or percent value, type in the desired amount; the field is automatically
formatted for the entry type. If a text value, edit the text as desired.

¢ To remove the attribute from the contract level, if the value is from a drop-down, select
from the drop-down. If the value is an integer, delete the value (setting the value to zero
does not remove the attribute, it just changes it to 0) by selecting the value and pressing
the Delete key.

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.
e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.
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Managing simulations

The ability to run a nearly endless number of simulations is one way that Axiom Contract Management
sets itself apart from older editions. Simulations are an essential tool during contract negotiations,
allowing you to model a number of proposed contracts and run reports for comparison to determine
which proposal is most profitable.

Create a simulation

Creating simulations that model the identical contract structure allows you to get a more accurate view
of how facility reimbursement is changing, and which services are affected. After creating a simulation
you can add contracts to it.

To create a simulation:

1. Atthe top of the Contracts page, to the left of the simulation drop-down, click the Edit icon:

Live v
Contracts

+ Add a New Contract
Contract Name

AETNA

2. Inthe Edit Simulations dialog, above the table of simulations, click Add a new Simulation. A new
simulation row is added to the table, as shown in the following example.
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Edit Simulations x

Simulations

+ Add a new Simulation

Simulation Name T
New Simulation

foldering

Okazlova00

1CRB

1_LRW_1

In the new row, type a name for the simulation and then click Save. The newly created
environment can now hold contracts.

Add a contract to the simulation.

Edit or delete a simulation

Use these instructions to change a simulation name or to delete a simulation.

To change a simulation name or delete a simulation:

1.
2.

At the top of the Contracts page, click the Edit Simulations link.
In the Edit Simulation dialog, for the desired simulation, click and then edit the name.

To delete a simulation, at the end of the simulation row, click the Delete icon (i).

Click Save.

Close the Edit Simulation dialog.

Setting up reporting across simulations

Axiom Contract Management administrators can assign simulations to the Expected Payment drill-down
reporting field for side-by-side reporting and analysis. Administrators can map up to four simulations for
a total of five mapped simulations. The first mapped simulation is to the Live environment, which you
cannot change.

» How the mapping works

The Estimated Payment fields in drill-down reports are used in this case to compare estimated payments
between different simulation environments. These fields are defined with the following field names:
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e TotalExpectedPaymentl where 1= Live simulation; so TotalExpectedPaymentl equates to
Estimated Payments from Live in drill-down reports

e TotalExpectedPayment2 where 2 = a simulation of your choice
e TotalExpectedPayment3 where 3 = a simulation of your choice
¢ TotalExpectedPayment4 where 4 = a simulation of your choice

e TotalExpectedPayment5 where 5 = a simulation of your choice

When users build drill-down reports, they need to include the TotalExpectedPayment variable for the
desired simulation in a calculated field they add to the report.

In the following example, a contract is compared between two simulations. The calculated fields Exp
Payl, Exp Payl%, and Exp Profitl are mapped to the Live environment by using the variable Total
Expected Paymentl in the equation for each calculated field:

e Exp Payl = Sum (Total Expected Payment1)
e Exp Payl% = Sum (Total Expected Payment1)/Sum (Total Charges)*100
e Exp Profitl = Sum (Total Expected Payment1)-Sum (Total Cost)

The calculated field Exp Pay2% is mapped to the EPAY2 simulation by using the variable
TotalExpectedPayment2 in the equation: Exp Pay2% = Sum (Total Expected Payment2)/Sum (Total
Charges)*100

wocs |y ||
Columns

APC Comparison

Claims | Lineltems 8355

Groupings Measures

+Add New XDelete

Exp Contractua

. Exp Pay Pct
Exp Pay
Exp Pay

o XD
Exp

- Exp
Exp
Exp

o E5D
Evp Pay4%

- | Contract | Facility Code ‘Contract ClauseDesc ‘Casasl Charges I Exp Payl " Exp Pay1% II Exp Pay2 % I SUM Total Cost I Exp Profit] ‘I

The generated example report looks like the following:

Administrator's Guide Axiom Contract Management | 146



Reports Help

APC Comparison
Claims | Line ltems
[ fows | vew | S | |
Design View  Export 1 record found
| [[contract v]~ [ cases | charges | ExpPayl | ExpPayl% | ExpPay2% |  SUMTomlCost | Exp Profitl [
E‘\_l‘AEI'NA | 14‘ ausa| 7 945‘ 90.0| 923| 26.946.11 | 47.000.20 -
Facility Code ~ | Cases | chages | ExpPayl | ExpPayl% | ExpPay2% |  SUMTomlCost | Exp Profit]
=] |13'Hc5p\(aIDulpal\em | 14| 82,163 | 7 945| 900| 923| 26,046.11 | 47000.20
| Contract ClauseDesc ~ Cases Charges Exp Payl Exp Pay1% Exp Pay2 % SUM Total Cost Exp Profitl
‘ SURGICAL 14 82163 73546 900 928 26946.11 47,000.20
: 14 82,163 73,946 90.0 928 26,946.11 47,000.20
‘ 14 ‘ 82,163 73,946 ‘ 90.0 | 928 | 2694611 47,000.20
4 , -
‘ ‘ | 14 ‘ 82,163 73,946 90.0 928 2694611 47,000.20
# Applied Filters
p
IMPORTANT: Since only administrators can see which simulations are mapped to each mapping
assignment field, as an administrator, you will need to create the custom calculated fields needed
and name them appropriately. For example, a calculated field representing Sum(Total Expected
Payment 1) for a simulation named Aetna KMC could be named AetnaKMC Exp Payment. For
information about creating calculated fields, see Add calculated fields to a report.

» Map simulations to drill-down reporting Expected Payment fields

To map simulations to expected payments variables:

1. Inthe main menu header, click Admin > Simulation Mapping.

2. For Mapping Assignment 2, from the drop-down, pick a simulation to assign to the Estimated
Payment drill-down reporting field.

NOTE: Mapping Assignment 1 is set to the Live simulation environment. This cannot be
changed.
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Simulation Mapping

Mapping Assignment 2
‘ A ChgAdj Per Line v |

Mapping Assignment 3
‘ CKK Test Simulation v |

Mapping Assignment 4

‘ LileTesting v |

Mapping Assignment 5
‘ Kendo Testing Chrome v |

Save

3. Repeat for the other mapping assignments as desired.

4. Click Save.

When you make a change to this assignment and click Save, the field is cleared to ensure that all past
calculation results from previously used simulations are not still stored and used in the report.

NOTE: Results from a newly assigned simulation become available only after a user calculates

contracts within the selected simulation. Past calculation results are not retained for a simulation
when it is assigned to a different mapping field.
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Working with claims

The View a Claim function in Axiom Contract Management allows you to access or view all information
related to claims. The multiple forms of information are compiled from data contained in the Claims,
Payments, and adjustments imports. Other important data fields are calculated by the system, or
imported from other Syntellis systems.

You have the following options for selecting and viewing claims:

e Patient Account # — Account number or billing identification number imported from the claim

e Patient Name — Patient name imported from the claim (you can also search for the name in this
field if you do not know the full name)

e Claim #/UCRN — Unique record number or Claim Sequence number assigned by the patient
accounting system

» Access View a Claim
To access View a Claim:

In the main menu header, click Claims > View a Claim.

The Claims page opens with fields for selecting a claim to view:

Claims

View By: | Patient Acct. # b4 Account # Live Claims Only View Claim(s)

The Axiom Contract Management system defaults to show Live Claims Only. To have the system return
results for all instances of the claims, clear the Live Claims Only check box before making a View a Claim
Selection.

View a claim by selected criteria

Use these instructions to view claims by patient account number, patient name, or client #/UCRN.
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NOTE: By default, the selection criteria include only live claims. To include all claims, clear the Live
Claims Only check box before clicking View Claim(s).

To select claims by patient account number:

1. Onthe Claims page, from the View By menu, select Patient Acct #.

2. Inthe Account # field, enter the account number and then click View Claim(s).

Claims
View By: | Patient Acct. # \/ Account # | C921371604 Live Claims Only

Acct # Claim Type Organization Patient Name MRN AdmitDate  Discharge... Sub Date Total Charges

€921371604 8371-111 - Active R KREG MEDICAL CTR Ms54748 09/24/2013 10/07/2013 10/29/2013 $89,836.46
€921371604 837P - Active Recor. KREG MEDICAL CTR. M54748 09/24/2013 09/24/2013 10/29/2013 $21.00
€921371604 837P - Active Recor. KREG MEDICAL CTR Ms54748 09/25/2013 09/25/2013 10/29/2013 $42.00
€921371604 837P - Active Recor. KREG MEDICAL CTR. M54748 09/25/2013 10/04/2013 10/29/2013 $1,164.00
€921371604 837P - Active Recor. KREG MEDICAL CTR Ms54748 09/27/2013 09/27/2013 10/29/2013 $787.50
€921371604 837P - Active Recor. KREG MEDICAL CTR. M54748 09/27/2013 09/27/2013 10/29/2013 $140.00
€921371604 837P - Active Recor. KREG MEDICAL CTR M54748 09/28/2013 09/29/2013 10/29/2013 $400.00
€921371604 837P - Active Recor. KREG MEDICAL CTR Ms54748 10/03/2013 10/03/2013 10/29/2013 $140.00
€921371604 837P - Active Recor. KREG MEDICAL CTR. M54748 09/27/2013 10/03/2013 11/04/2013 $94.00

To select claims by patient name:
1. From the View By menu, select Patient Name.

2. Inthe Patient Name field, type the patient last name, and then click View Claims(s). If this does
not return the desired claim, type in the patient’s first and last names.

TIP: You can also search for patient names using the percent symbol % as a wildcard: %son
(returns claims for patients whose first or last name ends in the letters “son”); son% (returns
claims for patients whose first or last name begins with the letters “son”); %son% (returns
claims for which the letters “son” appear anywhere in the first or last name).

NOTE: If the criteria selected matches multiple claims, all of those claims will appear in the
Account Selection List.

Claims
View By: | Patient Name v | PatientName = Smith Live Claims Only

Acct # Claim Type Organization Patient Name MRN Admit Date Discharge... Sub Date Total Charges

26463774 837P - Active Recor. KREG MEDICAL CTR SMITH, 10/03/2006 10/10/2006 10/15/2006 $100.00
26462967 837P - Active Recor. KREG MEDICAL CTR SMITH, 10/03/2006 10/10/2006 10/15/2006 $100.00
R03996273 #01 837P - Active Recor. KREG MEDICAL CTR SMITH, 03/21/2005 03/21/2005 03/26/2005 $520.24
26407789 837P - Active Recor. KREG MEDICAL CTR SMITH, 10/03/2005 10/03/2005 10/15/2005 §79.04
CLMNO12345 837P - Active Recor. KREG MEDICAL CTR Smith, ¢ 02/01/2004 02/01/2004 03/01/2004 $223293
TS234H3 837P - Active Recor. KREG MEDICAL CTR. SMITH, 05/06/2005 05/06/2005 07/11/2005 $252.71
756049CRB 8371-131 - Active R. QA Test Code 01 SMITH, 04/01/2005 04/01/2005 06/30/2005 $50.00
756049A 8371-131-Active R QA Test Code 01 SMITH, 04/01/2020 04/01/2020 06/30/2020 $50.00
W392-49141 8371-131 - Active R KREG MEDICAL CTR SMITH, 06/17/2005 06/17/2005 07/11/2005 $14.84
756049Q 8371-131 - Active R. QA Test Code 01 SMITH, 04/01/2005 04/01/2005 06/30/2005 $50.00
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To select claims by Claim #/UCRN:
1. From the View By menu, select Claim #/UCRN.

2. Inthe Claim #/UCRN field, enter the number and then click View Claim(s).

» Account Selection List details

TIP: To sort any column in the table of selection list results, click the gray column head.

The account selection list results contain the following claim fields:

e Acct# — Lists the account number imported from the claims

NOTE: Account numbers in this column are also links that take you to the Claim Details page
for the respective claim.

e Claim Type — Identifies the type of claim and its status in Axiom Contract Management
¢ Organization — Identifies the organization imported from the claim

e Patient Name — First and Last name imported from the claim

e MRN — Medical Record Number imported from the claim, if applicable

e Admit Date — Admission date imported from the claim

¢ Discharge Date — Discharge data imported form the claim

e Sub Date — Submission date imported from the claim

e Total Charges — Total Charge amount imported from 0001 line on the claim form minus non-
covered charges

View claim details

The claim details page of Axiom Contract Management provides an easy-to-use interface that allows you
to view all information associated with a claim. Click the tabs to navigate to various sections of the

claim.
aims > Patient Acct. # 921672524
) . Access this menu ¢
Claim Details from any details tab +# View Voucher  Go to Contract Grouper Edits View 835s
Summary Codes Demographics Insurance Lineltems Physicians Postings  Tracking

Summary for: C921672524 -

Claim Information

Patient Account #:| 921672524 Calculated Contract: | AETNA - Version 2 Admit Date:| 12/6/2013
Claim Number:| U322600943 Type of Bill:| 131 - Hospital-OutPatient-Admit Thro Discharge Date:| 12/6/2013
Import Batch # | 2395- 8371 Patient Status:| 01 - Discharged To Home Or Self-Care Submission Date:| 12/19/2013
Last Recalc:| 10/21/2021 5:15:47 PM Total Covered Chgs: $9,614.51 Length of Stay:| 0

Above the row of tabs is a line of links to related information:
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¢ View Voucher — Click this link to open a new browser tab containing the Claim Voucher Report.
The Claim Voucher Report provides an explanation of exactly how the system arrived at the
expected payment, and how much the payer has paid. This information is ideal for follow-up with

the payers to ensure proper payments are being received. Additionally, the voucher displays any
line item modifiers that affected the reimbursement calculation.

Simulation: [ Live Claim Voucher Report
Billp: © Admission Date:
Claim Status: A Discharge Date:
Patient Name: Prouision Date:
Insurance ID: SMID67S67 Provision:
Bill Gode: 13 Contract Name:
Insurance Plan Gode: CI012 Organization: KREG MEDICAL CTR ORG!

Govered Days: 0 Contractual Variance:

Version#: 2 Balance Du

IMPLANTS

Calculation Basis
Calculation Type
Calculation Measure

‘This Clause Matched on the Following RevCode Codes:

Service Date RevCode Cod Desc Rate
w2/6m2 wm w7e Med/Surg - Other Implants 0.00
Expected Payment for this Clause:  $1,435.31

Total Terms Reimbursement

Term #1: ANV/ALL SERVICES

ANY/ALL SERVICES

Galculation Basis Al Other Line ftems
Galculation Type: % Charges
Calculation Measure: PerLine hiem

This Term Matched on the Following All Other Line ftems Codes:

Servics Data code Rats.

216/2013 . 2000
—_ 2000
615 000
— 000
Jogso 0.00
ME 000
Jiess 0.00
Jz00 0.00
1225 0.00
Ja010 000
. 000
(=3 0.00%

¢ Recalculate — Click this button to recalculate the current claim. For more information, see
Recalculate a claim from Claim Detail.

e Go to Contract — Click this link to open the contract’s clause or term page to which the claim

applies in a new browser tab. Additionally, the specific contract clause is highlighted, as shown in
the following example.

Live > AETNA > Version 2 (7/1/2009 - 12/31/2017) > Hospital Inpatient (Including Medicare Part A) (7/1/2009 - 12/31/2015)
Clauses
+ Add a New Clause

Clause Description Calc Basis Calc Type Calc Measure Terminal? Attributes Rates Threshold Limits
1 DETOX RevCode Dollar Rate FerClaim Yes =
2> PsvoH ResCode Doller Rete =

RS REHAS RevCode Dollar Rate Yes =

P HOSPICE e =

s Dollar Rate ves =

s> rate =

> Dollar Rate ves =

8> ResCode Doller Rete =

9 > RevCode Dollar Rate Yes =

0 > ATE/COUINTERMEDIA.  RevCode Doller Rete =

1o RevCode Dollar Rate ves £

2 > e =

T Dollar Rate ves =

12 ALL OTHER IP Al Other Line items 2 Charges Per Line Iter
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¢ Grouper Edits — Click this link to detail all APC and eAPG edits. This is important when
determining why a Medicare claim has an expected payment = S0. In Axiom Contract
Management, if there is an edit on a line item (code, modifier, etc.), the system automatically
pays the claim at SO. This helps you easily identify claims that can potentially be fixed and re-
billed for a higher total redemption from Medicare. Following is an example of Grouper Edits for
APC ICD9 Code edits. For more information, see View Grouper Edits for a claim.

Grouper Edits X
Simulation: | Live v Claim Number: 182833

() APC claim Edits Q APC ICD9 Code Edits (O APC Line ltem Edits () eAPG Claim Edits (O eAPG ICDY Code Edits (O eAPG Line Iltem Edits

Edit Y  Edit Description Y  Procedure Code YT  Procedure Type T
0002 CMS: OCE ICDEdit - Diagnosis and age conflict. (RTP) 76503 [nied
0002 CMS: ( ICDEdit - Diagnosis and age conflict. (RTP) 76522 D3
0002 CMS: OCE ICDEdit - Diagnosis and age conflict. (RTP) V3000 D1

Claim Detail tabs

An overview of each tab follows.

» Summary tab
The Summary tab is divided into three sections of information:
¢ Claim Information — Information identifying the type of account, the contract used for
calculation, and important demographic information such as patient account number, claim

number, patient status, and so on; and a summary of the total covered charges and non-covered
charges.
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e Claim

Totals — This section contains all the information necessary to identify whether a claim is

paid correctly:

o

e}

¢ Claim

Expected Payment — Calculated expected payment using contract terms
Expected Contractual — Total Covered Charges minus Expected Payment
Actual Payments — Total of all Payments imported by Account # from payment import file

Actual Contractual — Total of insurance contractual imported by Account # from
Contractual File

Payment Variance — The difference between Expected Payment and Actual Payments

Contractual Variance — The difference between Expected Contractual and Actual
Contractual

Total Cost — Sum of Fixed, Variable, and Indirect Cost

Fixed Cost — Imported from cost accounting system — represents fixed cost (materials and
labor)

Variable Cost — Imported from cost accounting system — represents variable cost
(overtime)

Indirect Cost — Imported form cost accounting system — represent cost not specifically
assigned to dept.

Actual Profit — Total Covered Charges minus Actual Payments

Expected Profit — Total Charges minus Expected Payment

Tracking — Claim’s current tracking status and user information

Claim Details

Summary  Codes

Claim Information

Patient Account # ‘
Claim Nuﬂber"
Import Batch 4‘

Last Recalc: ‘
Ins. Plan Code.‘

DRG:|
Claim Totals
Expected Payment: ‘

Expected Cnmramual"

Total Cost: ‘
Fixed Cusi.‘
Variable Cost: ‘
Indirect Cnst"

Claim Tracking

Claim Status:

Last Activity Dale.‘

Claims > Patient Acct. #: C921672524

Summary for: C921672524 -

View Voucher Go to Contract Grouper Edits View 835s
Demographics  Insurance  Line ltems  Physicians  Postings  Tracking Recalculate
921672524 | calculated contract | AETNA-Version 2 | Admit Date: [ 12/6/2013 |
1922600043 ‘ Type of Bill ‘ 131 - Hospital-OutPatient-Admit Throt ‘ Discharge Date| 12/6/2013 |
2395-8371 ‘ Patient Status: ‘ 01 - Discharged To Home Or Self-Care ‘ Submission Date: | 12/19/2013 |
10/21/2021 5:15:47 PM ‘ Total Covered Chgs ‘ $9,614.51 ‘ Length of Stay | 0 |
cio12 ‘ Non-Covered Chgs. ‘ $0.00 ‘ Covered Days:| 0 |
$8.653.06 | Actual Payments; | $832043 | Payment variance | 5323.63 |
$061.45 ‘ Actual Contractual ‘ $1,285.08 ‘ Contractual Vaﬂaﬂcel ($323.63) |
$2,325.03 ‘ Actual Profit: ‘ $6,004.40 ‘ Medicare Deductible: | Not Imported |
$567.82 | Expected Profit | $6,328.03 |
$850.46 |
$906.74 |
Open ‘ Opened By ‘ Carolanne Browne ‘ Assignment | Review Contract |
8/7/2020 11:28:30 AM ‘ Closed By ‘ ‘ Assigned To: | Carolanne Browne |
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» Codes tab

The Codes tab contains all code-related information imported from the claim form. This information

includes:

¢ |CD9 Codes — Diagnosis and Procedure Codes

¢ Condition Codes

¢ Occurrence Codes
e Occurrence Span

¢ Value Codes

¢ User Defined Codes

You can navigate through the various code types by clicking the name of that code type. Code type
selection options are shown outlined in red in the following example.

Claims > Patient Acct. # 921672524
Claim Details

Summary Codes Demographics Insurance

Codes For: C921672524 -

View Voucher

Line ltems  Physicians Postings  Tracking

Go to Contract View 835s

Recalculate

Grouper Edits

Select Code Type: I © icp1o (O condition Codes

(O occurrence Codes (O occurrence Span

(O value Codes

() user Defined Codes I

Diagnosis Codes

Fx Metacarpal Shaft-Clos

Type Code POA Description
Diag. 1 81503
E-Code 1 E9174
Pat. Reason 1 815.03

Procedure Codes
Type Code

No records available.

Stat Ob W/0 Sub Fall Nec

Fx Metacarpal Shaft-Clos

Date Description

» Demographics tab

Use the Demographics tab to view demographic information imported from the claim.

Claims > Patient Acct. #: C921672524
Claim Details

Summary Codes Demographics Insurance

Demographics for: 921672524 --

Patient Information

Line ltems

Physicians ~ Postings  Tracking

Admission Information

Medical Record #[ M15490

Admit Date:] 12/6/2013

Patient Address: ‘ [ Atlanta GA 30344

From Date:| 12/6/2013

Birth Date: | 12/18/1991

Admit Source: ‘ 1- Physician Referral

sex|

Patient Weight ‘

Discharge Information

Patient Height ‘

‘ Admit Type ‘ 3- Elective

Provider Information

Discharge Date: | 12/6/2013 |

Discharge Status: | 01 - Discharged To Home Or Self-Care (Routine) |

Pay-to-Provider Information

Provider Details 1 ‘ Kreg Medical Centerl

Pay-to-Name ‘ ‘

Provider Details 2: ‘ 3525 Piedmont Road, NE

Pay-to-Address 1 ‘ 8 Piedmont Center Suite 412 ‘

Provider Details 3 ‘ 8 Piedmont Center Suite 412

Pay-to-Address 2" Atlanta, GA 30305 ‘

Provider Details 4. ‘ Atlanta, GA 30305

Federal Tax #:| 99-00003

NP1 | 8700008

View Voucher Go to Contract Grouper Edits View 835s

Recalculate

Responsible Party Information

Responsible Party 1 ‘ LastName, FirstName (HIPAA)

Responsible Party 2. ‘ Address1 (HIPAA)

Responsible Party 3 ‘ Address2 (HIPAA)

Responsiole Party 4:| Address3 (HIPAR)

Claim Remarks.

Remarks 1 ‘ Remarks1 (HIPAA)

Remarks 2 ‘ Remarks2 (HIPAA)

Remarks 3 Remarks3 (HIPAA)

Remarks 4 Remarks4 (HIPAA)
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» Insurance tab

Use the Insurance tab to view information imported from the claim associated with Primary, Secondary,
and Tertiary payer information.

Claims = Patient Acct. #: C921672524

Claim Details View Voucher  Goto Contract  Grouper Edits  View 835s
Summary Codes Demographics Insurance Lineltems Physicians Postings  Tracking

Insurance Information For C921672524 --

Payer Name Health Plan ID Rel. Info Asg. Ben. Prior Payments Est. Amount Due Provider ID
AETNA KV ciolz2 Y Y 50.00 $0.00  PPNS
Insured's Name Patient Relationship Insured's Unique ID Group Name Insurance Group #
LastName, FirstName (HIPAA) SMID67567 SGNum10709

Treatment Auth. Codes Document Control # Employment Status Employer Location Employer Name

City, State (HIPAR)

» Line Iltems tab

The Line Items tab is very important for claim review. Click the Line Items tab to view details for the line
items on the claim. This tab displays imported Revenue Code detail for the claim, and Medicare APC
information if the claim is a Medicare OP claim. All OP can be processed by the Grouper to get the APCs,
but only contracts set up to use the CMS Outpatient calculation will use that information to calculate
reimbursement. Otherwise, the APCs can be used for reporting to align non-Medicare with Medicare, if
desired.

Medicare Claims contain two non-Imported Fields with values assigned by the 3M APC GPS software
during import:

e APC - Ambulatory Payment Classification
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e Status Indicator (SI) — Identifies type of APC

Claims > Patient Acct. # C921743197
Claim Details

View Voucher Recalculate Go to Contract  Grouper Edits
Summary Codes Demographics Insurance Lineltems Physicians Postings Tracking

Line Items For: 921743197 --

Rev Code Line ltem Code APC si Units 4 Service Date Charge Amount  Nen-Covered Ch... Batch #
0370 N 60 10/30/2010 $765.00 $0.00 1517
0270 N 14 10/30/2010 §509.81 s0.00 1517
0250 Jor7o N 1 10/30/2010 $13.50 $0.00 1517
0250 Jo230 N 10/30/2010 $23.00 $0.00 1517
0258 N 1 10/30/2010 $50.00 50,00 1517
0324 7o 00260 X 1 10/30/2010 $170.00 $0.00 1517
0636 Ja430 N 10/30/2010 $20.10 $0.00 1517
0724 99465 00094 s 1 10/30/2010 §318.00 50,00 1517
1 1-8of 8 items

* Hover aver codes for descriptions

To see the description of a code listed in the Line Items tab, move your cursor over that tab, as shown in
the following example:

Summary Codes Demographics Insurance Line ltems Physicians  Postings  Tracking

Line ltems For: C921796617 --

Rev Code Line Item Code APC sl Units Service Date Charge Amount  Non-Covered ... Batch #
DREE 90656 L 1 1/29/2014 §76.12 50.00 2494
ca Drugs Requiring Id - Detail Codes | 00436 s 1 1/29/2014 $42.00 $0.00 2494

1 1-2of 2items

* Hover over codes for descriptions

» Physicians tab

The Physician tab displays physician information imported from the claim.

Claims = Patient Acct. # C921672524

Claim Details View Voucher ~ Goto Contract  Grouper Edits ~ View 835s
Summary Codes Demographics Insurance Line ltems  Physicians  Postings  Tracking

Physicians For: C921672524 --

Physician Type Physician Name: Primary ID Type Primary ID Secondary ID Type Secondary ID
Attending LastName, Firstname24 P998779 P1942069
NO DESCRIPTION LastName, Firstname2521 P399971 P1942068
Surgica LastName, Firstname24 P998779 P1942070
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» Postings tab

The Postings tab details each payment posted to a claim. The system default view is Payments; however,
you can change the view to show the different types of postings individually or together by clicking the
Contractuals or All radio buttons, respectively.

Claims > Patient Acct. #: C921672524

Claim Details View Voucher  Go to Contract Grouper Edits ~ View 835s
Summary Codes Demographics Insurance Lineltems Physicians Postings  Tracking

Postings For: C921672524 --

Select Payment Type: | © Payments (O contractuals O Al I
Posting Date Payment Date Payer Code Post Code Payment Type Is Prof? Amount Batch Number
12/21/2013 12/21/2013 clo1z 1180 Payment - P1 $8,329.43 6435

» Tracking tab

The Tracking tab allows you to mark an individual claim for follow-up. This includes identifying:

e The claim’s status

e A generalized assignment category
e The person the claim is assigned to
e Ten user-defined fields

e Any additional notes

It also allows you to view the claim’s Tracking History to see how it has been managed and follow it
through the recovery process. A summary of this information is provided on the Summary tab for quick
reference when you open an account.
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Claims > Patient Acct. #: C921672524

Claim Details View Voucher Go to Contract Grouper Edits ~ View 835s
Summary Codes Demographics Insurance Lineltems Physicians Postings  Tracking

Tracking For: C921672524 --

Claim Status ‘ Open v | Denial Category| None v ‘ DenieclAmoum‘ 3.00 ‘
Asswgwmem‘ Review Contract v | Denial Reason Code | None v ‘ Patient Respowbwllty‘ 0 ‘
Assigned To ‘ Carolanne v | Service Location | None v ‘ UP -1dentified ‘ 323.64 ‘
Pnority| None v ‘ UP—Recovered‘ 0.00 ‘

Closed Reason Code | None v ‘ UP - Unrecoverable | 100.00 ‘

Notes | et contract - QX indicates CRNA v. anesthesiologist - service reduced 50%

Tracking History

Date Status Assignment Assigned To Notes Modified By
8/7/2020 Open Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi CMA ZUser
10/16/2017 Open Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi Debra Eldon
6/11/2014 Open Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi Carolanne Browne
6/11/2014 Open Reimbursement Rate Carolanne Browne review anesthesia at 45% v. contracted 90% Carolanne Browne

View Grouper Edits for a claim

When claims are grouped and priced, they may create edits that affect reimbursement. You can view
these edits on a claim and switch to any relevant simulation these claims apply to from the Grouper
Edits dialog. A Simulation menu at the top of the dialog allows you to select different simulations to see
any grouper edits that simulation produces for the given contract (the contract needs to be modeled in
the simulations you select).

To view grouper edits on a claim:

1.
2.

From the Claims menu, select View a Claim.
Filter for and select the desired claim.
On the Claim Details page, in the menu above the tabs, click Grouper Edits.

At the top left of the Grouper Edits dialog, from the Simulation drop-down, select the desired
simulation.

The report lists any grouper edits that resulted from grouping and pricing the claim in the
selected simulation.
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Grouper Edits

Simulation: | Live

() APC Claim Edits
Edit T
0002
0002

0002

© APCICD9 Code Edits

Edit Description

CMS: OCE ICDEdit - Diagnosis and age conflict. (RTP)

CMS: OCE ICDEGi - Diagnosis and age conflict. (RTP)

CMS: OCE ICDEGit - Diagnosis and age conflict. (RTP)

(O APC Line ltem Edits

Claim Number: 182833

(O eAPG Claim Edits

(O eAPG ICDY Code Edits

(O eAPG Line ltem Edits

T Procedure Code T Procedure Type T
76503 D2
D3

V3000 D1

Tracking claims

Use Claim Tracking to organize institutional claims that need attention and then easily locate them at
another time. Claim Tracking also allows you to report on claims that are being tracked.

Assign a claim to track

Assigning a claim to be tracked is the first step in tracking claims.

To assign a claim:

1. Inthe main menu header, click Claims > View a Claim.

2. Inthe View By section on the left, select the criteria for the claim to include in your tracking list
and then click View Claims. For details, see View a claim by selected criteria.

o v &~ W
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On the Claim Details page, click the Tracking tab.

Select the claim tracking details as needed.

In the Acct # column, click the number of the claim to track.

Click Save Changes. The claim tracking details display in the Tracking History section.
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Claims > Patient Acct. #: C921672524

Claim Details View Voucher Go to Contract Grouper Edits View 835s
Summary Codes Demographics Insurance Lineltems Physicians Postings = Tracking

Tracking For: C921672524 --

Claim Status | Open v Denial Category | None v Denied Amount | 3.00
Assignment | Review Contract v Denial Reason Code | None v Patient Responsibility | 0.00
Assigned To | Carolanne v Service Location | None v UP - Identified | 323.64
Priority | None v UP - Recovered | 0.00
Closed Reason Code | None v UP - Unrecoverable | 100.00
Notes | egit contract - QX indicates CRNA v. a nesthesiologist - service reduced 50%

Tracking History

Date Status Assignment Assigned To Notes Modified By
8/7/2020 QOpen Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi CMA ZUser
10/16/2017 QOpen Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi Debra Eldon
6/11/2014 Open Review Contract Carolanne Browne edit contract - QX indicates CRNA v. anesthesiologist - servi Carolanne Browne
6/11/2014 QOpen Reimbursement Rate Carolanne Browne review anesthesia at 45% v. contracted 90% Carolanne Browne

Claim details example

NOTE: Admin and analyst users can build new Claim Status options, Assignment options, and User
Defined options into the system from Claim Tracking, as described in Edit user-defined claim tracking
quick filters.

As you follow the claim through the recovery process, you can make additional notes to any of the
critical information on the page. The most recently saved information displays at the top of the Tracking
History section.

Search tracked claims

You can search for tracked claims using the Quick Filters option or an existing filter containing saved
criteria. Both methods allow you to create a set of search parameters to locate groups of claims that
share the parameters.

Admin and Analyst users can create and modify claim lists, and create, delete, and edit user-defined
categories. Regular users can view and export claim lists and use existing filters.

To search for assigned claims using Quick Filters:
1. In the main menu header, click Claims > Track/Assign Claims.

2. Do one of the following:
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» Search using Quick Filters

a. On the Claim Tracking page, leave the default filter setting at Quick Filters.

Claim Tracking

Quick Filters  Existing Filters  Modify Claims

Select quick filters to create a view of claims:

Assignment: | Any v Denial Category: | Any v
Assigned To: | Browne, Carolanne v Denial Reason Code: | Any v
Status: | Open v Service Location: | Any v

Opened By: | An

Closed By: | An

y v Priority: | Any v

y v Closed Reason Code: | Any v

Fields with names in blue text are editable fields

b. In Quick Filters, select the following claim details as needed. You must have at least one
filter set to something other than “Any” for the search to work.

Administrator's Guide

Assignment — Select the general reason for assignment or select Any to return all
claims that match any assignment. Field entries are user-defined.

Assigned To — Select the user assigned to this claim or select Any to return claims
that match any user. The list of users to choose from is a list of all system users
generated by Syntellis and cannot be changed.

Status — Select Open, Closed, Any, or other status. Field entries can be user defined.
Opened By — Select the user or select Any. This list is not user defined.

Closed By — Select the name of the user or select Any. Only users who set a claim
tracking status to “closed” on a claim appear in this list. This list is not user defined.

NOTE: The following categories are defaults delivered with Axiom Contract
Management. Your options may vary if your organization has set up different
ones through Syntellis Support.

Denial Category — Select a category or select Any to return claims that match any of
the categories. Field entries can be user defined.

Denial Reason Code — Select a code or select Any to return claims that match any of
the denial reason codes. Field entries can be user defined.

Service Location — Select a location or select Any to return claims that match any of
the locations. Field entries can be user defined.

Priority — Select the priority or select Any to return claims that match any priority.
Closed Reason Code — Select a code or select Any to return claims that match any of
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the codes. Field entries can be user defined.

NOTE: Admin and analyst users can edit user-defined fields as described in Edit
user-defined claim tracking quick filters.

c. (Optional) To clear the search parameters and start a new search, click Clear.

» Search using Existing Filters

The Existing Filters list contains both filters built in Claim Tracking and advanced filters built in
Reports.

4 N\
IMPORTANT: Use caution when using Advanced Filters from Reports to select accounts in

Claim Tracking. Basic report parameters require you to specify a contract to run your report
on as well as a discharge date range. The advanced filter does not necessarily specify a payer
or date range; therefore, your returned results may be for all payers for the entire database.
Modify by filters carefully and be sure to view your results before applying changes.

a. On the Claims Tracking page, click Existing Filters.

b. From the Select an existing filter to create a view of claims drop-down, select a filter.
Alternatively, if you are an administrator or analyst, you can use the Build Filter button to
create a filter from scratch, as explained in Build an advanced filter for claims tracking.

Claim Tracking

Quick Filters  Existing Filters  Modify Claims

Select an existing filter to create a view of claims:

Select a Filter... v Build Filter

3. Click View Claims. A list of claims matching the search criteria displays below the filter options.

To collapse the upper part of the page, click the Collapse caret icon (<) on the right above the
search results.
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Claim Tracking

Quick Filters  Existing Filters ~ Modify Claims

Select quick filters to create & view of claims

Assignment: | Any v Denial Category: | Any -
Assigned To Denial Reason Code: | Any v
Closed By: [ Any - Closed Reason Code: | Any - Click to hide J
settings section
Export List Clear —
Account # Patient Name poB Admit Date Dschg. Date PlanCode  Insurance ID # Contract Version Provision Clause Total Chi
C921419717 4/10/ 3/8/2014 3/8/2014 BCOO1 SMID125191 ORG1-BCBS 7 13X[14% RADIATION THERAPY -
©921430465 16/ 3/24/2013 3/25/2013 cio12 SMID38120 AETNA 2 1314 IMPLANTS
©921439388 6/27/ 2/15/2014 2/15/2014 BCO01 SMID98721 ORG1-BCBS 7 13X14% IMAGING SERVICES
921445836 422/ 3/3/2014 3132014 Bc001 SMID125191 ORG1-BCBS 7 18X114% IMAGING SERVICES
921456426 310/ 2462014 2162014 Bc001 SMIDET1S ORG1-BCBS 7 13X114% g
921459939 4721/ 21572014 2152014 Beaot SMID125181 ORG1-BCBS 7 18X114% IMAGING SERVICES
921465188 930/ 8/28/2013 8/28/2013 BCOOT SMID106446 UNASSIGNED O UNASSIGNED NO CLAUSE ASSIGNED
921476215 225/ ¥31/2013 41872013 iz SMID48234 AETNA 2 19X14% SURGICAL
921479802 2013 ci012. SMID5633 AETNA 2 13X[14% SURGICAL
921484033 ci012. AETNA 2 13X[14% SURGICAL
921487209 BCOO1 UNASSIGNED [} UNASSIGNED NO CLAUSE ASSIGNED -

»

Number of claims found * - -
Che e — . N |
. Page navigation displays here
* Click Account # for Claim Details

4. To export the list of claims, click Export List. The list is exported to an Excel file that you can
rename and save to a desired location.

5. Toview a claim in the list, in the Account # column, click the linked account number.

6. (Optional) Make tracking changes for all claims in the list at once.

Build an advanced filter for claim tracking

Use these instructions to build an advanced filter for searching tracked claims. The steps are similar to
those for building an advanced filter in reports.

To build a new advanced filter:

1. On the Claim Tracking page, click Existing Filters.

2. To the right of the Select a Filter drop-down, click Build Filter.

Claim Tracking

Quick Filters  Existing Filters ~ Modify Claims

Select an existing filter to create a view of claims:

Select a Filter... v Build Filter

3. Inthe Filter By drop-down, select one of the following:
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e Claims — Select to filter by whole claims.

e Line Items — Select to filter by specific line items on claims.

The following example shows Claims selected in the Filter By option.

Advanced Filters

Field Selection  Applied Conditions

Filter By: Filter Name:
ICIaims v I Enter a filter name
Fields: Conditions:

» Demographic

TIP: Advanced filters allow you to select claims using a large number of criteria, so it is
best to know exactly what you want. Identify the criteria to use for this filter before
assigning them.

4. Inthe Filter Name field, type a descriptive, unique name for the filter. Spaces, hyphens, and
numbers are allowed.

5. From the Save To drop-down, select a destination or accept the default.
6. Inthe Fields section, expand the field categories as needed to see their criteria.

7. In an expanded field category, click the desired filter criteria. Depending on your selection, you
are presented with either a library list of options, or parameter conditions. In the Conditions
section, do whichever is applicable:

» Select from a library list
e If the list is long, you can filter it to display relevant items:
a. Inthe first drop-down, select how you want to filter the list: Starts With, Contains,
Ends With or Range.

b. Inthe related fields, enter the filter condition or, if filtering by range, enter the
beginning and ending data for the range.

c. Tofilter the list, click the filter icon button ( ¥ |). To remove the filter and start over,

click the filter reset button ( ¥ ).

¢ To select one or more options in the list, click the check box to the left of the item.

e To select all items in the library list, click the check box in the gray table header:
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Conditions:
By Value = By Range
sWith
BillCode
[] 110

e To select all items except a few, select only the items to exclude, and then click the Not
Included check box. When the Not Included check box is selected, all the items that you
did not select will be included in the filter. To clear items selected for exclusion, on the
right, click Remove, and then select the items you want to exclude.

Conditions:

By Value = By Range

Starts With
[] Bilicode Clear/Undo
110
1
] mnz2
[ mna3

e To select a range of items from the library list:

a.
b.

Click the By Range tab.

From the drop-down, select the desired comparison operator (>=, >, =, <=, <, <>)
and then type the beginning range value in the field.

Click + Add a Condition.
From the middle drop-down, either leave the default at AND or select OR.

In the second drop-down, select the comparison operator, and then type the end
range value in the field. If needed, add another condition.

e To clear selected items, on the right, click Clear/Undo.

» Select parameter conditions

You can create a range, or you can use a single operator to include all data values equal to, not

equal to, or above/below a specific value.

e To set a range, in the comparison operator drop-down, select a comparison operator (>=,
>, =, <=, <, <>) for the beginning of the range, and then select or type the beginning value
in the field. Next, click Add a Condition. Select a logical operator (AND, OR), and then, for
the end of the range, select a comparison operator and then enter or select the ending

value.
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e To set a specific value, select the equal comparison operator, and then select or enter the
value.

e To set an open-ended range, select a comparison operator that includes a greater-than or
less-than symbol, and then enter the beginning value.

8. Each time you select filter criteria from a field category, click the Apply to Filter button on the

right.

NOTE: At any time before saving the filter, you can view what you have applied so far, and
remove any items if necessary.

9. If needed, add additional filter criteria, remembering to click Apply to Filter after each selection.
10. To check or remove items from your filter as you build it:
a. Atthe top of the dialog, click the Applied Conditions tab and review your selections.
b. To delete a selection, do one of the following:

e if the item’s status is Pending save, then at the end of the row, click the Cancel icon

(©).
o If the item’s status is Saved, then at the end of the row, click the Delete icon (i)
and then click Save.

11. When finished adding criteria, click Save and Close.

Mass assign or modify tracked claims

You can assign multiple claims to be tracked, or modify multiple claims at once, by performing a mass
modification from the Claim Tracking page.

To assign claims from Claim Tracking:
1. In the main menu header, click Claims > Track/Assign Claims. The Claim Tracking page opens.

2. Build a list of claims to modify.

3. Click Modify Claims.

TIP: You can sort the list of claims by any one of the columns in the table at a time. Simply
click the heading to sort the column alphabetically or numerically, depending on the type of
data.

4. Inthe modification fields above the list of claims, change the tracking data as needed.
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IMPORTANT: Remember that the changes you make will apply to all claims listed, so be sure
that you want all claims in the list changed.

5. Click Modify Claims.

Edit user-defined claim tracking quick filters

Some of the claim tracking fields contain sets of selections that you can edit if you are an Admin or
Analyst user. These fields are referred to as “user-defined” fields.

To edit user-defined claims criteria:
1. Inthe main menu header, click Claims > Track/Assign Claims.

2. On the Claim Tracking page, select Quick Filters if it is not already selected. (You can also access
the user-defined fields from the Modify Claims tab.)

3. In the filter settings, the names of the fields that can be edited display in blue text. To edit a
field’s options, click the blue field name.

Claim Tracking

Quick Filters  Existing Filters ~ Modify Claims

Select quick filters to create a view of claims:

Any v Denial Category: | | Any v
Assigned To: | Browne, Carolanne v Denial Reason Code: || Any v
Open v Service Location: || Any v
Opened By: | Any v Priority: || Any v
Closed By: | Any v Closed Reason Code: | | Any v

4. In the Edit Filters: [Field name] dialog, do any of the following:

e To add a new option, click +Add a New Filter. A new line is added to the list table. Type the
new option in the row.

e To edit an option, click in the row and make the change.

e To delete an option, hover your cursor over the end of the row and click the Delete icon (
B). A red line displays across the option. The option is deleted when you save your work.

NOTE: If the option is currently in use by any claim, a message displays alerting you
that the option is in use, and what will happen if you proceed with the deletion.
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TIP: You can cancel the deletion before saving by clicking the row’s Cancel icon (&).

The following example shows user-defined options for the Denial Category field.

Edit Filters: Denial Category
+ Add a New Filter
Denial Category Y Is Assigned
125 Claim Denial Undefined @
16 Lacks Billing Information @
22 Coordination of Benefits @
24 Covered Under a Capitation Agreement @
A test category
A1 Claim or Service Denied @
B5 Coverage Guidelines Not Met @
B9 Patient is Enrolled in Hospice @
XX Bundling @

5. Do one of the following:
¢ To save changes and keep working in the dialog, click Save.

e To close the dialog after saving, click Save and Close.

¢ To cancel your unsaved changes and close the dialog, click Close.

Review change tracking report

» Why use this feature

Use the Change Tracking report to help determine why a contract is not calculating, if a payer code is
missing, which contract is using a payor code that you want to assign elsewhere, and so on.

» How this feature works

What: The Change Tracking report enables administrators to query the log files for changes based on
attributes or payor codes assigned to a contract, and then see the details related to the change: the
simulation, contract name, version number, related provision, clause, or term if any, and the payer code
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and the organizational code if they exist.

Where: This change applies to the Admin menu in the main menu header.

Who: Only Axiom Contract Management administrators can access this menu to query the log files.
How:

1. From the Admin menu, select Change Tracking.

2. On the Change Tracking page, select the query date range, whether to query attribute or payor
code data, by user, or by value.

3. Click Search.

4. Inthe search results, find the desired item and click in the row. Details about the event display in
the lower left of the page.

Change Tracking

Start Date:| 1/1/2022 Ed| Type:| PayerCode - User: | Select user - 0Old value

New Value
D T  ChangetDate t T  OldValue T  NewValue T  FirstName T  LastName T
13 32:00 AM cloi201 Admin Admin
19 cl072-01 Admin Admin
20 Clo12-02 Admin Admin
2 Cl07202 Admin Admin
= cio1z01 Admin Admin
23 cio7201 Admin Admin
24 CI012-02 Admin Admin
25 CI072-02 Admin Admin
26 \ clo12-01 Admin Admin
7 Selected item i o e e
28 Cl01202 Admin Admin
29 clo7202 Admin Admin
30 clo1201 Admin Admin
a cloi202 Admin Admin
3 Cl07202 Admin Admin

M 4 1 2 3 4 5 » M 6-30of 70 frems
Search results
Simulation: a CEB Test 2022

Contract: A Chg Adj for WD testing

Version: 1 Details for the item
Provision: selected in the search
Clause/Term

results display here

Payer Code: C1012

Org Code: 02

Model adjustments to claim charges

Use the Charge Adjustments feature to preview adjustments to claims charges in simulations to
understand the impact they will have on your net reimbursement and future contract performance.
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NOTE: This feature is available to administrative users only.

NOTE: This feature cannot be used in the Live environment.

To simulate claim charge adjustments:

1. If one does not already exist, create a simulation and add only the contracts for which you want
to preview charge adjustments.

2. From the Claims menu, select Charge Adjustments.

3. From the Simulation drop-down, select the simulation that has the contracts for which you are
running claim adjustments.

4. Inthe Adjust By section, select the type of adjustment. Refer to the following set of instructions
for the type of adjustment you selected.

» Overall Percentage

Adjusts the charges on all of the claims in the simulation by the percentage you specify.

a. Inthe Adjustment field, enter a percentage written as a decimal value. For example, for a
decrease, enter a decimal value less than 1: 0.95, 0.55, .07, etc. For an increase, enter a
decimal value greater than 1: 1.05, 1.25, 1.75, etc.

b. Click Save.

» Facility Code

Adjust the charges on all claims with the selected facility code. Facility codes enable you to select
inpatient and outpatient procedures.

a. Click + Add new record.
b. From the Type of Bill drop-down, select the type of bill.

c. Inthe Adjustment field, enter the adjustment as a decimal value. For example, for a
decrease, enter a decimal value less than 1: 0.95, 0.55, .07, etc. For an increase, enter a
decimal value greater than 1: 1.05, 1.25, 1.75, etc.

d. Click Save.

» Revenue Code or Line Item Code

Adjust the charge manually by entering code information or by uploading a file of revenue codes.
e To enter adjustments manually:

a. Click + Add new record.
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b. Inthe Code column, type the code, then press the Tab key.
c. Inthe Description column, type a description and then press Tab.

d. Inthe Adjustment column, enter the adjustment as a decimal value. For example,
for a decrease, enter a decimal value less than 1: 0.95, 0.55, .07, etc. For an
increase, enter a decimal value greater than 1: 1.05, 1.25, 1.75, etc.

e. Click Save Changes.
e To upload a file of code adjustments:
a. Under Import Data, click Select files.

b. Navigate to and select the file containing the codes and adjustments.

4 )
IMPORTANT: The file should be an Excel file and must have three columns in the
following order: codes in the first column, descriptions the second but can be

left blank, and adjustments in the third column. If the Description column is left
blank, the system will populate it from the appropriate library. If there are no

codes in the library, the field displays “No Description.”
|\ J

The file contents display on the page. You do not need to save the file as it has
already saved upon upload. If needed, you can edit the contents on this page.

5. To view how the adjustments affect your reimbursements, recalculate the claims and then view
the Voucher details; or from the Reports menu, run any of the standard reports for the adjusted
claims.

Edit or delete a charge adjustment

Use these instructions to make changes to an existing charge adjustment. To change to a different
charge adjustment type, you will need to either create a new simulation for the charges, or delete the
current adjustments in the simulation with the existing adjustments.

To edit an existing charge adjustment:
1. From the Claims menu, select Charge Adjustments.

2. On the Charge Adjustments page, from the Simulation drop-down, select the simulation with the
charge adjustment to modify.

3. To edit an Overall Percentage rate, in the Adjustment field, change the decimal amount and then
click Save.

4. To edit a Facility Code, Line Item Code, or Revenue Code:

¢ To change the adjustment amount, click in the Adjustment field for the code and make
changes, then click Save Changes.

e To delete an entry from a list of multiple codes:

Administrator's Guide Axiom Contract Management | 172



a. hover your cursor in the blank column after the Adjustment column and click the
trash can icon:

+ Add New Record

Line ltem Code Y  Description T Adjustment

72133 Ct lumbar spine w/o & w/dye 1.20000
s el

b. Click Save Changes.

To edit a description, type changes into the Description field for the desired item, then
click Save Changes.

e To add a new line of code, click +Add New Record and then in the new row, enter values,
and then click Save Changes.

¢ To cancel changes before saving, click Cancel Changes.

To delete a charge adjustment:

NOTE: Deleting removes adjustments from all claims in the selected simulation.

1. Onthe Charge Adjustments page, select the No Adjustment option.

A| Launch Page Contracts Claims Import Data Reports Admin Help
Charge Adjustments

Simulation

| DocuSim Y |

Adjust By

© NoAdjustment () Overall Percentage () Facility Code (O Revenue Code (O Line ltem Code
Current Adjustment Type: | Line Item Code

Delete existing adjustments: Delete

The adjustment about to be cleared is listed before clearing. After clearing, Clear Adjustments reads “None.”

2. Click Delete.

3. Inthe confirmation dialog, click Delete.
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Grouping and pricing APC and eAPG claims

Many contracts include clauses or terms that include APC or eAPG reimbursement methods. Before
these contracts can be calculated, the claim line items need to be grouped and priced into APCs or
eAPGs. Group and Price allows Admin users to queue up a single claim or a group of claims as needed.

NOTE: Grouping and pricing is available only for institutional outpatient claims.

Grouping and pricing is usually done during the nightly import. However, you may need to group and
price claims on demand; for example, new simulation contracts and changes to existing contracts do not
generate a Group/Price task automatically, so you need to set these up manually.

The Group and Price Claims page in the Claims section of Axiom Contract Management enables you to
set up, save, and execute claim grouping and pricing tasks. For information, see Group and price APC
and eAPG claims.

Additionally, you can also use the Shift Date By feature to view a forecast of how new schedules will
affect claims for the coming year.

Group and price APC and eAPG claims

For contracts with clauses or terms that include APC or eAPG reimbursements, you can group and price
claim line items into APCs or eAPGs. You can also run a projection of what future claims will look like by
shifting dates on claims forward in time to understand the impact of new CMS grouping and pricing
logic. For information, see Shift claim dates for grouping and pricing forecasts.

NOTE: Your system must have licenses for APCs and/or eAPGs. Currently, grouping and pricing is
available only for institutional outpatient claims.

To group and price claims:
1. From the Claims menu, select Group and Price.

2. From the Grouping/Pricing Type menu, select the desired option:
e APC
e eAPG

NOTE: Only options for which you are licensed display.

3. In Select claims by, select the desired option:

» Patient Account Number

a. Inthe Patient Account # field, enter the patient account number.
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NOTE: You may enter multiple account numbers separated by commas.

b. From the Claim Status drop-down, select the status of claims to include.

c. From the Simulation drop-down, select the simulation the claims are in.

» Claim Number/UCRN
a. Inthe Claim #/UCRN field, enter the claim number or UCRN.

NOTE: You may enter multiple account numbers separated by commas.

b. In the Claim Status field, select the status of claims to include.

c. From the Simulation menu, select the target simulation for the claims.

» Date Range
a. Select the Date Type.

b. For Start Date, click the calendar icon (ﬁ) and select the date range start date.

c. For End Date, select the date range end date.
d. From the Claim Status drop-down, select the status of claims to include.

e. From the Simulation drop-down, select the target simulation for the claims.

» Contract
a. Select the Date Type.

b. (Optional) Select a data range: For Start Date, click the calendar icon ([5]) and select the

date range start date. For End Date, select the date range end date.

NOTE: You do not have to select Start and End dates if you want to work with the
entire time frame selected by the provision/version.

c. From the Claim Status drop-down, select the status of claims to include.
d. Inthe Contracts section, from the Current View drop-down, select the target simulation.

e. Inthe Contracts section, select the contracts to include. You can select an entire contract,
certain versions of a contract, or specific provisions of a contract.

NOTE: Versions must have associated payor codes to display in the list.

Administrator's Guide Axiom Contract Management | 175



» Insurance Plan Code
a. Select the Date Type.

b. (Optional) Select a data range: For Start Date, click the calendar icon (f5]) and select the

date range start date. For End Date, select the date range end date.
c. From the Claim Status drop-down, select the status of claims to include.
d. Inthe Ins Plan Code table, from the Current View drop-down, select the target simulation.

e. Inthe Ins. Plan Code table, select the insurance plan codes to include. You can also select
an entire payer organization if desired.

4. Do one of the following:

e To perform the grouping and pricing now, click the Group and Price button.

e To process the grouping and pricing later, save the selected claims as a grouping and
pricing task:

a. Inthe upper right of the page, type a name in the field provided.

Create a Saved Task Enter a name for the task

b. Click Create a Saved Task

A confirmation message displays that the grouping/pricing task has been queued to run or saved,
depending on your selection.

NOTE: If you selected to save the claims as a group and price task, your task is listed in the
Saved Tasks tab, where you can run it at any time.

Shift claim dates for grouping and pricing forecasts

Users who group and price claims for APG and eAPG contracts can shift dates on claims forward in time
to accurately understand the impact of new CMS grouping and pricing logic for the upcoming year.

[ IMPORTANT: The shift claim dates feature works only in non-Live simulations. J

When the new CMS grouping methods and schedules are released, you can get a forecast of how they
will affect your APC and eAPG claims reimbursements by running some of your historical claims through
the grouping and pricing process using the new rules. Normally, grouping logic prevents you from using
future logic against historical claims because they are service-date specific. However, if you shift your
historical claim dates into the next year, you can align your service dates with the 3M logic.
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NOTE: You can also shift the dates backward in time by using a negative number of units. You might
do this if you want to know what this year’s claims reimbursements would have paid last year.

The Group and Price Claims page includes a Shift Date By section that remains inactive until you select a
non-Live simulation in which to group and price your claims. You can use the date shift feature for any
claims selection method (Patient Account Number, Claim Number/UCRN, Date Range, etc.) as long as
you select a non-live simulation.

"] Launch Page Contracts Import Data Reporis Queued Tasks: 0

Group and Price Claims = Saved Tasks

Group and Price Claims

Grouping/Pricing Type: | APC v | Creale a Saved Ta

Select claims by: © Patient Account Number (O Claim Number/UCRN (O DateRange O Contract O Insurance Plan Code

Patient Account #: |Shiﬂ Date By: | 0 | ‘ Days v ‘lﬂ
Claim Status: ‘ Live Claims Only v ‘
Simulation: DocuSim v

To date shift a set of claims for grouping and pricing:

1. In the main menu header, click Claims > Group and Price.

2. On the Group and Price Claims page, from the Grouping/Pricing Type drop-down, select the
type.

3. Inthe Select claims by section, select an option. For details, see Group and price APC and eAPG
claims.

4. From the Simulation drop-down, select the desired simulation.

[ IMPORTANT: The simulation must not be Live. J

5. Inthe first Shift Date By field, enter the number of units to shift the date by.

6. In the second Shift Date By field, click the drop-down and select the unit to shift the date by
(Days, Months, Years).

7. Click Group and Price.
8. After grouping and pricing, view the claim voucher report to see the results.

In the following example, the top of the voucher report shows that the service took place in 2013,
but on the bottom, you see that for calculating the expected payment, it used a future Grouper
Schedule, and therefore, a different Grouper Logic.
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Simulation: [EPay3 ™ Claim Voucher Report

BilllD: C921374551|Admission Date: 8/8/2013 Total Charges $1,714.00
Claim Status Active Discharge Date: 8/6/2013 Non-Covered Charges: $0.00
Patient Name: Keefe Weldy |Provision Date: 7/1/2013 to 9/30/2013 Expected Contractual: ($613.64)
Insurance 1D SMID30128 Actual Contractual $171.40
P X tal Cutpatient Hi tal Oth
Bill Code: 131 rovision Pl Quipatient Rospilal OMEr oo ted payment $2.327.64
Insurance Plan Code: CI012 Contract Name: S Aetna at Medicare Shift Actual Payments $1,542.60
Covered Days 0] _— Contractual Variance: ($785.04)
Version # 1 Organization. KREQMEDICAL CTR ORG1 Balance Due: $785.04
TOTAL CLAUSE REIMBURSEMENT $2,327.64
Total Terms Reimbursement $2,327.64
Term #1: ANY/ALL SERVICES $2,327 .64
ANY/ALL SERVICES
Calculation
BIos CMS Outpatient
Payment Summary Information
Medicare Outpatient Schedule: KH MCR 20140701-20140930
Schedule Effective Dates: 7/1/2014 - 9/30/2014
Services Epay Amount Medicare Portion Patient Portion
APC $2914.16 $2,321.80 $592 36
Total Expected Payment $2914.16 $2,321.80 $592 36

Compare line-level APC calculation detail results

When running drill-down reports on claims and line items, you can include line-level calculation detail
results created from grouping and pricing APCs from any simulation configured for drill-down reporting.
You can do a side-by-side simulation comparison down to the line-level of detail to compare the impact
of APC schedule changes on a set of claims.

NOTE: Your Axiom Contract Management administrator sets up simulations for drill-down reporting.

Claims and Line-level APC results for up to four simulations at a time

In addition to the Live simulation, up to four simulations can be set up to handle reporting of APC detail
at the claim level. Previous to the 2019.3 release, we only stored grouped and priced APC results from
the Live simulation. Now, we have extended grouping and pricing to all other simulations. The fields that
are populated on the Claims and Line items tabs are available for the other four simulations selected for
drill-down reporting. This means there are four fields for each claim and line level field currently
populated during the group and price process (for example, fields such as PPSPayment, CoPay, Outlier,
etc.).

Line Item tab Groupings:

e APC2
* APC3
* APC4
e APC5

Line Item tab Measures:
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e Expected Payment2-5
OPPS EPayCMS 2 -5
OPPS EPay Copay 2 -5
OPPS EPay Outlier 2-5

Claims tab Measures:

e Total OPPSEPay2-5

e Total OPPS EPay CMS 2 -5

e Total OPPS EPay Copay 2 -5
e Total OPPS EPay Outlier 2-5

To use these new fields in a drill-down report:
1. Run an APC group and price against claims in a simulation mapped to drill-down reporting:
a. Ensure your simulation environment contains the APC contract(s) with the appropriate
Schedule(s).

b. Ensure your simulation environment is mapped to drill-down reporting. You may need to
verify this with the Axiom Contract Management administrator.

c. Group and price the desired set of APC claims for the desired simulation (or simulations, if
you are performing a comparison). For more information, see Group and price APC and
eAPG claims.

2. Create a drill-down report using the desired Claim tab or Line Item tab fields, then add filters to
the report as needed to limit the data included, and then generate the report.

For more information, see the following:

¢ Build a new drill-down report
e Add an advanced filter to a drill-down report

e Export a drill-down report

Run a saved group and price task

These instructions are for running a saved group and price task from the Claims Group and Price Tasks
page.

To run a saved group and price task:
1. From the Claims menu, select Group and Price.

2. Click the Saved Tasks tab.
3. If needed, filter the list for the Simulation and Task Type.

4. On the right side of the page, for the desired task, click Run Once.
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Group and Price Claims  Saved Tasks

Group and Price Tasks

Simulation: | All Simulations v Task Type: | Al b
Task Name Simulation Task Type Claim Status
APC Quarterly Check Live APC Live Claims Only Run Once Delete
DAP Test Live APC Live Claims Only Run Once Delete
eAPG Quarterly Test Live eAPG Live Claims Only Run Once Delete

The page displays a brief notification that the task was queued.

5. To delete a task when finished, in the row for that task, click Delete.
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Calculating claims

Claims calculation is the process by which a claim is filtered through the defined contract structure to
generate a claim payment voucher and a total expected payment amount. Claims are calculated in
Axiom Contract Management in two ways:

e Nightly import process — Occurs during the import process and is done without any user
intervention.

¢ On-demand calculation — Users can perform ad-hoc claim calculation from the following
locations:

© Recalculate Claims page

° Claim Detail page

° Contract Clauses or Terms page

© Recalc History page (Administrators only)

You can also calculate simulated adjustments to claim charges.

Typically, every claim that enters the system calculates automatically during the nightly auto-import
process; however, there are times when you need to manually recalculate a claim using the ad-hoc
methods.

You might need to recalculate a claim for several reasons. The most common reason is a contract term
modification. If a claim is calculated on a specific clause of a contract and that clause is adjusted in a way
that the claim now qualifies for another clause or rate, a recalculation is warranted.

» Automatic calculation

Every new claim entering the system that has a matching Contract - Version = Provision -
Clause/Term will automatically generate an expected payment during the auto-import process. This
ensures that new information entering the system can be used during reporting and other analysis. No
user intervention is needed, but it is important to note that if the contract structure is not kept up to
date, then new claims that enter the system will not generate an expected payment. It is also important
to note that even though a contract may exist for payer, if it is not modeled accurately, then the
expected payment information will probably be inaccurate.

Keep an eye on contracts approaching expiration and make sure to extend the expiration date (if
applicable), or model the new contract in Axiom Contract Management.

» Ad hoc calculation

You can select to recalculate a claim at any time using the Recalculate Claims feature (Claims >
Recalculate). You can recalculate claims by a variety of criteria:
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e Recalculate by Patient Account Number
e Recalculate by Claim Number/UCRN

¢ Recalculate by Date Range

e Recalculate by Contract

e Recalculate by Insurance Plan Code

NOTE: You can also recalculate a claim from the Claim Detail page.

Recalculate a claim
Each of the following criteria give you more flexibility in determining which claims to recalculate.

e Patient Account Number and Claim Number/UCRN are typically used to calculate single
accounts/claims.

e Date Range and Contract allow you to select several claims at once for calculation.

e Insurance Plan Code allows you to recalculate all claims that have a specific payer code.

You select the claim to calculate in the Claim Type field. Your options are Institutional, Professional, or
All. Since professional claims are stored in Axiom Contract Management as separate bills, you must
select the appropriate Claim Type before calculating a claim.

The Claim Status field allows you to select whether to calculate on the Live accounts for a particular
account # or all accounts (Live and Inactive).

NOTE: Reports in the system are based on the Live accounts, so it is not always required to
recalculate inactive claims unless you are including those in your analysis.

To access Recalculate Claims:

In the main menu header, click Claims > Recalculate.

The Recalculate Claims page is displayed. Use the criteria explained in the following sections when
determining what to calculate.
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Al Launch Page Contracts Claims Import Data Reports Queued Tasks: 0

Recalculate Claims =~ Saved Tasks

Recalculate Claims Create a Saved Tas

Select claims by: Q) Patient Account Number (O Claim Number/UCRN (O pateRange (O Contract (O Insurance Plan Code

Patient Account #: | C921672524

Claim Type: [ Institutional a
Claim Status: |Lwe Claims Only v ‘
Simulation: |Lwe - ‘

NOTE: You can also recalculate a claim directly from a claim’s Claim Detail page. For information, see
Recalculate a claim from Claim Detail.

» Recalculate by Patient Account Number

You can calculate multiple accounts simultaneously by separating account numbers with a comma. If
there are claims that match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by account number:
1. Inthe Recalculate Claims tab, click the Patient Account Number option.

2. In the Patient Account # field, enter the account number.
3. From the Claim Type drop-down, select the type.

¢ Institutional
e Professional
o All

4. From the Claim Status drop-down, select the status:
¢ Live Claims Only
o All

5. From the Simulation drop-down, select the simulation.

6. Click Recalculate.
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» Recalculate by Claim Number/UCRN

IMPORTANT: This option should only be used if you are using the system’s Claim Number / UCRN
feature.

If any claims match your criteria, a message displays that says the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected

criteria, and to try again.

To recalculate by Claim Number / UCRN:

1.
2.
3.

In the Recalculate Claims tab, click the Claim Number/UCRN option.
In the Claim #/UCRN field, type the number.

Select the Claim Type:
e |nstitutional
¢ Professional

Select the Claim Status.
Select the Simulation.

Click Recalculate.

» Recalculate by Date Range

The date range option allows you to select all claims that fall between a specific date range and
recalculate them.

To recalculate by date range:

1.
2.

In the Recalculate Claims tab, click the Date Range option.
In the Date Type field, select the type of date:

e Discharge Date — Date the account was discharged
e Admit Date — Date the account was admitted
e Submission Date — Date the bill was submitted to the payer for reimbursement

For the Start Date and End Date fields, select the desired dates.

You can enter dates manually or use the drop-down calendar. Clicking any date sets that as your
start/end date.
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Recalculate Claims = Saved Tasks

Recalculate Claims

Select claims by: () Patient Account Number () claim Number/UCRN O Date Range (O contract (O Insurance Plan Code

Date Type: | Discharge Date v Claim Type: | Institutional v
Start Date: month/day/year i Claim Status: | Live Claims Only v
End Date: September 2021 TODAY Simulation: | Live v
Ju
Jul 1 2 3 4
Aug 5 6 7 8 9 10 11
Sep

12 13 14 15 16 17 18

19 20 21 22 23 24 25

Dec 26 27 28 29 30

4. Select the Claim Type:
e |[nstitutional

¢ Professional
5. Select the Claim Status.
6. Select the Simulation.

7. Click Recalculate.

If there are claims that match your criteria, a message informs you that the recalculation task has been
gueued successfully. If no claims match your criteria, a message informs you that no claims met your
selected criteria, and to try again.

» Recalculate by Contract

Selecting the Contract option allows you to select whole contracts. Calculating by contract gives you
added flexibility by allowing you to filter down into contracts, versions, or even to the provision level.
For example, to calculate only an outpatient provision of a contract, you can drill down to that provision
and select it for recalculation.

In the following example, a user is recalculating provisions 6 and 7 of their Cigna PPO contract, as well as
their entire ORG2 - BCBS contract.
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Recalculate Claims =~ Saved Tasks

Recalculate Claims

Select claims by: (O Patient Account Number O Claim Number/UCRN (O DpateRange @ Contract (O Insurance Plan Code

Date Type: | Discharge Date v Claim Type: | Institutional v
Start Date: | month/day/year = Claim Status: | Live Claims Only v
End Date: | month/day/year i
Contract: Current View: | Live v

- D KREG MEDICAL CTR ORG1
+ AETNA

ANTHEM OHAS

CIGNA HMO

CIGNA PFO
Version 1(07/01/2009 - 12/31/2009)
Version 2 (01/01/2010 - 12/31/2010)
Version 3 (01/01/2011-12/31/2011)

Version 6 (01/01/2014- 12/31/2014)

O
O
O
[ version 5(01/01/2013-12/31/2013)

Version 7 (01/01/2015-

KHA MANAGED CARE

Joo0o+ + + s s+ 0000

KHA PPO

Notice that the Contract option also includes the same features as the Date Range selection dialog,
allowing you to narrow your criteria even further.

To recalculate by contract:
1. In the Recalculate Claims tab, click the Contract option.

2. Inthe Contracts table, from the Current View drop-down, select the desired simulation.
3. Select the desired contract/version/provision to recalculate. You can select more than one.

4. Inthe Date Range section, enter the date range criteria (if you want to calculate the entire
contract, then entering date information is not required).

5. Inthe Enter a name for the task field, type a name for this recalculation.

6. Click Recalculate.

If any claims match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

» Recalculate by Insurance Plan Code

This option allows you to calculate claims for a single insurance plan code instead of calculating all the
insurance plan codes assigned to a contract version. For example, you can use this option when a new
insurance plan code has been added to a version and you do not want to re-process an entire version
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and all plan codes, just the claims with the new code.

To recalculate by insurance plan code:

1.
2.

In the Recalculate Claims tab, click the Insurance Plan Code option.
In the Date Type field, select the type of date:
e Discharge Date — Date the account was discharged
e Admit Date — Date the account was admitted
e Submission Date — Date the bill was submitted to the payer for reimbursement

For the Start Date and End Date fields, select the desired dates. You can enter dates manually or
use the drop-down calendar. Clicking any date sets that as your start/end date.

Select the Claim Type:

¢ Institutional

¢ Professional
In the Claim Status field, select whether to use Live claims or All.

In the In. Plan Codes table, do the following:
a. Inthe Current View field, select the desired simulation.
b. In the list of insurance plan codes, expand the organization and select the check box for
the desired code. You can select as many codes as desired. You can also select the parent

Org. code instead, which recalculates all claims that have that Org. code, including all the
Payer codes associated with that Org code.

Click Recalculate.

Save and schedule calculations

You can name and save calculation tasks and then schedule those tasks to run using the Axiom
Scheduler. This feature is great for repetitive calculations or when you need to schedule a large
calculation to run after hours or on a recurring, scheduled basis.

To save and schedule a calculation:

1.
2.
3.

In the main menu header, click Claims > Recalculate.
In the Recalculate Claims tab, select the claim to calculate.

In the Enter a name for the task field, type a name for the recalculation.

4. Click Create a Saved Task.
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Recalculate Claims ~ Saved Tasks l

Recalculate Claims Create a Saved Task | J.Smith_C921672524

Select claims by: @ Patient Account Number (O claim Number/UCRN O pateRange (O Contract (O Insurance Plan Code

Patient Account #: | 921672524

Claim Type: | Institutional v
Claim Status: | Live Claims Only v
Simulation: | Live v

5. In the Desktop Client, in the Explorer task pane, access the Scheduler at Libraries > Scheduler
Jobs Library > Contract Management.

6. If needed, create a new job for the calculation. Please see Scheduler for more details regarding
assigning and completing jobs and tasks using the Scheduler.

Run a saved recalculation task

You can rerun your saved recalculation tasks.

To run a recalculation task:

1. From the Claims menu, select Recalculate.
2. On the Recalculate Claims page, click the Saved Tasks tab.

The list of saved Recalculation Tasks displays all the saved tasks in all the simulations, by default.

TIP: To see the saved settings for a recalculation task, hover your cursor in the Task Name
column for the desired task, as shown in the following example:
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Recalculate Claims = Saved Tasks
Recalculation Tasks simulation: | All simulations v

Task Name Y  Simulation Claim Type Claim Status

092720 Claims Selected By: Patient Account # Live Institutional Live Claims Only Run Once Delete
PRyt Patient Account #:  €921690230 Live Institutiona Live Claims Only Run Once Delete
APC One Claim Live Institutional Live Claims Only Run Once Delete
APCGroupAndPriceCalc Live Institutional Live Claims Only Run Once Delete
ASC test ASC Test Sim Professional Live Claims Only Run Once Delete
ATI Prof ATl Testing Professional Live Claims Only Run Once Delete
CEBChargeCode ceb TEST sim Institutional Live Claims Only Run Once Delete
ChgAdjProf0323 ceb TEST sim Professional Live Claims Only Run Once Delete
ChgAdjTest0323 ceb TEST sim Institutional Live Claims Only Run Once Delete
Comorbid013020 ceb TEST sim Instituticnal Live Claims Only Run Once Delete
EAPG Group ad Price Live Instituticnal Live Claims Only Run Once Delete
eAPGGroupAndPrice Live Instituticnal Live Claims Only Run Once Delete
Enter a name for the task ceb TEST sim Institutional Live Claims Only Run Once Delete

3. If needed, from the Simulation drop-down, select the desired simulation to filter the list of tasks.
4. Locate the tasks to run and then, in the task row, click the Run Once button.

A brief message displays at the bottom of the page that says that the task has been queued to
run, and the “0” in the Recalculations Queued section changes to “1” (or the number of tasks you
selected to run).

5. To delete a task, click the Delete button in the row for that task. In the confirmation dialog, click
OK. A brief message informs you that the task has been deleted.

Recalculate a claim from Claim Details

Users modeling contracts can now recalculate a claim from the Claim Details page instead of using the
Recalculate Claims page if they want to recalculate just the claim they are viewing. This feature allows
you to recalculate a claim and then refresh the page to view the recalculation without having to
navigate between different pages and dialogs.

To recalculate a claim from Claim Detail:

1. From the Claims menu, select View a Claim.
2. Locate and view the claim.

3. Click Recalculate.
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Claims = Patient Acct. #:C921611776
Claim Details

Summary Codes Demographics Insurance

Summary for: C921611776 --

Claim Information

Lineltems  Physicians Postings  Tracking

Patient Account #:| C921611776

Calculated Contract: | TestEAPGEditlssue - Version 1

Claim h.ulrber:| 922273802

Import Batch :.!:| 470- UB04

Type of Bill | 131 - Hospital-OutPatient-Admit Throi ‘

Patient tatus: | 01 - Discharged To Home Or Self-Care

|
|
|
‘ Total Covered Chgs |
|
\

Last Heca\c2| 4/23/2019 2:42:49 PM $439.00 ‘ Length of Stay: ‘ Q
Ins. Plan Code;| clo16 Non-Covered Chgs | $0.00 ‘ Covered Days: ‘ 4]
DRG: |
Claim Totals
Expected Paymeni:| 80.00 ‘ Actual Payments: | $307.30 ‘ Payment Variance: ‘ (8307.30) ‘
Expected Comractua\:| $439.00 ‘ Actual Contractual | $131.70 ‘ Contractual Variance: ‘ $307.30 ‘

View Voucher Go to Contract Grouper Edits

!

Admit Date:| 5/30/2012

Discharge Date

5/30/2012

Submission Date:

\
|
6/10/2012 |
\
\

In the Queued Tasks section (on the right in the blue header), the “0” changes to “1.”

Logout Queued Tasks: 1 9
Priority Task Type Queued By Claims
1 Recalculation  Williams, 1

NOTE: If you already have recalculations waiting in the queue, or if other users have
calculations waiting in the queue, the number is incremented. If you select another claim to
recalculate before the first one is finished, the number increments again.

When the “1” changes back to “0,” the recalculation is finished.

4. Refresh the page in your browser to view the recalculation results.

The data in the Last Recalc: field has changed to reflect the new recalculation date.
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Import Data

Claims = Patient Acct. # C921742785
Claim Details

View Voucher Recalculate Goto Contract  Grouper Edits  View 8355
Summary Codes Demographics Insurance Line ltems  Physicians Postings Trd

Summary for: C921742785 --

Claim Information

Patient Account #:| C921742785 Calculated Contract: | AETNA - Version 2
Claim Mumber:| 922387852 Type of Bill: 111 - HospitalHnpatient (|
Import Batch #| 2614 - 8371 Patient Status:| 01 - Discharged To Homg
Last Recalc:| 5/4/2021 2:31:44 PM Total Covered Chgs:
Ins. Plan Code:| Cl1012 Non-Covered Chgs:
DRG:| 417
Claim Totals
Expected Payment: 50.00 Actual Payments:

For additional recalculation options or to recalculate multiple claims, use the Recalculate Claims feature.

View claims recalculation history and rerun claims

Administrators can access a history page for recalculated claims. The Recalc History page contains a log
of all recalculated claims, whether recalculated in a batch or individually, and the ability to rerun any
listed recalculation.

The history includes:

¢ Recalc ID — Recalculation ID number

* Run By — Username of person/entity/process that ran the recalculation

¢ Start Date/Time — Start date and time of the recalculation

* End Date/Time — End date and time of the recalculation

¢ Claims Selected — Number of claims selected for recalculation

* Claims Processed — Number of Claims Selected that triggered a contract clause/term for payment

e Error Count — Number of errors that occurred during processing. Any errors found are displayed
at the bottom of the page in the Recalc History Errors section.
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¢ Recalc button — Click to rerun any of the listed recalculations

Recalc Histor
y Filter the list to find a Click to rerun this
Start Date: [ 17172021 B3| End Date:| 12/31/2021 ] Clear lculation task
‘ | m - recajculation tas recalculate task

Recalc ID T  RunBy T StartDate End Date Claims Selected Claims Processed

1,402 Admin Admin 2021-04-13 2:27:35 PM 2021-04-13 2:27-44 PM 1 1 0 0 Recalculate -
1,401 Admin Admin 2021-04-13 2:20:50 PM 2021-04-13 2:20:58 PM 1 1 0 0 Recalculate

1,400 Admin Admin 2021-04-13 2:18:15PM 2021-04-13 2.18:23 PM 1 1 0 0 Recalculate

1399 Admin Admin 2021-04-13 2:05:13 PM 2021-04-13 2.05.24 PM 1 1 0 0 Recalculate

1398 CMA ZAdmin 2021-03-16 9:50:33 AM 2021-03-16 9:50:34 AM 5 4 0 0 Recalculate

1397 CMA ZAdmin 2021-03-16 9:50:19 AM 2021-03-16 9:50:22 AM 5 5 0 0 Recalculate

139 Admin Admin 2021-03-11 7:54:38 PM 2021-03-11 7:54:40 PM 1 1 0 0 Recalculate

1395 Admin Admin 2021-03-11 7:54:27 PM 2021-03-11 7:54:36 PM 1 1 0 0 Recalculate

1394 Admin Admin 2021-03-11 7:45:26 PM 2021-03-11 7:45:27 PM 8 8 0 0 Recalculate

1394 Admin Admin 2021-03-11 7:42:50 PM 2021-03-11 7:42:51 PM 8 8 0 0 Recalculate

1 2 3 4 5 6 7 8 » ™ 1-100f 77 items

Email: admin@axiomepm.com
Simulation Name: ATl MRP StepDown When a task is selected in the list,
Saved Recalc Name: ATI MRP StepDown additional details about it display here

Recalc History Errors
Claim Number Error Messa Contract Name Version Number Provision Description
Norecords auailzble < Any recalculation errors display in this area ' -

To access the Recalc History page, from the main menu, click Admin > Recalc History.

A Launch Page Contracts Claims Import Data Reports Admin Help

Manage Attributes
Recalculate Claims  Saved Tasks
Manage Insurance Plan Codes

Simulation Mapping
Recalculate Claims Recalc History

SQL Importer Log

Select claims by: Q) Patient Account Number (O Claim Number/! Provider Org Code Mapping ct

Manage Clause/Term Descriptions

Patient Account #: ‘

‘ Change Tracking
Claim Type: | Institutional v |
Claim Status: | Live Claims Only v |
Simulation: |Live v |

Verifying claims reimbursement calculation

Claims are automatically calculated during the nightly import process. However, there may be cases in
which a claim does not calculate an expected reimbursement. Use the following list of checkpoints to
ensure that claims are calculated properly, and to help you figure out why an expected reimbursement
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did not calculate as expected.

Claim calculation checkpoints

» Step 1: Verify that the claim dates fall within the contract version Start and
Expiration dates

Navigate to the contract version and check the Start and Expiration dates. For a claim to calculate
correctly against a contract version, the dates on the claim must fall within the contract version’s date
range, which is its active period.

A Launch Page Contracts Claims Import Data Reports Admin Help

Live » AETNA

Versions

+ Add a New Version =]
Version Start Date Y  Expiration Date Y | calculation Date
13 1/1/2008 2/2/2008 Discharge
2 0> 7/1/2009 1243172017 Discharge
3 > 1/1/2018 12/31/2018 Discharge
4 > 1/1/2019 1/31/2020 Discharge
5 3 7142020 12/31/2021 Discharge
6 1/1/2022 12/31/2022 Discharge
702 7/1/2023 12/31/2023 Discharge

» Step 2: Verify that the Payer Code on the claim matches a code assigned to the
contract

’ﬁ
1. Atthe end of the version row, click the Edit icon (I:l ).
2. Inthe Edit Version dialog, click the Insurance Plan Codes tab.

3. Inthe Insurance Plan Code tab, look in the Payer Code column and confirm that the claim
insurance Payer Code is assigned to the contract:
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Edit Version

Assigned
Organization
01 - KREG MEDICAL CTR ORG1
01 - KREG MEDICAL CTR ORG1

01 - KREG MEDICAL CTR ORG1

Settings  Insurance Plan Codes

Version 1 | Insurance Plan Codes

Documents

Payer Code

00882

ABCD

clonz

Attributes

e
Payer Description h
NO DESCRIFTION
ABCD Testing
NO DESCRIFTION
1-3of 3 items

P Step 3: Verify that the Claim Bill Type is built into the contract version Provision

1. On the contract version row, click the Go to Provisions.

2. On the Provisions page, at the end of the desired provision row, click the Edit icon (Et’ ).

3. Inthe Edit Provision dialog, click the Type of Bill tab. In the side menu, click Convert. The
Provision Settings dialog opens, displaying the Types of Bill on the provision. You may need to
expand the top category row to see the underlying bill types, as shown in the following example.

Edit Provision
Provision | Type of Bill
Settings  Type of Bill  Attributes

Assigned
Type of Bill

11X - Hospital Inpatient (Including Medicare Part A)

» Step 4: Confirm that the claim has criteria that match the contract build

1. Review the claim and compare the criteria to verify that it matches the capture data specified on

the contract clause/term.
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2. Check that the contract also has a clause that captures non-reimbursable claims. In addition to
criteria that catches reimbursable claims, each contract should have a final clause that captures
non-reimbursable claims. Without a capture clause/term, the claim will not calculate expected
reimbursement. In the following example, a No Qualifying clause is used.

Clauses

+ Add a New Clause

Live > KHA MEDICARE > Version 1 (1/1/2013 - 12/3

/2017) > Hospital Inpatient (Including Medicare Part A) (1/1/2013 - 12/31/2013)

Recalculate

Clause Description Calc Basis Calc Type Calc Measure Terminal? Attributes Rates Threshold Limits
1 PSYCH CMS Psych Yes =

2 REHAB CMS CMG Yes E,/~

3D TRANSFER 03,0506 Provider NP Dollar Rate Per Claim Yes =

4 CMS DRG CMS DRG ves =

5 NEWBORN LEVEL Il Multi-Channel Discount Dollar Rate Per Line ltem Yes E,/'

6 Go to Terms NO QUALIFYING CLAUSE Any and All Services Dollar Rate Per Claim Ves

7 No Description Line tem Code Modifier Dollar Rate Per Line ltem Yes E,/'
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Working with reimbursement detail
reports

Reimbursement detail reports provide you with various ways of viewing and analyzing calculations
related to reimbursement. Use these reports to help pinpoint areas of concern and areas of opportunity.

All three reports need to be enabled in your system by Syntellis Support before initial use.

( )

IMPORTANT: Both the Winning Detail and the Winning Detail Service Line report require some
setup before first-time use. These two reports use a new voucher table. To be used by the Winning
Detail reports, your data needs to be in the new voucher table. Once the new voucher table is
enabled, new incoming claims data will be stored there when claims are calculated. However, your
existing calculated claims will need to be recalculated. Additionally, after the new voucher table is
enabled, existing voucher details will not be able to pull data from the old tables, making the
voucher reports unusable until all claims are recalculated.

Please contact Syntellis Support to set up migrating your existing voucher data to the new voucher
table so that you do not need to recalculate existing claims.

» Calculation Detail

Previously, calculation detail has existed in the payment vouchers, with no easy way to get a more
encompassing view into how various services generate revenue for a given contract. The Calculation
Detail report solves this problem by enabling you to tag the services to include in the report, giving you
results customized to your needs. If you analyze contract terms, this report can help you understand the
different services and reimbursements that generate revenue.

The main difference between this report and the other reimbursement detail reports is that this one
requires that you set up reporting categories and tag individual clauses while the other reports come
with set categories. While this report takes longer to set up, it allows for greater customization because
you choose what to report on and you can group items together as you like. For example, if you want to
lump all of Radiology together, you can do so. Once set up, the report parameters copy over from
version to version.

See Using the Calculation Detail report for more information.
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» Winning Detail

The Winning Detail report enables you to see, by contract, all the elements that make up your
reimbursement and expected payment. The data is displayed in easy-to-read columns that clearly show
what you were paid based on the contract terms, the total amount available without contract
restrictions, and the difference between the two, down to the term level. You can include claims data in
the report to see how each claim affects reimbursement and see where applied limits are reported. This
report provides a simpler yet detailed alternative to using both the Contractual Analysis report and the
Clause Stats report to see where reimbursement occurs and where possibilities for negotiation exist.
You can export this report to Excel for offline viewing.

See Run the Winning Detail report for more information.

» Winning Detail Service Line

View all the elements that make up your reimbursement and expected payment by service line. This
report displays this information in easy-to-read columns that clearly show what you received from each
payer, the total amount available without contract restrictions, and the difference between the two,
down to the term level. The analysis spans contracts within a given simulation. Service Lines available
from the Service Line drop-down are specific to those used in the contracts in the simulation. To
facilitate this analysis, it helps to use the same Service Line (clause description) definitions when
structuring your contracts. As with the Winning Detail report, you can select to include claims
information and you can export the report to Excel.

See Run the Winning Detail Service Line report for more information.
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Using the Calculation Detail report

IMPORTANT: Although this report is available in the Reports menu, it needs to be enabled by
Syntellis Support before first time use.

The Calculation Detail report provides a detailed view of how the various reimbursements on services
generate revenue for a given contract. If you analyze contract terms, this report enables you to view the
different services and reimbursement that make up the total expected payment amount so that you can
understand where revenue is being generated.

This report is one of three reports that detail reimbursement, and like the others, is separate from
standard reports and drill-down reports.

Only Axiom Contract Management administrators can configure the Reporting Category attribute for
use with the Calculation Detail report. Only users with the Admin role may assign/remove Reporting
Category attribute tags to clauses and terms. No user role can delete the Reporting Category attribute
from the system.

» Report organization overview

The report can be long, so you may want to run it separately for each contract. However, you can run
the report on multiple contracts at a time as long as they are in the same simulation.

e The report is ordered vertically by contract if it includes multiple contracts.
e The first column is patient billing ID (CMABIllID). This column is present only one time in the
report (taking up one row).

e Totals in the report are by contract.
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e The following reporting columns are included in the report and do not need to be added to the

Reporting Category attribute:
© CMABIllID — Patient account ID
° Encounter Count = 1 — Used to obtain a total count of patients in the report
° Patient Type — Hospital Inpatient, Hospital other, etc.
° DRG Code
° Length of Stay
° Total Charges
° Total Expected Payment
° Total Expected Contractual
° Contract Name

° Reporting Category attributes you created and assigned to clauses and terms for each
contract

© Clause Total — Calculated Epay by clause/term

© Unassigned Total — Amount calculated but not associated with a clause/term attribute
© Global Limit calculation — Separate columns for min and max

° Final Expected Payment

° Global Limit Loss — The difference between the global limit and the calculated clause/term
amount.

The data for the built-in columns is automatically pulled by the report for all claims associated
with the contract date range used in the report. Claim amounts from untagged clauses and terms
fall into the Unassigned Total column on the report.

» Steps for report setup and generation

Following are the main steps in creating the Calculation Detail report.

1.

2
3
4.
5

Before you use the report for the first time, contact Syntellis Support to have the report enabled.
Before you use the report for the first time, set up the Reporting Category attribute.

Apply the Reporting Category attribute labels to clauses and terms.

Recalculate claims for the contracts to be included in the report.

Run the report.
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Set up the Reporting Category library attribute

The Axiom Contract Management administrator needs to set up this attribute before it can be used to
tag contract clauses and terms for the Calculation Detail report.

Before creating the report attribute labels, create a list of the categories you will need for all contracts
to be reported on in the Calculation Detail report.

You can use the categories in voucher reports as a starting point and then add more labels as you refine
your categories based on initial report results. This process is a bit time consuming at first, but usually
does not need to be done more than once, although you may need to change which clauses and terms
are tagged with reporting attributes.

To set up the Reporting Category attribute:

1. In the main menu header, click Admin > Manage Attributes.

2. Inthe list of Attributes, locate the Reporting Category attribute and then, at the end of the row,
click the Edit icon ([#).

3. On the Edit Attribute page, click Library.

4. Inthe Edit Library dialog, create the attribute labels with which to tag clauses and terms for your
contracts:

a. Click +Add new record.

b. Inthe Library Value field, enter the first category label in the field provided, then click
Save. The item is added to the list.

c. Repeat step b until you have added all the categories in the pick list.
d. Click the X in the upper right corner to close the dialog.

5. On the Edit Attribute page, click Save and Close.

Set up the Calculation Detail report

In addition to built-in report columns, this report uses clause/term attributes from the Reporting
Category library attribute to report on details being calculated. To set up this report, tag each clause or
term that calculates reimbursement with the reporting attribute label that describes the services being
reported. For example, you could tag surgical charge clauses with a label named “Surgical.” Any lab or
radiology services that apply on related clauses or terms could be tagged with “Laboratory” or
“Radiology.” Clauses/terms with the same label get totaled together for a given contract.

NOTE: Before you can label services with the Reporting Category attribute, the administrator needs
to set up the attribute with the desired labels.
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1. For the contract you want to report on, navigate to the first clause/term with data to be included
in the report.

2. Atthe end of the clause/term row, click the Edit icon (IZ,I').

w

In the Edit Clause/Term dialog, click the Attributes tab.

E

In the Reporting Category’s Attribute Value drop-down, select the desired category.
Click Save and Close.
6. Assign Reporting Category labels to other clauses or terms to be included in the report.

7. If desired, you can add other contracts to the report by tagging their clauses and terms.

NOTE: When reporting on multiple contracts, all contracts must be in the same simulation.

8. Recalculate the claims associated with the contracts to which you applied the attributes.

9. Run the Calculation Detail report.
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Run the Calculation Detail report

[ IMPORTANT: Before running this report, be sure you have completed report setup. J

Because this report can be quite large, it is not rendered to the page; instead, it is available for
download.

To run this report, you need the following parameters: simulation, contract, and discharge date (you
may select multiple). Running the report creates a downloadable Excel file with the complete voucher
details for each patient in the data set.

To generate the Calculation Detail report:
1. From the Reports menu, select Calculation Detail.

2. On the Calculation Detail page, select the simulation the contract is in, then select the contract,
and then select the Discharge start and end dates in the corresponding fields.

NOTE: The first time you open the report, the start and end dates default to the current date.
Once you set a date range, that becomes the new default until you change it again. The date
range set is specific to each user.

Calculation Detail

smlaton [T ] conract

3. Click Get Report. After processing, the report is available for viewing from a Downloads dialog:

Downloads O URETTINE A (ucued Tasks: 0

- CalculationDetailReportxlsx

Discharge Start Date | 1/1/2013 F= | Discharge E See more

4. Click Open file to view the report. You can also access the report from your regular download
location.
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Run the Winning Detail report

IMPORTANT: Although this report is available in the Reports menu, it needs to be enabled by
Syntellis Support before first-time use.

Run this report to see how contract terms such as limits affect your reimbursement, especially Lessor Of
language.

To run the report:

1.

e

i

Before using the report for the first time, contact Syntellis Support to have the report enabled
and to transfer your data to use the new voucher table.

If needed, recalculate claims for the contracts to be included in the report.

From the Reports menu in the main menu header, select Winning Detail.

From the Simulation drop-down, select the simulation with the contracts to be analyzed.
From the Contract drop-down, select the contract.

In the Discharge Start Date and Discharge End Date fields, type in or select a date range for the
report.

NOTE: Once you change the date range from the default (the current day), the date range you
selected becomes the new default until you change it again. Date ranges are tied to user
logins, so your date range does not impact other users’ date ranges.

To include data from claims that affect reimbursement, select the Include Claim Data check box.
When you drill down on a contract in the report results, you will be able to see each claim
associated with the total amounts, and then the actual gain and loss that occurred for that claim.

Click Get Report.
(Optional) Export the report to Excel:
a. On the top right of the page, click Export to Excel.

b. Inthe Download popup, click Open file.

Downloads B a - 2
WinningDetailReport.xlsx
i e T i

The report opens in Excel with all levels collapsed.
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10. Review the report.

Run the Winning Detail Service Line report

IMPORTANT: Although this report is available in the Reports menu, it needs to be enabled by
Syntellis Support before first-time use.

The Winning Detail Service Line report allows you to choose a particular line of business to compare
across payers. For example, you could examine your organization’s Cardiology services, Radiology, labs,
and so on, to see which lines are meeting reimbursement expectations and which are not. Select to view
gains, losses, and potential gains by service line (e.g., departments or services such as cardiology, labs,
specific therapies, and so on) down to the term level.

To run the report:

1.

N o v~ W

10.

Before using the report for the first time, contact Syntellis Support to transfer your claims data to
the new voucher table.

If needed, ensure your clause hierarchy is set up for service lines. For example, your clause
descriptions should reflect the service lines to which they belong. For details on setting up clause
and term descriptions, see Managing clause and term descriptions.

If needed, recalculate claims for the contracts to be included in the report.

From the Reports menu in the main menu header, select Winning Detail Service Line.
From the Simulation drop-down, select the simulation with the service lines to be analyzed.
From the Service Line drop-down, select the service line.

In the Discharge Start Date and Discharge End Date fields, type in or select a date range for the
report.

NOTE: Once you change the date range from the default (the current day), the date range you
selected becomes the new default until you change it again. Date ranges are tied to user
logins, so your selected date range does not impact other users’ date ranges.

To include data from claims that affect reimbursement, select the Include Claim Data check box.
When you drill down on contracts in the report results, you will be able to see each claim
associated with the total amounts, and then the actual gain and loss that occurred for that claim.

Click Get Report.
(Optional) Export the report to Excel:
a. On the top right of the page, click Export to Excel.

b. Inthe Download popup, click Open file.
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The report opens in Excel with all levels collapsed.

11. Review the report.

Review Winning Detail reports

This topic applies to both the Winning Detail and Winning Detail Service Line reports.

» View the reports in Excel

Open the exported Excel report file. The first time you open the report, it displays with all levels
collapsed, just like the online version.

To expand the report levels in Excel, click the number buttons in the row at the top left of the report, or
click the plus button ) corresponding to the desired level.

If you selected to include claim data, associated claims display in the rows under each clause or term

level. Additionally, the View a Claim column contains a link to the claim detail in Axiom Contract
Management.

Level expand buttons
correspond to rows 1-7+

o, I
i]2j3[4]s|6(7 A B C D E F G H
=] 1 Level Claims Discharge Date  Length Of Stay  Winning Total EPay Total Total Loss View a Claim
2 [simulation: a CEB Test WD 7 54874.161 33309.034 21565.127
-] 3 |Contract: WD Testing 7 54874.161 33309.034 21565.127
= 4 |Version: 1- 1/1/2013-12/31/2013 7 54874.161 33309.034 21565.127
[=] 5 |Provision: Hospital Outpatient 7 54874.161 33309.034 21565.127
[=] & |Clause: OBSERVATION 7 54874.161 33309.034 21565.127
7 |Account # C921534639 1 0 11245.806 5000 6245.806 | View a Claim
2 |Account #: 921771050 1 0 6610.023 5000 1610.023 | View a Claim
— 2071436982 1 0 9013.284 5000 4013.284 | View a Claim
. 27637 1 0 9980.802 5000 4980.802 | View a Claim
Click to collapse level 67316 1 0 5715.212 5000 4715.212 | View a Claim
1753444 1 0 4353.768. 4353.768 0 | ViewaClaim
13 |Account #: C921573015 1 0 3955.266 3955.266 0 | viewaClaim
14
15
ij Click to view claim in
10 Contract Management

Example of Winning Detail Service Line report

Reports displayed in Excel contain two additional columns not found in the online reports: Discharge
Date and Length Of Stay.

After the report is generated, the total loss for the batch of claims for that contract or service line
displays at the top of the Total Loss column. In the following example from the Winning Detail report,
the total loss is $38,890.67. Notice that the example includes claim data because the Include Claim Data

box is checked. You need to include claim data if you want to be able to view the loss details down to
the chargeable service.
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1. To see where the losses occurred, expand the levels down to the clauses or terms. In the
following example, a large loss is associated with a clause affecting three claims.

Winning Detail

Simulation | a CeB Testwo v | Contract | WD Testing v | Discharge Start Date | 1/1/2013 B3| Discharge End Date [12/31/2013 [EI Gotrerort W Export ToExcel WRETEEEIRES
Level Claims EPay Total Total Loss
$556,896.19 $38,890.67

 Contract: WD Testing

¥ Version $38890.67

¥ Prov spital Other

» Clause: LAB

» Clause: ALL OTHER OP 1

v Prou spital Inpatient (Including Medicare Part &
| > clause 3 527693
» Clause: STOP LG oo
» Clause: MATERNITY
$140008

» Clause: APPENDECTOMY

1
1
1
2
» Clause: DRG CA s 2
P

+ Provision: Hospital Outpatient

2. Expand the clause to see the associated claims. In the example, only one of the 3 claims is
responsible for the loss.

3. To view the claim, click the row.

Level Claims Winning Total EPay Total Total Loss
v Contract: WD Testing 583 $595,786.86 $556,896.19 $38,890.67
v Version: 1-1/1/2013-12/31/2013 583 $595,786.86 $556,896.19 $38,890.67
» Provision: Hospital Other 76 $4,023.51 $3,886.51 $137.00
v Provision: Hospital Inpatient (Including Medicare Part A) 10 $109,238.30 $102,588.84 56,649.46
v Clause: ONE DAY STAY 3 $12,600.00 $9,623.07 $2976.93
Click to open the
Account #: C921414488 claim details page 1 $4200.00 $1223.07 $2976.93
- for the claim
Account #: 921615883 1 $4,200.00 $4,200.00 $0.00
Account #: 921868205 1 $4,200.00 $4,200.00 $0.00

The claim opens on the Claim Details page. From there, you can view claim totals, codes, line
items and more, and you can use links to access the related voucher and contract.
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Working with standard reports

This chapter covers building a standard report.

Access standard reports

Use these instructions to access standard reports in Axiom Contract Management.

1. Inthe main menu header, click Reports > Reports.

Reports

| Live v Dril-Down Reports

Contracts

+ Add a New Contract
Contract Name Y Latest Expirg

a CEE 121019 12/31/2019

The Reports page opens to the Report List tab. All previously saved reports are located here.
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Contracts Claims Import Data Reports Help

Reports 2 [ ReportList | View/Edit New

Drag/Drop:

EEE

B[] Reports -
B[ Claim Tracking

B[ Contract Simulations

-] Contract Validation

-7 Denial Analytics

B[ User

B[] Varisnce Analysis

..... Aetna KMC Siim OCE APC Edits
..... Aetna KMC Siim OCE APC Edits
..... Aetnt Train CS

..... APCConfirm

..... apg edits

..... ATestOfFiltering

..... Bill Logic Exception Report

..... britestlinesum

..... Ch

..... CA A Prof

..... CA hetnia

..... CA Kreg Managed Care -

2. Do one of the following as desired:

¢ To create a new report, click the New tab, and then follow the instructions in Create a new
standard report.

* To view an existing report, select the report from the list and then click the View/Edit tab.

Create a new standard report

Use these instructions to create a new standard report.

To create a new report:
1. Inthe main menu header, click Reports > Reports.

2. Click the New tab.

3. Inthe Report Name field, type a name for the report.
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Reports 2 Reportlist  View/Edit | New

Report Name Report Type Save To

I | Clause Stats - Institutional v Save /Reports/User

~
# Parameters ¥ Advanced

Start Discharge Date 5/20/2022 V| End Discharge Date 5/20/2022 | Simulation |Live v|

4. From the Report Type drop-down, select the type of report template on which to base the
report.

Reports 2 ReportList View/Edit | New

Report Name Report Type
| Clause Stats - Institutional v S

Clause Stats - Institutional
% Parameters i Advanced Clause Stats - Professiona
Contractual Analysis - Institutiona |
Start Discharge Date £ Contractual Analysis - Professional nulation E
Denials - Claim Adjustment Summary
Denials - Line Adjustment Summary
Edits - NY EAPG
Edits - OCE APC
Line Item ASC Summary Report
Payer Score Card - Institutional
Payer Score Card - Professional
Surplus/Loss Analysis - Institutional
System - Bill Logic Exception Report
System - Rejected Records

5. Select a report date range. The report parameters available depend on the selected report type.
All reports have a date range parameter. You need to set a Start Date and an End Date for the
report.

a. Inthe Start Date field, click the drop-down.

b. In the calendar tool, click the year drop-down and select the year, then click the month
drop-down and select the month, then click the day.

c. Inthe End Date field, click the drop-down and select a date from the calendar.
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Reports D ReportList  View/Edit | New

Report Name Report Type

| Clause Stats - Instituti

-~
% Parameters ¥ Advanced

Start Discharge Date 1/1/202 End Discharge Date 1
& | January || 2020 v | 3

Sun |Mon| Tue (Wed | Thu | Fri | Sat

29 | 30 | N 1 2 3 4
5 6 7 8 9 (10| M
12|13 [ 14|15 |16 [ 17 | 18

19| 20 |21 | 22|23 | 24| 25

26 | 27 | 28 |29 |30 | 31 | 1

23| 4 5 6 | 7 8
Today: 5/20/2022

6. If the report type requires you to select a contract, then from the Contract drop-down, select a
contract.

7. If other parameters are required for the report type, these display in the Parameters section.
Select any as needed.

8. To add filters to your report, in the Parameters heading bar, click the down arrows icon to the
left of Advanced. Do one of the following:
e From the Filter drop-down, select a filter.

e Build an advanced filter for standard reports.

9. Click Save. The report generates.

View a standard report

After the standard report is processed, the system displays the report in the Web Client. The initial view
is the detailed view, meaning most of the rows are expanded, except for the most granular level; those
usually are collapsed, with a boxed plus symbol to the left of the rows. Expanded rows have boxed
minus symbols to the left.

To change the view of a report:

e To expand the details for an item, to the left of the item, click the plus symbol (+) (outlined in red
in the following example).

e To access a claim from a report, expand the account row and then click the account number link.
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¢ To view selected filters, on the left above the blue report column headings, click the plus symbol
next to Selected Filters.

NOTE: These are not the same as Advanced Filters.

e To hide report details, click the Hide Detail check box(outline in green in the example) and then
click Save. Report details usually include the most granular level of detail in a report, such as
individual claim level account numbers and patient account information.

¢ To change the size of the report on the page, select an option from the Page Width drop-down
(outlined in orange in the following example).

rocroes | s | e~

Report List | View/Edit | New
Report Name Report Type
ca | contractual Analysis - Institutiona Save
2 Parameters 3 Advanced
Start Discharge Date [1/172013 | End Discharge Date [1/31/2013 | simutation [Live | contract [CIGNA PPO ] Jide peran 1|
14 < 1 lef1 > > O © 150% v = Find | Next Exportto... ¥

Clause Contractual Analysis Report Report Date: 10-09-2018

Se ected Filters.

0
<)
=
g Expected Amount Balance CMA Payer | Contractual
= Clause Description Charges Payment Paid Due Contractual Contractual Variance
[ElcieNA PPO 38 54 $251524 $221,341 $198,790 $22 551 $30,183 549,590 ($19,407)
ES 38 54 $251,524 $221,341 $198,790 $22.551 $30,183 $49,590 (819,407)
[ElHospital Inpatient (Including Medicare Part A) 3 15 $150,339 $132,298 $120,283 $12,015 $18,041 $29521 (611,480)
( 10) ICU-INTERMEDIATE / CCU- 1 3 $61,313 $53,955 $50,030 $3,925 $7,358 $10,706 ($3,348)
INTERMEDIATE
ccl # Patient Name Date
(12) SURGICAL 1 9 $84,640 §74,484 $66,525 $7.959 $10,157 $18,157 ($8,001)
ccl # Patient Name Date
(14) ALL OTHER IP 1 3 $4,386 $3,860 $3,728 $132 $526 $658 (§132)
ccl # Patient Name Date
Hospilal Other 4 8700 5616 $465 $151 $34 $143 (859)
Report example

Export a standard report

Exporting reports to Microsoft Excel can be a useful tool for additional claim and data analysis. Exporting
to Excel allows you to perform enhanced data sorts, comparisons, calculations, and edits.

To export a standard report to Excel:

1. Navigate to the desired report.

2. Inthe gray toolbar at the top of the report, click the Export to drop-down, and select Excel.
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Simulation | Live

v| Contract | AETNA

dth *

=

Statistics by Contract

Find | Mext Exportto.. ¥
Export to._.
PDF
Word

A Download button displays to the right of the export drop-down, which now displays as “Excel.”

open it.

Click Download. The Excel file name displays in the lower left corner of the page. Click the file to

In Excel, you can expand report details similarly to the way you do in Axiom Contract

Management: by clicking on the plus icon (+) to the left of an item.

Insert Formulas

Clause_Statistics_by_Contract_Detailxls [Compatibi

Data View

Page Layout

Q Tell me what you want t

<, b cut Tahoma -7 - K A == ®- 5 WapTet General |::=—| D MNormal Bad
Paste EBCOW' C d | F Dt
= = = = 3= «0 00 E> Il
E. s Format Painter U === == H Merge & Center = $ = % ¢ 60 3.0 Foc::1 Elt::‘:n;' ?I.:;Iae 'ES Expia
Clipboard [} Font [F} Alignment [F} Number F}
D H = & o cxnafle -8 e e
HEEIAE A|B|C D |[E[F [G|H | | J | K | L (M| N O | P | @ | R | S |
1 Clause Statistics by Contract Reporibat
3
5:5E|ED|EC Fiters
12
Cl Expected| EPay
13 Clause Description Ci Payment g| Avg Daily Avg Daily EPay
-] 14 1,520 52,356,050 52,120,221 g
=] 15 1 1,520 52,356,050 52,120,221 59.99%
’_:_l 157 Hospital Inpatient (Including Medicare Part A) 57 152 $631,605 $568,220 89.96% 54,155 $3,738
. 17 | ( 5) MATERNITY C-SECTION 5 12 554659 549,177 89.97% $4,555 54,098
18_ Acct# Patient Name Date
19 CH531153 122172009 3 $10,502.56 $9,722688 S0.0% $3,600.59 33,240.8%
20 | CH1608445 01/14/2010 z 35,326 82 3533414 S0.0% 34,883 41 34,157.07
21 CH21835356 11/08/2010 2 $13238.78 51158850 S0.0% 35,849.39 35,384.45
2 | CI21502073 08/05/2008 2 $10.069.06 $9.05765 83.96% £5,024.53 $4.528.83
23 | Ca21878803 10/04/2009 3 $11.160.95 $10.033.52 B9.5% 37032 $2,344.51
. 24 { 6) MATERNITY NORMAL DELIVERY 5 1 531,944 528,750 90.0% 52,504 52614
25 | Acct# Patient Name Date
- 32 E!( T) MATERNITY 1 5 54,603 54,142 50.0% $921 5828
33 Acct # Patient Name Date
- 35 | { 8) NEWBORNS 8 18 §13,026 511,724 50.0% $814 8733
35: Acct # Patient Name Date
5 45 (10} ICU-INTERMEDIATE / CCU-INTERMEDIATE 4 11 365,831 359,247 90.0% 55,985 55,386
45: Acct# Patient Name Date
5 51 | (11} Icu/ccu 3 10 249716 544744 90.0% 54972 54,474
52 | Acct# Patient Name Date
= 56 | { 12) SURGICAL 13 43 5279,868 §251,872 50.0% 56,509 55,857
5?: Acct # Patient Name Date
- 1| (14} ALL OTHER IP 17 44 $131,959 §$118,564 89.85% 52,999 $2,695
L ?2: Acct# Patient Hame Date
[+] 90 Hospital Other 528,326 525,493 90.0%
L L 190 Hospital Outpatient $1,696,119 §1,526,507 90.0%
1501 I T R 7 | ]

Example report with expanded filters
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5. To expand all filters, click the number of highest value in the group that sits just above and to the

left of cell Al.

0 H E - - ¥ X B3 2 E- B~

S: FEE
| |

11z]z1+5] AlB|c| D |E| F |G|H| J | K | L MIN| O |
> Clause Statistics by Contract
3
= G_SEIECIE:F"[EI'SZ
7_ Discharge Date: TH2009 - 1243172011
] | Simulation: Live
If‘ g._ Contracts: AETHA
: 1U=

Each greater number represents a deeper level of expansion. In the image below, number 5 has
expanded the report down to the claim level.

Formulas Data

Insert Page Layout Il me what you want tc

- . v =

D 26 Cut Tahoma -7 - AN E = ¢ Wrap Text General M -: .O’ MNormal Bad
ER Copy ~

. ¥ Format Painter = - L g o Formatting - Table -
Clipboard ] Font ] Alignment Mumber ]

0O H E il 5-

tHllz2 - & e
|

TzTz]«1= AlB C D [E[|F [G|H] od K M o E | @ | R | S | T
e Clause Statistics by Contract Reportbete: 10-62
3
- § |Selected Fiters
. T_DISDHBTQB Date: THI2009 - 1203172011
8 | Simulation: Live
lf‘ g |Contracts: AETNA
. 10 |
12
2 Expected| EPay as % of
13 " | clause Description Payment g| Avg Daily ( Avg Daily EPay
H 14]
= 15
|E| 16 Hospital Inpatient (Including Medicare Part A) $568,220 89.96% 54,155 $3,738
- 17 { §) MATERNTY C-SECTION 5 12 §54,659 349,177 89.97% $4,555 54,088
|E| 18 | Acct# Patient Name Date
T Co21831153 12/21/2008 3 $10,802.58 35,7228 50.0% 53,600.98 53240
2[]_ C521608445 01/14/2010 2 $5.326.82 38.334.14 80.0% 68141 $4.197.07
21| Copieasass 1110872010 2 31325878 $11,988.50 50.0% 58.648.38 55.984.45
22_ C521502072 QB05/2005 2 $10,085.06 $9.067.65 89.96% $6.034.53 3452883
23| Cop1878853 10/04/2008 3 $11,180.55 31002252 £ 5372032 5334451
S o4 (6) MATERNITY NORMAL DELNERY 6 1" 531,944 528,750 90.0% 52,804 s2614
’_:_l 25_ Acct# Patient Name Date
- 26 £521503058 08282010 1 32.876.44 32.588.80 80.0% 32.876.44 32.588.80
27| £221500341 081252010 2 3448172 54,015.58 50.0% 2.230.88 52.007.77
28_ £521430101 106012010 3 $7.570.53 3717284 80.0% $2,856.93 $2.391.28
29 | C221911148 031372011 2 35.045.08 54,540.57 50.0% 5252254 52,270.28
3[]_ CE21724448 0843172011 1 M411.08 $3,969.95 80.0% M411.08 $3,969.95
31| Copisesar 120212011 2 57,172.28 38,481.32 50.0% 5358963 53,230 67
- 32 |:l( 7) MATERNITY 1 3 $4,603 $4,142 90.0% s921 5828
I%‘ 33_ Acct # Patient Name Date
. 34 £521848131 OT/28/2005 8 34,802.54 34,142.28 80.0% $920.51 $828.48
. 35 { 8) NEWBORNS 5 16 513,026 511,724 90.0% 5814 5733
=] 36 | Acct# Patient Name Date
- 37 C321813447 1211712009 3 3185875 3167283 50.0% $815.58 $557.83
38_ 10/15/2008 3 $2.401.50 $2.181.35 80.0% $800.50 $720.45
g [T 2 5128800 5118820 0.0% 354400 357380
d_[]_ 0512010 1 $904.20 $812.78 80.0% $904.20 $812.78
41_ 10:25/2010 2 5244072 32,198 85 50.0% $1.220.38 $1,038.32
42_ 0843172011 1 oz $928.50 80.0% oz $928.50
43_ 1011772010 2 3140371 3128334 50.0% $701.88 $631.67
M_ C521501441 12/08/2011 2 $1.887.14 $1.527.43 80.0% $848.57 78371
T { 10) ICU-INTERMEDIATE / CCU-INTERMEDIATE 4 1" 65,831 559,247 90.0% 55,885 5,386
[T Acct# Patient Hame Date

Example of fully expanded report
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Edit or delete a standard report

Use these instructions to modify and save an existing standard report, or to delete a standard report.
You can make changes incrementally if you want, by saving the report after each parameter change.

These instructions are generalized; not all reports contain the report parameters used in these
instructions, and some reports contain parameters not mentioned here.

NOTE: You cannot change a report’s type.

To modify a standard report:
1. Inthe main menu header, click Reports > Reports.

2. Inthe Report List tab on the Reports page, click the report to edit and then click the View/Edit
tab.

3. To change the report name, in the Report Name field, type a new name.

4. To change a date parameter, expand the Parameters section if needed, and then select a new
date range from the start and end date drop-downs.

5. To change the report’s simulation, in the Simulation drop-down of the Parameters section, select

a different simulation.

NOTE: If you change the simulation, you may be required to change the contract as well, since
contracts are simulation specific.

6. To change the contract, in the Contract drop-down of the Parameters section, select the desired
contract. You can select more than one.

7. Click Save.

To delete a standard report:
1. Inthe Report List tab on the Reports page, right-click the desired report and select Delete.

2. Inthe confirmation dialog, click OK to delete the report.

Run APC and eAPG Edits Reports in any simulation

You can run APC/eAPG edit reports targeting a simulation environment other than Live. Although there
is a Simulation drop-down menu for this report, previous to the 2019.1 release, the report always ran on
the Live simulation for APC/eAPG reports, regardless of the simulation selected. Now you can view edits
that occur on APC and eAPG claims grouped within any given simulation.

To run an APC/eAPG Edits report:
1. Click Reports > Reports.
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2. Click the New tab.
3. Inthe Report Name field, type a name for this report.

4. From the Report Type drop-down, select one of the following:
e Edits - EAPG
e For APC, Edits - OCE APC.

5. Expand the Parameters section if needed, and select a Start Import Date and an End Import
Date.

6. From the Simulation drop-down, select the desired simulation.
7. From the Contract drop-down, select the desired contract(s).
8. Click Save.

The report generates.
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Working with drill-down reports

Axiom Contract Management’s drill-down reporting feature enables you to create multi-level, complex
reports with expandable / contractible sections. Drill-down reports are interactive and highly modifiable.
After generating a report, you can sort and rearrange columns, add or delete additional rows or
columns, apply or remove filters, etc.

Accessing drill-down reports

To access Drill-Down Reports:

e In the main menu header, click Reports > Drill-Down Reports.

| Launch Page Contracts Import Data Reports

Reports
| Live | &= Drill-Down Reports
Contracts

+ Add a New Contract

Contract Name

Drill-Down Reports opens in a new browser tab. To get started, see Organizing drill-down reports.

Reports Help

Categories -
g Drill-Down Reports + Create New Report

+ Add New
APCs Select a Category
asd
Axiom Reports
» Claims Management
» Department Denials
HTL
» Jerry
mcmitest
» Monthly Report Set
New Category
Service Line Reports
Simulations
» Users
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Organizing drill-down reports

The initial page displays your organization’s drill-down report folder structure that stores all previously
saved reports. From this page, you can add a new folder to the structure, search for and open a saved
report, or click Create New Report to access the report builder.

I S S
Categories .
J Drill-Down Reports + Create New Report

+Add New
Claims Management

B Pro

Axiom Reports

> Claims Management
v Department Denials
Emergency
Gl Clinic

B Rev

or Claim Examples 2013 Aetna

IP Intensive Care Unit
IP Maternity
IP Medical
IP Nursery
IP Surgical
Laboratory
Nuclear Medicine
Oncology
OP Surgery
Pain Management
Radiology

HTL

Drill-down reports page example

The system comes with the following folders:

e Claims

¢ Line ltems

You can add and delete folders, and create additional subfolders as desired.

[ IMPORTANT: Be aware that when you make a change to any of the folders, it affects all users.

This initial set-up categorizes reports by type of report. Other options may be User Name or
Department. How facilities use the folder structure is up to them.

» Add report folders

First determine whether the new folder should be for a new category or a subcategory.

To add a new category folder:
1. Inthe Categories panel on the left, click +Add New.

This creates a new folder named New Category# that you can rename.
2. Rename the new category and then press Enter.

The new folder sorts alphabetically into the structure.

Administrator's Guide Axiom Contract Management | 218



Categories

* Claims Management

Axiom Reports

* Department Denials
HTL

» Jerry
mcmtest

* Monthly Report Set
Service Line Reports
Simulations

¥ Users

frew Categoryil

To add a new subcategory folder:
1. In the list of categories, right-click the existing category, and select Add New.

Categories
+ Add New
Axiom Reports
* Claims Management
- M Department Depgals
HTL Rename
Line ltems Add New
Medicare Delete

2. Rename the subcategory, and press Enter.

If a category has subcategories, an arrow icon (>) displays to the left of the Category name. To
display all subcategories, click the arrow.
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Categories
+ Add New
Axiom Reports
» Claims Management
Deparlment Denials
Emergency
Gl Clinic
IP Intensive Care Unit
IP Maternity
IP Medical
IP Nursery
IP Surgical
Laboratory

» Edit or delete report folders

You can rename or delete report categories and subcategories.

To rename a category or subcategory:

1. Right-click the category, and select Rename.

2. Change the name, and then press Enter.

To delete a category or subcategory:

1. Right-click the category, and select Delete.

Categories
+ Add New
Axiom Reports
* Claims Management

+ Department Denials

mﬂ

ename
GICl

Add New .
IP In Init

o 2]

2. Inthe confirmation dialog, click OK.
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» Edit the folder structure

You can rearrange folders and subfolders by dragging and dropping them to new locations. You can
move reports within folders the same way. Just keep in mind that any changes you make to a folder’s

structure or contents affects all users.

To move a folder to a different category folder:
e Drag a folder or subfolder to another category folder. Release the mouse button when the
destination folder name changes color.

In the following example, the user drags the Line Items folder to the Department Denials folder.

Categories
+ Add New
Axiom Reports
+ Claims Management
Contract Reports
Denials
» Depantment Denjals
HTL

m. m. <

* Medicare

» View the list of reports in a folder

To see the reports saved in folders:
1. Click the folder name. The reports display in the right pane under the name of the folder.
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Reports Help

catsgeries Drill-Down Reports
+ Add New

Axiom Reports #Claims Management
* Claims Management Actne BD not CT
* Department Denials Aetna CYS00

HTL BRFTestingAdvFilter

Line ltems Claims Tab Contract by version charges and payments
¥ Medicare CMAtest]
» Monthly Report Set CMAtest2

Coordination of Benefits
DE practice
DefaultReport_Pro
Exclude ClaimTracking
F Tracked100

ICD10 Claims

Inpatient

Max Charges

Service Line Reports
Simulations
» Users

2. To view summary details about a report, click the report name.

An information box displays just below the report name, showing more details about the report,
including the dates the report was created and last modified, the name of the user who modified
it, and any notes that were added when the report was saved.
A Payer Report Card
Design Includes SUM Claimz, SUM Total Charges, SUM Total Expected Payment, SUM Total Cost, Expected Profit

Edit Info
Tab: Claims

Created: 06/03/20714 by Preston Coates
Last Modified: 10/05/2018 by Holly Williams

3. To close the summary details box, click the name of the report again.

» Edit report summary information
In addition to viewing report summary information, you can edit the report name, description, and

folder location.

To edit report summary information:

1. To modify the report name, description, or folder location, on the left of the description, click Edit
info.
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Categories

Axiom Reports
+ Claims Management
Contract Reports
Denials
* Department Denials
HTL
Line ltems
* Medicare

+ Add New

Reports Help

Drill-Down Reports

Contract Reports
A Contractual Variance Report

Design Mo Description

B fo
Tab: Claims

Created: 01/09/2017 by Brendan Kreter
Last Modified: 01/09/2017 by Brendan Kreter

A Payer Report Card

2.

In the Update Report Detail dialog, edit the desired information, and then click Save.

Configuring drill-down reports

NOTE: Drill-down reports are based on institutional claims unless your organization only has
professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples on this page
depict data from institutional claims.

When you view a report with the Columns panel open, the Groupings and Measures tabs display on the
left side of the page. (By default, opened reports initially display with the Columns panel closed.)

Columns
Groupings Measures
+ Add New X Delete
E-Groupings -
B[] Claim Tracking

B[ Codes
B[] Dates
B[ 1CD Codes

B[] User Defined
...Admit Source
..dmit Type

..... Batch Mumber
..... BillCode

..... BilllD Number
..... Claim Type

..... Closed Reason Code

-

Reports Help

Claims Tab Contract by version charges and payments

Claims | Line ltems

| pows | vew | semss | |
Design View  Expor

28 records found

Contract # | Contract Version|  SUM Total Charges |  SUM Total Payments |

AETHA 1-7/1/2009 10 1275 150405.85 111,503.06 —
CIGNA PPO S-1/1/2013 10 12473 258,831.19 199,671.69

KHA MANAGED CAR1-1/1/201210 1275 1854270 223026

ORG1 - BCES 7-1/15%2013 1011 36,12278 42,347.08

ORG1 - BCES 4-115/2012 10 1/1 11,726.10 9,279.82

ORG1 - BCBS State |3-1/15/2013 t0 11 412,609.35 290,573.35

ORG1 - BCBS State |2-1/153/2012t0 11 209,574.68 156,993.48 -
L] [

Sort: () Current Page () All Pages | Export: (e Current Page ) All Pages Page of 1 | 8 5 ‘

% Applied Filters

Administrator's Guide
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Report shown in flat view

These tabs contain all of the data elements available for building reports. When building a report,
always select at least one item from Groupings and at least one item from Measures.

» Organizing groupings and measures

When organizing groupings and measures, you can use the provided folder structure or create your
own. You can customize the tabs by adding, deleting, and rearranging folders to organize the groupings
and measures data elements as you wish. The folder structure built by one user has no effect on any
other user, nor does how you choose to organize the data elements. However, data elements remain
within their designated tab, Groupings or Measures, and sort alphabetically within their folder.
Measures sort alphabetically first by standard measures, then by calculated fields.

To create a new folder:
1. Determine where the folder should be created.
e To create a main folder, click Groupings (or Measures), and then click Add New.
e To create a subfolder, first click the main folder, and then click Add New.
A new folder displays, prompting you to name it.
2. Type in the name and press Enter.

In the following image, Dates is a main folder containing two subfolders: Admit and Discharge.

Columns

Groupings Measures
+ Add Mew X Delete
E=-Groupings
[-[] Claim Tracking
|”_‘| Codes
ED Dates
| [ Admit
|’_‘| Discharge

To delete a folder:
1. Click the selected folder.

2. At the top of the tab, click Delete.

3. Inthe confirmation dialog, click OK.

NOTE: You cannot delete a folder with contents. Delete or move the folder’s contents and
then delete the folder.
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To move data elements between folders, do either of the following:
e Drag-and-drop the data element from its current location to the new folder.
¢ Right-click the data element, and click Cut. Then right-click on the new folder location, and click
Paste to move the data element.

E-Groupings
|’_‘| Claim Tracking E=-Groupings
[ Codes B[] Claim Tracking
E]D Dates |:| Codes
B Admit E][:| Dates
B1-[[] Discharge Bl Admit
..... Service B[] Discharge
MC|aim Max Serv Date C
..... Claim Min Seny  Cut E Aename
..... Import Date ...Claim Paste

About drill-down report fields

The following fields are used in drill-down reports.

NOTE: Users processing only professional claims will see the Pro Claims and Pro Line ltems tabs
instead of the Claims and Line Items tabs.

» Groupings

These fields display as a grouping of rows in the report, in column format. All information requested in
the report is totaled by the selected Grouping. In a report, the first grouping displays as the first column.
Any additional groupings selected are a subgroup of the first grouping picked.

Claims | Line ltems
| Admit Source Admit Type BillCode SUM Claims | SUM Total Charges |
Groupings

» Measures

These fields display as columns in the report.
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Claims | Line ltems

Admit Source Admit Type BilCode | SUMClaims |  SUM Total Charges
Measures

Three main functions are available to calculate a measure: sum, average, and count. You can also
choose to display the maximum or minimum value for the field.

Columns
Groupings Measures
+ Add New X Delete

B-Measures
-.Aamount Denied

...smount A Cut

..Amount LU SUM

AVG

..... Claims COUNT

...Coinsurar  MAX
-Contractu  pg|M
...Covered [

MO FUMCTION
..... Denied Ao

Measure names displayed in black text are standard measures in the system. Measure names in blue
text are user-defined calculated fields, as shown in the following example.

- Total OPPS EPay Copay
..Total Payments

-Act Pay %
LAetna Epay 1

Calculated fields are listed alphabetically beneath the standard measures in the folder they are saved in.
You automatically see calculated fields in your display. Calculated fields created by other users default to
the folder “Other Users’ Calculated Fields,” which is a subfolder of Measures.
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Columns
Groupings Measures
+Add New X Delete
E-Measures
[-Other Users' Calculated Fields

Calculated fields are used to create custom measures in the system. For instructions on creating
calculated fields, see Add calculated fields to a report.

» Add Filters

Use the Add Filters button to select specific criteria from the database to incorporate into a report. Note
that a filter is not required to run a report. However, if no filters are applied, the entire database is
queried.

The Add Filters button displays on the bottom right of the page when you open a drill-down report or
edit or create a drill-down report.

Add Filters

See Add an advanced filter to a drill-down report and the section on Editing and filtering drill-down
reports for more information.

» Claims/Pro Claims tab

The Claims/Pro Claims tab pertains to all information found on a claim. This information is only available
for claims filed and subsequently imported into Axiom Contract Management. The available Groupings
and Measures are provided in the Columns panel on the left side of the page.

Use the Claims/Pro Claims tab to report claim and contract information. You can generate reports to
analyze actual contract performance as well as expected profitability using expected payment
information. You can generate Detailed Tracking Reports (institutional claims only) to track

underpayment recoveries by payer.
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Reports Help

Columns ;
A Contractual Variance Report

Groupings Measures
+ Add New X Delete

[:] Claim Tracking 4

i Codes Design View  Export

Claims | | Line ltems

» Line Items tab

The Line Items/Pro Line Items tab provides details from the claim form at the line item level. Only
patients whose claims were filed and subsequently imported into Axiom Contract Management are
available. The available Groupings and Measures are listed in the Columns panel on the left side of the

page.

Use the Line Items/Pro Line Items tab to report on data at the line item level, including Revenue Code,
Service Date, and Quantity detail.

Columns

: A Contractual Variance Report
Groupings Measures
+Add New xDelete [ C1MS

E-Groupings Select groupings and measures from the left

» Applied Filters
The Applied Filters button is located at the bottom left of the page. The Applied Filters dialog displays all
of the filters applied to the current report.

¢ To display all the filters from the Claims and Line Items tabs that you selected to apply to the
current report (see the following example), click the up arrows on the Applied Filters button.

¥ Applied Filters
= Claims | Clear All
Filter Criteria Value
Discharge Date == 1/1/2017 AND <= 12/31/2017
Claim Type = INSTITUTIONAL 837 CLAIM

¢ To delete a single filter, click to the left of the value, and press the Delete key.

¢ To remove all filters, click Clear All on the right of the page. If no filters are attached to a report,
the system will search the entire database for results.
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Viewing drill-down reports

All saved reports are available when you first open Drill-Down Reports. The Category section on the left
side of the page contains the folders in which saved reports are stored.

NOTE: Drill-down reports are based on institutional claims unless your organization only has
professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples on this page
depict data from institutional claims.

» Open a saved report
To open a saved report:

1. In the Categories panel, click the folder where the report is stored.

2. Hover your cursor over the report name, and click View.

== | = [

S Drill-Down Reports
+ Add New
Axiom Reports Claims Management
* Claims Management ProClaims ChgAdj Review
* Department Denials Review for Claim Examples 2013
HTL Review for Claim Examples 2013 Astna

The report generates and opens.

After generating the report, you can edit it, change the design view, or export it to Excel. Building
and editing reports is covered in Building reports.

3. When finished viewing the report, to return to the main Drill-Down Reports page, in the menu
bar, click Reports > Open.

To open a saved report while working elsewhere in Drill-Down Reports:

1. Inthe menu bar at the top of the page, click Reports > Open.
You are taken back to the Drill-Down Reports opening page.
2. Click the folder in which the report is stored.

3. Hover your cursor over the name of the report, and click View.

» Open and close the Columns panel

When you open a saved report, the system generates the report and displays the results using the full
page. In this view, you do not see the Groupings and Measures tabs in the Columns panel because the
panel is minimized.
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To maximize the panel, click the arrow to the left of the results. In the following images, the one on the
right shows the bar the arrow resides on in blue. You can click anywhere on this bar to maximize and

minimize Columns panel.

Claims Tab Contract by version charge Claims Tab Contract by version charge
Claims Line Items Claims Line Items
| Rows | view | semgs | M Rows | vew | sewnos [
Design View  Export Design View  Export
Contract * Contract Version SUM Total Charges ! Contract Contract Version SUM Total Charges L
AETHA 1-71/2009 to 12/3 150,405.85 AETHA 1-7/1/2009 to 123 150,405 85
CIGNA PPO 5-1/1/2013 to 1273 258,831.19 CIGMA PPD 5-1/1/2013 1o 1274 258,831.19
KHA MANAGED CAR T -1/1/20712 to 1243 1884270 KHA MANAGED CAR T -1/1/2012 to 12/ 18,84270
ORG1 - BCES 5-11%2013t0 1N 56,12278 ORG1 - BCES 5-1/15%2013 1011 5612278
ORG1 - BCES 4-11520121 1N 11,720.10 ORGT - BCES 4-11520121 11 11,726.10
ORG1 - BCES State [3-1/13%2013 101N 412609.35 ORGT - BCBS State (3-1/15/2013 10141 412,609.35
ORG1 - BCBS State |2-1/15/201210 11 208,574.68 ORG1 - BCBS State (2-1/15/201210 111 209,574.68
ORG1 - Humana Gol{ 5-10/1/2012 10 9/3 84517943 ORGT - Humana Gol{ 5-10/1/2012 to 9/F 845179.49
ORG1 - Managed Mq 5-10/1/2012 10 9/3 321,033.81 ORGT - Managed Mg 5-10/1/2012 to 9§ 321,033.81
ORG1 - Medicaid 5-10/1/2012 10 9/3 2299 417.73 ORG1 - Medicaid 5-10/1/2012 to 93 2299 417.73
ORG1 - Medicaid SN[ 4-10/1/2012 10 9/3 76,501.02 ORGT - Medicaid SN| 4 -10/1/2012 10 93 76,501.02
ORG1 - Medicare S-10/1/20012 10 9/3 10,893,041.74 ORG1 - Medicare 5-10/1/2012 10 93 10,893,041.14
ORG1 - Medicare Co{ 3-10/1/2012 10 9/3 58,880.85 ORG1 - Medicare Co{ 3-10/1/2012 to 9/ 58,5689.85
\ | ORGT - Medicare HM 3 - 10/1/2012 to 9/3 35200 ORG1 - Medicare HM 3 -10/1/2012 to 9/F 35200
ORG2-BCES T-1/15/20131t0 11 308,741.08 ORG2-BCBS T-115/201310 11 308,741 .06
ORG2-BCES B-1/1%2012t0 11 270, 74281 ORG2-BCES 6-1/15%/201210 11 270, 74281
ORG2-BCES State [3-1/1%2013 1011 4215268 ORG2-BCBS Swate (3-1/15/201310 11 4218268
ORGZ - BCES State |2-1/13%20121t0 11 17,5656.43 ORGZ- BCBS State (2-1/15/201210 11 17,568.43

Likewise, while working with a report, you can minimize the Columns panel by clicking on the same bar,

as shown in the following example.
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Reports Help

Columns . .
: Claims Tab Contract by version charg
Groupings Measures
+ Add New X Delete Claims | Line ltems
Bl Claim Tracking
B[] Codes Design View  Export
+]..[ 7] Dates
- Contract * Contract Version SUM Total Charges
Bl-[JICD Codes
AETHA 1-7/1/2009 to 12/3 150,405.85
B[] User Defined
. CIGNA PPO 5-1/1/2013 to 1243 258,831.19
.dmit Source
. KHA MANAGED CAH 1 -1/1/2012 to 1243 1834270
.Admit Type
_____ R DRGI - BCBS 5-1/15/2013 ta 1/1 5612278
_____ BillCode DRGI - BCES 4-1/15/201210 111 11,726.10
_____ BilllD Number DRG1 - BCBS State |3-1/15/2013 10 1/1 412,609.35
_____ Claim Type DRG1 - BCBS State |2-1/15/2012 10 1/1 209,574.68
..... Clozed Reason Code ORG1 - Humana Gal{ 5 - 10/1/2012 to 9/ B845,179.43
..... Color DRG1 - Managed Md 5 - 10/1/2012 to 9/3 321,033.81
..... Contract ORG1 - Medicaid | 5-10/1/2012 to 9/F 229941773
..... Contract Clause DRGT - Medicaid SN| 4 - 10/1/2012 to 9/3 76,501.02
----- Contract ClauseDesc DRGI - Medicare | 5-10/1/2012 to 9/3 10,893,041.14
----- Contract Provision DRG1 - Medicare Co{ 3 -10/1/2012 to 9/3 58,859.85
----- Contract Version [ | DRG1 - Medicare HM 3 - 10/1/2012 to 9/3 35200
..... Denial Category N |oRG2-EBCES 7-1/15/2013 10 111 308.741.06
""" Denial Reason Code ORG2 - BCBS 6-1/15/2012 to 1/1 370,742 81

Building drill-down reports

Use the New Report page in Drill-Down Reports to create new drill-down reports. To update existing
reports, see Editing and filtering drill-down reports.

Build a new drill-down report

Use these instructions for building a new drill-down report. Creating a report that has filters, and saving
it in the drill-down interface, saves the advanced filter.
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NOTE: Users processing only professional claims will see the Pro Claims and Pro Line Items tabs
instead of the Claims and Line Items tabs on the New Report page. Likewise, Groupings and
Measures available will be specific to those used for professional claims instead of institutional
claims.

To build a new report:
1. Navigate to the Drill-Down Reports page.

2. Do one of the following:
e Near the top of the page on the right, click Create New Report.

¢ In the header menu, click Reports > New.

Reports

Mew...

Download Report
Report Sets

Standard Reports ¥

3. Of the tabs on the right side of the page (Claims, Line Items, for institutional claims; ProClaims,
ProlLineltems for professional claims), click the tab for the type of data being retrieved. The
Claims and Line Items tabs contain information found on the patient’s UB04 or 837 claim forms,
and reside within Axiom Contract Management.

e e

New Report

Claims  Line ltems

Select groupings and measures from the left

Data View: (®) Hierarchical Flat

On the left side of the page are two tabs, Groupings and Measures.

NOTE: You must select at least one parameter from each tab to generate and display a report.

4. On the left side of the page, in the Groupings tab, click the plus sign (+) to expand any folders as
needed to locate report groupings options.
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Columns
Groupings Measures

+ Add Mew X Delete
E-Groupings
I:I Claim Tracking
EII:I Codes
- Condition Codes
I:I Occurrence Codes
I:I Occurrence Span Codes
I:I Value Codes
=[] Dates
(3 Admit
I:I Discharge

----- Claim Max Serv Date

[y

----- Claim Min Serv Date

----- Import Date

5. Double-click a groupings option to add it to the report. When added, that option displays on the
right side of the page above the Generate button, as shown in the following example. Select more
row groupings if desired.

NOTE: If you select more than three groupings, only the first three display when you generate
the report in hierarchical view. All groupings display when you generate a report in flat view.

T

New Report

Claims | Line Items

Generate Data View: (®) Hierarchical () Flat

6. Click the Measures tab, expand any folders as needed, and then double-click the desired
measures, one at a time, to add them to the report. If you do not see the measure you need, you
can create one. See Add calculated fields to a report.

¢ To add a measure to the report as SUM of that measure, double-click the measure.

* To add a different calculation, right-click the measure, and select a calculation option from
the menu as shown in the following example.
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El-Measures
E _..Amount Denied

-Amount Identified

~Amount Recovered

~Amount Unrecoverable
é...BaIaﬂce Due

;...Cases

;...Clai'“"

-...Coil Cu
5...[3-::”1 SUM
?...Cov AVE
...Den COUNT
MAX
MIN

NO FUNCTION

Len
. Life
:. Mo
. 0Orig

i...Percent of Medicare

When you chose the calculation option for the desired measure, the selected measure
displays to the right of the selected grouping. This is the order in which the columns in the
report display. You can rearrange them or delete a grouping or measure before or after
you generate the report if you change your mind.

e e
New Report
Claims | Line ltems
| Track Status ‘ SUM Contractual Variance SUM Claims

Generate Data View: (®) Hierarchical Flat

e To remove any selected options from the report before generating, right-click the option,
and select Delete.

e To rearrange report columns, drag and drop the columns to the desired order. In the
following example, the user drags the measure COUNT claims to the middle row. The red
arrows show where the measure label will start, which in this example, is after Payer Code:
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T

New Report

Claims | Line ltems

¥
Payer Code COUNT[claims | COUNT Claims
Data View: Hierarchical (® Flat

7. Inthe Data View section to the right of the Generate button, select the report grid type:

» Hierarchical — Select this option to display the report with grouping columns arranged in a
hierarchy.

e Flat — Select this option to display the report with grouping columns arranged side-by-side.

8. Click Generate.

9. If desired, save the report so you can use it later.

Add calculated fields to a report

If you need a measure that does not exist, you can build a calculated field. You create calculated fields

by choosing current measures and creating expressions with mathematical functions to calculate the
desired results.

To create a calculated field:

1. Open the drill-down report to which you want to add a calculated field. If you are creating a new
report, select the tab for the type of report (e.g., Claims or Line items).

2. Inthe menu bar at the top of the page, click Reports > Create Calculated Field.

The New Calculated Field dialog opens.

NOTE: You cannot use a calculated field in an equation for another calculated field.
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New Calculated Field x

Description: New
Filters

* Mot using Using

Measures Expression
CARCT Amount

CARCT Units

CARC2 Amount

CARC2 Units

CARC3 Amount

CARC3 Units

CARC4 Amount

CARC4 Units

CARCS Amount

CARCS Units

CARCE Amount

CARCE Units

Total Lime Adjustment Amc ™

Clear All Functions Save

Close

3. Do one of the following:

e To use filters from a saved report, click the Using option and then select a report from the
drop-down list. Reports available in this list are based on the tab that you are on when
building the calculated field. A calculated field on the Claims tab can use only the filters
from other Claim reports.

NOTE: Using the filters option limits the calculated field to only the claims found in the
selected saved report. For example, to compare pediatric claims to all claims, you need
to create a calculated field for SUM(claims) with a filter from a report limited to

pediatric claims. You can select only one report to apply as a filter to a calculated field.

However, the report used for the calculated field can contain as many filters as you
need.

¢ |f you do not want to use a filter, leave the default Not using selected.

4. Build the expression by selecting measures from the Measures list on the left:

a. Click the desired measure, and select the desired function from the list of available

functions. The measure is added to the Expression box. Now you need to add an operator
or mathematical symbol.
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New Calculated Field x

Description: New

Filters
Mot using (®) Using | Inpatient v|
Measures Expression

Amount Denied
Amount |dentified
Amount Recovered

Sum([Amount Becovered])

E—
Balance Due Sum
Cases
Claims
Coinsurance Days| Count
Contractual Variar]

Avg

Covered Days Max
Denied Amount Min A
Length Of Stay
Lifetime Reserve [ Variance
Stnd Dev Clear All Functions Save
MNone

b. Click the Functions button to select the desired operator, or, for a mathematical equation,
use the mathematical symbols on your keyboard (+ - / *) for add, subtract, divide, and
multiply, between your measures to string them together.

NOTE: Do not use special characters, such as dashes and slashes, in a calculated field
name.

TIP: If you make a mistake with the expression, click Clear All and start over.

c. Add the next measure and symbol, as needed, until your expression is complete.

TIP: If you know the complete expression, you can type it into the Expression box
manually instead of selecting Measures and Functions from the menus.
d. Click Save.

e. Inthe Save As dialog, select a location to store the measure on the Measures tab, and then
in the Name field, type a name for it.

f. Click Save and Return.

The new measure name displays in blue text on the Measure tab in the folder you
selected. The name becomes a column header when added to a report.

Edit or delete a calculated field

Use these instructions for managing your calculated fields.
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To edit a calculated field:

1. Inthe Columns panel, click the Measures tab.
2. Inthe Measures list, right-click the desired calculated field, and select Edit Calculated Field.

3. Inthe Edit Calculated Field dialog, do any of the following as desired:

e To clear the entire expression in the Expression box, click Clear All and then rebuild the
expression.

¢ To replace part of the expression, use the backspace key to remove the part you want.

¢ To add a measure, in the Measures list, click the desired measure, and select the
calculation type from the pop-up menu.

¢ To add an operator between measures, type a mathematical symbol (+ - * /) or click the
Functions button, and select a function.

Edit Calculated Field x

Description: TotalChargeMinusPayment
Filters

#) Mot using Using

Measures Expression

Amount Denied Sum([Total Charges])-Sum([Total Payments])
Amount Identified
Amount Recovered
Amoun
Balance
Cases Avg
Claims

Coinsuf  CoUNt

Sum

Contraqg Max

Covereq

Denied | Min

Length| .

Lifetim¢ *anance 7

Stnd Dev

Clear All Functions Save

None Save As

Close

4. Do one of the following:

e To save the measure as a new measure, click Save As and then, in the Save As dialog,
select a location for the measure. In the Name field, type a new name. Click Save and
Return.

¢ (Click Save.

To move a calculated field:
1. Right-click the calculated field, and select Cut.

2. Select the desired location / folder in the Measures tab, right-click and select Paste.

TIP: You can also drag and drop calculated fields to different locations in the Measures tab.
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To delete a calculated field:
1. Inthe Measures tab, right-click the calculated field, and select Delete.

2. Inthe confirmation dialog, click OK.

NOTE: You cannot delete calculated fields that are attached to a report.

Add an advanced filter to a drill-down report

Use these instructions to add filters while building or viewing a drill-down report. Filters enable you to
select data more precisely from the database for your reports.

To add an advanced filter:
1. Open the drill-down report in Design View or, on the bottom right of the page, click Add Filters.

2. To change the type of filter you are applying, click the Filter by drop-down, and then make a
selection (see the following example). Each type has various field categories that group together
similar data elements.

Advanced Filters

Filter by:

|Claims Eh

Fields

w-Demographic

#-Codes
#-Physicians
@-Diagnostics

m Procedires

3. Inthe Fields section, click the plus symbol (+) next to the field category to view the available filter
criteria.

Filters that contain a limited set of values display in a library list like the following example:
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Advanced Filters x

Filter by:
|Claims v |

Fields

#-Demographic ICD Proc Code 01
H-Codes
[
[

5.Physicians Filter [ *NOT" [Defaur]

i-Diagnostics Field Value
=-Procedures ] [ NoCode - No Description - |:|
CD Proc Code 01 [CJ | 00.01 - Ther Uit Head & Neck Ves Check ltems

CD Proc Code 02 [CJ | 00.02 - Ther Ultrasound Of Heart
CD Proc Code 03 0

CD Proc Code 04 0

||| 00.03 - Ther Uit Peripheral Ves | |

|| | 00.09 - Other Therapeutic Ultsnd

Check Range
ICD Proc Code 05 ||| 00.10 - Implant Chemothera Agent
CD Proc Code 06 [_]| 00.11 - Infus Drotrecogin Alfa Check All
&-Measures | 00.12- Adm Inhal Nitric Oxide
m-Attributes (| 00.13 - Inject/infus Nesiritide Uncheck All
||| 00.74 - Injection Oxazolidinone
(| 00.15 - High-Dose Infusion 112 Use These

]| 00.16 - Pressurized Treat Graft -

Filters that contain too many values for a library list display parameter condition options from
which you can narrow the set of values to a single item or a set. The following example shows a
range of dollar amounts for Balance Due:

Advanced Filters x

Query Name: Filter by: Save To:

| | [claims M Save & Exit |/3rd here M
Fields:

Demographic = Balance Due

) -Codes

@-Physicians Balance Due| >=_v|[s5000 || [ano_+] Use These
# Diagnostics Clear
#-Procedures Balance Duel] <= VH1000 00 | ‘AND V|

E-Measures

Amount Denied

Balance Due | = v

-.Amount Identified
--Amount Recovered
--Amount Unrecoverable

-|Balance Due
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» To search for filter values:
Do any of the following as needed:
© Scroll down the list until you find the desired value.

° If you know the exact value you want, type it into the field above the table and then
click Filter. The list is filtered to items that match.

© Use the wild card feature. If you do not know the exact value for the filter but you
know part of the value, in the Check Items field, type the percent (%) symbol in the
field along with a known portion of the number/text, and then click Filter. For
example, to find a certain ICD Procedure number that relates to the heart, type
“%heart.” The system provides all the ICD Procedure codes that include the word
“heart” in the description.

Advanced Filters x

Filter by:
Claims v
Fields
m-Demographic ICD Proc Code 01
m-Codes
Bl-Physicians I“‘L‘“ee"I I Filter "NOT" [Default]
B Diagnostics Field Value
El-Procedures 00.02 - Ther Ultrasound Of Heart |:|
‘ CD Proc Code 01 33.6 - Comb Heart/Lung Transpla Check Items
ICD Proc Code 02 35.20 - Replace Heart Valve Nos
\CD Proc Code 03 #| | 35.70 - Heart Septa Aepair Nos | |
;““‘CD Proc Code 04 35.95 - Heart Repair Revision Check Range
ICD Proc Code 05 35.96 - Perc Heart Valvuloplasty
+-ICD Proc Code 06 ##| | 35.98 - Other Heart Septa Ops Check All
E-Measures 35.99 - Other Heart Valve Ops
w-Attributes 36.39 - Oth Heart Revasculer Uncheck Al
36.99 - Heart Vessel Op Nec
37.10 - Incizion Of Heart Nos
37.21 - Rt Heart Cardiac Cath -

4. To select filters to apply to the report:

e For values presented in a library list, in the Field Value table, select the check box to the
left of the filter name, or select the value or range of values using the Check Items or
Check Range fields.

¢ To exclude one or a few of the values, select those values and then, on the right, select the
“Not” [Default] check box.

¢ To set parameter conditions, first select a comparison operator (>, <, =, >=, <=, <>), then
type the beginning range value in the corresponding field. Next, select, the logical operator
(AND, OR), and then the end range value in the corresponding field. To select all values
that equal a specific value, are above or below a specific value, select the comparison
operator and then enter the value in the field as shown in the following example:
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Amount Denied

$100.00 Use These
Clear

Amount Denied

Amount Denied

Amount Denied

e For fields that require setting dates, select one of the following:
© Absolute Dates (default) — Use to set a date range or an exact date.

° Relative Dates — Use to set a general time frame such as YTD (Year to date),
LastNMonths, etc. From the drop-down, select the relative time frame, then, in the
field, enter the number of days/months/quarters, etc., as applicable.

Advanced Filters X

Filter by
Claims v |

Fields
=-Demographic Admit Date
Admit Date

. Admit Day of Week
. Admit Fiscal Qtr LastNMonths v|4 Use These

O Absolute Dates ® Relative Dates

_.Admit Fiscal Year Clear
Admit Fiscal Yr-Qtr

.. Admit Hour

_..Admit Month

..Admit Source

. Admit Type

¢ To clear all selections and start over, click Uncheck All.
5. Each time you select a value, click Use These to add the value to the filter.

6. To view the list of applied filters, at the bottom left of the dialog, click Applied Filters. From here,
you can delete any filter criteria that you decide not to use: to remove a value, select the row by
clicking the blue square at the beginning of the row, then press the Delete key.

7. To save your filter selections, click Save & Exit.

8. After adding all of the groupings and measures to the design view and applying the filters, click
Generate to view the report.
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Claims

Line Items

| Rows | Vew | sewmgs | |
Design View  Export

| Contract ¥ | SUM Cases SUM Total Charges SUM Contractual Variance
] | ORGT - Medicaid 1,627 7,219,909 -667,567
[l | ORGT - Medicare 1,934 12147,566 -343,088
[l | 0RG2 - Medicare 342 1,421,388 -275,704
[ | oRG2 - Medicaid 774 1,623,800 -39.848
] | DRGT - BCES State 65 426,854 -14,008
] | DRG2 - BLES State 22 86,225 -12,933
[ |oRG2-BCES 44 136,320 -6,544
] | 0RG4 - Medicare HMO Other 168 707,892 51,697
[ | ORGT - Humana Gold Choice 27 867,323 84,349

Save a drill-down report

Saving a drill-down report saves all of the selected groupings, measures and filters, and any changes to
the report format or layout.

NOTE: Users processing only professional claims will see the Pro Claims and Pro Line ltems tabs
instead of the Claims and Line Items tabs on the New Report page. Examples in this help topic depict

data from institutional claims.

We recommend that you save the report while viewing the report layout. This ensures that the report is

saved as the correct type (Claims or Line Items for institutional claims; Pro Claims or Pro Line Items for
professional claims).
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Reports Help

New Report

Claims | Line ltems

| Fows | vew | sewns |
Design View  Export

Admit Source ~ Admit Type BillCode SUM Claims SUM Total Charges
9 - Information Mot Available 2 - Urgent 13 30.00 847394
9 - Information Not Available 2 - Urgent 132 4.00 1,177.00
9 - Information Mot Available 2 - Urgent m 6.00 106,079.30
9 - Information Mot Available 1 - Emergency 851 149.00 104,694.95
9 - Information Mot Available 1 - Emergency as7 1.00 58331
9 - Information Mot Available 2 - Urgent 87 1.00 10,370,100
9 - Information Mot Available 2 - Urgent 851 3.00 833.00
9 - Information Mot Available 2 - Urgent 14 57.00 11,953.00
9 - Information Mot Available 2 - Urgent 133 24.00 8,883.00
9 - Information Mot Available 2 - Urgent 134 4.00 TE85.00
9 - Information Mot Available 1 - Emergency 137 15.00 26,220.92
9 - Information Mot Available 1 - Emergency 14 63.00 12,392.00
9 - Information Mot Available 1 - Emergency 132 200 429.00
; 9 - Information Mot Available 1 - Emergency m 3.00 24,485.16

Report layout view (shows institutional claims)

To save the report:
1. Inthe menu header at the top of the Drill-Down Reports page, click Reports > Save.

Reports Help

MNew...

Open...

Save

Claims | SUM Total Charges |

Create Calculated Field...

Download Report
Data View: (#) Hierarchical () Flat

Report Sets

The Add New Report dialog opens. The Tab field defaults to the Report tab that you were on
when you saved the report.

2. Inthe Folder field, select the folder in which to save the report.

3. Inthe Name field, type a unique name for the report. Give the report a name you can easily
remember and identify later.

NOTE: When naming a report, do not use special characters such as dashes or slashes.
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4. If desired, in the Description field, type a detailed description of the report.

Tah: Line ltems
Folder: | Line ltems v|
Name: |HE"-.-' Code line items |

Description: |Rey code line items charge

Save Cancel

5. Click Save.

You can continue to work on the report and either save the changes or select Save As to save as a new
report with a new name.

Export a drill-down report

Use these instructions to export a copy of drill-down report results to Microsoft Excel, which transfers
the report into an Excel spreadsheet.

The system defaults to Export Row State (Expanded or Collapsed) and Export Filter Information. If you
do not want to export any of these features, highlight and click the desired setting to clear the check
mark.

To export a drill-down report:
1. Generate the report.

2. In menu header above the report results, click Settings > Export to Excel, and then select the
following as desired:
¢ Toinclude the ability to expand entire row levels at a time, click Export Row State
(Expanded/Collapsed).
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¢ Toinclude a list of filters applied to the report in the report results, click Export Filter
Information.

¢ To verify your selections, click Settings > Export to Excel The option(s) you selected should
have a check mark to the left, as shown in the following example:

-m_
Export to Excel W K
Ded__ p : Export Row State (Expanded/Collapsed)

— | Export Filter Information

3. Below the dark gray menu header, click the blue Export link.

Shors | v | s |

| Admit Source v|a SUM Claims SUM Total Charges
1|71 - Physician Referral 511,574.00 1,132,928,386.57
[ | 2 - Clinic Referral 7.191.00 4,446,587.16
[] | 4 - Transfer From Hospital 3.647.00 38,739,838.81
[ | 5 - Transfer From SMF 3,338.00 11,237,691.09
[_] | & - Transfer From Anaother Facility 256.00 2,366410.08
Cl|7- Emergency Room 16,924.00 TTADT.543 86

The report generates. This may take several minutes if the report is long.

The report file downloads to your computer, and a link to the file displays in the bottom left
corner of the page, as shown in the following example.

4
[T

Denials by Payer_Tl..xlsx

4. At the bottom of the page, click the Excel file to open it.

The following example shows a report generated in hierarchical view that was exported with the
options Export Filter Information and Export Row State (Expanded/Collapsed) selected.

The applied filters export as a collapsible list above the report results, for reports in flat view and
in hierarchical view (see list outlined in red in the following example).
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Each report level has its own expand/collapse button () to the left, which you can use to

expand and collapse report sections.

On the left, above the list of filters, is a row of numbered squares (outlined in blue in the
following example). Use these buttons to expand/collapse all rows of the level that corresponds

to each button.

Denials Trending by Bill ID_1063 (1).xlsx - Excel

Home  Inset  Pagelayout  Formules  Data  Review  View @ Tell me what you want to
O H E i 9- ¥ X B R B E B XE-E-
F762 = F
1]12]3 A|B C D E F G H I
L é axiomsoftware  Denials Trending by Bill ID
2
3 3 |Filters
o 4 Claims:
5 Contract = ORG1 - Medicaid
6 Denial Category = 16 Lacks Billing Information
7 Discharge Date >=10/1/2013 AND <= 3/31/2014
g
9 Disch Yr-Month SUM Cases SUM Total Charges SUM Total Expected Paymentl SUM Balance Due | Patient Responsibility| SUM Contractual Variance
,_:_‘ 10 | 2013-100ct 166 968,514 222,700 42,216 (35,266 (6,951)
- 11 Denial Reason Code SUM Cases SUM Total Charges SUM Total Expected Payment1 SUM Balance Due | Patient p ibility| SUM Contractual Variance
12 :N3 Missing Consent Form 7 68,652 18,077 13,736 (51,078) 37,342
- 13 BilllD Number SUM Cases SUM Total Charges SUM Total Expected Paymentl SUM Balance Due | Patient Responsibility| SUM Contractual Variance
- 14 45 1 11,566 3,418 3,308 (10,580) 7,272
- 15 1 11,365 2,630 2,630 (11,365) 8,735
- 16 1 10,634 2,630 2,630 (10,634) 8,004
- 17 1 9,506 2,598 2,508 (8,926) 6,417
- 18 1 9,893 2,630 29 0 (29)
- 19 1 9,573 2,630 2,630 (8,573) 6,943
- 20 C921391452 1 6,115 1,540 0 0; (0}
-2 7 68,652| 18,077 13,736 (51,078) 37,342
[+] 22| :N30Patient neligible for this 12 60,815 15,648 4,997 2,028 (7,025)
E‘ 37 MAGG Invalid Principle Proced 5 2,110 539 198 0 (198)
E‘ 45 MA130 Incomplete or Invalid I 56 539,270 103,172 (3,196) 7,686 (2,489)
EI 104 MA30 Invalid Type of Bill 1 2,523 772, 772 (2,525) 1,752
[+] 108 ims1invalid Procedure code 35 275,141 84,491 27,709 8,624 (36,333)
| - 196, 166 968,514 222,700 42,216 (35,266) (6,951)
+] 197|2013-11Nov 163 772,733 217,764 51,617 15,806 (67,423)
E 381|2013-12Dec 86! 430,233 128,534 52,897 5,391 (58,288)
[+] 485|2014- Lian 96 604,691 172,658 47,708 (8,279) (39,432)
[+] 605/2014- 2Feb 48 378,538 87,006 27,406 (15,605) (11,801)
E 6772014~ 3Mar 53 486,149 146,742 53,421 (6,857) (46,564)
757, 612 3,640,857 975,404 275,266/ (44,806) (230,450)

5. To view report details, do any of the following:

* To expand/collapse individual rows, click that row’s buttons ( /E).

®* To expand all level 1 sections, click the second square ) in the row.

® To expand all levels, click the last square in the row, which is the third square () in the
example.

® To collapse all expanded sections, click the first square ().

Editing and filtering drill-down reports

Drill-down reports are interactive, allowing you to filter the report to display only what you want.
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Report filtering options

Several buttons, icons, and drop-down menus display in rows above the gray shaded field names on a
generated report. These functions allow you to further edit the report.

» Limit button

The Limit button sets additional report filters. For example, to display results for Emergency and Urgent
only, select the check boxes to the left of their names, and click Limit.

Chos | v | s |

| Admit Source v|a SUM Claims SUM Total Charges
[##] | 1 - Physician Referral 511.574.00 1,132.928,386.57
[#] | 2 - Clinic Referral 7.191.00 4.446,587.16
[l |4 - Transfer Fram Hospital 3.647.00 38,759,838.81
[ |5 - Transfer Fram SNF 3,338.00 11.237,681.09
1 | 6 - Transfer From Anather Facility 256.00 236641008
Cl7- Emergency Room 16,924.00 T7ALT 54386
[[]| 8 - Court/Law Enfarcement 8.00 2143331
[[] |9 - Information Not Available 3,745.00 10,073,730.45
[LJ | A - Transfer From CAH 6.00 108,206.3%
[[J | D-NO DESCRIPTION 90.00 854,005.39

This sets these Admit Type selections as an additional filter. They will be the only results displayed:

| Rows | View | Semwmgs |
Design View  Expont

| Admit Source v|a SUM Claims SUM Total Charges
1|1 - Physician Referral 511.,574.00 1,132,928,386.57
[) | 2- Clinic Referral 7.191.00 4,446,587.16

To remove applied limits, see Remove an applied filter.

» Rows menu

Use the Rows menu to make selections from the results. For example, if you sorted charges in
descending order to reveal the Admit Sources with the most charges and you are only interested in the
top five Admit Source, click Rows > Select > First 5, which selects the first five names displayed.
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select > o View  Export

Expand All First 5

Collapse Al Next & v|a SUM Claims SUM Total Charges
1|7 -Physig None 211.,574.00 1,132,928,386.57
)| 2- Clinic Inverse T.191.00 4446,587.16
[l | 4- TransferFrom AoEptal 3.647.00 38,759,838 81
[ | 5- Transfer From SNF 3,338.00 11.237,691.09
[l | & - Transfer From &nother Facility 256.00 236641008
C|7- Emergency Room 1692400 TrA0T.543 86
[[] | 8 - Court/Law Enforcement 3.00 21,4333
[ |9 - Infermation Mot Available 3,745.00 10,073,750.45
[ | A- Transfer From CAH 6.00 108,206.33

¢ To display the top ten, go back to Rows > Select > Next 5, which selects the next five Admit
Sources listed.

¢ To display only the top four Admit Sources:
a. Select Rows > Select > None; this clears all of the selected Admit Sources.

b. Manually click the top four in the report. When all desired Admit Sources are selected,
click Limit to remove all of the non-selected Admit Sources from the view, displaying only
those selected.

| Rows | View | Semmgs | |
Design View  Export

| Admit Source v|a SUM Claims SUM Total Charges
[ |1 - Physician Referral 511,574.00 1,132,928,386.57
[ | 2- Clinic Referral 7,191.00 4.445,587.16
[] |4 - Transfer From Hospital 3.647.00 38.759.838.81
[[] | 5- Transfer From SNF 3,338.00 11.237,691.09

NOTE: When you select and limit rows of data from the results, this information is set as a
filter, which is then visible in the Applied Filters dialog. If you make an error, open the Applied
Filters dialog, and remove the new filter.

You can also use the Rows menu to expand and collapse sub-grouped rows when a report uses multiple
groupings.
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» View menu

Change the grid type between Hierarchical and Flat. This is the same as selecting Flat view or
Hierarchical view when viewing the report in design view.

Claims | Line ltems

| Rows | view | semngs |

Grid Type * | Flat

v Hierarchical
[ I T - =

For examples of how to use these views, see Add a grouping as a subtotal.

» Settings menu

Use this menu to set the formatting for reports exported to Excel.

For instructions on exporting a report using this menu, see Export a drill-down report.

» Design View

Design View is report-building view. In Design View, you can add, delete, or rearrange the groupings and
measures in a report. Although the following example shows a new report, you can edit existing reports
in Design View. For instructions, see Change report column order.

New Report

Claims | Line [tems

| Admit Source | BilllD Number SUM Claims SUM Total Charges

Groupings and measures are added to the system in the order they were selected, with groupings
placed before measures. However, you can change the order of groupings and measures at any time
(groupings still order together before measures). For instructions, see Change report column order.

Sort report columns and rows

When building a report, you can easily sort and rearrange report columns.
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After generating a report, you can modify the results using various functions. For example, you can alter
or sort data, add or delete additional rows or columns, or continue to drill down into the report to view
more specific results.

NOTE: Drill-down reports are based on institutional claims unless your organization has only
professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples in this help
topic depict data from institutional claims.

As an example, the following image displays partial report results using the following criteria:

¢ Filter: DRG =291, 292, 293
¢ Grouping: Admit Source

¢ Measures: Sum Claims, Sum Total Charges

| Rows | View | sewngs |
Design View  Export

| Admit Source v|a SUM Claims SUM Total Charges
[ |1 - Physician Referral 511,574.00 1,1325928,386.57
[ 2 - Clinic Referral T.191.00 4.446,587.16
[ | 4 - Transfer From Hospital 3.647.00 38,759,838.81
[_] |5- Transfer Fram SNF 3,338.00 11,237,6591.059
[l | &- Transfer From Another Facility 256.00 2.366.410.08
[]7- Emergency Room 16,924.00 TrAlT,543.86
[ |8 - Court/Law Enforcement 8.00 21,4333
[ |9 - Information Not Available 3.745.00 10,073,730.45
[ | A- Transfer From CAH 6.00 108,2068.3%
] |D- MO DESCRIPTION 90.00 854,005.39
[C] | E- MO DESCRIPTION 52.00 41,9781
[_] |F- MO DESCRIPTION 5.00 2173.00
[l | MoCode - Mo Description 197.00 5601727
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To sort report columns:

¢ Click one of the gray report column headings. A small up or down arrow displays to the right of
the column name to indicate the column is sorted in either ascending or descending order.

Shon | Ve | s

| Admit Source v | sum claims[x] SUM Total Charges
[ |1 - Physician Referral 511,574.00 1,132,928,380.57
|7- Emergency Room 16,924.00 TTADT,543 86
[] | 2 - Clinic Referral 7.191.00 4.446,587.16

¢ You can also sort columns by right-clicking a column heading and selecting Sort, and then from
the pop-up menu, selecting Ascending or Descending.

Shors | e | s |

| Admit Source v | SUMCaimese | o

[1|1 - Physician Referral s ? | Ascending

[ |7 - Emergency Roam Decimal Places ? | Descending

(] | 2- Clinic Referral Delete 4446,587.16
[[] | 2 - Information Not Available 3,745.00 10,073,730.45
[l | 4- Transfer From Hospital 3.647.00 38,759,838.81
[l | 5 - Transfer From SNF 3,338.00 11.237,691.09
[l | & - Transfer Fram Anather Facility 256.00 236641008
[l | MoCode - Mo Dezcription 197.00 5601727
Ll m sin mEcrmunmine [ T o 1n1 OC A NNc 90N
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¢ Right-click a measure heading to get the same options, and to select a decimals option which,
when highlighted, lets you adjust the number of decimal places displayed in your data, as shown
in the following example.

| Rows | View | sewngs |
Design View  Export

| Admit Type |~ SUM Claims Sm' == -|Charges

|1 |7 - Emergency a1, £ GAG 8T 77
[ |2 - Urgent 3 Decimal Places ¥ | o5 |
[l |3 - Elective 425] Delete 1 07 |
] |4 - Newborn 2,856.00 2 E

3

4

5

b

T

8

9

10

Add a grouping as a subtotal

NOTE: Drill-down reports are based on institutional claims unless your organization has only
Professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples in this help
topic depict data from institutional claims.

When you build a report with more than one grouping, the system subtotals the second grouping
underneath the first. For example, to see all of the Bill IDs associated with each Admit Source, double-
click the Bill ID field in the Groupings tab. The system displays the following:

| Admit Source | BilllD Number SUM Total Charges SUM Claims

After generating, the report displays a plus symbol (+) to the left of the check box in each row:
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Shors | e | sewge |

| Admit Source v |~ | SUM Total Charges SUM Claims
1|1 - Physician Referral 1,132.928,386.57 511,574.00
[ | 2 - Clinic Referral 4446,557.16 7.191.00
[ |4 - Transfer From Hospital 38,759,838.81 3.647.00
[[] | 5- Transfer From SNF 11,237,691.09 3,338.00
[ | & - Transfer From Anather Facility 2.366,410.08 256.00
]7- Emergency Room TrA0T.543 86 16,924.00
[C] | 8 - Court/Law Enforcement 21,4333 &.00

To display all of the rows that subtotaled under a field value, click the plus symbol (+). You can sort or
delete these subtotaled rows, as well as sort the columns.

T

| [ [Admit Source v/~ |  SUMTotal Charges | SUM Claime
= |D |1 - Physician Referral | 4,887,309.99 | 1.460.00
BilllD Number #~ SUM Total Charges SUM Claims
E C921371776 2,400.00 1.00
E |coz1372286 403530 1.00
H |coz1372549 371448 1.00
E C921372876 241400 1.00
E 921372910 3,398.29 1.00
H |coz1373280 471982 1.00
H |coz1373020 484279 1.00
E 921374071 4,647 63 1.00
E 921374832 2967.28 1.00
H |co21375331 445293 1.00
E |co2137504 4,367.00 1.00
E C921375966 3,993.03 1.00
E C921376241 4,166.78 1.00
E |coz1376507 478881 1.00
E |coz21376830 3475.00 1.00
H |coz1378303 438172 1.00
E C921379512 250882 1.00
E 921380490 3,189.44 1.00
E |coz1380586 3,031.00 1.00
H |co21380904 282931 1.00
y

| ] 4,887,309.99 1,460.00
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When building reports with multiple groupings, the system defaults to the Hierarchical view as seen in
the previous image. This is one of two views available for displaying data. The other is the Flat view. The
Flat view displays groupings side-by-side, as shown in the following example.

| fows | wvew | genos [ |
Design View  Export

Admit Source ~ BilllD Number Disch Fiscal Yr-Month SUM Total Charges SUM Claims
1 - Physician Referral 921387567 FY2010- 8Aug 2,400.00 1.00
1 - Physician Referral C921387164 FY2010- 7Jul 2,123.00 1.00
1 - Physician Referral C921386995 FY2010- 8Aug 4,183.20 1.00
1 - Physician Referral C921388294 FY2010-7Jul 4337.05 1.00
1 - Physician Referral C921387914 FY2010- BAug 3,637.33 1.00
1 - Physician Referral €921387896 FY2010- 7Jul 411358 1.00
1 - Physician Referral C€921385112 FY2010- 8Aug 4,556.65 1.00
1 - Physician Referral C921383862 FY2010- 7Jul 372072 1.00
1 - Physician Referral £921283415 FY2010- 7Jul 2,149.18 1.00
1 - Physician Referral C921386390 FY2010- 95ep 2,880.00 1.00
1 - Physician Referral 921385992 FY2010- 7Jul 4,000.00 1.00
1 - Physician Referral 921385974 FY2010- 8Aug 2,838.00 1.00

NOTE: Reports with more than three groupings must be run in the flat view. Also, while the
hierarchical view subtotals the groupings, the flat view does not provide totals.

To change from the default Hierarchical view to the Flat view, do one of the following:

¢ Before clicking Generate to run the report, instead, for Data View, click the Flat option.

| AdmitType |  BilllD Number SUM Total Charges

SUM Claims

o After the report is generated, from the View menu, select Grid Type > Flat.

Notice that in the following example, Hierarchical is the view being displayed. Likewise, if the
results display as Flat, you can follow the same steps to change it to Hierarchical.

I R ——

Grid Type * | Flat

v Hierarchical

| Admit Type Y= SUM Total Charges SUM Claims
[ |1 - Emergency 216,545,087.21 91,687.00
[]|2- Urgent 294,0071,415.09 23,954.00
[]|3-Elective 762462,974.01 428.479.00
[ |4-Mewbam 5,294,542 74 2,856.00
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Change groupings

NOTE: Drill-down reports are based on institutional claims unless your organization has only
Professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples in this help
topic depict data from institutional claims.

After building and generating a report in hierarchical data view, you can change groupings without
having to delete the field, add the new grouping, and regenerate the report. You can use the drop-down
arrow immediately to the right of the first grouping to select the new field.

When a report is in hierarchical view, the first grouping is a drop-down selectable field, which makes it
easy to change it to a different grouping.
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To change the first grouping for a report displayed in hierarchical data view:
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¢ |n the first column heading, click the drop-down arrow to the right of the column name, then
locate and click a different grouping.

Claims| Line ltems
| Rows | View | Semwmgs |

| Admit Source | ~ |~ SUM Claims SUM Total Charges
[ 1 - Physician Referral 511.574.00 1.132.928,386.57
[ | 2 - Clinic Referral 7.191.00 4.448,587.16
[ |4 - Transfer From Hospital 3.647.00 38,759,838.81

First grouping with drop-down arrow outlined in red

T T T

Admit Source ¥|A SUM Claims SUM Total Charges
|| | 1 Admit Date - 511,574.00 1,132.928,386.57
] 5" "m 7,191.00 4,446,587.16
ISCal
|4 admit Fiscal Year 3,647.00 38,759,838.81
|| |2 Admit Fiscal Yr-Month 3,338.00 11,237,691.09
||| 4 Admit Fiscal Yr-Qtr 256.00 2.366,410.08
O [ — 16,.924.00 77,407,543 86
I_I Cmm Mmm o i A2 27

Selecting a different grouping from the list

The report regenerates with the new data, as shown in the following example:
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| Rows | View | Sewngs | |
Design View  Export

| Admit Day of Week v |~ SUM Claims SUM Total Charges
|| 1-Sunday T4,960.00 17889349476
| | ZMonday 89,582 00 196,824,540 30
| | FTuesday T.697.00 181,525.915.71
| | 4&-Wednesday 7814200 18525571465
| | Thursday Tr126.00 181,853,853 48
|| | &-Friday T4,800.00 177, 790,645.07
| | 7-Saturday T4,379.00 176,159,857 48

Notice that the data have changed in the two measure columns because the measures now apply
to the new grouping.

Change report column order

NOTE: Drill-down reports are based on institutional claims unless your organization has only
Professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items options instead of the Claims and Line Items options in dialog menus. Examples in this help
topic depict data from institutional claims.

Use design view to change the order of a report’s groupings and measures columns before or after
generating the report. You can also remove groupings and measures from your report in design view.

NOTE: Groupings always precede measures in report layout, regardless of how you order them. You
can re-order groupings within a report’s set of groupings, and re-order measures within the report’s
set of measures. You cannot put a measure before any grouping, however. Even if you do, when the
report generates, the measure will be grouped with the other measures in the report.

To access design view without opening the report:

1. On the main Drill-Down Reports page, in the Categories panel, click the folder where the report
is saved.

2. On the right side of the page, click the name of the report to open the report summary
information box.

3. On the left side of the summary information box, click Design.
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Reports Help

Categories ;
Drill-Down Reports
+ Add New

Axiom Reports Axiom Reports
» Claims Management Contractusl Analysis
» Department Denials Contains BillD

HTL Edit Info ,

Tab: Claims

* Jerry Crested: 08/16/2019 by Admin Admin

mcmtest Last Modified: 08/16/2019 by Admin Admin

» Monthly Report Set

The design view of the report opens on the right.

Reports Help

Columns

Denials by Payer

Claims | Lineltems 8355

Groupings Measures
+ Add New X Delete

E-Groupings -
["_‘] Claim Tracking

| conract | SuMCases |  SUMTotal Charges SUM Contractual Variance

Data View: (® Hierarchical () Flat

4

To access Design View from an open report:
e Above the report, click Design View.

Claims | Line ltems

| Rows | View | sewngs |
Design View | Export

To change the order of groupings or measures:

1. Click the grouping or measure to move and drag it to its new location.

2. When the two red arrows display in the desired position, release the mouse button.

¥
| Admit Type | SUH{ SUM Contractual Variance | SUM Contractual Vanance
L

Data View. (® Hierarchical () Flat

The measure columns are now in the new order:
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| Admit Type | SUM Cases SUM Contractual Variance SUM Total Charges

To remove groupings or measures from the report:
¢ Right-click the measure or grouping to remove, and click Delete.

I
Delete

| Facility Code | Contract ClauseDesc =) Number SUM Cases

Remove an applied filter

When filtering drill-down report results, you may add a filter that you later want to remove instead of
recreating the report.

To remove an applied filter:
1. Atthe bottom left of the page, click the arrows to the left of Applied Filters.

[2]Applied Filters

The Applied Filters dialog opens, showing the filters currently applied to the report.

2. To clear a single filter, click the blue box to the left of the filter, and then press the Delete key.
The filter is removed.

3. To clear all filters, click Clear All.

To close the filter box, click the arrows to the left of Applied Filters.
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plied Filters

[=l Claims

|

Value

291

292

293

Admit Source

T - Emergency Room

Admit Source

1 - Physician Referral

Admit Source

4 - Transfer From Hospital

Admit Source

5 - Transfer From SNF

When the filter box closes, the report automatically regenerates with the updated filters.

Delete a saved drill-down report

You can delete reports you no longer need.

To delete a drill-down report:

1. On the main Drill-Down Reports page, locate the desired report.

2. Right-click the report, and then select Delete.

Drill-Down Reports

Denials
Claim Denials by Service Line
Denials by Phyl  DElete
Denials by Service Line
Denials Trending by Bill ID
Denialz Trending by Month
Missing Consemnt by Contract
Missing Consent by Rev Code

3. Inthe confirmation dialog, click OK.

IMPORTANT: If you accidentally confirmed a deletion, you need to recreate the report; a

deleted report cannot be retrieved.
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Reporting across tabs

Reporting across tabs allows you to create multi-sided reports and conduct multi-dimensional analysis.
For example, to see the admit source of claims that include a specific administered drug, you need to
include Line Item filters in your claim report. The drug code is stored with the charge data, while Admit
Source is a reportable field on the Claims tab. From the Claims tab, you can also find the number of
claims and their associated charges, and payments, (see following example). This methodology works
for the other tabs as well.

To report across tabs, you create a multi-tab report, as explained in the following section.

» Create a multi-tab report

The following example uses a Claims tab report. The Claims tab applies to institutional claims only. The
steps are outlined from the perspective of using the Claims tab only. However, you can add filters from
any tab. If your organization processes professional claims only, you can add filters for to professional
claims reports.

NOTE: Examples in this help topic depict data from institutional claims.

To build a multi-tab report:

1. Open an existing report or create a new one.
2. At the bottom right of the page, click Add Filters.
The Advanced Filters dialog opens.

3. From the Filter by drop-down, select Line Items. This sets a Line Items tab filter without your
needing to switch tabs.

4. Inthe Fields panel, expand the Demographic folder, and select Line Item Code. In the right side
of the dialog, Line Item Code values display with their descriptions.

5. Click the check box for each Line Item Code filter to apply to the report, and then click Use These.

In the following example, the user searched for a certain kind of drug by using the wildcard
search “%furo%”, which returned two kinds of injection drug.
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Filter by:
Line ltems I v|

Fields
EllDemographic_| Line Item Code

..... APC |%f - | = .
----- Batch Number ura titer NOT" [Defaul]

----- BilllD Number | Fietd vaive |
""" Code Type ]| J0697 - Sterile cefuroxime injection |:|

J1940 - Furosemide injection Check ltems

----- EAPG Category
----- EAPG Type

_____ mport Date [ 1
--Line Item Code I Check Range

----- Modifier 1
----- Meodifier 2 Check All
----- Modifier 3
----- Modifier 4

Uncheck All

_____ RevCode Use These

----- Service Date 1

----- Service Date 1 Day of Week
----- Service Date 1 Fiscal Qtr
----- Service Date 1 Fiscal Year

v

6. Close the Advanced Filters dialog.

7. To confirm your selected filter(s), at the bottom left of the page, click Applied Filters. In the
Applied Filters dialog, review the applied filter(s).

¥ Applied Filters

= Line ltems [~ Clear All

Filter Criteria Value
Line Item Code = J1940 - Furosemide injection

Setting a Line Items filter causes the system to automatically filter through the database so that
only claims information related to the criteria selected from Line Items is accessible.

8. Close the Applied Filters dialog by clicking the arrows to the left of Applied Filters.
9. Inthe Columns panel, on the Groupings tab, double-click Admit Source.

10. Click the Measures tab.

11. Double-click the following: Claims, Total Charges, and Total Payments to add them to the report,
calculated as SUM.
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Claims | Line [tems

| Admit Source | SUM Claims SUM Total Charges SUM Total Payments

Data View. (® Hierarchical () Flat

12. After selecting all desired fields, click Generate.

The results show the Admit Source and the number of claims that have administered the selected
drug, along with all associated charges and payments.

Design View  Export

| Admit Source |~ SUM Claims SUM Total Charges SUM Total Payments
[_] |1~ Physician Referral 1,774.00 25654,914.39 9,251,337.68
[C] | 2- Clinic Referral 3.00 3810322 26,088.76
[ | 4 - Transfer From Hospital 74.00 2546,496.78 1.050,277.27
[ | 5- Transfer From SNF 21.00 541,599.24 183,485.50
[_] | & - Transfer From Another Facility 6.00 12083171 53,857.66
[_] | 7 - Emergency Room 455.00 13111,602.24 534671972
[_] |9 - Information Mot Available 200 16,522 86 5,143.06
[[J | D - NO DESCRIPTION 5.00 66,405.54 32658.13

NOTE: If you add a new filter that limits the Admit Source on the Claims tab, the Applied
Filters tab shows the filters from both the Claims and Line Items tabs, separating them by
filter type.

¥ Applied Filters

E Claims B Clear All

Filter Criteria Value
i)\d mit Source = T - Emergency Room
E Line items |
Filter Criteria Value
i Line Item Code = J15940 - Furesemide injection
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» Save a multi-tab report

NOTE: Drill-down reports are based on institutional claims unless your organization has only
professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items tabs instead of the Claims and Line Items tabs. Likewise, they will only see menu selections
related to Pro Claims and Pro Line Items in the filters dialogs.

You use the same process to save a multiple-tab report as when saving a single-tab report. However, it is
important to note the tab you are on when you save the report. The Applied Filters from each tab is
saved; however, the report will only save the Rows/Columns of the tab you are viewing at the time that
you save the report.

In the previous example, if you switched to the Line Items tab before saving, saving the report while on
the Line Items tab would save only the filters, not the selected Admit Source, Claims, Charges, and
Payments from the Claims tab. However, saving from the Claims tab will save the Row/Columns you
selected and all filters applied to the report, regardless of the tab they are associated with.

Improve variance reporting with Posting subcategories

When running drill-down reports on payment and adjustment posting totals, you can break out these
items into subcategories for more detailed reporting. In addition to Total Payment and Total Contractual
fields, there are 10 payment and 10 adjustment fields available in the Measures column for the Claims
tab in Drill-Down reports. These fields allow you to break out payment and adjustment posting totals by
type for improved contractual variance reporting. You can use these fields to report on refunds, bad
debt adjustments, etc. The new drill-down report fields for adjustments are A1-A10. The new fields for
payments are P1-P10.

NOTE: To take advantage of this postings breakout feature, you need to provide a posting file with

category breakouts for payments and adjustments imported using Axiom ETL. This import can be in
addition to or part of the Axiom Contract Management Full Import job.

In the example below, adjustment fields A1 and A2 are used to break out primary contractual and
facility adjustments:
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(A B | ¢ | D | E | F | G | H |
X é axiomsoftware Contractual Review
2

3 |Filters
8

SuUmM SUM Total SUM Total Expected | SUM Total Primary | SUM Total Facility SUM Contractual

9 Contract ClauseDesc Cases Charges Contractual Contractual (A1) Adj (A2) Variance
10 |ALL OTHER OP 31 26,199 2,620 2,620 935 (0)
11 |CARDIOLOGY 3 19,808 1,981 1,500 15 81
12 |EMERGENCY CARE 54 94,717 3,472 10,472 245 (1,000)
13 |IMAGING SERVICES 30 37,963 3,798 3,291 505 505
14 |IMPLANTS 10 19,460 1,946 2,057 111 (111}
15 |LAB 68 23,744 2,374 2,374 0 0
16 |OBSERVATION 3 22,197 2,220 2,210 10 10
17 |PT/OT/ST 15 8,504 250 1,000 150 (150)
18 |RADIATION THERAPY 8 64,505 6,485 6,490 5 (5)
19 |RADIOLOGY SERVICES B 2,786 279 279 o (0)
20 |SURGICAL 9 104,189 10,419 15,867 534 (5,448)
21 239 424,073 42,441 48,560 2,515 (6,119)

Using report sets

The Report Sets feature allows you to create single or multi-report workbooks and to schedule them to
run automatically, one time or on a regular basis.

When you run reports from the Report Sets dialog, the generated reports are automatically exported to
Excel and saved to a selected directory accessible from the Axiom Desktop Client. The default directory
is Axiom > Reports Library > CMAData > ReportSets. From this directory, you can view, save, export, and
delete reports.

A | Bxiom Explorer ? d
@ ) [ Vwiom\Reports Library\CMAData\ReportSets o

File = View ~

My Files - Name Maodified Locked By Size
File Groups ~ @] BrendanReport 10/22/2019 10:15 Ap 607 KB

¥ }- b

Libraries . -.—J_] High_Cost_Variances 10/22/2019 10:37 AP 16 KB

+ &l Reports Library
« ). CMAData
|. ReportSets

» [ Table Library
# Ribbon Tabs Library
» [E5 Scheduler Jobs Library
» & Imports Library
» 4 Exports Library

ReportSets  Description: Open
l File Folder B
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Create a report set

Use these instructions to create set of drill-down reports.

To create a Report Set:

1.
2.
3.

In the main menu header, click Reports > Drill-Down Reports.

On the Drill-Down Reports page, click Reports > Report Sets.

At the bottom left of the Report Sets dialog, click Add New Report Set.
A new row displays at the bottom of the Report Set grid.

In the Name column of the new row, type a name for the new report set. The name of the report
set will also be the name of the report file that exports.

NOTE: Do not use any spaces or special characters in the report name. Limit the title to 15
characters because this is used for the workbook name.

If desired, click in the Description column for the new row and enter a description of the report
set. Spaces and special characters are allowed in the Description field.

The Last Run At column displays the last time the report ran through the Scheduler.

To enable the report set to be scheduled to run at a set time, select the Enabled check box.
At the right end of the new report row, click Save.

In the confirmation dialog, click OK.

The Report Set saves to the grid in alphabetical order.

Administrator's Guide Axiom Contract Management | 268



Report Sets X

Report Sets | Sheets
Name Description Last Run At Enabled
BrendanReport (] | Upd"l Del || Rllnl -
BRFLinkReports O Upd]| Del |[ Run
CFD Report Set for Upper Managment (0} Upd"l Del | Run|
ClaimDemo o Upd"l Del || Run|
DenialsByPayer Report set for denials (] Upd"l Del || Run|
DeptHead Department Head Revenue Reports 08/03/2018 8:00 AM il Upd"l Del || Run|
GeosReport Report Set Test for Geo (0} Upd"l Del | Run|
HBIReports [0 [ upd|[ Det |[ Run]|
HTLTest Test (] Upd]| Del |[ Run
HTLTest2 Test2 (] Upd|[ Del || Run|
HTLTest3 Testd Lile ] Upd|[ Del || Run|
ImpartCheck Import Check Report Set 07/30/2018 8:00 AM # [ Upd|[ Del |[ Run]|
KRDTest] Test O Upd]| Del |[ Run
MonthlyReport o Upd|[ Del || Run|
NameWithNoSpace o Upd"l Del || Run|
RPCTest Patient, Charge, and Payment 373 04/24/2007 10:05 AM (] Upd"l Del || Run|
Serviceline (] Upd"l Del || Run|
TraingDay2 o Upd|[ Del || Run|
VarianceAnalysis Monthly Variance Analysis Report (] | Upd"l Del | | Ru n|
7z JHFRepontSet Report set for moving to Axiom (] | Upd"l Del || Rllnl
-

9. Next, add reports to the report set.

Add reports to a report set

Use these instructions to add drill-down reports to an existing report set, and to set up headers and
footers for the generated reports.

NOTE: Drill-down reports are based on institutional claims unless your organization has only
professional claims. Users processing only professional claims will see the Pro Claims and Pro Line
Items tabs instead of the Claims and Line Items tabs. Likewise, they will only see menu selections
related to Pro Claims and Pro Line Items in the filters dialogs.

To add reports to the report set:
1. Inthe Report Set table, find and select the report set.

2. At the top of the Report Sets dialog, click the Sheets tab.

3. On the Sheets tab, at the bottom left, click Add New Sheet. A new row is added to the Sheets
table.

4. Click in the Query Name field, and then from the drop-down menu, select the drill-down report
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to add.

5. Inthe Worksheet Name field, type a name for the worksheet. Worksheet names become the
names of the tabs used in the generated report.

All reports, regardless of type (Claims/Pro Claims or Line Items/Pro Line Items), are listed here
alphabetically. Each added report will be an additional sheet in the report set Excel workbook.

Report Sets =]

Report Sets | Sheets

Report Set: Example

Sheet# Query Name Worksheet Name Header/Footer
1 Aptna Cases Aetna Details Upd || Del
2 A Payer Report Card Payer Report Card Details Save|| Del

6. Near the right end of the new row, click Save.

7. If desired, you can add header and footer information to the sheet. See the following instructions
“Add headers and footers to reports in the set.”

8. Run and view the report, or schedule the report set to run at another time.

» Add headers and footers to reports in the set
To add header and footer information to the sheet:

1. Inthe Header/Footer column for the new sheet row, click Details.

2. Inthe Header Details section, type the desired information into the fields that corresponds to the
section of the header where you want the text to display.
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Report Sels

Report Sets | Sheets

Report Set Sheet Details for: DenialsByPayer (Sheet 1)
e | )| RE

Header Details

Left Center Right

KH Medical

Footer Details

Left Center Right
Back to Sheets Submit Details

3. Inthe Footer Details section, type the desired information into the fields corresponding to the
footer sections (Left, Center, Right) where you want to place text. To add page numbers and a
time stamp of when the report was created, do the following:

a. Click in the field where you want the page number to populate; then, in the formatting

menu at the top of the dialog, click the page number button (‘i')

b. Click in the field where you want to put the date and time that the report was created,

then, in the formatting menu, click the date button (@), and then click the time button (

B,

Footer Details
Left Center Right
&[Page] &[Date] &Time]

Example of page number and report time stamp set in the footer

4. At the bottom of the dialog, click Submit Details.
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Run and view a report set

Use these instructions to generate and view a set of drill-down reports.

NOTE: Before you run reports from the Report Sets dialog, confirm that your reports have been
built, that they run correctly, and that they have been saved. Otherwise, you may receive an error
when attempting to run the set.

1. Open the Report Sets dialog:
a. Inthe main menu header, click Reports > Drill-Down Reports.

b. On the Drill-Down Reports page, in the menu header, click Reports > Report Sets.
In the Report Sets tab, in the row for the desired report set, click Run.
In the confirmation dialog, click OK.

Open the Desktop Client.

vk~ N

In the Axiom Explorer, navigate to Libraries > Reports Library > CMAData > ReportSets and
locate your report.

6. Double-click the report to open and view it.

Drill through the report by clicking the plus buttons on the left, as shown in the following

example.
1[z[a ale]| c D | E F G H | ) k.~
. - =
n axiomsoftware Segment Contractual
o
(] 3 |[Filters
6 | ¢ i
7 7 Contract | SUM Cases SUM Total Charges SUM Total Cost SUM Total Payments | SUM Total € Total Expected Payme| G Variance
+] 8 |AETNA 83.00 164,641.87 48,079.41 121,298 90 31,444.73 148,133.48 114,045.34)
+] 1 lricus nad Click to drill down | 46,00 120,749.87 36,874.08 100,307.77 18,787.09 106,259.89 (4,297.11)
+] 224 | 641,00 1,069,250.44 337,640.78 778,700.06 265,980.63 3,335.00 799,934 81
+] a7t kaamand 1O the nextlevel  F 5.00 41,103.49 30,195.20 14,328.90 31,734.59 25,463.07 116,09 17)
+] 885 |ORG1 —— 26.00 88,645.69 24,717.11 68,475.38 18,821.15 69,143.4 681,12
+] 22.00 243,101.54 11131113 160,256.80 73,891.47 818,655.19 1650,045.12)
+] 302,00 797,080.24 274,140.73 232,596.02 583,752.46 223,536.99 110,209 21)
+] anaged Medicare 151.00 470,862.80 17182717 181,411 87 310,353.77 116,691.45 1781758
+] G1 - Medicaid 858.00 2,419,464.82 935,487.56 441,350.91 2,050,516.08 §34,124.81 1265,176.08)
+] GL- Medicaid SNF 10,00 85,208.93 65,332.78 43.230.71 41,534.22 39,390.30 4,284.41
+] G1- Medicare 4,616.00 11,077,883.99 4.066,820.44 3,428,83637 8,134,808.75 3,193,947.27 1250,672.03)
+] G1 - Medicare Contract 100.00 520,399 69 434,36 66 334,390.59 359,50.20 930537
+] care HMO Other 3.00 1,593.15 2,530.40 1,991.44 1652.47)
+] 223.00 360,265.15 141,640.73 259,384.97 {11,875.84)
+] CBS State 49.00 81,476.80 30,093.00 57.639.63 @
+] G2 - Humana Gold 50.00 139,252.64 57,709.75 42,800.21
+] G2 - Managed Medicare 28.00 63,903.15 34,115.86 25,611.16
+] G2 - MedCost 20,00 55,879.70 30,143,840 47,21835
+] G2 - Medicaid 303.00 309,628.69 122,706.09 117,572.83 (31,558.45)
+] G2 - Medicare 961.00 2,119,475.06 1,035,381 31 1,526,515 31 530,503.34 237,633 59)
+] 37.00 67,198.03 23,608.17 24,458.31 39,269.76 25,596.76 2,33151
+] 123.00 483,580.14 181,598.46 335,317.69 156,234,132 (6,97167)
+] 1,627.00 1.021,956.89 762,698.14 S11,894.69 1,81322000
[+]  [1078sUniTED 228.00 130,950 50 108,352.04 305,336.64 5.73)
[+]  [11096|zMiscellaneous Plan Codes 718.00 1 536,061.53 974,288.00 440,014.97 0.00 1,09 9
11821, 11,231.00 25.900,932.54 9,888,333.68 10,545,674.24 15,525,324.76 8,120,016.18 2,264,591.60
11822 : =
W« v |\ Contractual Variance / Cases by DRG [4] | _'H

Worksheets named in the
Report Set display as tabs ]

7. After viewing the report, do any of the following:
¢ Close the report. When prompted to save, select to save it.
¢ Close the report and export it. To export the report, right-click it and select Export.
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¢ Close the report and delete it. To delete the report, right-click it and select Delete.

Schedule a report set to run

Use these instructions for scheduling the running of drill-down report sets. You can schedule reports to
run once or on a regular basis. To schedule reports, you need to have CMA Scheduler permissions.

NOTE: Before scheduling a report set, confirm that the reports in the set have been built, that they
run correctly, and that they have been saved.

To schedule and run a report set:

1. Open the Report Sets dialog:

a. Inthe main menu header, click Reports > Drill-Down Reports.

b. On the Drill-Down Reports page, in the menu header, click Reports > Report Sets.

2. Inthe Report Sets tab, in the row for the desired report set, ensure the Enabled box is checked.

3. Open the Desktop Client.

4. In the Admin ribbon tab, click Scheduler.

ab

Admin Task
Panes -

AXIOM MAIM

»

Locked
Items

HELP

System
Browser,

ADMIN

F.' T_":.
Eo+H!
Scheduler

CONTRACT MAMAGEMENT Home

L
Imports & Data File
Utilities « Protection =

5. In the Scheduler dialog, on the Job tab, click New.

6. Click the Add button and select Report from Query.
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A Bxiom Scheduler - Mew Job

Job Service

P A

New Open Save Close FRun Add ove Move Remove ea
=i rlﬁ Active Directory Import
& Scheduled Jobs | [] New Job [ CMA 5010 Importer
[E] CMA Duplicate File Check

General
Variables [E CMA Full Import
Scheduling Rules [  CMA Platform To CMA Table Move
Ever.ﬂ:_ Ha_ndlers rﬁ CMA 5L Importer
Motification
Tacks ||=|:| Collect Worksheets
Results ||=|:| Copy On Demand Plan Files

rlﬁ Create Plan Files

Fﬁ Delete Episodic Grouping Results
||=|:| Eche Task

||=|:| Execute Command Adapter

rlﬁ Execute SOL Command

Fﬁ Export ETL Package

WYY VYYY iy s VWYY,

[l Pu_ .Sy .mvL .a
||=|:| Raise Event
||=|:| Rebuild Database Indexes

q @ Report From Query
=

1 Den Covmmnl Bllnren

7. Inthe New Job tab, on the right of the Selected Report Set field, click the open folder icon to
view available reports.

8. Inthe Choose Report dialog, select the report to be scheduled, and then click OK.

NOTE: Only report sets that are enabled for scheduling display in the Choose Report dialog.
For details, see Create a report set.
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A | Axiom Scheduler - New Job ? X
Job Service
-
L = > | = * ¥ = =Hf
New Open Save Close n Add Move Move Remove Clear
- Up vn Selected  All
Job Tasks
i Scheduled Jobs | [] New Job
General > Task Control
Variables v Task Details
Scheduling Rules <none selected>
Event Handlers 2 tores] (o D
Notification
4 Tasks
Al Ch Report X
Report From Query 003 hepo
Results [T Select the report set to use
ImportCheck
DeptHead
BrendanReport
High_Cost_Variances
‘ OK | | Cancel |

In the New Job tab on the left, click Scheduling Rules, and then click Add. A new rule is added to
the right side of the dialog.

A | Axiom Scheduler - New Job
Job Service
-
b H Wb = =X

New Open Save Close Add Remove Clear
Selected Al

Job Scheduling Rules

& Scheduled Jobs | [] New Job

General Active Starting On Ending On Day Of We:  Hours Minutes
Variables * ' '
Scheduling Rule: o <none selected>

Event Handlers

Motification

4 Tasks

Report From Query
Results

10. Set the run day and time:
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a. Under Day Of Week, double-click near the asterisk to activate the cell and then enter a
selection:

e * (Default): The job will be run on all days within the start / end range.

e 0-6: The job will run on the specified day(s), where 0 is Sunday and 6 is Saturday.
Use a comma or a hyphen to separate multiple days (hyphen if the days are
contiguous, commas if not). For example, you can enter 1,3,5 for Monday,
Wednesday, and Friday, or enter 1-5 for Monday through Friday.

b. Under Hours, specify the time of day (hours) that you want the job to run, in relation to
the specified days:
e * (Default): The job will be run on all hours.

e 0-23: The job will be run on the specified hour or hours, where 0 is midnight and 23
is 11:00 PM. Use a comma or a hyphen to separate multiple hours (hyphen if the
hours are contiguous, commas if not). For example, you can enter 0,12 to run at
midnight and noon, or enter 0-12 to run every hour from midnight to noon.

c. Under Minutes, specify the time of day (minutes) that you want the job to run, in relation
to the specified hours:
e * (Default): The job will be run on all minutes (essentially the job is run
continuously, once per minute).

e 0-59: The job will be run on the specified minute or minutes of the hour, where 0 is
the first minute of the hour and 59 is the last minute of the hour. Use a comma or a
hyphen to separate multiple minutes (hyphen if the hours are contiguous, commas
if not). For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you enter an
hour but leave the minutes at the default asterisk, then the job will run every
minute in that hour.

11. If desired, schedule email notification to alert users when the report is available for viewing:
a. Inthe New Job tab on the left, click Notification.

b. On the right, select the desired settings and specify message content.

12. Click Save and then name and save the schedule in the Contract Management or Product Line
Management folder.
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11

Advanced filters

Advanced filters can provide more refined results within a report or when tracking claims. For example,
use advanced filters to isolate claims that share similar characteristics or to provide detail on more
specific scenarios.

Note the following about advanced filters:

e The Advanced Filters feature allows you to create detailed filters using a large number and wide
variety of criteria, so be sure of what you want the filter to capture. You can start with broader
criteria and then refine the filter until you obtain the results you want.

¢ Only one saved filter query at a time can be attached to a report.
¢ The default filter is the first filter found in the folder structure.

e Filters in Drill-Down Reports, Standard Reports, and Claim Tracking all reference the same saved
filters. In Standard Reports, these are listed in the Filter drop-down of the Advanced Parameters
section.

e Advanced filters can be edited from Drill-Down Reports.

e Some reports, such as Denials reports (in Standard Reports), do not support advanced filters.
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e Depending on the type of filter criteria you select, filter options are displayed as either a library-
style list or as parameter conditions:

» Library list

Libraries are used when the criteria includes a limited, known set of possible values such as
condition codes, bill codes, contracts, and so on. Libraries allow you to select from all records of
that type in the database. In the following examples, the selected category is BillCode. All
BillCodes in the system are available for selecting from the library list in the middle of the dialog.

Advanced Filters

Field Selection  Applied Conditions

v Demographic
Admit Date
Admit Day of Week
Admit Fiscal Qtr
Admit Fiscal Year
Admit Fiscal Yr-Qtr
Admit Hour
Admit Month
Admit Source
Admit Type
Batch Number
BillCode
BilllD Number
Claim Max Serv Date
Claim Min Serv Date
Claim Type
Closed Reason Code
Contract
Contract Clause2
Contract Clause3
Contract Clause4
Contract Clause5

Contract ClauseDesc

Filter By: Filter Name: Save To:
Claims A | | My claims filter | |,fA><\om Reports
Fields: Conditions:

|s1artswith v || BillCode starts with

BillCode

113
14
115

116

*JO00o0D0o0DOoODOoOooDooOooooood

Example from Claim Tracking
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Advanced Filters x

Query Name: Filter by: Save To:

Institutional Claims HW ‘ Claims hd | Save & Exit ‘Brd here v‘
Fields:
=-Demographic - EollEri
i..Admit Date
_ Admit Day of Week
L..Admit Fiscal Qtr
...Admit Fiscal Year
;...Admil Fiscal Yr-Qtr
_Admit Hour
_.Admit Month
L..Admit Source
i..Admit Type
_.Batch Number
_BillCode
_BilllD Number
~.Claim Max Serv Date

Filter [ "NOT" [Default]

Field Value

110 &

Check ltems
m

1z

13
14 Check Range

15
116 Check All
17
118

Uncheck All

e Use These

Claim Min Serv Date
i..Claim Type
-.Closed Reason Code -

120

0|0 0|0|0|0|0|0|0/0/0|0] »

121 -

¥ Applied Filters

Example from Standard Reports

» Parameter Conditions

Parameter conditions are used when the criteria include a set of possible values too broad for a
library. For example, a patient’s date of birth, a balance due, or a claim number. Parameter
conditions include comparison operators (>=, <=, >, <, =, <>) and logical operators (AND, OR). You
can use the comparison operators alone to select specific data, such as Admit Date = 1/1/22, or
you can combine them with logical operators to create search conditions that filter the data to a
specific range: Admit Date >= 3/1/2021 AND <= 8/31/2021.
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Advanced Filters

Field Selection  Applied Conditions

Filter By: Filter Name: Save To:
Claims A | | Enter a filter name | |,«’Axiom Reports
Fields: Conditions:
» Demographic -
Admit Date |>: S | |‘If‘|f2020 ﬁ]|

Admit Date

Admit Day of Week AND v

Admit Fiscal Qtr

Admit Fiscal Year AdmitDate <= v | [1/1/2022 =]
Admit Fiscal Yr-Qtr

Admit Hour + Add a Condition

Admit Month

Admit Source
Admit Type
Batch Number
BillCode

BilllD Number

Example from Claim Tracking

Advanced Filters x

Query Name: Filter by: Save To:
[Institutional Claims HW ‘ ‘ Claims V| Save & Exit ‘/3fd here V‘
Fields:
=-Demographic -~ Admit Date
--Admit Date
Admit Day of Week Admit Date | = v ‘ I 3n/203 ‘ v| ‘ hd ‘ Use These
-.Admit Fiscal Qtr Clear

-.Admit Fiscal Year Admit Date

--.Admit Fiscal Yr-Qtr
i ot
Admit Source
Admit Type
Batch Number
--BillCode
--BilllD Number
Claim Max Serv Date
Claim Min Serv Date
-.Claim Type
--Closed Reason Code -

‘ ¥ Applied Filters

Example from Standard Reports

You can apply advanced filters to Standard Reports, Drill-Down Reports, and Claim Tracking.
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Apply advanced filters

You can view and apply existing advanced filters from Standard Reports, Drill-Down Reports, or Claim
Tracking.

» From Standard Reports

Currently, the only way to apply a different advanced filter to a standard report that already has one is
to create a new version of the report and apply the filter when building that report. See Build an
advanced filter for standard reports.

» From Drill-Down Reporting

e To build a new advanced filter while working with drill-down reports, while in Design View or
while viewing the report, in the bottom right corner of the page, click Add Filters. Follow the
instructions in Add an advanced filter to a drill-down report.

NOTE: The Add Filters button displays in all drill-down report pages except the report
selection page.

T T N

Columns

Default Org

Claims | Lineltems 835s

Groupings Measures
+ Add New x Delete

E--Groupings | ProviderName |  BilllD Number SUM Total Charges
(][] Claim Tracking |E
+ [ Codes
&[] Dates Data View: ® Hierarchical O Flat
H1.071CD Codes
[ Mew Folder

= T lenr Dinfinnd

% Applied Filters

e To view filters already applied to the report if any, on the bottom left of the page, click Applied
Filters.

» From Claim Tracking

To use an existing filter, on the Claim Tracking page, from the Select a Filter drop-down, select a filter.

Administrator's Guide Axiom Contract Management | 281



Claim Tracking

Quick Filters  Existing Filters  Modify Claims

Select an existing filter to create a view of claims:

Select a Filter... v Build Filter

Build an advanced filter for claim tracking

Use these instructions to build an advanced filter for searching tracked claims. The steps are similar to
those for building an advanced filter in reports.

To build a new advanced filter:
1. Onthe Claim Tracking page, click Existing Filters.

2. To the right of the Select a Filter drop-down, click Build Filter.

Claim Tracking

Quick Filters Existing Filters  Modify Claims

Select an existing filter to create a view of claims:

Select a Filter... v Build Filter

3. In the Filter By drop-down, select one of the following:

e Claims — Select to filter by whole claims.
¢ Line Items — Select to filter by specific line items on claims.

The following example shows Claims selected in the Filter By option.
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Advanced Filters

Field Selection

Applied Conditions

Filter By: Filter Name:
|Claims v | Enter a filter name
Fields: Conditions:

» Demographic

TIP: Advanced filters allow you to select claims using a large number of criteria, so it is
best to know exactly what you want. Identify the criteria to use for this filter before
assigning them.

4. In the Filter Name field, type a descriptive, unique name for the filter. Spaces, hyphens, and
numbers are allowed.

5. From the Save To drop-down, select a destination or accept the default.

6. Inthe Fields section, expand the field categories as needed to see their criteria.

7. In an expanded field category, click the desired filter criteria. Depending on your selection, you

are presented with either a library list of options, or parameter conditions. In the Conditions
section, do whichever is applicable:

» Select from a library list

e |If the list is long, you can filter it to display relevant items:

a. Inthe first drop-down, select how you want to filter the list: Starts With, Contains,
Ends With or Range.
b. Inthe related fields, enter the filter condition or, if filtering by range, enter the

beginning and ending data for the range.
c. To filter the list, click the filter icon button ( ¥ |). To remove the filter and start over,

click the filter reset button ( ¥ ).

e To select one or more options in the list, click the check box to the left of the item.
e To select all items in the library list, click the check box in the gray table header:
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Conditions:
By Value = By Range
sWith
BillCode
[] 110

e To select all items except a few, select only the items to exclude, and then click the Not
Included check box. When the Not Included check box is selected, all the items that you
did not select will be included in the filter. To clear items selected for exclusion, on the
right, click Remove, and then select the items you want to exclude.

Conditions:

By Value = By Range

Starts With
[] Bilicode Clear/Undo
110
1
] mnz2
[ mna3

e To select a range of items from the library list:

a.
b.

Click the By Range tab.

From the drop-down, select the desired comparison operator (>=, >, =, <=, <, <>)
and then type the beginning range value in the field.

Click + Add a Condition.
From the middle drop-down, either leave the default at AND or select OR.

In the second drop-down, select the comparison operator, and then type the end
range value in the field. If needed, add another condition.

e To clear selected items, on the right, click Clear/Undo.

» Select parameter conditions

You can create a range, or you can use a single operator to include all data values equal to, not

equal to, or above/below a specific value.

e To set a range, in the comparison operator drop-down, select a comparison operator (>=,
>, =, <=, <, <>) for the beginning of the range, and then select or type the beginning value
in the field. Next, click Add a Condition. Select a logical operator (AND, OR), and then, for
the end of the range, select a comparison operator and then enter or select the ending

value.
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e To set a specific value, select the equal comparison operator, and then select or enter the
value.

e To set an open-ended range, select a comparison operator that includes a greater-than or
less-than symbol, and then enter the beginning value.

8. Each time you select filter criteria from a field category, click the Apply to Filter button on the
right.

NOTE: At any time before saving the filter, you can view what you have applied so far, and
remove any items if necessary.

9. If needed, add additional filter criteria, remembering to click Apply to Filter after each selection.
10. To check or remove items from your filter as you build it:
a. Atthe top of the dialog, click the Applied Conditions tab and review your selections.
b. To delete a selection, do one of the following:

e if the item’s status is Pending save, then at the end of the row, click the Cancel icon

(©).
o If the item’s status is Saved, then at the end of the row, click the Delete icon (i)
and then click Save.

11. When finished adding criteria, click Save and Close.

Build an advanced filter for standard reports

Use these instructions for building advanced filters while working with standard reports. Reports
created in Standard Reports can also be used in Claim Tracking from the Existing Filters feature, and in
Drill-Down reports.

To build a new advanced filter:
1. From the main menu header, click Reports > Reports.

2. On the Reports page, click the New tab.

3. Click the down arrow icons to the right of Advanced to expand the Advanced section:
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ReportList  View/Edit | New

Report Name Report Type

Clause Stats - Ind

% Parameters| ¥ [Advanced

Start Discharge Date 5/13/2022 V| End Discharge Dats

4. Inthe Advanced Parameters section, click Build Filter. The Advanced Filters dialog opens.
5. Inthe Query Name field, type a descriptive name for the new filter. The name must be unique.
6. From the Filter by drop-down, select one of the following:

e Claims — Select to filter by whole claims.

¢ Line Items — Select to filter by specific line items on claims.

7. From the Save To drop-down, select a destination or accept the default (the first available folder
in the Reports folder list).

8. Inthe Fields column on the left, expand a desired field to view its filter criteria. Depending on the
type of criteria you selected, the page displays either a library list of options (formerly “option
bank”) or parameter conditions from which you select specific data or a range of data. Do one of
the following as applicable:

» Select from a library list

e If the list is long, you can filter the list to display fewer items:

° Tofilter the list to a specific item, in the field above the table, type the value name
or number and then click the Filter button to the right of the field. The list is
shortened to all entries that match your entry.

° To select a range of items, on the right in the Check Range field, enter the item
range separated by a hyphen and then click Check Range. All the items in the range
are selected, as shown in the following example:
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BillCode
Filter [ "NOT" [Defauli]
Field Value =
O] e -
Check [tems

D 1
112
3 112-119
114 Check Range
115
116 Check All
T Uncheck All
118
s Use These
| 120
D 121 -

° To select all values containing a specific word or number, type the word or number
into the Check Items field and then click Check Items to select them.

° To select one or more options in the list, click the check box to the left of the item.
° To select all items in the library list, click Check All.

° To select all items except a few, select only the items to exclude, and then click the
“Not” [Default] check box. When this check box is selected, all the items that you
did not select will be included in the filter.

Advanced Filters x

Query Name: Filter by: Save To:

[Claims v] | saesEit [ /3rd here

Fields:
=-Demographic A BillCode
Admit Date
Admit Day of Week
Admit Fiscal Qtr
Admit Fiscal Year
Admit Fiscal Yr-Qtr
Admit Hour
Admit Month
Admit Source

I i

Filter "NOT" [Default]

Field Value ‘

Check ltems
m

J[n2
)| ]
114 Check Range
J{115
]1116 Check All
1117

Admit Type
Batch Number
BillCode

Uncheck All

° To clear all selected items, click Uncheck All.

° To toggle between viewing the items you added to the filter and creating the filter,
at the bottom left of the Advanced Filters dialog, click Applied Filters.
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» Select parameter conditions

You can create a range or you can use a single comparison operator to include all data items
equal to a specific value, above/below a specific value, or equal to and above/below a specific
value.

NOTE: When setting parameter conditions, always start with the field set at the top of the
box.

e To set a range, from the comparison operator drop-down, select a comparison operator
(>=, >, =, <=, <, <>) for the beginning of the range, and then type the beginning range value
in the corresponding field. Select a logical operator (AND, OR), and then, for the end of the
range, select a comparison operator, and then enter the ending range value.

¢ To set a specific value, select a comparison operator, and then select or enter the value.

e To set an open-ended range, select a comparison operator that includes a greater-than or
less-than symbol, and then enter the beginning value. The following example sets an open-
ended range of values equal to or greater than $500.00.

Amount Denied

500.00 Use These
Clear

Amount Denied

Amount Denied

Amount Denied|

9. After making each selection, on the right, click the Use These to add the values to the filter.

NOTE: More complex filters may add time to report processing. Also, discharge date and
contract are already part of your basic report parameters. No additional filtering is needed
unless you require a specific payer code.

10. To review or change your filter selections before saving:

a. Inthe bottom left corner of the Advanced Filters dialog, click the Applied Filters arrows
icon.

b. If filters appear collapsed, expand the group.

c. If needed, remove or add filters:
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e To remove a filter, click the blue box at the beginning of the filter row and then
press Delete on your keyboard.

e To add filters, click the Applied Filters arrows icon again to toggle back to the
Advanced Filters dialog where you can add more filters.

11. When finished adding criteria, click Save & Exit.

Edit an advanced filter

You can edit filters as you create them in Claim Tracking and Standard Reports, but once saved, filters
can be edited only from Drill-Down reports. Editing a filter can include changing the name, description,
the folder it is stored in, and the filter criteria.

To access the advanced filter:
1. In the main menu header, select Reports > Drill-Down Reports.

2. Inthe Categories list on the left of the Drill-Down Reports page, click the name of the folder the
report is stored in.

3. On the Drill-Down Reports page, in the list of filters, click the name of the filter to view its menu.
To change the filter name, description, or folder it is saved to:
1. In the filter menu, click Edit Info.
2. Inthe Update Report Detail dialog, do any of the following:
* In the Name field, type the new name. Remember that is must be unique.
e In the Description field, change the description.
e From the Folder drop-down, select a folder.

3. Click Save.

To change the filter criteria:
1. In the filter menu, click Design.

2. Atthe bottom left of the filter’s page, click Applied Filters. The Applied Filters dialog displays the
list of filter criteria in a table.

3. To remove filter criteria, do any of the following:

e Toremove a value, click the blue square at the beginning of the value’s row to select the
row and then press the Delete key on your keyboard.

e To clear all values, click Clear All.

4. To add filter criteria:
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a. At the bottom right of the page, click Add Filters.

b. In the Advanced Filters dialog, select the desired options. After making each selection,
click Use These. For details on selecting filter values, see Add an advanced filter to a drill-
down report.

c. When finished applying filter values, close the dialog by clicking the X in the upper right
corner.

5. To save your changes, in the menu header at the top of the Drill-Down Reports page, do one of
the following:

¢ Click Reports > Save.
e Click Reports > Save As to create a copy with the changes, and then provide a new name.

6. To close the Applied Filters table, to the left of Applied Filters, click the arrow icon.
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12

Scheduler Overview

Using Scheduler, you can schedule certain Axiom Contract Management tasks to be processed on a
Scheduler server at a specific date and time. For example, you can schedule plan file processing or data
imports.

Processing tasks using Scheduler has advantages over manual processing, such as:
e Leverages the server's processing power and frees up your computer's resources.
e Enables recurring scheduling of ongoing tasks.
e Allows tasks to be scheduled during "off hours," during periods of low network and system
activity.
e Allows tasks to be performed in batch, including enforcing task dependencies.

Scheduler processes tasks using jobs. Each job is a scheduled unit that can contain one or more tasks.
The tasks in a job can be processed sequentially or concurrently as appropriate.

Only system administrators and users with the Scheduled Jobs User security permission can access
Scheduler.

Most Scheduler setup activities can only be performed in the Desktop Client (Excel or Windows Client).
Therefore, the Desktop Client Scheduler is the primary focus of this document. However, some job
management activities can be performed in the Web Client, such as monitoring the job schedule,
viewing job results, and running jobs manually on demand. For more information, see Web Scheduler.

About Scheduler

This section contains conceptual information about the Scheduler feature in Axiom Contract
Management.

» Scheduler jobs and tasks

The primary unit of Scheduler processing is a job. Each Scheduler job can contain one or more tasks to
be performed as part of that job.

Each Scheduler job defines the following basic properties:

e The tasks to perform for the job and the properties of those tasks
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e The schedule of the job, including recurrence (if any)
e The priority of the job
e The notification options for the job

The tasks define the actual activities to be performed by the job, such as importing data or processing
plan files. Some Scheduler tasks correspond to existing features that can also be processed manually
(such as Process Plan Files), while other tasks are Scheduler-specific and can only be processed via
Scheduler. Each task has a unique set of options that are specific to that task and to the activity to be
performed. For more information on the available task types, see Scheduler Task Reference.

The tasks in a job can be processed sequentially or concurrently as appropriate. Tasks can be dependent
on other tasks in the job as needed—for example, you can configure a job so that if a task fails, the job
stops and does not process the next task. Tasks can also be processed iteratively, to perform the same
task repeatedly over a defined set of values.

The Scheduler jobs in your system fall into the following basic categories:
¢ Client-created: You can create Scheduler jobs as needed to perform tasks in your system.
e System jobs: Axiom Contract Management provides a set of system jobs to perform necessary
system tasks.
e Product-controlled: When a product is installed, it may include one or more Scheduler jobs to

support the use of that product. Generally speaking, these jobs should not be changed unless the
product documentation says customization is allowed, or as advised by Axiom Support.

» How Scheduler jobs are run
Once a Scheduler job has been created, it can be run using any of the following options:

e The job can be scheduled for execution at a future date and time using a scheduling rule.
Scheduling rules can be one-time only, or recurring.

e The job can be run "one time" manually as needed through Scheduler.

e The job can be triggered for execution using an event handler. This allows Scheduler jobs to be
triggered in various ways, such as by clicking a button in an Axiom form.

Scheduler jobs are processed by one or more servers running the Scheduler service. For Axiom Cloud
systems, the Scheduler service is part of your cloud system and managed by Axiom Support. For on-
premise systems, the Scheduler service is installed on one or more servers in your environment. The
Scheduler service polls the Axiom Application Server periodically to check for any jobs that are ready to
be run. Eligible jobs are then executed on the server, based on their processing priority.

When a job is executed by Scheduler, it is run using a particular user identity. In order for a job to be
executed successfully, the user must be an active user defined in Axiom Contract Management security,
and the user must have the appropriate security permissions to perform the tasks in the job. The user
identity for a job is determined as follows:

e |fajobisasystem job, thenitis run as the system-managed identity of System instead of a user
identity.
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e If ajobis run by using Run Now, then it is run as the user who placed the job on the schedule.

e If ajobis run by an active scheduling rule, then it is run as the job owner. The job owner is the
user who last saved the job.

e If ajobis run via an event handler, then the job may be run as either the job owner, or the job
requester (the user who raised the event).

» System jobs

System jobs are automatically created by Axiom Contract Management to support necessary system
functionality. Some system jobs are created as part of the initial installation and are intended to run on
an ongoing basis, while other system jobs are created on-demand in response to system events. Only
administrators can edit these system jobs.

System jobs have two defining characteristics:

e System jobs are run using the system-managed identity of System instead of a user identity. The
System identity has full rights to the system as necessary to perform system tasks.

e System jobs are run by the default System Scheduler service. For on-premise systems, this service
is created and started automatically on the Axiom Application Server, and does not require a
separate installation. This service is exclusively for running system jobs.

Axiom Cloud systems may or may not have a separate System Scheduler service, depending on
the system configuration (as determined by Axiom Support). If your cloud system does not have a
System Scheduler service, then your system jobs are run using the available Scheduler services for
the cloud system.

In the Scheduler dialog (Desktop Client), the System Scheduler service is listed on the Servers tab
using the following naming convention: <ServerName>-System.

If necessary, a product-controlled or client-created job can be flagged as a system job, so that it can be
run using the System identity instead of a user identity. To designate a job as a system job, enable Mark
as System Job in the General job properties. The following rules apply to manually-created system jobs:
¢ Only system administrators can designate a job as a system job.
e The job cannot contain any tasks that are designated as “non-system” tasks. Non-system tasks
are any tasks that might involve spreadsheet processing, such as Process Plan Files.

» Processing priority for scheduled jobs

Once a job reaches its start time, it is eligible to be processed by Scheduler and joins the processing
gueue. For scheduled jobs, the start time is based on the scheduling rule that placed it on the schedule.
For other jobs, the start time is the time that the job was placed on the schedule using Run Once or
triggered by an event handler.

Administrator's Guide Axiom Contract Management | 293



Each Scheduler service has a configured number of threads that are used to process jobs. As a Scheduler
thread becomes available, it takes the next job in the processing queue. The priority of jobs in the
processing queue is determined by the combination of the job's priority category, and its Priority
Elevation setting.

Each job has a priority category, based on how the job execution was initiated. The priority categories
are as follows:

1. Manual: The job was executed manually.
2. Event Handler: The job was executed by a Scheduler event handler.
3. Scheduled Job: The scheduled instance of the job results from an active scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a currently executing job.

Manual jobs are highest priority and are processed first, and subordinate jobs are lowest priority and
are processed last. Within each category, jobs are processed according to their Priority Elevation
setting.

For example, imagine that Scheduler has 2 available threads and the following jobs are eligible to be
processed:

Job Priority Category  Priority Elevation
A Manual Default

B Event Handler Default

C Scheduled Default

D Scheduled Elevated

e Scheduler will execute jobs A and B first, because those are the highest priority jobs based on
their priority category.

¢ When the next thread becomes available, Scheduler will execute job D. Although job C may have
entered the queue first, and the two jobs have the same priority category, job D's priority
elevation is set to Elevated so it takes precedence within the category. If instead both jobs were
set to Default, then job C would be executed first if it entered the queue before job D.

e When the next thread becomes available, Scheduler will execute job C.
NOTE: If a job's Priority Elevation is set to Interrupt, then it is run as soon as it is eligible, regardless
of its priority category and regardless of whether any Scheduler threads are currently available to

process the job. If no Scheduler threads are available, a new one is created to process the job, even
if this temporarily exceeds the number of configured threads for the server.
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The Scheduler dialog

The Scheduler dialog is used to create and manage Scheduler jobs.

To access Scheduler:

e On the Axiom tab, in the Administration group, click Manage > Scheduler.

NOTE: In systems with installed products, this feature may be located on the Admin tab. In
the System Management group, click Scheduler.

The top section of the Scheduler dialog contains a ribbon-style toolbar with two tabs: Job and Service.
e Onthe Job tab, you can create, run, and edit jobs.

¢ On the Service tab, you can manage scheduled jobs, view job results, and perform other
Scheduler management activities.

As you perform actions on the Job and Service tabs, additional tabs are opened in the navigation pane
of the dialog. For example, clicking the Scheduled Jobs button on the Service tab opens the Scheduled
Jobs tab in the navigation pane. You can move between any open tab in the navigation pane, regardless
of which tab is selected in the ribbon. The ribbon updates to show the related commands for the
selected item.

A | Axiom Scheduler - Process Plan Files ? s

Job Service

e N N

(3 = H P = =X =
New Open Save Close Run Add Remove Clear
Once - Selected  All

i Scheduled Jobs [ Process Plan Files

» Task Control

General
Job Variables v Task Details
Scheduling Rules
Event Handlers Options | Plan Files | Axiom Queries | Processing Variables
Motification
4 Tasks Processing Mode
Process Plan Files @ N Ip .
Job Results ® MNormal Processing

() Process with Utilities
() Update Persistent Plan Files

() Process with Custom Utility {requires Excel)

Processing Options

Select File Group: |Current Budget
Save document after processing
Run Save To Database on plan files after processing

[ Create a plan file restore point before processing

Example Job tab
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€} Axiom Scheduler - Scheduled Jobs ? *
Job Service
- = P .
- = V&S - ﬂ
Scheduled Event Remote Data Job  Servers
Jobs  Handlers Connections Results
&~ Scheduled Jobs
ID Job User Status Server Priority Start Time Due In
4559790  System.ProcessNotification System Pending Scheduled Job 771172018 17:01  44.42 minutes
4559766 Systemn.SystemDataPurge System Pending Scheduled Job  7/12/2018 01:00  8.72 hours
4559769  System.ndexMaintenance System Pending Scheduled Job  7/12/2018 02:13 12,97 hours
4559792 Process Plan Files admin Pending Scheduled Job  7/12/201816:05  23.81 hours

Example Service tab

When you right-click a tab in the dialog's navigation pane, you can close or save items as follows:

e For all items, you can Close, Close All, or Close All But This.

e For jobs, you can Save or Save As. Selecting Save As allows you to save a copy of the job to the
Scheduler Jobs Library in the Axiom Contract Management file system.

The Scheduler Jobs Library is also accessible via Axiom Explorer.
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13

Scheduler Job Setup

To perform Axiom Contract Management tasks using Scheduler, you must create jobs. Each job can
execute one or more tasks. This section discusses how to set up jobs, including how to schedule jobs for
future execution and how to be notified when a job has been completed.

Managing Scheduler jobs and tasks

Using the Axiom Scheduler dialog, administrators can create and edit Scheduler jobs. To access this
dialog:

e On the Axiom tab, in the Administration group, click Manage > Scheduler.

NOTE: In systems with installed products, this feature may be located on the Admin tab. In
the System Management group, click Scheduler.

This section discusses how to create, edit, and delete jobs and tasks, not how to manage the Scheduler
gueue once jobs have been placed on the schedule. If you need to stop or reschedule a scheduled job,
see Managing scheduled jobs.

Scheduler jobs are saved as XML files and are stored in the Axiom Contract Management file system at
\Axiom\Scheduler Jobs Library.

» Creating a Scheduler job

You can create a new Scheduler job to perform one or more tasks.

To create a new job:
1. Inthe Scheduler dialog, on the Job tab, click New.
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A Biom Scheduler - Scheduled Jobs

Job Service
New Open

i Scheduled Jobs

ID lob User Status
4575512 System.ProcessMotification System Pending
4575500  Systemn.SystemDataPurge Systern Pending
4575502 System.ndexMaintenance System Pending

A new tab appears in the navigation pane, labeled New Job. The left-hand side of the job lists
sections for which you can define various job settings. When you click a section name, the
settings for that section display in the right-hand side of the job.

2. Inthe General section, define general job settings as desired.
For detailed information on the available settings for a job, see Job properties.
3. In the Scheduling Rules section, specify scheduling details for the job.

You can schedule the job for future execution, for one time or on a recurring basis.

NOTE: If you are always going to run the job manually, and do not need to schedule it for
future execution, then you do not need to define scheduling rules.

For more information, see Defining scheduling rules for a job.
4. In the Notification section, specify email notification options for the job.

You can send email notifications every time the job completes, or only when the job experiences
errors. By default, the job is configured to notify on completion.

For more information, see Setting up notifications for jobs.
5. Inthe Tasks section, add one or more tasks to the job.

a. Onthe Job tab of the ribbon, in the Tasks group, click Add. This brings up a list of available
tasks. Select the task that you want to add.

The task is added to the Tasks section, and the settings for the task display in the right-
hand side of the job.
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b. Complete the settings for the task as desired.

The Task Control section of the task contains standard task settings, and the Task Details
section contains settings unique to the task type. For more information, see Task Control
properties.

If a required setting is not completed, the setting is highlighted in red and error text
appears in the bottom of the dialog. Make sure to complete all required settings for the
task before saving.

Repeat this process until you have added all desired tasks to the job. Tasks are processed in the
order listed. If you need to change task order, select a task and then click Move Up or Move
Down.

6. In the Job tab of the ribbon, click Save.

7. At the bottom of the Save As dialog, in the File name box, type a name for the job, and then click
OK.

The job is saved as an XML file in the Scheduler Jobs Library.

If the job was saved with an active scheduling rule, Axiom Contract Management determines the next
scheduled date of execution and schedules the job. You can view the job in the Scheduled Jobs list (on
the Service tab of the ribbon, click Scheduled Jobs).

Advanced job settings
This procedure covers the basic steps of creating a job. Jobs also support the following advanced
options:
¢ Event handlers: You can create event handlers for the purposes of running the job using the
RunEvent function. This allows users to trigger job execution from within an Axiom file.

¢ Job variables: You can create job variables and then use those variables within certain job
settings. You can then dynamically pass in values for those variables when using the RunEvent
function to execute the job.

For more information, see Advanced options, Using job variables, and Using RunEvent to execute a
Scheduler job.

» Editingajob
You can edit a job at any time to change job settings, add or remove tasks, change scheduling rules, or
change notification options.

This section describes the general process of opening a job for editing. For more details on the impacts
of editing scheduling rules, see Defining scheduling rules for a job.

To edit a job:
1. Inthe Scheduler dialog, in the Job tab, click Open.
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The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.
2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(the most recently opened tab is the active tab by default).

3. Edit the job and task properties as desired.

For detailed information on the available settings for a job, see Job properties. For detailed
information on task settings, see Task Control properties.

4. In the Job tab of the ribbon, click Save.

» Deleting a job

Deleting a job removes any scheduled executions of the job from the scheduled jobs list.

To delete a job:
1. Inthe Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Navigate to the job that you want to delete, then right-click the job and select Delete.

You can also delete Scheduler jobs from Axiom Explorer or the Explorer task pane.

Defining scheduling rules for a job

Once a job has been created, you can run it on demand, or you can schedule it for future execution. Jobs
can be scheduled to be run one time, or on a recurring basis. To schedule a job, you define scheduling
rules for the job.

You can add, edit, and remove the scheduling rules for a job at any time using the Scheduling Rules
section of the job properties. You can also flag a rule as active or inactive. If a job has no scheduling
rules, or if all of its scheduling rules are inactive, then it will not be run unless it is run manually by a
user.

If a job is saved with an active scheduling rule, then Axiom Contract Management determines the next
scheduled instance of the job and places it in the scheduled jobs list. Once that instance has been
processed, the next scheduled instance is determined and scheduled, and so on. Each time the job is run
using an active scheduling rule, it is run as the current job owner (unless the job is a system job, in which
case it is run as the Scheduler Service System identity).

If a job has multiple active scheduling rules, Axiom Contract Management evaluates all of the rules and
schedules a single instance of the job, for the earliest time allowed by the rules. Multiple scheduling
rules do not result in multiple scheduled instances of the job.
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NOTE: If a time zone is listed on the Scheduling Rules section of the job, then the defined rules will
be evaluated in the context of that listed time zone. Otherwise, scheduling rules are evaluated in the
context of the local time zone for the Scheduler Server. If necessary, the system configuration
setting SchedulingBehaviorTimezone can be used to specify a particular time zone for evaluating
scheduling rules.

» Adding a Scheduling rule

You can add a scheduling rule to a job to schedule it for future execution, either one time or on a
recurring basis.

If you only plan to run the job manually on demand, then you do not need to create a scheduling rule.

To add a scheduling rule to a job:
1. Inthe Scheduler dialog, open a job to edit or create a new job.

2. Inthe left-hand side of the job, select Scheduling Rules.
By default, this area is empty. You must add a rule in order to define scheduling for the job.
3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules section, click Add.

A new row appears in the right-hand side of the job. By default, the new row is active, but does
not have start / end dates or any specific recurrence settings.

4. Complete the following settings within the row as needed:

Item Description

Active If you want the job to be placed on the schedule as soon as you save the
job with the new scheduling rule, then you should leave this option
checked.

However, if you just want to save your schedule settings but you are not
ready to begin scheduling the job, then you can clear the Active check box
for the rule. The job will not be scheduled until it is saved with an active
scheduling rule.
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Item Description

Starting On Optional. These dates specify the time frame for the scheduling rule. The
starting date defines the earliest point in time that the job can be
scheduled, and the ending date defines the latest point in time that the
job can be scheduled.

Ending On

If these dates are not defined (left blank), then the job will be perpetually
scheduled according to the rule settings, as long as the rule is active.

If you want to schedule a one-time job, then set the starting / ending
dates to the same date and time.

NOTE: Your system locale determines the format of dates.

Day of Week Specify the day(s) of the week that you want the job to be run:
e * (Default): The job will be run on all days within the start / end range.
e 0-6: The job will be run on the specified day or days, where 0 is Sunday
and 6 is Saturday. Use a comma or a hyphen to separate multiple days
(hyphen if the days are contiguous, commas if not).
For example, you can enter 1, 3, 5 for Monday, Wednesday, and Friday,
or enter 1-5 for Monday through Friday.

Hours Specify the time of day (hours) that you want the job to be run, in relation
to the specified days:
e * (Default): The job will be run on all hours.

e 0-23:The job will be run on the specified hour or hours, where 0 is
midnight and 23 is 11:00 PM. Use a comma or a hyphen to separate
multiple hours (hyphen if the hours are contiguous, commas if not).

For example, you can enter 0, 12 to run at midnight and noon, or enter
0-12 to run every hour from midnight to noon.
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Item Description

Minutes Specify the time of day (minutes) that you want the job to be run, in
relation to the specified hours:

e * (Default): The job will be run on all minutes (essentially the job is run
continuously, once per minute).

e 0-59: The job will be run on the specified minute or minutes of the
hour, where 0 is the first minute of the hour and 59 is the last minute
of the hour. Use a comma or a hyphen to separate multiple minutes
(hyphen if the hours are contiguous, commas if not).

For example, you can enter 0, 30 to run at the top of the hour and the
half hour, or enter 0-30 to run every minute from the top of the hour to
the half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you
enter an hour but leave the minutes at the default asterisk, then the job
will run every minute in that hour.

If the Active check box for the rule is selected when the job is saved, then Axiom Contract Management
will calculate the date and time of the first scheduled execution and will place the job on the schedule.

» Editing a scheduling rule

You can edit a scheduling rule at any time, to toggle between active and inactive, and to change the
start / end dates and recurrence settings.

NOTES:

¢ If a pending instance of this job is currently on the schedule, and you edit the scheduling rule,
the pending instance will be updated to match the new schedule.

¢ [If you inactivate a scheduling rule, any currently scheduled instances of the job will be
automatically removed from the schedule.

To edit a scheduling rule:
1. Inthe Scheduler dialog, open a job to edit or create a new one.

2. Inthe left-hand pane of the job, select Scheduling Rules.
The defined rules display in the right-hand pane of the job.

3. Make any desired changes directly within the scheduling rules grid.
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» Deleting a scheduling rule

You can delete a scheduling rule at any time. If a job has no active scheduling rules, it will not be
processed unless it is manually run.

To delete a scheduling rule:
1. Inthe Scheduler dialog, open a job to edit.

2. Select the Scheduling Rules section of the job, and then select the rule that you want to delete.
3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules group, click Remove Selected.

Alternatively, if you want to delete all scheduling rules for the job, click Clear All.

Any jobs in the scheduled jobs queue that were related to the deleted rule(s) are also deleted.

» Scheduling rule examples

The following are some example schedules and the rules used to achieve them:

Schedule Start/End Day of Week Hours Minutes
Weekdays at 11:00 <optional> 1,2,3,4,5 23 0
PM
Every 15 minutes <optional> * * 0,15,30,45
Mondays at 11:30 <optional> 1 23 30
PM
One time Start: 06/30/2022 00:00 * 13 30
(6/30/2022) at 1:30 4 7/01/2022 00:00
PM
(Option 1)
One time Start: 06/30/2022 13:30 - & &
(6/30/2022)at 1:30 ¢ 4 06/30/2022 13:30
PM
(Option 2)
Every Wednesday in Start: 07/01/2022 00:00 3 12 0
I
July at noon End: 08/01/2022 00:00
Continuous <optional> & & &

To schedule a job to execute monthly, create twelve active scheduling rules, one for each month. This is
necessary because scheduling rules do not have a property for day of month, so it is not possible to use
a single scheduling rule to create a monthly schedule. In the following example, the job will be executed
on the first day of each month, at 3:30 AM:
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Example scheduling rules to execute a job monthly

When you save the job, the rules will be evaluated and the first scheduled execution will be placed on
the schedule—in this example, the January 1 execution. Once that scheduled execution is complete, the
rules will be evaluated again, which will cause the next scheduled execution (Feb 1) to be placed on the
schedule, and so on.

Setting up notifications for jobs
Scheduler can be configured to send an email notification when a job completes, or when a job has
errors. In order for an email notification to be sent for a particular job, the following must be set up:
¢ The job must be configured to send a notification on completion or error. The notification
settings must include valid To and From email addresses (or use system variables).

e The System.SMTPMessageDelivery system job must be configured with a valid SMTP server for
your environment. For more information, see Scheduler setup.

When a job creates an email notification, the notification is first saved to the database. When
notifications are detected in the database, the System.SMTPMessageDelivery system job is triggered to
deliver the notifications.

NOTES:

¢ By default, all new Scheduler jobs are configured to send an email notification on completion,
to the user who created the job. You only need to edit the notification settings if you want
the job to use different notification behavior.

e Currently, it is not possible to configure a Scheduler job to send notifications within the
application only, instead of by email. However, when a job is run manually, the user who ran
the job may receive an in-application notification of the job status in addition to any
configured email notifications. See Application notifications for Scheduler jobs that are run
manually.

To configure a job to send email notifications:
1. Inthe Scheduler dialog, open a job to edit or create a new job.

2. Inthe left-hand side of the job, select Notification.
3. Inthe Job Notification Level section, select one of the following:

¢ Send all email notifications: (Default) An email notification is always sent when the job is
executed, regardless of the job status (success, failure, aborted, etc.).
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¢ Send email notification only when the job has errors: An email notification is only sent if
the job experiences errors. If the job completes successfully with no errors, no email
notification is sent.

¢ None: No email notifications are sent for this job. The only way to check the status of the
job execution is to view the job history.

¢ Send email notification to different email addresses when the job has errors or
succeeds: This option works the same way as Send all email notifications, except that a
separate email address can be specified to receive the error notifications.

4. Inthe Notification Message Content section, complete the following for the notification email:

Iltem Description

To The email address(es) to receive the notification email. Separate multiple

addresses with a semicolon. For example:

e To send the email to two recipients, enter the addresses such as:
jdoe@company.com;dsmith@company.com

e To use a Scheduler job variable to define a notification recipient, enter
the variable name with curly brackets. You can combine regular email
addresses and variables, such as: { JobOwner.EmailAddress};
jdoel@company.com

By default, the notification is configured to be sent to the user who

executed the job, using the variable {CurrentUser.EmailAddress}.

The entries in the To field must be valid email addresses, or Scheduler job
variables that will resolve to valid email addresses. Currently, it is not
supported to list user or role names, or to look up email addresses from
Axiom Security.

NOTE: When using Send email notification to different email addresses
when the job has errors or succeeds, this user will be notified if the job
completes successfully (including partial success), but not if the job fails.
Job failure notifications are sent to the To (on error) recipients.
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Item Description

From The email address that the message is sent from. This can be something
like axiomscheduler@company.com, so that the recipient can easily tell
that the message has been generated by Scheduler.

By default, this is set to the Scheduler "from" email address as defined in
the system configuration settings, using the system variable
{Scheduler.FromEmailAddress}.

NOTE: For installations that are using subsystems, the system variable
{Scheduler.FromEmailAddress} may resolve to a subsystem
administrator email address instead of the Scheduler "from" email

address.

Subject The subject of the message. By default, this is set to "Axiom Scheduler
Notification."

User Message Optional body text for the email. This text is included in addition to the

Scheduler auto-generated text regarding the job status.

If Send email notification to different email addresses when the job has errors or succeeds is
enabled, the following additional options are available:

Iltem Description

To (on error) The email address(es) to receive the notification email when the job result
is Failed. Separate multiple addresses with a semicolon.

This user only receives a notification if the job fails. If the job result is
Success or Partial Success, this user will not receive a notification (only
the To user will).

Subject (on The subject of the job failure message. By default, this is set to "Axiom
error) Scheduler Notification."

Job variables can be used in all notification settings.

» Application notifications for Scheduler jobs that are run manually

If you run a Scheduler job manually, you can receive a notification within the application to let you know
the status of the job. This notification will display in the Notifications task pane of the Desktop Client,
and in the Notifications panel of the Web Client. This notification works as follows:

e The in-application notification is only sent if the Scheduler job is run manually using the Run Now
option in Scheduler (or by using an equivalent "run now" action within a product-specific web
page). In-application notifications are not sent if the job is run via a scheduling rule or an event
handler.
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e The in-application notification honors the Notification settings defined for the job to determine
whether the notification is sent. For example, if the job is set to None, then the in-application
notification is not sent. If the job is set to Send all email notifications, then both an email
notification and an in-application notification will be sent when the job completes.

e The in-application notification only reports the status of the job—success, failure, or partial
success. It does not contain any error or success details, and does not include any messaging as
defined in the Notification settings for the job. For more information, view the job results within
the Scheduler dialog in the Desktop Client, or the Scheduler page of the Web Client.

e The in-application notification is always sent to the user who ran the job manually.

NOTE: If the job is configured to Send email notification to different email addresses when the job
has errors or succeeds, this is treated as Send all email notifications for purposes of sending the in-
application notification. The user who ran the job will be notified when the job is completed,
regardless of the job status.

< Axiom Assistant

My Notifications

v ) Process Plan Files

Explorer

The job has completed processing all tasks successfully.

55

Example success notification

Job properties

This topic is a reference for the settings that can be defined for a Scheduler job.

» General

This section defines general settings for the job.

Item Description

Description Optional. The description of the job.

The job description can also be edited in Axiom Explorer, in the Scheduler Jobs
Library.
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Item Description

Job Restart Specifies whether and how the job should be restarted if it is interrupted prior
Behavior to completion. Select one of the following:

¢ Do not reschedule this job. In this case, you must manually reschedule the
job if it needs to be run before its next scheduled execution.

¢ Restart the job from the first task. The entire job is run again, even if some
of the tasks were completed successfully before the job was interrupted.

¢ Resume the job beginning with the first uncompleted task. (Default) The
job resumes and only the uncompleted tasks are run.

A job would be interrupted if the Scheduler server processing it was restarted,
or if the Scheduler service on the server was stopped or restarted, or if the
Scheduler server was disabled from the Servers tab (Service > Servers) of the
Scheduler dialog.

Job Results Specifies whether historical job results are purged when the job is run.

Cleanup To purge job results:

1. Select Purge historical job results whenever this job runs.

2. In Number of days to keep results for this job, specify the number of
days to keep when purging results. By default this is set to 0, which
means all job results will be purged except the result for the current job
execution.

A day is counted as 24 hours from the time the cleanup task is executed. So if
you specify 1 day, and the task is run at 11:00 PM on Tuesday, then all results
prior to 11:00 PM Monday are purged.

If this option is not selected, then historical job results remain in the database
until the system's Purge System Data task is run.
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Item Description

Priority Elevation  Specifies the priority of the job in the scheduled jobs queue, within the job's
priority category. Select one of the following:

e Default: (Default) This job is run on a "first come, first served" basis. The
total number of jobs that can be run at one time is determined by the
configured number of Scheduler threads for the installation.

¢ Reduced: The job is designated as a low priority job, and remains at the
bottom of the queue until other jobs with Default and Elevated priority have
been run.

e Elevated: The job is designated as a high priority job, and is moved to the
top of the queue to be run before Default and Reduced priority jobs.

e Interrupt: The job is run immediately, regardless of any jobs currently
waiting in the scheduled jobs queue, and regardless of whether any
Scheduler threads are currently available to run it. If no Scheduler threads
are currently available, a new thread is created, even if this exceeds the
configured thread limit for the installation.

Job execution order also depends on the priority category of a specific job
execution. See Processing priority for scheduled jobs.

Mark as System Specifies whether the job is run as a system job. Only administrators can edit
Job this check box.

If this check box is selected, the job is run under the "Scheduler Service" system
identity instead of a user identity, and the job is run by the system Scheduler
server which operates on the Axiom Application Server.

Generally, this check box should only be selected for system "support" tasks
that should not depend on individual user rights. This check box is not available
if the job contains non-system tasks (generally, spreadsheet-related tasks).

For more information, see System jobs.
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Item Description

Put the system If this option is selected, then the system will be placed into administrator-only
in 'admin only' mode at the start of the job, and then placed back into full access mode when
mode during this  all tasks are completed (including any sub-jobs). This is the same behavior as
job going to Manage > Security > System Access and selecting Administrators
Only.
NOTES:

¢ You should make sure that any jobs using admin-only mode do not overlap.
For example, imagine that job A starts and places the system in admin-only
mode. While job A is still running, job B starts and finishes. If job B also uses
admin-only mode, then when job B finishes the system will be placed back
into full access mode, meaning the remainder of job A will be processed in
full access mode.

¢ Any job using admin-only mode must be run by an administrator.

Generally speaking, any job set to run using admin-only mode should be run at
a time when no end users will be logged into the system and no other
Scheduler jobs will be running.

» Job Variables

This tab has two sections for job variables:

¢ |Inthe Job values section at the top of the tab, you can manage user-defined variables for use in
the current job.

To add or remove variables, use the Add, Remove Selected, or Clear All commands in the Job
Variables group of the Job tab. This group is only available when you have selected the Job
Variables section in the left-hand side of the job.

When creating user-defined variables, do not add curly brackets to the variable name. Curly
brackets are only required when you use the variable in a job or task setting.

¢ |n the System defined values section at the bottom of the tab, you can view the system variables
available for use in the job.

You can right-click any variable in this section (user-defined or system-defined) and select Copy variable
name to clipboard. You can then navigate to the setting where you want to use the variable, and then
paste it. The variable will be pasted with the necessary curly brackets.

For more information, see Using job variables.

» Scheduling Rules

Each row in this section defines a scheduling rule for the job. Jobs will be automatically scheduled
according to the settings in this section.
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To add or remove scheduling rules, use the Add, Remove Selected, or Clear All commands in the
Scheduling Rules group of the Job tab. This group is only available when you have selected the
Scheduling Rules section in the left-hand side of the job.

For more information, see Defining scheduling rules for a job.

Iltem Description

Active Specifies whether the scheduling rule is active. If this check box is not selected,
then the rule is ignored for purposes of scheduling the job.

Starting On Optional. Specifies the earliest date and time for the scheduling rule to take
effect.

If you want the job to run one time only, set Starting On and Ending On dates
to the same date/time.

Ending On Optional. Specifies the expiration date and time for the scheduling rule. Once
this date is past, no further executions will be scheduled for this rule.
Day of Week Specifies the day(s) of the week that you want the job to be run:
e  (Default): The job will be run on all days within the start / end range.

e 0-6: The job will be run on the specified day or days, where 0 is Sunday and
6 is Saturday. Use a comma or a hyphen to separate multiple days (hyphen
if the days are contiguous, commas if not).

Hours Specifies the time of day (hours) that you want the job to be run, in relation to
the specified days:
e * (Default): The job will be run on all hours.

e 0-23: The job will be run on the specified hour or hours, where 0 is midnight
and 23 is 11:00 PM. Use a comma or a hyphen to separate multiple hours
(hyphen if the hours are contiguous, commas if not).

Minutes Specifies the time of day (minutes) that you want the job to be run, in relation
to the specified hours:

e * (Default): The job will be run on all minutes (essentially the job is run
continuously, once per minute).

e 0-59: The job will be run on the specified minute or minutes of the hour,
where 0 is the first minute of the hour and 59 is the last minute of the hour.
Use a comma or a hyphen to separate multiple minutes (hyphen if the hours
are contiguous, commas if not).

» Event Handlers
If an event handler is associated with the job, it is listed here. There are two types of event handlers:

e System event handlers, for completing system-triggered tasks. See Managing event handlers.

e User-defined event handlers, for running jobs via RunEvent. See Advanced options.
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To add or remove event handlers, use the Add, Remove Selected, or Clear All commands in the Event
Handlers group of the Job tab. This group is only available when you have selected the Event Handlers
section in the left-hand side of the job.

Iltem Description

Active Specifies whether the event handler is active or not within the current job. If
inactive, then actions that trigger the event handler will ignore this job.

Event Name The name of the event handler.

Multiple jobs can have an event handler with the same name; all those jobs will
be affected when the event handler is triggered.

Execute As The user identity under which the job will be run when the event handler is
triggered.
¢ Owner: For system-managed event handlers, the owner is the system
Scheduler identity. For user-defined event handlers, the owner is the user
who last saved the job.
e Requester: For all event handlers, the requester is the user who caused the
event handler to be triggered.

» Notification

This section defines email notification settings for the job. For more information, see Setting up
notifications for jobs.

Job variables can be used in this section. For more information, see Using job variables.

Iltem Description

Job Notification Specifies when email notifications are sent for the job. Select one of the
Level following:
¢ Send all email notifications (Default)
¢ Send email notification only when the job has errors
* None
¢ Send email notification to different email addresses when the job has
errors or succeeds
If anything other than None is selected, then you must complete the remaining
fields.

To The email address(es) to receive the notification email. Separate multiple
addresses with a semicolon.
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Item Description

To (on error) The email address(es) to receive the notification email when the job fails.
Separate multiple addresses with a semicolon. Only applies when Send email
notification to different email addresses when the job has errors or succeeds

is enabled.
From The email address to use as the "From" address for the notification email.
Subject The subject text for the notification email.
Subject (on The subject text for the notification email when the job fails. Only applies when
error) Send email notification to different email addresses when the job has errors

or succeeds is enabled.

User Message Optional. The body text for the notification email.

Text entered here will be appended to the body text generated by Scheduler.

» Tasks
This section defines the tasks in the job. In the ribbon, task commands are available on the Job tab, in
the Tasks group.

e To add a task, click Add.

e To change the order of tasks, select a task and then click Move Up or Move Down.

¢ To delete a task, select the task and then click Remove Selected.

e To delete all tasks, click Clear All.

e To copy a task, right-click the task and then click Copy. You can copy the task within the same job,
or to another open job in the Scheduler window. Right-click any task (or the Tasks section header)
and then select Paste. The job is pasted underneath the job you right-clicked (or at the end of the
list if you right-clicked the Tasks section header).

e To rename a task, double-click the task name to make it editable, and then type the new name.
For example, if you have a job with multiple File Processing tasks, then you may want to edit the
name of each task so that you know which file each task relates to at a glance. (You can also right-
click and select Rename.)

Tasks are processed in the order they are listed in the job. By default, when you add a new task to a job,
it is placed at the bottom of the list. Make sure to move the new job if it should not be processed last.

Tasks can be processed concurrently instead of sequentially if they are configured to be run as a
subordinate job within the parent job.

Each task type has its own unique settings in addition to the standard task settings. For more
information, see Scheduler Task Reference.

» Job Results

Displays historical results for the job. This section is blank if the job has never been run.

Administrator's Guide Axiom Contract Management | 314



Job results may be purged periodically by using the Job Results Cleanup option for the job, or by the
system Purge System Data task.

NOTE: Users with the Scheduled Jobs User security permission only see results for jobs that they
executed. Administrators see results for all executions.

For more information on job results, see Viewing job results.

Advanced options

Creating event handlers for a job

You can create user-defined event handlers in a job, for the purposes of automatically triggering the job
for execution when the event name is called by another feature. Axiom Contract Management supports
several features that can be used to raise an event:

e The RunEvent function and command
¢ File Group triggers
¢ The Raise Event Scheduler task

Event handlers are defined by name. Multiple jobs can have an event handler with the same name.
When that event handler is called, it will affect all jobs that contain the event handler with the matching
name.

To create an event handler in a job:
1. Inthe Scheduler dialog, open a job to edit or create a new job.

2. Inthe left-hand side of the job, select Event Handlers.
3. On the Job tab of the ribbon, in the Event Handlers group, click Add.
A new event handler is added to the job.

4. Double-click the Event Name field so that the field becomes editable, and then type the desired
event handler name.

For example, if the event handler will be used to trigger Process Plan Files jobs, you might name
the event handler ProcessPlanFiles.

This event name is the name that will be used in features such as RunEvent to trigger this job for
execution.

5. Inthe Execute As field, select one of the following to determine the user identity that will be
used to run the job when it is executed via the event handler:

e Owner: The job will be run under the identity of the job owner.
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The job owner is the user who last saved the job. If you are not sure who the current job
owner is, you can check the Job Variables tab. The current job owner is listed in the
System defined values section.

e Requester: The job will be run under the identity of the user who triggered the event
handler.

By default, event handlers are set to run as the Owner. You should carefully consider this option
as it may affect whether the job can be run and how the job is run.

For example, if the event handler is set to Requester, but the user who triggered the job does not
have access to the file group specified for a Process Plan Files task, then the task will fail.

This may be the desired outcome—you may want the job to be dependent on the user's rights,
and therefore you should specify Requester. On the other hand, you may want the job to runin
the same way every time, regardless of the user that triggers the job. In that case you should
specify Owner.

By default, the event handler is set to Active, which means it will be found by any process that triggers
the event handler. If you want to temporarily exclude this job from event handler processing, you can
clear the Active check box.

» Associating an event handler with a file group

If a Scheduler job with an active event handler is stored in a file group Utilities folder, then the event
handler is associated with that file group. When using RunEvent to trigger jobs for execution, you can
optionally specify a file group context so that only event handlers associated with that file group (or no
file group) are considered.

In order to store a Scheduler job within a file group, you must first create and save the job within the
Scheduler Jobs Library. Then, you can use Axiom Explorer to move the job from the Scheduler Jobs
Library to the file group Utilities folder. If the file group and its utilities are later cloned using any
process—such as regular file group cloning, scenario creation, or file group rollover—then the event
handler is also cloned and will be associated with the new file group.

» Deleting an event handler

If you no longer need an event handler, you can delete it from the job. Select the event handler and
then click Remove Selected. You can also Clear All to remove all event handlers from the job.

User-defined event handlers display along with the system event handlers in the Event Handlers tab
(Service > Event Handlers). If you right-click a user-defined event handler in this location and select
Remove event handler, it does not delete the event handler from any jobs that use it, but it does set
the event handler to inactive.
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Using job variables

You can use job variables within a Scheduler job, to define the value of the variable when the job is run.
Job variables are managed in the Job Variables section of the job.

There are two types of variables:

e User-defined variables: You can create a variable and then use it within any job or task setting
that supports variables, but only within that particular job. The primary use for user-defined
variables is to run a job via RunEvent (either the function or the command), and pass in a variable
value at that time.

e System variables: Axiom Contract Management provides a number of system variables that can
be used within relevant job and task settings. For example, instead of specifying a "hard-coded"
email address for the job notification, you can use a system variable to specify that whoever ran
the job should receive the notification.

In all cases, to use a variable within a job or task, enter the variable name into the desired setting,
enclosed in curly brackets. For example: {variable}

TIP: If you want to use a variable in a job, you can right-click the variable and then select Copy
variable name to clipboard. Navigate to the setting where you want to use the variable, and then
paste it into the setting (the curly brackets are added automatically).

At the job level, variables can be used in any of the Notification Message Content settings in the
Notification tab. At the task level, in general, variables can be used in any task field that accepts typed
user input.

When the job is run, the variable values used for the job display in the job results under Job Values, and
also in the email notification (if applicable).

» User-defined variables

User-defined variables are created in the Job Variables tab. You define the name of the variable
(without brackets), and if desired, define a default value for the variable.

When the job is run, the user-defined variable will be replaced with a value as follows:

e If the job was scheduled using RunEvent (function or command), and RunEvent sent a name /
value pair that matches the name of the job variable, that value is used.

e If the job was scheduled as a result of a file group trigger, and the trigger has a defined variable
that matches the name of the job variable, that value is used. Multiple values are returned as a
comma-separated list.

e If the job contains a Process Document List task or a Process Plan Files task with a defined post-
processing variable that matches the name of a job variable, that value is used after that task has
been processed.
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¢ Otherwise, the default value defined in the Job Variables tab is used.

If the value is blank, then the job or task setting using the variable will be evaluated as blank. If the
setting cannot be blank, then an error will result when the job is executed.

» System variables

The available system variables are listed at the bottom of the Job Variables tab. Most of these variables
relate to user names and addresses, for use within the job notification settings.

When the job is run, the system variable is replaced with the applicable system value.

The following values are available:

VEIELE Description

{CurrentUser.EmailAddress} Returns the current user's email address,

{CurrentUser.LoginName} login name, or full name.

{CurrentUser.FullName} The current user is the user identity
under which the job is currently being
run. Generally, this is the user who
executed the job. If the job was executed
via an event handler and the event
handler is set to owner, then the current
user will be the job owner.

{JobOwner.EmailAddress} Returns the job owner's email address,

{JobOwner . LoginName ) login name, or full name.

{JobOwner.FullName} The job owner is the user who last saved
the job.
{Scheduler.ConfiguredFromEmailAddress} Returns the system's default "from"

address, as defined in the system
configuration settings.

{Scheduler.FromEmailAddress} This returns a value as follows:
¢ [f the current user belongs to a

subsystem, this returns the subsystem
administrator's email address.

¢ |f the current user does not belong to
a subsystem, this returns the default
configured "from" address.
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VEIELE Description

{CurrentSubsystem.AdminEmailAddress} Returns the email address of the

subsystem administrator for the
subsystem that the current user belongs
to.

¢ |f the subsystem has multiple
administrators, the email is sent to the
first administrator.

¢ [f the user belongs to multiple
subsystems, the first returned
subsystem for the user will be used.
No specific logic is applied to
determine the "correct" subsystem for
any particular job.

¢ |f the user does not belong to a
subsystem, then no email address is
returned.

{EventHandler.EventName} Returns the name of the event handler
that caused the job to be scheduled, if
applicable. Otherwise the variable returns
blank.

{NotificationAddress} Returns the notification address defined
for the plan codes that triggered a
Scheduler job.

This variable only applies when the job is
executed as a result of a file group
trigger, and only if the optional
notification address settings are defined
for the file group. Otherwise, no email
address is returned.

{Task.CurrentIterationvValue} Returns the current iteration value and

{Task.IterationNumber} the current iteration number. These
variables only apply when using the
Iteration feature for a task.

For more information, see Using iterative
task processing.

Processing tasks in parallel

Each Scheduler job can have multiple tasks. By default, each task in the job is processed sequentially, in
the order that the tasks are listed in the job.
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If desired, you can configure tasks so that they are processed concurrently (in parallel) instead of
sequentially. If appropriate, this may speed up the processing of the job.

» Configuring tasks for parallel processing
In order to process tasks in parallel, the tasks must be configured to run as subordinate jobs (sub-jobs).
To do this, edit the following settings in the Task Control section for each task:

» Select Create a Subordinate Job for this Task.

e Ensure that the following setting is not selected: Wait for all Subordinate Jobs to complete
before proceeding to the next Task.

In the following example, if all four tasks are configured to be run as subordinate jobs, then they can be
run in parallel (depending on the available Scheduler threads).

A | Axiom Scheduler - FileProcessing ? =

Job | Semvice

2 ’ ’
New Open Save Close Run Add Move Remove Clear
Once - Down Selected All
i Scheduled Jobs | [] FileProcessing
General  Task Control
Variables
Scheduling Rules [ Skip this Task.
Event Handlers
Netification Process task only if the value of this expression is true
4 Tasks
File Processing-1

File Processing-2

File Processing-3

File Processing-4 ) ) .
Resulte [ 1 this Task fails, continue executing subsequent Tasks.
Create a Subordinate Job for this Task.

[ Wait for all Subordinate Jobs to complete before proceeding to the next Task.

> Task Details

Scheduler task configured to run as a subordinate job to enable parallel processing

» How parallel processing works

When a task is configured to execute as a subordinate job, then it is not processed within the "parent"
job. Instead, a sub-job is created for the task. The sub-job joins the Scheduler queue and is eligible for
processing according to the normal Scheduler processing rules. For more information, see Processing
priority for scheduled jobs.

For example, imagine that you have a job with four tasks, and these tasks are not dependent on each
other. If you use the default settings, Scheduler takes the first task in the list and starts processing. The
second task is not started until the first task is complete, and so on.

If instead you configure each task as a sub-job, then when the "parent" job is processed, it will create
four sub-jobs. If two Scheduler threads are available for processing, then two of the sub-jobs are
processed at the same time. If four Scheduler threads are available, then all four sub-jobs are processed
at the same time. Once all of the sub-jobs are complete, the parent job is completed, and its status
reflects the overall status of all of the sub-jobs.
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If tasks are dependent on each other, then you should not process them as sub-jobs, or you should use
the Wait setting as appropriate. For example, imagine that the first four tasks in the job can be run in
any order, but the fifth task must be processed last. In that case, you can configure the first four tasks to
run as sub-jobs, but on the fourth task you must enable Wait for all Subordinate Jobs to complete
before proceeding to the next Task. This will cause Scheduler to wait for all sub-jobs to finish before it
proceeds to the fifth, final task.

In the following example, the file processing tasks are configured as sub-jobs so that they can be run in
parallel. The last file processing task is configured to wait, so that all of the file processing tasks will be
finished before the file collection task begins.

A Axiom Scheduler - FileProcessing

Job Service

¥ W) =t 8=

New Cpen Close  Run Add Move Move Remove Clear
Once - Up Down Selected All

i Scheduled Jobs | [] FileProcessing

General w Task Control

Variables
Scheduling Rules L] skip this Task.
Event Handlers
Natification Process task only if the value of this expression is true
4 Tasks
File Processing-1
File Procassing-2
File Processing-3
File Processing-4
Collect Worksheets
Results

[ If this Task fails, continue executing subsequent Tasks.
Create a Subordinate Job for this Task.

Wait for all Subordinate Jobs to complete before proceeding to the next Task.

* Task Details

Scheduler task configured to wait for all subordinate jobs to complete

» Using an Echo task to control jobs with sub-jobs

By default, if a sub-job fails, this failure status will not prevent the parent job from continuing to process
tasks. If you want the parent job to stop processing on sub-job failure, you can use an Echo task to do
this.

If the Task Control option Wait for all Subordinate jobs to complete before proceeding to the next
task is enabled for an Echo task, then the Echo task will inherit the status of the sub-jobs when they are
completed. If one of the sub-jobs fails, then the Echo task will inherit that failed status. By default, this
means that the job will not process any further tasks due to the sub-job failure.

In the previous example, if one of the file processing tasks being run as a sub-job fails, this will not stop
the final file collection task from being processed. To work around this, you can place an Echo task after
the file processing tasks and configure it to wait, and then if any of the file processing sub-jobs fail the
Echo task will fail. This task failure within the parent job will stop the final file collection task from being
processed. (When using this configuration, the fourth file processing task does not need to be
configured to wait, because the job will wait on the Echo task instead.)
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Using iterative task processing

You can configure a Scheduler task to use iterative processing, so that the task is repeated multiple
times using a designated list of values. Each iteration of the task uses a different item in the list, until all
items have been processed.

When you enable iterative processing for a task, you define the list of values by specifying a table
column and an optional filter. The task will then be processed for each unique item in the table column.
You can reference the column values within the task properties by using a built-in Scheduler job
variable. As each iteration of the task is processed, the variable is replaced with the column value for the
current iteration. Using this approach, the task can dynamically change for each iteration.

For example, you may have an import that you want to perform for four different entities in your
organization. The import configuration is exactly the same except that the source file or query is
different for each entity. If the import uses entity as a variable, then you can set up a single import task
and configure it to iterate over the list of entities. Each iteration uses a different entity name or code,
which you can pass into the import variables so that the import uses the correct source file or query for
the current entity.

» Enabling iterative processing

Iterative processing is enabled in the Task Control properties of the task. Select the task within the
Scheduler job, then click Task Control to expand that section. Any task can use iterative processing,
though it is more useful for certain task types such as Import ETL Package.

Complete the following properties in the Iteration section of the Task Control properties.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate Specifies whether each iteration is processed as a separate subordinate

Job for each iteration job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution of multiple iterations. This option should
only be enabled if the order of iteration processing is not important.
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Item Description

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept .Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the
iterative processing. You can use any filter that is valid against the source
table (the table of the iteration column).

When iterative processing is enabled for a task, the iterations are always processed within a subordinate
job. Therefore, enabling the Task Control option of Create a Subordinate Job for this Task is
unnecessary.

If your job has multiple tasks, and you want the tasks after the iterative task to wait for all iterations to
complete before executing, then you must enable the following Task Control option for the iterative
task: Wait for all Subordinate Jobs to complete before proceeding to the next Task.

» Configuring the task to change for each iteration

In order for the Scheduler task to apply the current iteration value to each iteration, you must use the
built-in iteration variables within the task. These variables are job variables, and can be used like any
other job variable. The following variables are available:

Variable Description

{Task.CurrentIterationValue} Returns the current value from the iteration list.

{Task.IterationNumber} Returns the number of the current iteration.
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To continue the previous example, imagine that you are setting up an import for iterative processing by

entity. To define the list of entities, you set up the Iteration settings in the Task Control section like the
following:

A | Axiomn Scheduler - import_iteration

Job Service

a a, N

L] P | ek =X =

New  Open Cloze  Run Add Remove Clear
Cnce - Selected  All

i~ Scheduled Jobs D import_iteration

General lteration
Wariables )
Scheduling Rules Iterate this Task.
Evant FHandlers [] Create a Subordinate Job for each iteration.
MNotification
4 Tasks Caolumn
Import ETL Package s .
Results Entity.Entity
Group By
Order By
Filter
Entity.Costing=1

This example will iterate over the list of entities in the Entities column, limited to only those entities

where the Costing column is set to True. If this resolves to 4 entities, then the task will be processed 4
times, once for each entity.

The import is configured with a variable {Entity}, which it uses to process the correct entity source
file. In order to pass the current task iteration value to the import variable, you can use the job variable
{Task.CurrentIterationValue} inthe import task settings. For example:
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A | Axicmn Scheduler - import_iteration

Job Service

e N N
i P | m =X =
New  Open Close  Run Add Remaove Clear

Once - Selected Al

i Scheduled Jobs | [ import_iteration

General » Task Control

Variables v Task Details
Scheduling Rules

Event Handlers Select ETL Import Package

Motification Import GL data
4 Tacks
Import ETL Package .
Source Filename
Resultz

[==)
(=]

A
m

WWileserver\importfiles\GL\GL_{entity}.xlsx

Package Vanables
Entity [Task.CurrentlterationValue}

When the first iteration is performed, the { Task.CurrentIterationValue} will be resolved as
Entity_1, so the import will be processed using Entity_1 as the value for the {Entity} import variable.
For the second iteration, the value Entity_2 will be used, and so on. Using this approach, the import will
be processed for all entities in the iteration column.

Conditionally processing tasks in a job

You can configure a task so that it is only processed if a particular condition is met. This feature is
configured in the task settings, in the Task Control section, under Process task only if the value of this

expression is true.

To enable conditional processing, you must specify a logical expression that will resolve to either true or
false when the job is executed. If true, then the task is processed as normal. If false, then the task is

skipped.
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i Scheduled Jobs | ] Mew lob

General w Task Control

Job Variables
Scheduling Rules
Event Handlers

["] Skip this Task.

Motification Process task only if the value of this expression is true
4 Tasks GetData("Process”,"FG3="2012 Budget™,"SystemStatus")=1
Process Plan Files
Job Results

[ If this Task fails, continue executing subsequent Tasks.
Create a Subordinate Job for this Task.
Wait for all Subordinate Jobs to complete before proceeding to the next Task.

Choose Workbook Processing Engine
| Use Excel '@ Use Axiorn Web Engine

The logical expression is evaluated using an IF function on the Scheduler server as follows:
=IF (Expression, 1, Q)

You can enter any expression that would be valid in an IF function. You can use Excel functions, Axiom
functions, and Scheduler job variables in the expression. If you use a job variable, it must be placed in
guotation marks unless you expect the variable value to be resolved and evaluated as a number.

If the task is not processed because the condition resolves to false, this is not considered a failed task. If
there are other tasks in the job, they will be processed. If you want an entire job to be conditional, you
can do either of the following:

e Repeat the condition in each individual task settings. Keep in mind that the condition will be
evaluated for each individual task, which means that if it is possible for the condition to change in
between tasks, some tasks might be processed while others aren't.

e Use the condition on a Raise Event task that then triggers another job for processing. For more
information, see Raise Event task.

» Examples

The following are some example expressions for conditional processing:

GetData ("Process","FG='2012 Budget'","SystemStatus")=1

If this GetData function returns 1, the expression resolves to true and the task is processed. If not, it is
false and the task is skipped.
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AND (" {EventHandler.EventName}"="ProcessPlanFiles", {Dept}=1000)

If this job was triggered for execution by the ProcessPlanFiles event handler, and if the job variable Dept
resolves to 1000, then this expression is true and the task is processed. Note that in the first part of the
expression, the event handler variable will return a string value so it must be placed in double quotation
marks. In the second part of the expression, the department variable will return a number so it is not
placed in quotation marks.

AND (Day (Now () ) <=7, Weekday (Now () ) =2)

This expression will return true if it is the first Monday of the month, otherwise it will return false.
Using RunEvent to execute a Scheduler job

Using RunEvent, you can trigger the execution of a Scheduler job from various contexts, such as within
Axiom files, task panes, or Axiom forms. There are two different versions of RunEvent:

¢ RunEvent function: The RunEvent function can be used in Axiom files to trigger the execution of a
Scheduler job from a spreadsheet.

¢ RunEvent command: The RunEvent command can be used in task panes or Axiom forms to
trigger the execution of a Scheduler job.

Both the function and the command work in the same way and use similar parameters. Some limitations
apply depending on the context where RunEvent is being used. It is assumed that an administrator (or a
power user with the necessary rights) sets up the desired jobs within Scheduler, and then sets up
RunEvent in the appropriate context so that end users can trigger it.

The end user who triggers the job using RunEvent does not need to have file permission to the job or
any access to Scheduler. The job itself can be configured to execute its tasks using the permissions of
the job owner or using the permissions of the end user who triggered the job (the requester). If the job
is run as the requester, then the end user must have the appropriate permissions to the files impacted
by the job (for example to the target file for File Processing, or to the target file group and plan files for
Process Plan Files).

NOTE: You can also use the Raise Event Scheduler task to trigger the execution of a Scheduler job
from a different Scheduler job. This works in a similar manner as the RunEvent features.

» Setting up a Scheduler job for RunEvent
All uses of RunEvent require the same job setup in Scheduler:

e The job that you want to execute via RunEvent must already be created within Scheduler. When
setting up the job, consider items such as the notification settings. Do you want the notifications
to go to the user that executed the job, or to the job owner, or both?

Administrator's Guide Axiom Contract Management | 327



e The job must contain an event handler that will be used to trigger the job execution. When
creating the event handler, consider whether you want the job to run as the job owner, or as the
requester (the user who clicks on the RunEvent function). This may impact email notifications and
determines the user rights under which the job will run.

i Scheduled Jobs | |_] test_runevent

General Active Event Name Execute As
Named Values ] ProcessPlanFiles Owner v |
Scheduling Rules
Event Handlers
Natification
4 Tasks
Process Plan Files

Job Results

For more information, see Advanced options.

e Optionally, the job can use variables. Variable values can be defined in the RunEvent function or
command and passed to the job. You would do this if aspects of the job need to be dynamic; for
example, if you want to use a different filter depending on which user is running the job or based
on a user selection in the file. For more information see the Variable example section below.

» Setting up RunEvent
RunEvent uses the following properties to trigger Scheduler jobs:

e The event handler name that identifies the Scheduler job(s) to trigger for execution.

e An optional confirmation message to present to the user before proceeding with the event. Not
available when using the command within an Axiom form.

* An optional success message to present to the user after the event has been raised.

e An optional file group context to target the job execution to only event handlers that are
associated with a particular file group (or no file group). For the RunEvent command, this is an
optional parameter. For the RunEvent function, the current file group context is automatically
applied if the file with the function belongs to a file group.

e |If variables are being used, one or more variable names and values to pass to the Scheduler job.
This is available in all contexts, however, task panes do not currently support the ability to
determine the variable values dynamically.

The following shows an example RunEvent function for use in an Axiom file:

=RunEvent ("Click here to process plan files","ProcessPlanFiles","You are
about to process plan files for the "&C3&" region. Do you want to
continue?",,"filter = "&C4)

The first parameter defines the display text for the function, while the second parameter specifies the
event handler name. In this example we have also defined a custom confirmation message for the user
and a variable value to pass a filter to the job. The following screenshot shows the function in the
spreadsheet:
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> [E] RunEvent
v j =RunEvent("Click here to process plan files","ProcessPlanFiles","You
5 B | c | o | e | F |
[=
::I_ 1
g N
. 3 Marth
§ 4 Dept.Region="North'
=]
&9 |
7]
*g' 7 |Click here to process plan files !

The next screenshot shows a RunEvent command set up on a Button component for an Axiom form. You
can see the same event name and the filter variable also being read from a sheet location.

A | Shortcut Properties X
Choose Shortcut

Shortcut Target

command://RunEvent . X

Shortcut Parameters

Event Name ProcessPlanFiles

Result Message |Process Plan Files has been scheduled.

File Group

Processing Step | Form - Before Processing ¥

Event Variables S

Filter [Sheet1!A15] X

oK l l Cancel
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» RunEvent behavior and user experience
The behavior and user experience for RunEvent depends on the context and whether you are using
optional custom messages.
e The user starts the process by doing one of the following:
° Double-clicking the RunEvent function in the spreadsheet.
° Clicking the Button component that is configured for RunEvent in the Axiom form.
° Double-clicking the RunEvent item in the task pane.
e A confirmation prompt displays to the user, asking them to confirm that they want to proceed.

The user can click Yes to proceed, or No to cancel. Default text is used if no custom text is defined
in the RunEvent properties.

f \ You are about to process plan files for the Morth region. Do
A * you want to continue?

Yas Mo

NOTE: This step does not apply when executing RunEvent from an Axiom form. The Axiom
form context does not support a confirmation message. However, you can configure the
Button component to display a confirmation message before executing the RunEvent
command.

e Axiom Contract Management checks the list of event handlers in Scheduler to see if any match
the specified event handler name in RunEvent. This check works as follows:

° |If RunEvent has a file group context, then Axiom Contract Management only tries to match
with event handlers that are associated with the same file group, or with no file group. Any
event handlers associated with a different file group are ignored. The RunEvent command
has a file group context if a file group is specified in the shortcut parameters, whereas the
RunEvent function automatically has a file group context if the file with the function
belongs to a file group.

° If RunEvent does not have a file group context, then all event handlers are eligible to
match.

If any matching event handler names are found, then all Scheduler jobs that reference the event
handler are triggered for execution. If multiple jobs reference the matching event handler, then
all of those jobs will be executed.

If variable values are defined in the RunEvent properties, those values are passed to the job and
are used when the job is executed.
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e A confirmation message displays to the user as follows:
° If no jobs were found that contained the specified event handler, the user is notified that
no jobs were found.

° If jobs were placed on the schedule, the user is notified that the specified event was

scheduled. Default text is used if no custom text is defined in the RunEvent properties.

NOTE: If executing RunEvent from an Axiom form, this message displays in the bottom left
corner of the form, not in a separate message dialog.

When the job is finished processing, email notifications are sent according to the settings in the job.

» Variable example

When using RunEvent to execute a Scheduler job, you can pass a variable value to the job. For example,
imagine that you want to execute a Process Plan Files job, and you want to send a filter value to the job.

Step 1: Set up the variable in the job

The first step would be to create a job variable in the job, and then use the job variable in the filter
setting.

i Scheduled Jobs | _] test_runevent

General Job values

Job Variables Variable Name Default Value
Scheduling Rules
filter 1=0

Event Handlers
Motification
4 Tazks
Process Plan Files

Job Results

Example job variable

NOTE: In this case, we have defined a default value for the filter variable (1=0) that does not result in
any plan files. This is because we do not want to process any plan files unless a filter is provided by
RunEvent. If we left the default value blank, that would mean all plan files would be processed if no
filter was provided by RunEvent.
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i Scheduled Jobs | _] test_runevent

* Job Control

General
Job Variables
Scheduling Rules * Task Details
4 Tasks Specify plan files to process: ) Choose from list @ Use filter ) All
Process Plan Files
Job Results Plan File Filter: T2 Filter Wizard
{filter}

Plan files matching filter: 0

DEPT E] Description E| Locked By E| Template E| Country E|

Example use of variable in job settings

For more information on Scheduler job variables, see Using job variables.

Step 2: Configure RunEvent to use the Variable

Now that the job is set up to use the filter variable, you must configure RunEvent to pass in a value for
that variable. If you are using the RunEvent function in an Axiom file, you use the following syntax within
the function parameters:

variablename=variablevalue
These name / value pairs can be placed in the RunEvent function starting in the fifth parameter of the

function. If you have two name / value pairs to pass to the job, you can use the fifth and sixth
parameters, and so on.

For example, to pass the filter DEPT.Region="North' to the job, the RunEvent function would be
constructed as follows:

=RunEvent ("Double-click to process plan
files","ProcessPlanFiles",,,"filter=dept.region="North'")

More likely, you would be reading the variable value from another place in the sheet, so the function
would look something like:

=RunEvent ("Double-click to process plan
files","ProcessPlanFiles",,,"filter="&C4)

Where the filter value is read from cell C5.

When the job is executed by use of this RunEvent function, the value DEPT.Region="North"' will be
placed in the Plan File Filter box of the Process Plan Files task, and the job will be run using that filter.

Administrator's Guide Axiom Contract Management | 332



When using RunEvent in an Axiom form, the variables and their values are defined in the Event Variables
section. In this context you place the name of the variable in the left-hand box, and then in the right-
hand box you enter the cell reference (in brackets) where the variable value will be read.

Event Variables ap

filter [Sheet1!C4] X

The Event Variables section is also present when configuring RunEvent for use in a task pane, however in
this context the only option is to "hard-code" the values in the RunEvent properties.

Run another Scheduler job from within a Scheduler job

Scheduler jobs have two ways to run another Scheduler job:

e Raise Event task: This task uses an event handler name to trigger one or more Scheduler jobs for
execution. The jobs triggered by the event handler are run independently from the job containing
the Raise Event task.

e Run Scheduler Job task: This task runs a specified Scheduler job as a subordinate job within the
current "parent" job. Essentially, the tasks in the target job are run within the parent job, which
means that other tasks in the parent job can reference the results of those tasks.

The decision of which task to use depends on several factors, but the most important is whether the
Scheduler jobs are independent or dependent. If the first job is dependent on the execution of the
second job, then you must use the Run Scheduler Job task. When the Raise Event task is used, the
triggered jobs are run independently.

The following chart details some comparison points between the two tasks:

Comparison Raise Event Run Scheduler Job
Can pass variables to target job Yes Yes

Can execute target job as requester or owner Yes No

Can wait for target job to complete before No Yes
continuing

Can use results of target job in subsequent tasks No Yes

» Using the Raise Event task

The Scheduler Raise Event task is typically used when you need to trigger another job for execution once
the current job is complete. The Scheduler job(s) triggered by the event handler are added to the
schedule and then executed independently from the current job. For example, you might place the Raise
Event task at the end of the task list, so that all tasks in the current job must complete successfully
before the Raise Event task is run.
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Because the jobs triggered by the event handler are run independently, you cannot perform additional
tasks in the current job that depend on the results of the triggered jobs. The current job will not wait for
the triggered jobs to be run.

Event handlers can be configured to run a job as either the job owner or as the requester (meaning the
user that triggered the event). This allows some additional flexibility in how the triggered jobs are run.
For example, you may want to trigger a job that needs to be run using administrator permissions. As
long as the event handler is configured to run as job owner (and the owner is an administrator), then
that triggered job will always have the necessary permissions, regardless of the user who is running the
job with the Raise Event task.

» Using the Run Scheduler Job task

The Run Scheduler Job task is typically used when you need to run another job and then perform
additional tasks once that job is complete. Because the target job is run as a subordinate job within the
"parent" job, the parent job can wait for the "child" job to complete before it continues processing
tasks. Later tasks in the parent job can reference the results of the completed child job, such as querying
data saved from the child job, processing plan files created by the child job, and so on.

Keep in mind that if you want the parent job to stop processing tasks if the target job fails, then Wait for
all Subordinate Jobs to complete before proceeding to the next Task must be enabled for the task and

If this Task fails, continue executing subsequent Tasks must be disabled for the task. This is the default

configuration.

The child job is run using the same user permissions as the parent job. The user running the parent job
must have the appropriate permissions to complete all tasks in both the parent job and the child job.

» Chaining multiple Scheduler jobs

You can "chain" multiple Scheduler jobs together using either approach. For example, you may have
three Scheduler jobs that you want to run, in a particular order.

You can place multiple Run Scheduler Job tasks in a parent job, where each task triggers a separate job.
Because these tasks run as subordinate jobs, and the parent job can wait for each child job to complete,
it is easy to run the jobs in order.

To chain jobs using Raise Event, the last task in each job can be a Raise Event task. Each job will perform
its tasks and then trigger the next job in the chain. When using this approach, the chain automatically
stops if failure occurs, because if a task in the job fails then the job stops and will not proceed to the
Raise Event task. The disadvantage of this approach is that the jobs cannot also be run separately, unless
you manually disable the Raise Event tasks or configure the Raise Event tasks to not run based on a
condition.
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Running a job
If a job is saved with an active scheduling rule, then the job is automatically placed on the schedule to be

run according to that rule. Each time the job is run according to the rule, it is run as the current job
owner (unless it is a system job, in which case it is run as the System identity).

However, you can also choose to run a job manually. If you run a job manually, the job is added to the
Scheduled Jobs list with a start time of now, to be processed according to its job priority settings. The
job will be run using your user identity (again, unless it is a system job).

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

To manually run a job:
1. Inthe Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.
2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(the most recently opened tab is the active tab by default).

3. Inthe Job tab of the ribbon, click Run Once.

A confirmation message informs you that the job has been placed on the schedule.

NOTE: When you click Run Once, any unsaved changes to the job are automatically saved. This save
will designate you as the job owner (if you are not already the job owner).

You can also run jobs manually using the Scheduler area of the Web Client. For more information, see
Running a job manually in the Web Client.

Scheduler Task Reference

Each Scheduler task in a job has two sections of task properties:

e Task Control: Common task properties that apply to all task types. For more information, see
Task Control properties.

e Task Details: Properties specific to the current task type. For more information, see the topics for
each individual task type.

The following task types are available:
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Task Description

Active Directory Import users from Active Directory into Axiom Contract Management. This
Import task adds new users, and can also disable users that no longer exist in the
Active Directory domain.

Collect Worksheets Collect worksheets from multiple files into a single file.

Copy On Demand Copy plan files from one on-demand file group to another.

Plan Files

Create Plan Files Create new plan files (same as the Create Plan Files utility for file groups).
Echo Task Test the Scheduler server. This task sends a message to the Scheduler

server and asks it to send the message back.

Execute Command Execute a command from the Command Library.
Adapter
Export ETL Package Export data to an external database, using an export utility defined in the

Exports Library.

File Processing Perform file processing actions on a report. You can use the report's
native file processing settings, or override the settings.

Import ETL Package Import data into Axiom Contract Management, using an import utility
defined in the Imports Library.

Process Document Process any set of Axiom files—for example, driver files or report utilities.
List The task calculates and saves the files, and can also refresh Axiom queries
and save data to the database.

Process Plan Files Process plan files (same as the Process Plan Files utility for file groups).

Process Template List Process a template file. The task runs designated Axiom queries, time-
stamps the queries, and saves the template.

Purge System Data Purge old Scheduler results and system temp tables.

Raise Event Trigger another Scheduler job for execution, using a named event handler.
Run Scheduler Job Run another Scheduler job as a subordinate job.

SMTP Message Deliver email notifications resulting from Scheduler jobs.

Delivery

Start Process Start a process definition for Process Management.

Update Indexes and Update the indexes and constraints in your Axiom Contract Management
Constraints database.

Web Report Process web reports for production reporting.

Processing
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Task Control properties

The following task properties are available for all Scheduler task types. To edit these properties, select
the task in the Scheduler job, then expand the Task Control section.

Item Description

Skip this Task If selected, the task will not be run when the job is processed.

By default, this option is not selected, which means this task will be run.

Process task only if Optional. Enter a logical expression to conditionally process this task
the value of this depending on whether the expression resolves to true or false at the time
expression is true the job is executed. If true, the task is processed as normal. If false, the

task is skipped.

The logical expression is evaluated by the Scheduler server using an IF
function. The expression can be any statement that would be valid within
an IF function. You can use Excel functions, Axiom functions, and
Scheduler job variables in the expression. If you use a job variable in the
expression, you must place the variable in double quotation marks unless
you expect it to be resolved and evaluated as a number.

For more information, see Conditionally processing tasks in a job.

If this Task fails, If selected, the job will continue processing even if this task fails.
continue executing

By default, this option is not selected. If a task in a job fails, the job is
subsequent Tasks

canceled and no further tasks are processed.

Create a Subordinate If selected, this task will be processed as a subordinate job to the current
Job for this Task job.

Selecting this check box enables concurrent processing of different tasks,
if the option to Wait for all Subordinate Jobs to complete before
proceeding to the next Task is not selected.

NOTE: This option is not available for Process Plan File tasks.

Wait for all If selected, the job will wait for any subordinate jobs to complete before
Subordinate Jobs to moving to the next task.

complete before
proceeding to the
next Task

If this check box is not selected, and the option Create a Subordinate Job
for this Task is selected, then tasks can be processed concurrently instead
of sequentially.

This check box is selected by default for Plan File Refresh and File
Processing tasks. For other task types, this option is not selected by
default.
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Item Description

Override Log Level for By default, Scheduler jobs perform logging at the same level that is

this Task specified for the application. If necessary, you can override the logging
level for a particular task, so that it always runs at a specified logging level.
You may want to do this if you encounter performance issues for tasks
that generate a lot of logged messages.

To do this, select the check box for Override Log Level for this Task, then
select the desired logging level from the drop-down list.

NOTE: This option is only available for File Processing tasks.

NOTE: Older systems may see a setting named Workbook processing engine to use. If this option is
present, it should always be set to Axiom Web Engine. Use of Excel for processing on the Scheduler
server is no longer supported. All Scheduler tasks that involve spreadsheet processing are processed
using the same spreadsheet emulation engine as the Windows Client.

Iteration

This section can be used to optionally enable iterative processing for the task. For more information, see
Using iterative task processing.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate Specifies whether each iteration is processed as a separate subordinate

Job for each iteration job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution of multiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept .Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).
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Item Description

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the
iterative processing. You can use any filter that is valid against the source
table (the table of the iteration column).

Active Directory Import task

This task imports users from Active Directory groups into Axiom Contract Management security. For
more information on using Active Directory integration with Axiom Contract Management, see the
Security Guide.

This task has three tabs of settings: Source Directory, Notification, and Preview Import.

NOTE: The user running this task must be an administrator or have the Administer Security
permission.

For Axiom Cloud systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by
Scheduler.

» Source Directory tab

On this tab, you specify the domain to import from and the groups to import.
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Item Description

Domain or
Server

Credentials

Never Enable
Users

Groups to
import

Administrator's Guide

Select either Domain or Server to specify the source domain for the import.
¢ |f you select Domain, enter the name of the domain.

e |f you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the
source domain, and your current domain does not have access to the source
domain. In this case, you must use domain credentials in order to access the
source domain.

Only one domain can be selected per import task. If you want to import users
from multiple domains into an Axiom Contract Management system, then you
must create multiple import tasks.

Specifies the credentials to use when accessing Active Directory for the import.
Select one of the following:

e Use process credentials: (Default) Use the credentials of the network

service account for Axiom Scheduler Server (on-premise installations) or
Axiom Cloud Integration Service (Axiom Cloud systems).

» Specify domain credentials: Enter the credentials of a specified domain

User and Password. This option is required if you identified the source
domain using the server name instead of the domain name.

Specifies whether the import enables imported users as part of the process:

¢ |If unchecked (default), then newly imported users are enabled as part of the

import. Additionally, any existing imported users who have been changed to
disabled are re-enabled.

If checked, then newly imported users are not enabled as part of the
import. A security administrator must modify the security settings after the
import is complete to enable the new users. Existing imported users retain
their current enabled status.

The Active Directory groups for which members will be imported into Axiom
Contract Management Security.

e Click Add to select from a list of groups for the specified domain. If the

specified domain name is not valid or if Axiom Contract Management
cannot connect to it, then an error will result when attempting to add
groups.

If you need to remove a group, select the group and click Remove.

Click Role Mapping to define mappings for the selected groups. If a
mapping exists for a group, then when users are imported for that group
they are automatically assigned to the mapped role and subsystem. See the
discussion following this table for more information.
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Role mapping

In the Role Mapping dialog, click Add mapping (the plus icon) to add a role mapping for a group. Then
complete the following:

¢ |nthe Directory Group column, select the Active Directory group to be mapped.

* In the Axiom Role column, select the role to be assigned to users in that group. If you want to
map the group to more than one role, add another mapping row. You can select None if you do
not want the users in the group to be assigned to any role.

¢ In the Subsystem column, select the subsystem for users in that group. If you want to map the
group to more than one subsystem, add another mapping row. This option only displays if
subsystems are enabled for your system.

¢ |nthe User Type column, select the license type for the imported users. The default license type
is Standard.

¢ |n the Authentication Type column, select the authentication type for the imported users,
Windows User or SAML. The default authentication type is Windows User. Note that the selected
authentication type will be assigned to users regardless of whether that authentication type is
currently enabled for the system.

You can map each group to multiple roles and subsystems. If a group has no defined mappings, then the
users will not be assigned to any roles or subsystems. If the import creates new users without mappings,
the assigned user type is Standard and the assigned authentication type is Windows User.

To remove a mapping, select the mapping in the grid and then click Remove mapping (the X icon). If
users have already been imported using this mapping, removing the mapping will not remove the users
from the role or subsystem in subsequent imports (unless other group mappings in the import use the
same role or subsystem, and the users are not also part of that group).

NOTE: If a user belongs to multiple mappings—either multiple mappings for a single group, or
multiple mapped groups—then the user will be assigned to the user type and the authentication
type for the last-processed mapping.

» Notification tab

On this tab, you specify users to be notified when changes are made in Axiom Contract Management
Security due to the import.

Type in one or more email addresses to be notified. Separate multiple addresses with a semi-colon. For
example:

jdoe@axiomepm.com; jsmith@axiomepm.com
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When the import task is run, if any users are created or modified in the Axiom Contract Management
system, an email notification will be sent to the addresses specified here. The email summarizes the
changes made. This email notification is independent of any job-level notification settings (which notify
based on overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator(s)
responsible for maintaining the security settings in Axiom Contract Management, so that he or she can
define security settings for newly added users, validate changes made to existing users, and perform any
other follow-up tasks.

Scheduler job variables can be used in this setting.

» Preview Import tab
On this tab, you can preview the import results to test that the import is set up as desired.
To preview the results, click Preview. Axiom Contract Management processes the import task but does

not actually make the changes to the system. Instead, the tab displays a summary of the changes that
would result.

The preview shows a list of users that would be added, changed, or disabled.

NOTE: The preview is always executed locally, even for Axiom Cloud systems. The remote data
connection to the Cloud Integration Service is only used when the task is executed by Scheduler.

Collect Worksheets task

This task collects sheets from multiple source workbooks and combines them into a single target
workbook. You can then save the target workbook to a specified file location, and/or email the
workbook.

NOTE: This task is primarily intended for backward-compatibility only. The main method of
performing a file collect operation is to use the file processing feature with the File Processing
Scheduler task. For more information on setting up a file collect report using file processing, see the
Axiom File Setup Guide.

Typically, this task would be used at the end of a job with multiple File Processing tasks, to take the
results of those tasks and collect them into a single workbook.
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Item Description

Save or Email Specifies the delivery option for the target workbook. Select one of the
Workbook following:

e Save Workbook: The target workbook is saved to the specified output
folder.

e Email Workbook: The target workbook is emailed to the specified
recipients. The file is not saved anywhere on the file system.

e Save and Email Workbook: The target workbook is both saved and emailed.

» Target Workbook

Complete the following settings to define the target workbook:

Item Description

Output Folder The folder location where the target workbook will be saved (if you are saving
the workbook). Click the folder icon to select a folder location, or type a folder
location.

If the specified folder does not already exist, Axiom Contract Management
attempts to create it.

Job variables can be used in this setting.

Output File The name of the target workbook. Job variables can be used in this setting.
Name
File Type The file type of the target workbook. Select XLS, XLSX, or XLSM.

NOTE: PDF displays as an option, but it is not supported in this context.

» Email Settings

This section only applies if you are emailing the target workbook. The "From" address is always the
Scheduler default From address (as defined in the system configuration settings).

Item Description

To Enter the email addresses to receive the target workbook via email. Separate
multiple addresses with a semicolon.

Subject Line The subject line for the email.

Body Text The body text for the email.
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» Source Workbooks

In this section, you specify one or more source workbooks from which to collect worksheets. Workbooks
are identified by folder location. Within a folder location, you can specify one or more workbooks by
name, or by using wildcards, or by using *.* to collect all workbooks at the location.

All sheets in each source workbook will be collected. Ideally, you will be collecting from workbooks that
only contain relevant sheets (for example, no blank "Sheet2," etc.), and where the sheets have unique
names. If multiple workbooks have sheets with the same name, the sheets will be incremented by
number in the target workbook.

+ To add a workbook, click the Add button. In the Edit Workbooks Source dialog,
complete the settings as described below, then click OK to add the workbook to
the list.

X To remove a workbook, select the workbook in the list and then click the Remove
button. Only one workbook can be selected at a time.

a“aw To change the order of workbooks, select the workbook in the list and then click
the arrow buttons to move the workbook up or down. Source workbooks are
processed in the order they are listed in the grid.

Iltem Description

Folder Path The folder location of the source workbook(s). Click the folder icon to select a
folder location.

NOTE: The Folder Path location must be accessible by the Scheduler service
user account. If you specify a network folder location using the Browse button,
the location is automatically entered as a UNC path. If you specify a C: drive
location, that will be evaluated as the C: drive of the Scheduler server.

Job variables can be used in this setting.

Workbooks The workbooks from which you want to collect worksheets, within the specified
folder path.

e Specify *.* if you want to collect all files in the folder path.

¢ Specify individual file names to collect from specific files. Separate multiple
file names with semicolons.

You can use wildcards (* or ?) to specify groups of files that share naming
conventions. For example: North*.x1s to collect all XLS files where the file
name starts with "North".

Only files with the following file types are valid to be collected: XLS, XLSX,
XLSM. If you are using wildcards, the matches must be valid file types, or else
the task will fail with an error.

Job variables can be used in this setting.
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Once you have saved a source workbook location, you can edit it by double-clicking the row.

Copy On Demand Plan Files task

This task copies on demand plan files from one file group to another. It performs the same actions as
the Copy On Demand Plan Files command in the Command Library.

This is an advanced feature and should only be used if it is the only way to achieve the desired
population of plan files between two related file groups. It is the responsibility of the solution designer
to ensure that the copied plan files will behave as expected in the target file group. For example, the
plan file must be designed to dynamically save to the appropriate tables and columns within the context
of the new file group.

The Copy On Demand Plan Files task uses two tabs to define the properties of the task.
e Options: Defines the options to be used for the copy operation
e Plan Files: Specifies the plan files to copy

» Options tab

The following options are available on the Options tab. Note that all of these options can be changed
dynamically by using system variables.

Iltem Description

Source File The file group to copy plan files from. Click the folder icon to select a file group.
Group You can select any on-demand file group, or any file group alias that currently
points to an on-demand file group.

Destination File The file group to copy plan files to. Click the folder icon to select a file group.
Group You can select any on-demand file group, or any file group alias that currently
points to an on-demand file group.

Keep original Specifies whether the plan file creator for the copied plan files is set to the
plan file creator same creator as the original plan files. By default, this option is enabled.

If this option is disabled, then the plan file creator for the copied plan files is set
to the user identity used by the Scheduler job when it is run.
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Item Description

Use default Specifies whether the copied plan files have the option to adopt the default

template template of the new file group. This is primarily intended to be used when
copying plan files to a file group that uses virtual, form-enabled plan files, so
that the copied plan files can be converted to virtual files and use the new
template.

e |f disabled (default), then the target file group must contain copies of the
original templates that were used to create the plan files from the source
file group. If these templates are not present, then the copy process will fail.

* |f enabled, then the copied plan files will be assigned a template as follows:

° If the target file group contains copies of the original templates that
were used to create the plan files from the source file group, the copied
plan files use those templates.

° If the target file group does not contain copies of the original templates,
the copied plan files use the default template specified for the target file
group in the file group properties.

If the target file group does not contain copies of the original templates and
does not have a designated default template, then the copy process will fail.

Copy plan file Specifies whether plan file attachments are copied to the target file group
attachments when a plan file is copied. By default, this option is enabled.

If this option is disabled, then plan file attachments will not be copied to the
target file group.
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Item Description

Save plan files Specifies whether the new plan files are processed and saved in the target file

after copy group after the copy is performed. This is intended to perform a save-to-
database within the context of the new file group. By default, this option is
disabled.

If you enable this option, then after the plan files are copied to the new file
group, they are opened, refreshed, and saved (including a save-to-database).
The refresh includes all active Axiom queries where Refresh during document
processing is enabled.

Regardless of whether this option is enabled, if it is ever intended to save the
copied plan files in the target file group, then they must be designed so that
they save data to the appropriate tables after being copied.

NOTES:

» |f Process with Utilities is enabled for the target file group, then utility
processing is performed instead of normal processing. The default data
source is used.

e If you enable this option but also specify a Copy data utility, then the new
plan files are not processed and saved. Instead, the designated utility file is
processed for each new plan file.

Copy data utility Optional. Specifies a utility file to process for each copied plan file. You can
select any file in the Utilities folder of the target file group, or a file in the
Reports Library.

The primary purpose of this option is to handle copying virtual plan files
between file groups. Because the plan files are virtual, no data exists in the file
itself and therefore saving the new plan file will not populate data for the new
file group. Instead, you should create a utility file that queries in the necessary
data for the original plan file, then saves the necessary data for the new plan
file to the appropriate tables for the new file group. Reserved document
variables are available to return information in the utility file such as the old
plan file code and the new plan file code.

For more information, see Copy data utility.

NOTE: Save plan files after copy must be enabled in order to specify a copy
data utility. If a utility is specified, then the new plan files are not saved and
instead the utility file is processed for each new plan file.

Default Values Optional. This section can be used to apply default values to any columns in the
target plan code table, when the new record is created in the target file group.
For more information, see Defining default values.
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» Plan Files tab

On the Plan Files tab, specify the plan files from the source file group that you want to copy to the
target file group. There are three different options that you can use to specify the plan files: Choose
from list, Use filter, and All.

The most common option when copying plan files using Scheduler is to define a filter. You can
dynamically copy a subset of designated plan files using the filter. If the Scheduler task is triggered by
using RunEvent, you can pass in the filter from the source of the RunEvent (such as an Axiom form).

Copy a filtered set of plan files

To use a filter to copy a subset of plan files, select Use Filter. When the Scheduler task is executed,
Axiom Contract Management will process only the plan files that meet the filter. You can specify the
filter directly, or use a job variable.

To specify the filter, click the Filter Wizard button. You can also manually type a filter criteria statement
into the filter box. The filter must use the plan code table of the source file group, or a lookup table. For
example: CapReq2021.Transfer=1, where CapReq is the plan code table.

Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

If you want to set the filter dynamically, you can use the Filter system variable to override the filter
defined in the task. This is intended for use when running Scheduler jobs via RunEvent. If a variable
value is specified when triggering the event, such as the value CapReq2021.CapReq IN (45,67,98)

, then that filter statement is used to determine the plan files to be copied instead of the filter defined in
the task.

Copy all plan files

To copy all plan files, select All. When the Scheduler task is executed, Axiom Contract Management will
copy all plan files in the file group (except for those hidden via the Show on List column). This is not a
common use case for the copy feature, but can be used if needed.

Copy selected plan files

To copy certain plan files, select Choose from list, and then select the check boxes for the plan files that
you want to copy. When the Scheduler task is executed, Axiom Contract Management will copy only the
selected plan files. This is not a common use case for the copy feature, but can be used if needed.

NOTE: This option is not available when using a file group alias as the source file group for the task.

This is because the alias could change to point to any file group, which could result in a different list
of plan files.
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» Defining default values
When the copy action is performed, the columns for the new record are populated as follows:
e |If a value has been defined for a column in the Default Values section, that value is used.
e Otherwise, the value from the original record in the source file group is used. This only occurs if

the column names match in the source and target tables, and if the column in the target table is a
compatible data type to accept the copied value.

If a column exists in the source table but not the target table, that value is ignored and does not cause
an error. If a column exists in the target table but not in the source table, then it is only populated
during the copy action if a default value has been defined. If the target table contains columns with
lookup relationships, those columns must be populated with valid values (either from the original record
or by using default values) or else the copy action will fail.

To define default values for the new records:

* Click the plus button * to add a new column/value pair to the Default Values section.

¢ In the left-hand box, type the name of the column in the target plan code table. For example:
SourceID. Do not use Table.Column syntax.

¢ In the right-hand box, type the value to be placed in this column. You can enter a "hard-coded"
value, or you can enter the name of a column from the source plan code table in brackets to use
the value from that column. For example, [CapID]. The column reference is only necessary if
you want the source column value to be placed in a column that has a different name than the
source column. If the columns have the same name, the value will be copied automatically as
noted previously in this section.

For both the column name and the value, you can use file group variables via a file group alias. Axiom
Contract Management looks up the current target of the alias, and finds the current value of the
designated variable within that file group. Built-in variables and custom variables can both be used. To
reference a variable, use the following syntax:

{FileGroupAliasName.VariableName}

For example: {CP CurrentYear.FileGroupYear} returns the file group year for the file
group that is currently the target of the CP_CurrentYear alias.

Scheduler job variables can also be used in the column name and in the value.

» Overriding task settings using system variables

All of the settings for the Copy On Demand Plan Files task can be overridden using system variables. This
is intended for use when the task is being triggered by RunEvent (such as from within an Axiom form),
and you want to pass in variable values to determine how the task is run.

The variable names for this task are as follows:
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VEIELE Description

CopyDataSourceFileGrouplD Overrides the Source File Group. Must be set to a valid file
group ID. File group names or alias names cannot be used.

CopyDataTargetFileGrouplID Overrides the Destination File Group. Must be set to a valid file
group ID. File group names or alias names cannot be used.

CopyDataUtilityPath Overrides the Copy data utility. Must be set to a valid document
path in Axiom Contract Management.

Filter Overrides the Plan File Filter to specify the plan files to copy.
Must be set to a valid filter criteria statement.

KeepOriginalPlanFileCreator Overrides the option Keep original plan file creator. Must be
set to a valid Boolean value (True/False).

UseDefaultTemplate Overrides the option Use default template. Must be setto a
valid Boolean value (True/False).

CopyPlanFileAttachments Overrides the option Copy plan file attachments. Must be set to
a valid Boolean value (True/False).

SavePlanFilesAfterCopy Overrides the option Save plan files after copy. Must be set to a
valid Boolean value ( True/False).

To override task properties using these variables:

e Add the variables that you want to use to the Job Variables tab. For example, if you want to
override the source and target file groups, the copy data utility, and the plan file filter, then add
those variables to the Job Variables tab. You do not need to add a variable name if you do not
plan to override it.

i Scheduled Jobs | [ copy_pf

General Job values
Job Variables
Scheduling Rules
Event Handlers

Variable Name Default Value

CopyDataSourceFileGrouplD

MNotification CopyDataTargetFileGrouplD
4 Tasks , CopyDataUtilityPath
Copy On Demand Plan Files .
Job Results Filter

Example Job Variables tab to override certain settings for the copy task

You do not need to define a default value for the variable. If the value is blank, then the setting
defined in the task is used. The corresponding task property will only be overridden if the variable
has a defined value.

¢ You do not need to add the variables to the task properties. The variables automatically overwrite
the task properties if they have defined values.
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e When configuring RunEvent, define values for the variables as needed. For example, you could
have a form where you allow the user to select the source and target file group for the copy
action. Based on the user's selected file group names, you can use the GetFileGrouplID function to
determine the IDs for those file groups. You can then pass those IDs as variable values for the
variables CopyDataSourceFileGroupID and CopyDataTargetFileGrouplID.

A | Shorteut Properties *

Choose Shortcut

Shortcut Target
command:/fRunEvent I 4

Shortcut Parameters
Event Mame CopyPF
Result Message

Processing Step | Form - After Updating Values *

Event Variables b
CopyDataSourceFileGrouplD | [Variables!D20] Pt
CopyDataTargetFileGrouplD |[Variables!D21] Pt
CopyDataltilityPath [Variables!D22] x
Filter [Varnables!D23] P

| OK | | Cancel |

Example RunEvent properties to pass certain variable values to the copy task

» Plan file process considerations
If the target file group has an active plan file process, the new plan file is started in that process as part
of the plan file creation. The process initiator for the plan file is set as follows:

e |f the plan file process has a designated Process Initiator Column, the user listed in that column is
the process initiator.

e If the plan file process does not have a Process Initiator Column, or the column value is blank,
then:

o If Keep original plan file creator is enabled for the command, then the original plan file
creator is the process initiator.

° Otherwise, the user performing the copy operation is the process initiator.
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» Copy data utility
If a Copy data utility is specified, this processing is performed as follows:

e The selected plan files are first copied to the new file group. If the plan files are virtual, then the
placeholder document records are copied instead of physical plan files.

e The utility file is opened once before processing begins. Any data lookups or Axiom queries that
are configured to refresh on open are executed at that time.

e The utility file is then iteratively processed for each new plan file as follows:
° Document variables are set in the utility, and the workbook is calculated.
© Axiom queries set to Refresh during document processing are refreshed.

° A save-to-database is executed.

The utility file is not closed and reopened for each new plan file. All processing occurs within the same
file session, similar to when performing multipass file processing.

The following reserved document variables are available to the utility file, to be returned using
GetDocumentinfo. These variables return necessary information about the copied plan files and the
source and target file groups.

Variable Description

SourceFileGrouplD The ID of the source file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to query from the source file group.

SourcePlanCode The plan code of the original plan file from the source file group. You can
use this code to filter Axiom queries to return data for the original plan
file.

TargetFileGrouplD The ID of the target file group. You can use this ID in functions such as

GetFileGroupVariable—for example, to return the name of the data table
to save data to for the target file group.

TargetPlanCode The plan code of the new plan file in the target file group. You can use this
code to save data for the new plan file.

For example, GetDocumentInfo ("Variable", "SourceFileGroupID") returns the ID of the
source file group.

Create Plan Files task

This task creates plan files for a file group. It works the same way as the Create Plan Files utility that is
available from the file group menu.

This task has two tabs of settings in the Task Details area: General and Plan Files.
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NOTE: If you are using Create Plan Files to create new on-demand plan files, those plan files will be
automatically started in the designated Plan File Process for the file group. This only applies when

creating a brand new plan file. If an existing plan file is overwritten, its process status will be left as
is.

» General tab

The following settings are available on the General tab:

Iltem Description

Select File Group  The file group for which plan files will be created. You can select any file group
or file group alias.

If the Scheduler job is stored in a file group Utilities folder, then you can select
Use Current File Group to automatically use the file group that the Scheduler
job belongs to. This is the recommended approach when the Scheduler job
belongs to a file group, so that it will automatically update to point to the
current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files on
the Plan Files tab. Only the Use Filter and All options are available.

Overwrite By default, this option is not selected, which means that existing plan files will
existing plan not be overwritten, even if the plan file is selected to be created.
files?

If selected, existing plan files will be overwritten.

» Plan Files tab

On the Plan Files tab, specify the plan files that you want to create. This tab lists all plan codes that you
have the right to access. (If a plan code has been set to False in the designated Show On List Column for
the plan code table, then it is not available in this list.)

You can create plan files in any of the following ways:

e Create all plan files: To create all plan files, select All. This will cause all plan files to be created,
for all existing and future plan codes.

Alternatively, you can select Choose from list and then select the check box in the column
header, causing all plan codes to be selected, but then the list of plan codes is fixed and will not
adjust for any future changes. For example, if you add a new department in the future, that new
department will only be created by this task if you use the All option.
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e Create selected plan files: To create certain plan files, select Choose from list and then select the
check boxes for the desired plan codes.

To find the plan files you are looking for, you can sort, filter, and group the list using standard
Axiom grid features. You can show additional columns and hide columns by right-clicking in the
column header. If you have filtered the list, you can select the check box in the header to select
only the plan codes that currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the
list of plan files could change when the alias target changes.

e Create a subset of plan files using a filter: To use a filter to create a subset of plan files, select
Use filter, and then type a filter into the filter box. You can also use the Filter Wizard to build the
filter. The filter must use the plan code table or a reference table that the plan code table links to.
For example: DEPT.Region="West".

Once you have entered a filter, you can click Refresh plan file list to show only those plan codes
that currently match the filter. This feature is to help you determine whether you have defined
the filter as intended. The filter will be applied to the list of plan codes when the Scheduler job is
processed, so if changes have been made to the plan code table since then, the actual list of plan
files processed will reflect those changes.

You can also use a job variable for the filter. For example, you can define a job variable named
"filter" and then place the text {filter} in the filter box. This is intended for use when running
Scheduler jobs by using the RunEvent function. If a value is specified in the RunEvent function,
such as "Filter=dept.region='west", then that filter will be used in place of the {filter} variable
to determine the list of plan files to be created.

NOTE: If you use a variable, and you leave the default value for that variable blank within the
Job Variables tab, then all plan codes will be created if no value is passed by the RunEvent
function (or if the value is invalid). You may want to define a default filter that results in no
values (such as 1=0), so that plan files are only created if a valid filter value is passed.

IMPORTANT: For all of these options, the Overwrite existing plan files option on the General tab
determines whether all selected plan files are created, or only the plan files that do not already
exist.

Echo task

This task is primarily used for testing purposes, to check whether a Scheduler server is running and
operational. The task sends a message to the Scheduler server, and asks it to send the message back (an
"echo"). If successful, the message displays in the job results. No other action is performed.
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Item Description

Message to Echo  The message to send to the Scheduler server for testing.

Job variables can be used in this setting.

Sleep Time The time to pause in between message echoes, in seconds. Scheduler will echo
the message once, then wait the specified sleep time, then echo the message
again.

» Using an Echo task to control jobs with sub-jobs

If the Task Control option Wait for all Subordinate jobs to complete before proceeding to the next
task is enabled for an Echo task, then the Echo task will inherit the status of the sub-jobs when they are
completed. If one of the sub-jobs fails, then the Echo task will inherit that failed status. By default, this
means that the job will not process any further tasks due to the sub-job failure. This behavior can be
used to stop a job from processing tasks if previous sub-jobs fail.

For example, you could have a Scheduler job with several import tasks configured to run as sub-jobs,
followed by some document processing tasks. Since the document processing tasks depend on the
imported data, you do not want the document processing tasks to be run if any of the import tasks fail.
However, because the import tasks are running as sub-jobs, the sub-job failure does not stop the parent
job from continuing to process tasks. You can place an Echo task after the import tasks and configure it
to wait, and then if any sub-jobs fail the Echo task will fail.

Execute Command Adapter task

This task executes a selected command from the Command Library.

» Task properties

This task has one property named Command Name that specifies the command to execute.
To select a command to execute:
1. Click Edit Command.

2. Inthe Shortcut Properties dialog, click the browse button [...] to the right of the Shortcut Target
box.

3. Inthe Axiom Explorer dialog, select the desired command from the Command Library, then click
Open.

This returns you to the Shortcut Properties dialog. The selected command is now listed in the
Shortcut Target box, and the Shortcut Parameters section displays the parameters for the
command.

4. Complete the Shortcut Parameters for the command as needed. The available parameters
depend on the selected command.
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You can later edit the shortcut parameters or select a different command by clicking Edit Command.

» Supported commands

Only certain commands are available for execution in this context. The following commands are
available:

e File Group Rollover

e Create File Group Scenario

* File Group Rollover
e Create File Group Scenario

Systems with installed products may have Scheduler jobs that use the following additional commands:
e Create File Group From Prototype

e Upgrade File Group To Prototype Version

These commands can only be configured by product developers. Clients looking for more information on
how to use a particular product-delivered Scheduler job should consult their product documentation.
Syntellis employees should consult internal resources for more information on this feature as needed.

Export ETL Package task

This task exports data from Axiom Contract Management to an external database (same as executing an
export from the Exports Library).

This task has one setting, Select ETL Export Package. This is the name of the export package to process.
You can select any export that is defined in the current system.

File Processing task

This task performs file processing on a specified report file or file group utility. The file must already be
enabled for file processing. You can use the file processing settings that are already in the file, or you
can override any setting.

The following settings must be completed for the task:
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Item Description

File to Process The report to process for the task. Click the Browse button to open the Axiom
Explorer dialog, and then select a report to process. You can select any report
that you have access to within the Reports Library or a file group Utilities
folder.

Only one report can be selected for each File Processing task. If you want to
process multiple reports, you can add multiple File Processing tasks to the
Scheduler job.

TIP: Once the file is selected, only the file name displays in the task. If you want
to know the folder location of the selected file, hover your cursor over the field.
The folder location is listed in the tooltip.

If this Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the report through the Current File Group node at the
top of the file groups list. When you do this, the path to the file is stored
relative to the current file group, which means that it will automatically update
when the file group is cloned. This is the recommended method of referencing
the report to process when both the Scheduler job and the report belong to the

A Axiom Explorer
Q 4 [\wxiom\File Groups\Budget 2021\Utilties
File ~ Open ~
My Files ~ s Name Modified Locked By Size Type Modified By
¢ Favorites ) Allocations 6/15/2020 8:32 AM 17KB Microsoft £ admin
X"
&l Recent ) budget_assignment 7/25/2019 3:28 PM 278 Microsoft £ admin
» J. My Documents
[T] CreateScenario 4/13/2020 4:43 PM 17K8 Microsoft £ admin
Libraries ~ = ‘ . o
) process_employee_transfer 3/18/2020 1:16 PM 13KB Microsoft £ admin
» 13 Reports Library Qe oy
) process_metrics 8/9/2019 12:49 PM 14KB Microsoft £ admin
File Group Utilities ~
] process_report 8/10/2018 923 AM 142K Microsoft £ admin

~ ¥Z]Current File Group (Budget 2021) «({’
] utilities
» Z] Capital Requests
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Item Description

Override file to Optional. Specifies a Scheduler job variable to override the file to process. The

process override file will then be used for processing instead of the original file. This
feature allows you to pass in an alternate file to process, when using Run Event
or Raise Event to trigger the Scheduler job for processing.

To use a job variable, enter the variable name in curly brackets, such as
{MyFile}. When the job is executed, this variable must resolve to a valid file
path in the Axiom Contract Management file repository. Note that it is not valid
to leave the variable value blank (the task will not use the original file to
process).

NOTES:

e The override feature is only exposed to product developers. It is only
visible in client systems if the job is delivered as part of a product
package and an override variable is specified in that job.

¢ The File to Process field must point to a valid file for file processing
when the override feature is used, even though that file will never
actually be processed by the task. If the file to process is missing or
invalid, then the task validation will fail.

Process Specifies whether the report will be run using multipass processing.

Multipass * If this option is selected, multipass processing is performed. This is
equivalent to selecting File Output > File Processing > Process File
Multipass.

e Otherwise, multipass processing is not performed and multipass settings do
not display in the task. This is equivalent to selecting File Output > File
Processing > Process File.

NOTE: If you select Process Multipass, but the file does not have any defined
multipass settings, then you must override the blank multipass settings for the
file and define them in the equivalent of "advanced mode." If you want to use
"basic mode" settings (specify only a source column and Axiom Contract
Management automatically completes the rest of the settings for you), then
you should edit the file to define the basic mode multipass settings so that they
can be inherited by the task.

Enable iterative Specifies whether iterative calculations are enabled for the file during
calculation while processing. In most cases you will leave this option disabled.
processing

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings are
fixed at a maximum of 100 iterations and a maximum change value of .001.

For more information on iterative calculations, see the Microsoft Excel Help.
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» Advanced options

This section only displays if multipass processing is enabled for the task, and the task uses settings that
are eligible for parallel processing. Click on the down arrow next to the title to expand the section and
view the options.

Parallel processing for file processing tasks is performed based on multipass passes. With certain task
settings, multiple passes can be separated into sub-jobs, which can then be processed at the same time
(in parallel). This can improve the performance of the task.

For example, imagine that you are multipass processing a file by department. If the task is processed
sequentially, then the task would process Dept 100 and finish it, then move to Dept 110 and finish it,
etc. When parallel processing is used instead, Depts 100-199 can be separated into one sub-job, Depts
200-299 into another sub-job, etc. Because the sub-jobs are processed in parallel, multiple departments
are processed at the same time, so the overall task can complete more quickly.

Item Description

Maximum The maximum number of subordinate jobs to run in parallel. The default
Parallel Jobs number is 4.

This is the total number of sub-jobs that can be run at the same time for this
task. Ultimately the number of sub-jobs that are run in parallel depends on the
number of Scheduler threads that have been configured for use at your
organization, and the number of Scheduler threads that are currently available
(threads that are not processing other higher-priority jobs).

Processing Batch The number of multipass passes to include in each sub-job at a time. The
Size default number is 10 for eligible snapshot and export processes, and 7000 for
eligible save-to-database processes (save once at end).

Passes are determined based on the multipass list of items. For example, if you
are processing by department (DEPT.DEPT), then each department is a separate
pass. If the batch size is set to 10, then each sub-job would process 10
departments at a time.

In most cases, the default settings are sufficient. If you are experiencing lengthy
processing times and want to optimize performance, you can adjust this setting
as follows: divide the number of passes by the number of available Scheduler
threads. For example, if there will be 100 passes and there are 4 Scheduler
threads, set the batch size to 25.
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NOTES:

¢ For save processes, only "save once at end" processes are eligible for parallel processing. In
this case, the records to be saved to the database are extracted after each pass to a central
temporary table. Once all passes are complete, then all records are saved to the database
from the temporary table. Save processes where data is saved directly after each pass are not
eligible, because these processes may depend on sequential processing.

¢ There is no way to disable parallel processing if the task is eligible; however, you can adjust
the parallel processing settings if desired.

» File processing settings

Once you have selected a file to process, the file processing settings from that file display within the task
as read-only. You can leave the settings as they are, or you can override any setting.

e To override a setting, select the Override check box to the right of the setting. The setting
becomes editable, and you can change it. The change only applies to the file processing task—the
setting remains unchanged within the file.

¢ |f you override a setting, make sure that any related settings make sense in the context of the
change. For example, if File Generation is set to Multiple Output Files, and you override it to be
Single Output File, then you should also check the Sheet Names setting to make sure that you
will end up with unique sheet names within the file.

NOTE: If the target file for the task uses File Collect or Batch processing, then it is not possible to
override the settings on the File Collect Configuration Sheet or the Batch Control Sheet.

For more details on file processing settings, see the Axiom File Setup Guide.

Note the following requirements when running file processing using Scheduler:

e The Output Folder location must be accessible by the Scheduler service user account (for on-
premise systems) or the Axiom Cloud Integration Service (for cloud systems). If you specify a
network folder location using the Browse button, the location is automatically entered as a UNC
path. If you specify a C: drive location, that location will be evaluated as the C: drive of the
Scheduler server.

 If the file processing type is Print, the Scheduler server(s) must be configured to access the
specified printer. This may require the assistance of your IT department.

Job variables can be used in any file processing setting that accepts a typed user input.

» Batch variables

If the file has defined batch variables, you can specify variable values to be used for the file processing
task. When the task is executed, any specified variable values are temporarily placed within the file,
within the designated cell for that variable value. The file can be set up to use the variable value in some
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way during processing.

Iltem Description

Variable Names The names of the variables, as defined in the File Processing Control Sheet for
the source file. If no names are listed, then no variables are defined in the file.

Variable Values The variable values to be placed within the file when the file processing task is
executed.

Job variables can be used in the batch variable settings. For example, a job variable can be used as the
value for a batch variable.

Import ETL Package task

This task imports data into Axiom Contract Management (same as executing an import from the Imports
menu).

NOTE: If the import package is configured to Ignore lookup and key errors, then if errors are found
the execution status of the job will be Partial Success. This will trigger an email notification if the job
is configured to notify only on error.

Item Description

Select ETL The import package to process. You can select any import that is defined in the
Import Package current system.

Source Filename The path and name of the source file. This option only applies in the following
situations:

e The import is configured to pull data from a source file (instead of a
database table).

e The import is configured to prompt the user for the source file during
execution.

If the import is configured to always use the same source file, then that file

displays for reference in the Source Filename box, but it is grayed out and

cannot be changed.

Job variables can be used in this setting.

Package Specifies values for any variables used in the import package.

VAL Variables are listed in the right-hand side of the grid. Use the drop-down list

next to the variable name to select from the defined set of choices, or type in a
value.

Job variables can be used in this setting.
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Process Plan Files task

This task processes plan files in a file group. It performs the same actions as the Process Plan Files utility
available from the file group menu.

The Process Plan Files task uses several tabs to define different options. The available tabs and the
options on those tabs depend on the selected Processing Mode on the Options tab.

Options: Defines the overall processing mode and processing options

Plan Files: Specifies the plan files to process

Axiom Queries: Specifies which Axiom queries to run in plan files (only applies to Normal
Processing)

Utilities: Specifies which data source to use for utility processing (only applies to Process with
Utilities)

Processing Variables: Defines variables to pass into plan files from Scheduler, and to Scheduler
from plan files

» Options tab

The following options are available on the Options tab:

Item Description

Processing Mode Select the type of processing to perform:

e Normal Processing: Plan files are opened, refreshed, and saved. You
can configure which actions occur.

e Process with Utilities: A list of utilities is iteratively processed per plan
file. Utilities are opened, refreshed with data for each plan code, and
saved. This is primarily intended for processing form-enabled plan files
with embedded forms.

e Update Persistent Plan Files: Update existing plan files for text,
formatting, or formula fixes. This is an advanced feature.

e Process with Custom Utility: Plan files are processed using a custom
utility provided by Axiom Support. This is an advanced feature.

The default processing mode is Normal Processing. However, if the file
group has been configured so that utility processing is the default
processing mode for that file group, then Process with Utilities is selected
by default.
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Item Description

Select File Group The file group for which plan files will be processed. You can select any file
group or file group alias, including file group scenarios (click Show
Scenarios in the Choose File Group dialog to show scenarios in the file
group list).

If the Scheduler job is stored in a file group Utilities folder, then you can
select Use Current File Group to automatically use the file group that the
Scheduler job belongs to. This is the recommended approach when the
Scheduler job belongs to a file group, so that it will automatically update
to point to the current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files
on the Plan Files tab. Only the Use Filter and All options are available.

Advanced Options: Optional. Specifies the number of plan files to be processed in each batch.
Worker Batch Size The batch size must be a number between 10 and 100.

By default this is left blank, which means that the batch size is
automatically calculated based on the number of plan files to be
processed divided by the total number of threads on all enabled Scheduler
servers. Generally speaking, you should not customize this setting unless
you are advised to by Axiom Contract Management Support.

NOTE: Each batch of plan files is processed by a subordinate job. These
subordinate jobs are automatically created for the Process Plan Files task
and are processed in parallel, dependent on the number of Scheduler
threads that are available at any one time.

Options for Normal Processing mode

If Normal Processing is the selected processing mode, the following additional options are available on
the Options tab:
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Option Description

Save document Specifies whether plan files are saved during processing. This option is selected
after processing by default.

This option does not cause a save-to-database to be performed—that option
must be selected separately.

NOTES:

¢ [f this option is not selected, then the utility will open the file as read-only
and will not attempt to acquire the document lock before processing.

¢ [f the file group uses virtual plan files, this option does not apply because
the plan files cannot be saved. However, if the option is enabled, Axiom
Contract Management will attempt to acquire the document lock before
processing, which is not necessary. This option should not be enabled when
processing virtual plan files.

Run Save To Specifies whether a save-to-database is performed in plan files during
Database on processing. This option is selected by default.
plan files after

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a
save-to-database.

processing

Create a plan file If selected, then a plan file restore point will be created before processing
restore point begins. This option is not selected by default.
before

. Restore points can be used to restore plan files to the state they were in before
processing

changes were made.

NOTE: If the file group uses virtual plan files, this option does not apply. Plan
files are not saved and therefore restore points are irrelevant.

Options for Process with Utilities

If Process with Utilities is the selected processing mode, there are no additional options on the Options
tab.

Plan files are not saved when using Process with Utilities, and plan file restore points are not created.
When using this mode, the processing is being performed in the utility files, not in the plan files, so it is
not necessary to save the plan files. Additionally, in most cases the plan files used with this mode are
virtual form-enabled plan files, so the save and restore options are irrelevant.

Options for Update Persistent Plan Files

If Update Persistent Plan Files is the selected processing mode, the following additional option is
available on the Options tab:
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Option Description

Report File Click the Browse button to select the report file that is configured with the
PlanFileReconfig_ControlSheet. This file must be saved in the Reports Library.

This control sheet contains the settings that will be applied to plan files during
processing.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the
plan file update.

Options for Process with Custom Utility

If Process with Custom Utility is the selected processing mode, the following additional options are
available on the Options tab:

Iltem Description

Report File Click the Browse button to select the Microsoft Excel spreadsheet file that
contains the VBA custom utility. The file must be saved in the Reports Library.

VBA Module Select the VBA module to run as part of this utility. The drop-down list shows
the VBA modules available in the selected file.

VBA Function Select the VBA function to run as part of this utility. The drop-down list shows
the VBA functions available in the selected module.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the
custom utility processing.

» Plan Files tab

On the Plan Files tab, specify the plan files that you want to process. There are three different options
that you can use to specify the plan files: Choose from list, Use filter, and All. You should use the option
that corresponds to how many plan files you want to process—all plan files, or a subset of plan files. If
you want to process a subset of plan files, you can select individual files to process or you can use a filter
to define the subset.
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NOTES:

e If a plan file is locked by another user when the task is executed, then processing for that file
will fail. Failures are noted in the result history for the job.

¢ [f a plan file has not yet been created for a particular plan code, then that plan code will not
display in this list and will be ignored when processing. Scheduler does not support creating
plan files as part of the Process Plan Files task (you must use the separate Create Plan Files
task for this purpose).

¢ |f the file group uses a Show on List column, then any plan code that is set to False will not
display in the plan file list and will be ignored when processing.

Process all plan files

To process all plan files, select All. The list of all plan files is generated each time the Scheduler task is
executed, so that if new plan files have been added then those new plan files will be included in the
processing (the reverse is also true if any plan files have been removed).

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all current plan codes to be selected. However, in this case the list of selected plan codes is fixed
and therefore will not automatically adjust for any future changes.

Process selected plan files

To process certain plan files, select Choose from list, and then select the check boxes for the plan files
that you want to process. When the Scheduler task is executed, Axiom Contract Management will
process only the selected plan files.

To find the plan files you are looking for, you can sort, filter, and group the list using standard Axiom grid
features. You can show additional columns and hide columns by right-clicking in the column header. If
you have filtered the list, you can select the check box in the header to select only the plan files that
currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the list of
plan files could change when the alias target changes.

Process a filtered set of plan files

To use a filter to process a subset of plan files, select Use Filter. When the Scheduler task is executed,
Axiom Contract Management will process only the plan files that meet the filter.

You can use the Filter Wizard to create the filter, or you can manually type a filter criteria statement into
the filter box. The filter must use the plan code table or a lookup table. For example:
DEPT.Region='US West' where Dept is the plan code table.
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Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

You can also use a job variable for the filter. For example, you can define a job variable named "filter"
and then place the text {filter} in the filter box. This is intended for use when running Scheduler jobs
via RunEvent. If a variable value is specified when the event is triggered, such as the value
dept.region="west', then that filter statement will replace the { filter} variable and will be used
to determine the list of plan files to be processed.

NOTE: If you use a variable, and you leave the default value for that variable blank within the Job
Variables tab, then all plan codes will be processed if no value is passed by the RunEvent function.
You may want to define a default filter that results in no values (such as 1=0), so that plan files are
only processed if a valid filter value is passed.

» Axiom Queries

On the Axiom Queries tab, select the queries that you want to run in the plan files. By default, all listed
queries are selected. This tab only applies when using Normal Processing mode.

If you do not want to run a particular query, you can clear the check box. You can select or clear
individual check boxes, or you can use the check box in the header to select or clear all queries currently
displayed in the list. You can sort, filter, and group the list using standard Axiom grid functionality.

Options | Plan Files | Axiom Queries

Active Axiom Queries for selected Plan Files are shown in the list below. Selected Axiom Queries will be run when the related Plan Files
are processed.

Template E‘ Worksheet B Axiom Query Izl Refresh On Open Izl Dynamic
Master Stat_Rev AQT: Stat_Rev Falze False
Master Stat_Rev AD2: NetRevSection Falze True
Master Stat_Rev AC3: Forecast False True
Master Stat_Rev AC4: ColHide Cn Open True False
Master Stat_Rev AQS5: Statistics On Open True False
Master JobCode AQT: Labor Configuration Driver On Open True False
Master JobCode AQ2: Labor Configuration Driver On Open True False

Example Axiom Queries tab

The list of Axiom queries is based on the source templates that were used to create the plan files. Only
Axiom queries that meet the following criteria are eligible for selection:

e Active is set to On, or the setting uses a formula.

¢ Refresh during document processing is set to On.
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If a query uses a formula for the Active setting, this means the query is dynamic and may or may not be
run, depending on how the formula resolves in each plan file to be processed. When a particular plan
file is processed, each selected query will be evaluated based on the current settings in that plan file. If
both Active and Refresh during document processing are On for that plan file, then the query will be
run. If either or both settings are Off for that plan file, the query will not be run. You can tell whether a
query is dynamic or not by looking at the Dynamic column in the query list.

If a query is not selected on this tab, then that query will not be run in any plan files during processing,
regardless of whether Active or Refresh during document processing are enabled in the plan file.

The plan file selection on the Plan Files tab affects the Axiom query list as follows:
e If you have selected individual plan files, then only the eligible queries for the source templates of
the selected plan files are shown.
e If you have selected All or Use Filter, then all eligible queries for all used templates are shown. If
the file group has templates that have not been used to create any plan files, then those
templates are not included in the list.

The listed queries are identified by template, worksheet, and query name. The following additional
properties are also listed for each query:

e Refresh On Open: Indicates whether the Axiom query is configured to refresh automatically
when the file is opened. This is for information purposes only, to help you determine whether the
guery needs to be included in the processing. The Refresh on Open status is ignored by Process
Plan Files—if the query is selected it will be run along with the other selected queries, and if it is
not selected it will not be run.

e Dynamic: Indicates whether the query is dynamically enabled. True means that the query uses a
formula for the Active setting.

NOTE: If a query is listed on this tab but it is grayed out and unavailable for selection, that means
that although the query is active (either directly or dynamically), the query is not eligible to be run
using Process Plan Files (because the setting Refresh during document processing is set to Off). This
query is listed for your information only, so that you understand the query cannot be run as part of
the process.

» Utilities tab

On the Utilities tab, select the ProcessPlanFileUtilities data source to use during processing. This data
source determines which utility files are processed and the processing order. This tab only applies when
using Process with Utilities mode.
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Options | Plan Files | Utilities

The list below shows the selected utilities data source for each template in the currently selected plan files,
Template Name  Utilities Data Source

FormTemplate Setl ~

Example Utilities tab

For each template listed, use the Utilities Data Source field to select the data source to use for plan files
created from that template.
¢ [f the template only has one data source, that data source is selected.

e |If the template has multiple data sources, then the data source marked as the default data source
is selected by default. If desired, you can use the drop-down list to select a different data source.

When plan files are processed, Axiom Contract Management reads the specified data source in each
plan file to determine the utilities to be processed for that plan file.

The plan file selection on the Plan Files tab affects the Utilities list as follows:
¢ [f you have selected individual plan files, then only the templates used to create the selected plan
files are shown.

¢ [f you have selected All or Use Filter, then all used templates are shown. If the file group has
templates that have not been used to create any plan files, then those templates are not included
in the list.

» Processing Variables

This tab can be used to define variables to pass into plan files before processing begins, and to pass
variables back to the Scheduler job after processing has been performed. This tab is optional and is only
used in special situations.

Pre-Processing Document Variables

This section can be used to pass document variables into plan files before processing. This can impact
the processing of plan files if the files are configured to use the variable values in some way.

For each pre-processing document variable, you can specify a variable name and a variable value. The
plan files must be set up with GetDocumentInfo functions that return the values for the specified
variables.
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+ To add a variable, click the Add button to add a row to the list. Complete the
settings for the variable as described below.

X To remove a variable, select the variable in the list and then click the Remove
button. Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When
you are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the
cell.

Iltem Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Pre-Processing Workbook Variables

This section can be used to pass values into plan files before processing. This can impact the processing
of plan files if the files are configured to use the values in some way.

For each pre-processing variable, you can specify a workbook location to place the value, and the value
to be placed.

Item Description

Workbook The location in the workbook for the value to be placed. Any existing value in
Location this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, then the value will be saved in the file.

The location can be specified using SheetName! CellRef syntax (for example:
Report ! A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the plan file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.
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The specified location and value will apply to all plan files being processed by the task. If you are going
to use pre-processing variables, the location should be predefined in the template and therefore
available to all plan files built using that template. If the plan files will be built using multiple templates,
then all templates should be set up with the same designated location, or you should set up separate
processing tasks based on template type.

Post-Processing Workbook Variables

This section can be used to pass a value from plan files back to the Scheduler job after processing has
been performed. This can impact the processing of subsequent tasks in the job if those tasks are
configured to use the value in some way.

For each post-processing variable, you can specify the location in the workbook to find the value, and
the job variable to use that value.

NOTE: If this task processes multiple plan files, the resulting variable value will be from the last file
that was processed.

Iltem Description

Workbook The location in the workbook to find the value to be passed to Scheduler. This

Location value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName! CellRef syntax (for example:
Report !A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created. However, in most cases you will want the variable to be
already set up with a default value, so that the job does not have validation
errors that prevent saving.

The specified location and job variable will apply to all plan files being processed by the task. If you are
going to use post-processing variables, the location should be predefined in the template and therefore
available to all plan files built using that template. If the plan files will be built using multiple templates,
then all templates should be set up with the same designated location, or you should set up separate
processing tasks based on template type.

Even though the task may process many plan files, only the job variable value from the last-processed
plan file will be used. The plan files must be set up so that all plan files result in the same value after
processing, or else your results will vary depending on which plan file was the last file to be processed.
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Process Document List task

This task processes a user-defined set of documents. The process operation always calculates the files.
In addition, you can opt to run Axiom queries in the files, process alerts in the files, and then perform a
save-to-database and/or save the files.

You can process any Axiom-managed Excel files by using this task. The primary intent of the task is to
process files such as driver files or report utilities. For example, you may be using Axiom queries and
GetData functions in your driver files that need to be updated regularly. Rather than opening,
refreshing, and saving each driver file, you can use this task to define the set of files and schedule
processing.

NOTES:
¢ Generally speaking, plan files should not be processed using this task. Instead, the Process
Plan Files task should be used.

¢ This task does not perform file processing actions on the file. File processing can be set up for
report files and driver files, and can be used to perform actions such as file delivery, using
standard or multipass processing. If you want to perform file processing using Scheduler, use
the File Processing task.

» Documents to process

Specify the documents to be processed when the task is run. Documents are processed sequentially in
the order listed.

+ To add a document, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

X To remove a document, select the document in the list and then click the
Remove button. Only one document can be selected at a time.

a“ v To change the order of documents, select the file in the list and then click
the arrow buttons to move the file up or down.

Only Axiom-managed Excel files are valid to be processed in the task.

Selecting a document using a file group alias

You may want to specify the document to process using a file group alias, so that the task does not have
to be manually updated after rolling over to a new file group for a new year of planning. When you are
selecting a document in the Axiom Explorer dialog, you can expand the file group alias to see all of the
files in the current target of the alias.
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For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.

A | Axiom Explorer ? *

@ ) 4 [\Axiom\File Groups\Budget 2018\Utilities o
File = View = Open -

My Files - Mame Madified Locked By Size

b ¢ Favorites =] Add New Initiative 7/27/2017 8:34 AM 28KB

? il Recent (] Allocations 7/27/2017 8:34 AM 22 KB

| My Documents -
] budget_assignment T2T2017 8:34 AM 39 KB

File Groups . ) M 7/27/2017 8:34 AM 19 KB

™ e File Group Aliases ] process_metrics 7/27/2017 8:34 AM 14 KB

~ =] Current Budget
m Calc Methed Libraries
’ m Drivers
m Plan File Attachments
[ Plan Files
m Process Definitions
m Templates
M utilities
m Workflow
I:I’?U Scenarios
¥ =] Current Capital

IE ] Allocations  Description: Open | | Clase

Microsoft Excel Worksheet Size: 22 KB Date modified: 7/27/2017 8:34 AM  Locked by:

Selecting a document to process using a file group alias

When you select a document underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the document within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected document.

Documents to process

Allocations.jlsx
3

document://{filegroup://Current Budget/alias}\Utilities\Allocations.dsx [

Processing Options

File path using file group alias syntax
When the file group alias is updated to point to a new file group, the Scheduler task will use the file in

the new file group automatically. If the file does not exist in the new file group, the task will fail with an
error.

» Processing Options

By default, both options are selected. Axiom queries are refreshed before the save-to-database occurs.
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If neither option is selected, then the files are calculated and then saved.

Iltem Description

Perform all enabled If this option is selected, then all eligible Axiom queries in all selected files
Axiom Queries in will be refreshed when the task is run. This option is selected by default.

selected workbooks . . - L . .
Axiom queries are eligible for processing if they are active and use either

of the following refresh behaviors: Refresh on File Open and Refresh
During Document Processing.

Enable iterative Specifies whether iterative calculations are enabled for the file during
calculation while processing. In most cases you will leave this option disabled.
processing

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings
are fixed at a maximum of 100 iterations and a maximum change value of

.001.
For more information on iterative calculations, see the Microsoft Excel
Help.
Save document after If selected, then files will be saved after processing. This option is selected
processing by default. The user executing the task must have Read/Write access to
the files.

This option does not cause a save-to-database to be performed—that
option must be selected separately.

NOTE: If this option is not selected, then the utility will open the file as
read-only and will not attempt to acquire the document lock before
processing.

Run Save To Database If selected, then a save-to-database will be performed after processing.
on plan files after This option is selected by default. The user executing the task must have
processing the Allow Save Data permission to the files.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a
save-to-database.

Process alerts in If selected, then alerts in the file will be processed. The file must contain
selected workbooks an Alert Control Sheet and one or more alerts must be defined in the file.

If Axiom queries are enabled for processing as well, the queries will be run
before alerts are processed.
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» Pre-Processing Document Variables

This section can be used to pass document variables into the target files before processing. This can
impact processing if the files are configured to use the variable values in some way, such as to filter an
Axiom query.

For each pre-processing document variable, you can specify a variable name and a variable value. The
target file must be set up with GetDocumentinfo functions that return the values for the specified
variables.

+ To add a variable, click the Add button to add a row to the list. Complete the
settings for the variable as described below.

X To remove a variable, select the variable in the list and then click the Remove
button. Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When
you are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the
cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

The following example screenshot defines the value for the document variable Dept. The value is
defined using the value of a Scheduler job variable {Dept}. A value for Dept can be passed into the
Scheduler job when the job is started, and then passed into the target file using the document variable.

Pre-Processing Document Variables + X

Variable Mame Variable Value

Dept {Dept}

» Pre-Processing Workbook Variables

This section can be used to pass values into the file before processing. This can impact processing if the
files are configured to use the values in some way. For each pre-processing variable, you can specify a
workbook location to place the value, and the value to be placed.
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NOTE: The specified value will be placed in all files listed to process. Therefore, unless all files are set
up to use the same location and the same way of deriving the value, you will need to create a
separate Process Document List task for each file. If you are not using pre-processing variables, then
this does not matter.

+ To add a variable, click the Add button to add a row to the list. Complete the
settings for the variable as described below.

X To remove a variable, select the variable in the list and then click the Remove
button. Only one variable can be selected at a time.

e To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When
you are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the
cell.

Iltem Description

Workbook The location in the workbook for the value to be placed. Any existing value in
Location this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, the value will be saved in the file.

The location can be specified using SheetName! CellRef syntax (for example:
Report !Al13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the target file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.

» Post-Processing Workbook Variables

This section can be used to pass a value from the file back to Scheduler after processing has been
performed. This can impact the processing of subsequent tasks in the job if those tasks are configured to
use the value in some way. For each post-processing variable, you can specify the location in the
workbook to find the value, and the job variable to use that value.
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NOTES:

¢ |f this task processes multiple documents, the resulting variable value will be from the last
document processed.

¢ [f the task is run as a sub-job, then the post-processing variable is not passed back to the
"parent" job. The task must be executed as a regular task within the job in order to pass the
variable value back to the job.

+ To add a variable, click the Add button to add a row to the list. Complete the
settings for the variable as described below.

X To remove a variable, select the variable in the list and then click the Remove
button. Only one variable can be selected at a time.

&~ To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When
you are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the
cell.

Item Description

Workbook The location in the workbook to find the value to be passed to Scheduler. This

Location value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName! CellRef syntax (for example:
Report !A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created when the job is executed. However, in most cases you
will want the variable to be already set up with a default value, so that the job
does not have validation errors that prevent saving.

Process Template List task

This task processes a user-defined list of file group templates. During processing, any Axiom queries with
Refresh during template processing enabled are executed and time-stamped, and then the template
files are saved.
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The primary purpose of this task is to enable use of time-stamped Axiom queries with virtual plan files.
Because virtual plan files are re-created from template each time they are accessed, Axiom queries
cannot be time-stamped within the plan files. Virtual plan files can use the time stamp from the
template, but under normal circumstances, Axiom queries are not time-stamped when they are run in
templates. However, when Axiom queries are run during template processing, the Last refresh time for
the query is updated, which means that the queries can be configured to only run if the primary table
has changed.

To use this task to enable time-stamped Axiom queries for virtual plan files, do the following:

e In the template, enable Refresh only if primary table changed since last refresh and Refresh
during template processing for the Axiom queries that you want to be time-stamped.

* |n Scheduler, create a job with a Process Template List task and add the template to the task.
Define a scheduling rule for the job as appropriate. For example, you might want the template to
be processed nightly.

When the template is processed, the designated Axiom queries will be run if the primary table has
changed, and the time stamps are updated. When a virtual plan file that uses this template is opened,
the queries will not be run again if the primary table has not changed.

This task should only be used to process Axiom queries that meet the requirements of time-stamped
queries.

» Templates to process

Specify the templates to be processed when the task is run. Templates are processed sequentially in the
order listed. If you have multiple templates to process (in the same or different file groups), you can run
them all in the same task.

+ To add a template, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

X To remove a template, select the file in the list and then click the Remove
button. Only one file can be selected at a time.

“ v To change the order of templates, select the file in the list and then click
the arrow buttons to move the file up or down.

Normal template behavior rules apply during processing. For example, save-to-database and action
codes are not run in templates. The only exception to normal template behavior during this task is that
any executed Axiom queries will be time stamped.

Selecting a template using a file group alias

You may want to specify the template to process using a file group alias, so that the task does not have
to be manually updated after rolling over to a new file group for a new year of planning. When you are
selecting a template in the Axiom Explorer dialog, you can expand the file group alias node to see all of
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the files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.

A | Axiom Explorer ? *

(]

0 | ‘If ‘AxiomiFile Groups\Budget 2018\ Templates
=y

File = View = Open ~ ||=D All Templates

My Files - MName Madified Lacked By Size
b 3¢ Favorites i3] FormTemplate T/2T/2017 8:34 AM I0KB

* i Recent 5 Master Budget Template 7/27/2017 8:34 AM 53 KB
) My Documents

File Groups S

= |, File Group Aliases
~ ¥=] Current Budget
F[| Calc Methed Libraries
’ m Drivers
m Plan File Attachments
I Plan Files
m Process Definitions
m Templates
I utilities
m Workflow
D'T'ﬂ Scenarios
¥ =] Current Capital

43| Master Budget Template Description:
Jd l

o a
Microsoft Excel Macro-Enabled Worksheet Size: 53 KB Date modified: 7/27/2017 8:34 AM Locked by: pen || os%

Selecting a template to process using a file group alias

When you select a template underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the template within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected template.

Templates to process

Master Bug et Template.xdsx

documenty//{filegroup://Current Budget/aliasP\Templates\Master Budget Template.xdsx

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in
the new file group automatically. If the file does not exist in the new file group, the task will fail with an
error.
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Purge System Data task

The Purge System Data task is intended to clean up old data in your system, to help keep your system
running efficiently.

NOTE: Scheduler automatically creates a system job for this task (System.SystemDataPurge), which
administrators can edit as needed.

This task purges the following data when it is run:

Scheduler job result history

Scheduler and system email notifications
System temp table data

Audit history

Alerts

For each category of data, you can specify a number of days of data to keep when the task is run. All
results older than the specified number of days will be deleted. Note that O days means that no data is
purged for that category.

Section ltem Description
Scheduler Results Number of days to keep The number of days of job result history to
result history keep when the task is run. By default, this is

set to 15 days.

SMTP Messages Number of days to keep The number of days of delivered message
delivered messages and data to keep when the task is run. By default,
attachment data this is set to 15 days.

Temporary Tables Number of days to keep The number of days of temp table data to
temp table data keep when the task is run. By default, this is

set to 15 days.

Audit History Number of days to keep The number of days of system audit history to
system history keep when the task is run. By default, this is

set to 15 days.

"System history" encompasses all audit
data—including prior document versions and
deleted documents—except table audit data.

Audit History Number of days to keep The number of days of table audit history to

table history keep when the task is run. By default, this is
set to 15 days.

Table audit data is tracked for tables where
Audited is set to True.
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Section ltem Description

Alerts Number of days to keep The number of days of alerts to keep when
alerts the task is run. By default, this is set to 60
days.
Announcements Number of days to keep The number of days of expired
announcements after announcements to keep when the task is run.
expiration date By default, this is set to 30 days.

Job variables can be used in all of these settings.

Each purge routine in the task is limited to purging a specific number of rows at a time (50000). If the
number of rows to be purged exceeds this limit, then the excess data is retained until the next time the
task is run. If you notice data in the database that you expected to be purged, most likely the amount of
data to be purged exceeded the limit, and the data will be purged next time the task is run.

» Other purged data
This task also cleans up the following items in your system:

e Deleted columns. When a column is deleted from a table in Axiom Contract Management, the
column is immediately deleted from the associated view (which prevents it from being accessed
in the system), but it remains in the base table. This task finishes the process of removing
obsolete columns from the base tables.

¢ Orphaned user folders. If the system contains any user folders that do not match up with existing
users, these folders are deleted. Although user folders are deleted when a user is deleted from
security, orphaned user folders can result from other processes, such as migrating a system
between different management databases.

These items are not associated with any specific task settings; the delete process is performed whenever
the task is executed.

Raise Event task

The Raise Event task can be used to trigger other Scheduler jobs for execution, using a named event
handler. This task has one required setting:
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Item Description

Event Name Enter the name of the event that you want to raise for execution. This name
must match a defined event handler name in one or more other Scheduler jobs.

When this task is run, it looks for any jobs that contain the specified event
handler name. These jobs are added to the schedule and are eligible to be
processed immediately, depending on Scheduler thread availability and any
other higher-priority jobs already in the queue.

NOTE: It is not possible to specify a file group context for the event handler
when using Raise Event. Axiom Contract Management will run all jobs that

contain the specified event handler name, regardless of whether the event
handler is associated with a file group.

Event Variables

This section can be used to pass variables into the jobs triggered by the event handler. If the jobs are
configured to use the variables, these values can impact how the jobs are processed.

+ To add a variable, click the Add button to add a row to the list. Complete
the settings for the variable as described below.

X To remove a variable, select the variable in the list and then click the
Remove button. Only one variable can be selected at a time.

For each variable, you can specify a variable name and a variable value. To edit the variable settings,
double-click the applicable cell to make the cell contents editable. When you are finished editing, you
can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Iltem Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Run Excel Macro task

This task runs an Excel macro on an Axiom file.

NOTE: This task is no longer supported because it requires Excel processing on the Scheduler server.
It is still available on the task list, but cannot be executed.
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Please contact Axiom Contract Management support if you need assistance with this task.

Iltem Description

Workbook Path The path and name of the file to run the macro on.

You can click the Browse button to navigate to the file.

Macro Name The name of the macro to run.
Macro If the macro takes arguments, you can enter the argument values here.
Arguments

Click Add to add an argument, Remove to delete the selected argument, or
Clear to clear all arguments.

Job variables can be used in all of these settings.

Run Scheduler Job task

This task runs a specified Scheduler job as a subordinate job within the current job. The job containing
the Run Scheduler job task is the parent job, and the target job for the task is the child job.

By default, the parent job waits until the child job is complete before continuing to the next task in the
parent job. This means that tasks after the Run Scheduler Job task can be reference the results of the
child job. For example, the child job may perform a save-to-database. The subsequent tasks in the
parent job can access the data saved by the child job.

» Task Control options

When you create the Run Scheduler Job task, the options in the Task Control section are pre-set as
follows:

e The option Create a Subordinate Job for this Task is grayed out. This is because the target job is
always run as a subordinate job.

e The option Wait for all Subordinate Jobs to complete before proceeding to the next Task is
enabled by default. This means that tasks after the Run Scheduler Job task can be dependent on
the target job and reference the results of that job. If you disable this option, then the parent job
will continue to the next task in the job immediately after creating the subordinate job—it will
not wait for the subordinate job to complete.

Keep in mind that if you want the parent job to stop processing tasks if the target job fails, then Wait for
all Subordinate Jobs to complete before proceeding to the next Task must be enabled for the task and

If this Task fails, continue executing subsequent Tasks must be disabled for the task. This is the default

configuration.

Administrator's Guide Axiom Contract Management | 383



If needed, you can use the option Process task only if the value of this expression is true to detect
whether a subsequent task in the parent job should be processed. For example, if you know that the
child job saves a particular value to the database, you can check for the existence of that value to
determine whether to process the task. For more information on using this option, see Conditionally
processing tasks in a job.

» Target Scheduler job

In the Task Details section, use the Browse button to select the target Scheduler Job. You can select any
job that you have access to in the Scheduled Jobs Library.

When the Run Scheduler Job task is executed, it creates one or more subordinate jobs as needed to
execute the tasks in the target Scheduler job. As long as Wait for all Subordinate Jobs to complete
before proceeding to the next Task remains enabled in the Task Control options, the parent job waits
for all subordinate jobs to be completed before moving on to the next task in the parent job.

NOTE: The user executing the job does not need to have security access to the target Scheduler job
for Run Scheduler Job. It is assumed that if the user can execute the parent job, the user should be
able to execute the target job.

» Child Job Values

If the target job for the Run Scheduler Job task has defined job variables, those variables and their
default values are listed in this section. The default values are determined as follows:

 |f the parent job and the child job have a variable with the same name, the default value is the
value defined in the parent job. This value will be passed to the child job and used when the child
job is run.

e Otherwise, the default value is the value defined in the child job.

To override a variable value, select the Override check box and then click inside the Override Value field
to enter a value. You can enter a hard-coded value or use a job variable from the parent job. Enter the
variable name in curly brackets to use that variable's value as the override value.

For example, imagine that both the parent job and the child job have a variable of {Dept}. In the parent
job, the value of {Dept} is set to 20000, and in the child job the value is set to 40000. The Run
Scheduler Job task will display the parent value of 20000 as the default value, and that value will be

used when the child job is executed.

Now imagine that the parent job has a variable of { StartDept} setto 20000, and the child job has a
variable of {Dept} set to 40000. In this case, the Run Scheduler Job task will display the value of
{Dept} as defined in the child job (40000). If you want to use the parent job value for {StartDept}
instead, then you must select the Override check box and enter {StartDept} as the Override Value.
Now the value of {Dept} in the child job will be overridden and set to 20000.
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SMTP Message Delivery task

This task delivers email notifications for Scheduler jobs.

NOTE: Scheduler automatically creates a system job for this task (System.SMTPMessageDelivery),
which administrators can edit as needed.

Item Description

Server name The server name of the SMTP email server.

Port number The port number for the SMTP email server. By default, the port is 587, but
you can specify a different port number if needed.

Server requires Select this check box if the SMTP email server requires authentication.

authentication
If selected, type a Username and Password.

Test Mode Specifies whether the task is run in test mode. If this check box is selected, the
task verifies that it can successfully connect to the SMTP server to send email
notifications, but no emails are actually sent.

For the System.SMTPMessageDelivery job, new systems are automatically set
to test mode. If you restore a database, the restore process also sets the
system job to test mode. You must disable test mode before any emails will
be sent.

Start Process task

This task starts a process for Process Management. You can use this task to automatically start a process
at a specific point in time, including recurring schedules (such as to automatically start a monthly
process).

This task can be used to start a generic process definition or a plan file process definition.
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Item Description

Process to start The process definition to start. Click the Browse button to select the process
definition file. You can select any process definition that you have access to
within the Process Definition Library or within a file group Process Definitions
folder.

If the Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the process definition file through the Current File Group
node at the top of the file groups list. When you do this, the path to the file is
stored relative to the current file group, which means that it will automatically
update when the file group is cloned. This is the recommended method of
referencing the process definition file when the Scheduler job belongs to a file

group.

A Axiom Explorer: Fil
O 4 \Axiom\File Groups\Budget 2021\Process Definitions

| File~  View~

My Files -~ Name Modified Locked By Size Type Modified By
#) Budget Many 3/12/2020 12:09 PM 11K8 AXPFile  admin
4/8/2020 3:22 PM 69 KB AXPFile  admin
4/1/2020 2:25 PM 12K8 AXPFile  admin

» {71 Budget 2020
» Z]Budget 2021
» 7=1Budaet 2022

Restart process Specifies whether the Scheduler task will restart the process if it is already
if it is already running, or if the process will be left as is.
running  Select this option if you want to start the target process regardless of

whether it is already running. The current process instance will be aborted
and a new process instance will start over at step 1. This option is selected
by default.

e Clear this option if you want to leave the existing process instance running.
In this case, the Scheduler task will take no action if the target process is
already running.

Web Report Processing task

This task performs multipass processing on a web report. The report is processed over a dimension with
a filter automatically applied to limit the data in the report to the current dimension value. The result of
each pass is either a PDF or Excel output file, which can be saved to a designated folder location and/or
emailed.

IMPORTANT: Only web reports created from product-delivered templates can be processed by this
task. Consult the separate product documentation for more information on any web report
templates delivered with your product. Web reports that were created in the Report Builder cannot
be processed at this time.
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» General task properties

The general task properties at the top of the task settings determine the report to process.

Item Description

File to Process The web report to process for the task. Click the Browse button to open the
Axiom Explorer dialog, and then select a report to process. You can select any
template-based web report that you have access to within the Reports Library.

Only one report can be selected for each File Processing task. If you want to
process multiple reports, you can add multiple File Processing tasks to the
Scheduler job.

TIP: Once the file is selected, only the file name displays in the task. If you want
to know the folder location of the selected file, hover your cursor over the field.
The folder location is listed in the tooltip.

Override file to Optional. Specifies a Scheduler job variable to override the file to process. The

process override file will then be used for processing instead of the original file. This
feature allows you to pass in an alternate file to process, when using Run Event
or Raise Event to trigger the Scheduler job for processing.

To use a job variable, enter the variable name in curly brackets, such as
{MyFile}. When the job is executed, this variable must resolve to a valid file
path in the Axiom Contract Management file repository. Note that it is not valid
to leave the variable value blank (the task will not use the original file to
process).

NOTES:

¢ The override feature is only exposed to product developers. It is only
visible in client systems if the job is delivered as part of a product
package and an override variable is specified in that job.

¢ The File to Process field must point to a valid file for file processing
when the override feature is used, even though that file will never
actually be processed by the task. If the file to process is missing or
invalid, then the task validation will fail.

Advanced options

When the task is configured to output multiple files (File Generation is set to Multiple Output Files),
then multiple passes can be separated into sub-jobs, which can then be processed at the same time.
This parallel processing can improve the performance of the task.
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For example, imagine that you are multipass processing a report by department. If the task is processed
sequentially, then the task would process Dept 100 and finish it, then move to Dept 110 and finish it,
and so on. When parallel processing is used instead, Depts 100-199 can be separated into one sub-job,
Depts 200-299 into another sub-job, etc. Because the sub-jobs are processed in parallel, multiple
departments are processed at the same time, so the overall task can complete more quickly.

Item Description

Maximum The maximum number of subordinate jobs to run in parallel. The default
Parallel Jobs number is 4.

This is the total number of sub-jobs that can be run at the same time for this
task. Ultimately the number of sub-jobs that are run in parallel depends on the
number of Scheduler threads that have been configured for use at your
organization, and the number of Scheduler threads that are currently available
(threads that are not processing other higher-priority jobs).

Processing Batch  The number of multipass passes to include in each sub-job at a time. The
Size default number is 10.

Passes are determined based on the multipass list of items. For example, if you
are processing by department (DEPT.DEPT), then each department is a separate
pass. If the batch size is set to 10, then each sub-job would process 10
departments at a time.

In most cases, the default settings are sufficient. If you are experiencing lengthy
processing times and want to optimize performance, you can adjust this setting
as follows: divide the number of passes by the number of available Scheduler
threads. For example, if there will be 100 passes and there are 4 Scheduler
threads, set the batch size to 25.

NOTE: There is no way to disable parallel processing if the task is eligible; however, you can adjust
the parallel processing settings if desired.

» Report processing properties

The report processing properties in the middle of the task settings determine the output of the task.
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Item Description

Processing Type Select one of the following to determine the output format of each pass:

e Export to Excel (default): The contents of the report are exported to a
spreadsheet (XLSX) file. The output uses the same behavior as when you
export to spreadsheet while viewing the web report.

e Export to PDF: The report is saved as a PDF file. The output uses the same
behavior as when you save to PDF while viewing the web report.

Save or Email Select one of the following to determine the delivery method for the output:
Files e Save Files (default): The output files are saved to the specified output
folder.

¢ Email Files: The output files are emailed to the specified recipients. The
output files are not saved anywhere on the file system.

e Save and Email Files: The output files are both saved and emailed.

File Generation Select one of the following to determine whether the output is saved as a
single file or multiple files:

e Multiple Output files (default): The results of each pass are saved as
individual output files. For example, if the multipass settings result in 10
passes, then 10 output files are created (one file for each pass).

¢ Single Output File: The results of each pass are collected into a single
output file. For example, if the multipass settings result in 10 passes, then
the results of all 10 passes are placed in a single output file.

If the output type is Excel, then each pass is a separate sheet in the Excel
file. If the output type is PDF, then the PDF for each pass is combined into
one large PDF file.
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Item Description

File Name Specify how the output file (or files) should be named. You can do the
following:

* You can use processing variables and/or Scheduler job variables to generate
dynamic file names.

¢ You can type a "hard-coded" file name.

If the task will generate multiple output files, then the file name (or the output
folder path) must use a processing variable so that the output of each pass is
unique. If the task will generate a single output file, then variables are not
required.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select the
variable that you want to use.

For example, you could set the file name to Income Statement [Current
Value]. If the report is being processed by region to multiple output files, this
will generate file names such as Income Statement West, Income
Statement East, and so on (where "East" and "West" are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job variables
are enclosed in curly brackets.

Sheet Name Specify how the sheet for each pass should be named. This property only
applies when the processing type is Export to Excel. You can do the following:

e You can use processing variables and/or Scheduler job variables to generate
dynamic sheet names.

* You can type a "hard-coded" sheet name.

If the task will collect all of the output into a single spreadsheet file, then the
sheet name must use a processing variable so that the output of each pass is
unique. If the task will generate multiple output files, then variables are not
required.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select the
variable that you want to use.

For example, you could set the sheet name to [Current Value]. If the report
is being processed by region, this will generate sheet names such as West,
East, and so on (where "East" and "West" are region names).

NOTE: Processing variables and Scheduler variables use different syntax.
Processing variables are enclosed in square brackets. Scheduler job variables
are enclosed in curly brackets.
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Export to Excel Settings

Complete the following properties if the processing type is Excel.

Item Description

Include Column Specifies whether column headers are included in the file output. By default

Headers this is set to On, which means column header text is included in the first row of
the spreadsheet. Column grouping headers and multi-row headers are not
included.

If this option is set to Off, then column headers are omitted from the file
output and the data starts in the first row of the spreadsheet.

Include total row  Specifies whether the total row is included in the file output. By default this is
set to On, which means that the total row is included in the spreadsheet.

If this option is set to Off, then the total row is omitted from the file output.

NOTE: This option only applies when the web report being processed is a
dynamic row report with the total row enabled. If the web report being
processed uses a fixed row structure, then the total and subtotal rows defined
in the fixed row structure are always included in the spreadsheet.

Export to PDF Settings
Complete the following properties if the processing type is PDF.

Iltem Description

PDF Orientation Select the orientation for the PDF, either Portrait or Landscape. Portrait is the
default orientation.

Page Size Select the page size for the PDF. You can choose from the following standard
page sizes: A3, A4, A5, Legal, Letter, or Tabloid. Letter is the default size.

Output File Settings

Complete the following properties if file output is being saved. These settings do not apply if the output
is email only.
(missing or bad snippet)

Email Settings

Complete the following properties if file output is being emailed. These settings do not apply if the
output is saved only.
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Item Description

Recipient Optional. Specify a table column that holds the desired email recipients for
column each pass. This option only applies if File Generation is set to Multiple Output
Files, so that each pass will be sent a separate email.

You can type the name of a table column, or click the column button Ff to
select a column from the multipass table or a lookup table. (You must select a
multipass column first before you can use the column button to select a
column.) For example, if the multipass column is Dept.VP, the recipient column
might be Dept.VP.Email.

The specified column can contain any of the following: email addresses, user
login names, and/or role names. The column can contain multiple values
separated by a semicolon. The recipients listed in the column will be used as
the To address for the email (in addition to any recipients listed directly in the
To field). If the column contains a user login name, that user's email address as
defined in security will be used. If the column contains a role name, the email
will be sent to all users in the role.

To verify that the recipient column will resolve as you expect for each pass, you
can click the Preview Multipass List button in the Multipass Data Settings
section. The specified recipient column displays in this preview so that you can
see the recipient column values associated with the multipass column values.

NOTE: The recipient column must have a one-to-one relationship with the
values in the specified multipass column.

To Specify the To recipient(s) for the email. This is required if a recipient column is
not specified. If a recipient column is specified, the recipients listed here will be
added to the recipients listed in the column for each pass.

You can type one or more email addresses, user login names, and/or role
names. Separate multiple recipients with semicolons. If a user login name is
listed, that user's email address as defined in security will be used. If a role
name is listed, the email will be sent to all users in the role.

NOTE: If File Generation is set to Multiple Output Files, the recipients in the To
field will receive a separate email for each pass. The only way to dynamically
send the emails to different recipients per pass is to use the Recipient Column
option.

cC Optional. Specify the CC recipient(s) for the email. This field follows the same
rules as the To field.

BCC Optional. Specify the BCC recipient(s) for the email. This field follows the same
rules as the To field.
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Item Description

From Select one of the following to specify the From address for the email:
e Current User: The email will be sent from the user who executes the
Scheduler job.
e System User: The email will be sent from the designated From user for
Scheduler. This is the same value returned by the
{Scheduler.FromEmailAddress} job variable.

Subject Line Enter the subject line for the email. Processing variables can be used in the
subject line when File Generation is set to Multiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select the
variable that you want to use.

For example, you could set the subject line to Monthly report for
[Current Value] in order to include the current pass value in the subject
line.

Body Text Enter the body text for the email. Processing variables can be used in the body
text when File Generation is set to Multiple Output Files.

To use a processing variable, you can type the variable or you can click the
pencil icon to open a text editor. From the Insert Variable list, select the
variable that you want to use.

Scheduler job variables can be used in any of the email settings except the From setting.

» Multipass properties

The multipass properties at the bottom of the task determine how the report will be processed over a
dimension.
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Item Description

Multipass Specify the column to use for multipass processing. You can type a

Column Table.Column name, or click the column icon £ to select the column from a
dialog. You can select any column on a data or reference table, though typically
processing is performed by a dimension such as Dept.Dept, or a grouping such
as Dept.Region.

The report will be processed once for each unique value in the specified column
(except for any values excluded by the Source Filter). A filter is applied to the
data query in the report so that the data is limited to the current pass value.
For example, if you are processing by Dept.Dept, then the report will be
processed once for each department, and the report data will be limited to only
the data for that department.

Keep in mind the difference between processing by a data table column such as
GL2022.Dept, versus a dimension table column such as Dept.Dept. When
processing by GL2022.Dept, the report will be processed by each department
with data in the GL2022 table. When processing by Dept.Dept, the report will
be processed by each department in the Dept table.

To verify the list of values for processing, click the Preview Multipass List
button to view the list of items. The first 100 values are shown, in the order
they will be processed. If the task configuration includes a Recipient Column (in
the email settings) or a Sort By column, these columns are also shown in the

preview.
Current Pass Optional. Define a header to display in the report output file. This option only
Header applies if the processing type is Export to PDF.

The current pass header should use processing variables to display information
about the current pass. To use a processing variable, you can type the variable
or you can click the pencil icon to open a text editor. From the Insert Variable
list, select the variable that you want to use.

For example, you can define a header such as:

Processed by [MULTIPASS COLUMN] [CURRENT VALUE]

When processing by Dept.Dept, this would resolve such as Processed by
Dept 22000

By default, if the current pass header is left blank, then the PDF output will not
include a header to indicate the current pass information. However, it is
possible that the template used to create the report may have been designed
with a dynamic header that will display this information.
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Item Description

Sort By Optional. Specify one or more sort columns for the list of multipass values. You
can type a Table.Column name, or click the column icon £ to select the column
from a dialog. You can also optionally specify Asc or Desc after the column
name (ascending order is used if not specified). For example: Dept.Dept
Desc. Separate multiple values with semicolons.

By default, the values are sorted by the multipass column in ascending order.
The Sort By field only needs to be used if you want the values to be sorted in
descending order instead, or if you want the values sorted by a different
column in the same table.

The processing order is only relevant when File Generation is set to Single
Output File, since it determines the order of each individual pass within the
single file. When outputting to Multiple Output Files, the order is still used
during processing but it has no useful impact on the outcome.

Source Filter Optional. Specify a filter to limit the multipass list of items. You can type a filter,

or you can click the filter icon ¥+ to use the Filter Wizard.

When the multipass list of values is generated, any value that does not meet
the source filter will be excluded from processing.

By default, all values in the specified multipass column are processed if the
source filter is left blank.

Scheduler job variables can be used in any of the multipass settings.

» Using processing variables

The following processing variables can be used in various settings within the Web Report Processing
task, in order to dynamically change the setting using information for the current pass.

Iltem Description

[CURRENT_VALUE] This variable returns the current multipass processing value. For
example, if you are processing by Dept.Dept, and the current pass is
for department 20000, the variable will be replaced by the value
"20000" for this pass.

This variable is typically used in settings such the file name, sheet
name (when generating Excel output), and folder path.

[CURRENT_PASSNUMBER] This variable returns the current pass number. For example, if the
current pass is number 20 of 35 passes, the variable will be replaced
by the value "20" for this pass.
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Item Description

[MULTIPASS_COLUMN] This variable returns the name of the multipass column. For example,
if you are processing by Dept.Dept, the variable will be replaced by
the value "Dept" for all passes.

This variable could be used whenever you want to reference the
name of the dimension processed. For example, instead of just
referencing the current value in the file name, you might want to
reference the column name and the value. A variable construction
like [MULTIPASS COLUMN] [CURRENT VALUE] would resolve to
"Dept 20000" when processing by Dept.Dept and the current pass is
for department 20000.

Processing variables can only be used in certain settings, and sometimes only when the output is
multiple files (versus a single file). See the documentation for each individual setting to see if processing
variables are supported in that setting.

Scheduler tasks for database maintenance

Scheduler provides several built-in tasks that are intended for database maintenance. By default, these
tasks are included in the System.IndexMaintenance job, which runs regularly to maintain your database.
The following database maintenance tasks are available:

¢ Rebuild Database Indexes task

e Update Indexes and Constraints task

You can use the Source Axiom Database field to specify whether the task is executed against the system
database or the audit database.

For the SQL Command Text, the actual SQL code used by each task is generated automatically by Axiom
Contract Management when the task is executed. This ensures that the tasks always use the most
current SQL code for each task as defined by Axiom Contract Management.

Web Scheduler

Although most Scheduler setup activities can only be performed in the Desktop Client, some job
management can be performed in the Web Client. Using the "Web Scheduler", you can monitor and
manage the job schedule, review job results, and process existing jobs on demand.
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To access Scheduler in the Web Client:

153

1. Inthe Web Client, click the Syntellis icon =21 in the Navigation bar. From the Area menu, select

System Administration.

PRODUCT AREAS
Home
Intelligence Center

System Administration

1o @ i

2. From the Navigation menu, select Tools > Scheduler.

System Status

@ Active

AXIOM/| System Administration = Dashboard Tools ~ Auditing ~ System Status v

Table Manager

Custom Help Admin

Save Lock Administration

Scheduler

Security Manager
Expires

When you access the Scheduler area, a Scheduler panel becomes available in the left side of the Task
bar. You can use this panel to change the current Scheduler view.
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AXIOM| System Administration = Dashhoard Tools -~ Auditing ~ System Status -~ Infrastructure Section ~  Software Configuration O o @ Qi

] c w Q@

Schedul
S : Scheduled Jobs

Scheduled Jobs

Job Status User Server Priority Start Time Due In Actions
Job Explorer
Job Results System.ProcessNotification Pending System Scheduled Job 10/20/2020 ayear ago
Event Handlers System.SystemDataPurge Pending System Scheduled Job Tomorrow at 1:00 AM in 9 hours
Web Report Processing Fixed De Pending jdoe Scheduled Job Tomorrow at 3:02 AM in 11 hours
Web Report Processing Fixed Ex..  Pending admin Scheduled Job Tomorrow at 3:05 AM in 12 hours
System.IndexMaintenance Pending System Scheduled Job  Tomorrow at 5:15 AM in 14 hours

Example Scheduler area in Web Client

Managing the job schedule in the Web Client

In the Scheduler area of the Web Client, you can view the status of all jobs that are currently on the
schedule. If necessary, you can view the job details, remove the job from the schedule, or run the job
now.

To view the current job schedule:
¢ On the Scheduler page, from the Scheduler panel, select Scheduled Jobs.

AXIOM| System Administration

Scheduler

Scheduled Jobs
Job Explorer
Job Results

Event Handlers

The Scheduled Jobs grid displays all jobs that are scheduled to be processed, or are currently in process.
This includes scheduled jobs, jobs executed manually via Run Now, and jobs that were triggered for
execution via an event handler.
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AXIOM/| System Administration Dashboard

]

Scheduled Jobs

Job Status
System.ProcessNotification Pending
System.SystemDataPurge Pending

Web Report Processing Fixed Dep Pending
Web Report Processing Fixed Exc..  Pending

System.IndexMaintenance Pending

Example Scheduled Jobs grid

User

System

System

jdoe

admin

System

Auditing ~

Server

System Status ~

Priority

Scheduled Job

Scheduled Job

Scheduled Job

Scheduled Job

Scheduled Job

Start Time

Today at 4112 PM

Tomorrow at 1:00 AM

Tomorrow at 3:02 AM

Tomorrow at 3:05 AM

Tomorrow at 5:15 AM

Infrastructure Section ~

Due In

in 35 minutes

in 9 hours

in 11 hours

in 11 hours

in 14 hours

s @ ki

Actions

@ @ »

You can use the Actions column in the right side of the grid to perform any of the following actions on a

job:

Remove the job from the schedule.

@ Vjew the job properties and results.

IMPORTANT: If the job is on the schedule due to a scheduling rule, this

action disables the scheduling rule and removes all future executions

from the schedule as well. If you want future scheduled instances of the

job to proceed, you must edit the job to re-enable the scheduling rule.
p Run the job now.

This action places the job on the schedule for immediate execution (if
another manual instance of the job is not already pending). The future
scheduled instance of the job remains on the schedule.

To refresh the list, click the Refresh icon %~ in the Task bar.

For each job on the schedule, you can view the following information:

Item Description

Job The name of the job.
User The user identity that the job will be run as. If the job is a system job, the user is
System.

This is typically the name of the user who placed the job on the schedule, but not
always (for example, when using an event handler that is set to run as the job owner

instead of as the requester).
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Item Description

Status Job status is either Pending (waiting to be executed) or Working (currently being
executed).
Server If a job is currently Working, then the server executing the job is listed here.

Otherwise, this column is blank.

Priority The priority category for the job:
1. Manual: The job was executed manually.
2. Event Handler: The job was executed by a Scheduler event handler.
3. Scheduled Job: The scheduled instance of the job results from an active
scheduling rule.
4. Subordinate Job: The job was generated as a subordinate job, from a

currently executing job.

The priority category determines how jobs are evaluated for processing order, in
conjunction with the job's Priority Elevation setting. Manual jobs are highest
priority, and subordinate jobs are lowest priority. For more information, see
Processing priority for scheduled jobs.

Start Time The start time of the job. The job is eligible for immediate execution if the start time
is now or passed. Jobs may not be executed right at the start time if no Scheduler
threads are currently available to execute the job, or if other eligible jobs have
higher priority.

If the job is on the schedule due to a scheduling rule, the start time is based on the
scheduling rule. If the job was manually executed via Run Now or triggered by an
event handler, the start time is the time the execution was initiated.

Due In The length of time until the job is due to be processed. For example, if the job is
scheduled to run at noon and it is currently 11:50 AM, then the job is due to be run
in 10 minutes.

This column is intended to make it easy to see when a job will be run, without
needing to calculate it based on the start time.

NOTE: If a job has a scheduling rule with a recurring schedule, only the first scheduled execution
appears in the Scheduled Jobs list. For example, if you have a job that is scheduled to run once a
month for a year, you will not see all twelve scheduled executions in the list—you will only see the
first scheduled execution. Once that instance has been run, the scheduling rule is re-evaluated and
the next scheduled execution appears in the list.

Administrator's Guide

Axiom Contract Management | 400



Viewing job results in the Web Client

In the Scheduler area of the Web Client, you can view the results of jobs that have been executed. For
each job, you can see when it was run, and whether it completed successfully or had errors.

To view job results:
¢ On the Scheduler page, from the Scheduler panel, select Job Results.

AXIOM| System Administration

Scheduler

Scheduled Jobs
Job Explorer
Job Results

Event Handlers

The Job Results grid shows a list of jobs that have been recently executed. The grid shows the following
summary information:

¢ The name of the job, and the ID of the particular execution of that job
¢ The user identity the job was run as

¢ The status of the job, such as Success or Failure

¢ The Scheduler server that ran the job

e The start time and duration of the job

To refresh the list, click the Refresh icon %~ in the Task bar.
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AXIOM/| System Administration Dashboard Tools ~ Auditing ~ System Status ~ Infrastructure Section ~ [m} @ @ Ei

i S w @
Job Results
Hide system jobs
D Job User Status Server Start Time Duration
4636975  File Processing admin Success Today at 3:43 PM a few seconds @
4636966  Process Plan Files admin Success Today at 3:42 PM a few seconds
4636073 Process Plan Files(4641920)[01][7] admin Success Today at 3:42 PM a few seconds
4636972 Process Plan Files(4641920)[01][6] admin Success Today at 3:.42 PM a few seconds
4636971 Process Plan Files(4641920)[01][5] admin Success Today at 3:42 PM a few seconds
4636970 Process Plan Files(4641920)[01][4] admin Success Today at 3:41 PM aminute
4636069 Process Plan Files(4641920)[01][3] admin Success Today at 3:41 PM aminute
4636068 Process Plan Files(4641920)[01][2] admin Success Today at 3:41 PM aminute
4636067 Process Plan Files(4641920)[01][1] admin Partial Suc... Today at 3:41 PM a few seconds

Example Job Results grid

To view detailed results for a particular job execution, hover your cursor over the job and then click the
View icon <®> in the far right column. This opens the job properties to the Job Results section, with the
corresponding execution ID expanded. You can further expand the job results to see the specific tasks
that were executed.
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Dashboard Tools ~ Auditing ~  System Status

AXIOM/| System Administration
i
File Processing | Results

D Result

v 4636975 Success
+ Job: File Processing Server: Success

Task: File Processing Success

Example Job Results detail showing tasks executed

Infrastructure Section ] 19 @ T':i
S w @
Start Time Duration User

Today at 3:43 PM a few seconds admin

Today at 3:43 PM a few seconds

Today at 3:43 PM a few seconds @

To view the detailed task results, hover your cursor over the task and then click the View icon @ in the
far right column. This opens a dialog to display the results for that task. For example, for a file processing
task, the detailed results would contain information such as the processing type and the number of

passes, and the output that was created at the end of the process.

Once you are viewing the Job Results section of the job properties, you can review all of the available
job history as needed. Expand any execution ID to view the details for that particular execution.

TIP: You can also view job results by opening a job and viewing the job properties, which include the
job results. In some cases it may be easier to open the job and review all of its results rather than
trying to find the job within the overall job results. For more information, see Viewing jobs and event

handlers in the Web Client.

NOTE: Users with the Scheduled Jobs User security permission can only see job results for jobs that

they executed. Administrators can see job results for all jobs.

» System job results

By default, system job results are hidden in the Job Results grid. System jobs such as the SMTP message
delivery job may run frequently, and can easily fill up the result history, making it difficult to find results

for user-initiated jobs.
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If you want to view results for system jobs, you can do one of the following:
e (Clear the Hide system jobs check box above the Job Results grid. The list immediately updates to
include system jobs.

e QOpen the system job directly, and view its job results within the job. For example, you can go to
the Scheduled Jobs page and double-click the System.SystemDataPurge job to view all results for
that job.

» Job result availability

Job results are purged periodically to help optimize system performance. The availability of job results in
your system depends on the configuration of the system job System.PurgeSystemData. This system job
runs periodically to purge old data in your system, including old job results. By default, when this job is
run, it purges job history older than 15 days.

The configuration of this system job can only be viewed and edited in the Desktop Client, and only by
administrators. For more information, see Configuring Scheduler system jobs.

Additionally, individual jobs can be configured to purge old results when the job is run. In the Web
Client, you can view the job properties to see if this option is enabled, but you cannot edit the job
properties. The option is displayed in the General section of the job, under Job Results Cleanup. For
more information on viewing job properties, see Viewing jobs and event handlers in the Web Client.

Running a job manually in the Web Client

In the Scheduler area of the Web Client, you can run a job manually as needed.

When using this approach, the job is run now. It is not possible to run a job manually and specify a
future execution time. If you want to schedule a job for future execution, you must define a scheduling
rule on the job, which can only be done in the Desktop Client. For more information, see Defining
scheduling rules for a job.

To run a Scheduler job manually:

1. Onthe Scheduler page, from the Scheduler panel, select Job Explorer.
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2. Inthe Job Explorer page, locate the job that you want to run. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the Run Once icon P in the far right column.

The job is added to the schedule with a start time of now, and is eligible for immediate execution
(pending available Scheduler threads and any higher-priority jobs already in the queue). You are
automatically taken to the Scheduled Jobs area of Scheduler, so that you can see the job on the
schedule.

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

Viewing jobs and event handlers in the Web Client

In the Scheduler area of the Web Client, you can view Scheduler jobs and event handlers.

» Viewing jobs

You can view any job in the Scheduler Jobs Library that you have permission to access.

Scheduler jobs are read-only in the Web Client. You can view the job properties to better understand
the purpose of a particular job and the tasks that it performs. The Web Client does not support creating

new jobs, editing existing jobs, or deleting jobs. If you need to perform any of those actions, you must
use the Desktop Client. For more information, see Scheduler Overview.
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To view a Scheduler job:
1. Onthe Scheduler page, from the Scheduler panel, select Job Explorer.

AXIOM| System Administration

Scheduler

Scheduled Jobs
Job Explorer
Job Results

Event Handlers

2. Inthe Job Explorer page, locate the job that you want to view. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the View icon ¢®> in the far right column.

The job opens, and the Scheduler panel updates to show the viewable sections of the job. You can
switch between sections by selecting section names in the Scheduler panel. By default, the General
section is shown.
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Scheduled Jobs section name

Job Explorer

Description
Job Results
Event Handlers Job Restart Behavior Resume the job beginning with the first uncompleted task.
T Stiffct!gh;gggrl‘[?gsor Job Results Cleanup Purge historical job results whenever this job runs
General that vou want to view Number of days to keep results for this job: 2
Variables
Priority Elevation Default - jobs run on first come, first served basis, limited by the configured number of scheduler threads that
Scheduling Rules are available
Event Handlers
Notifications Additional Settings None

Tasks

Results

Example job properties

All job properties are defined in the Desktop Client. The following is a brief overview of the job
properties shown in the Web Client.
Section Description More Information

General General job properties that impact the job's Job properties
processing priority and processing behavior.

Variables Variables used by the job. Using job variables

¢ [f the job has defined variables, those variables
display in the Job Variables section at the top of
the page. Most likely, the tasks in the job are
configured to use these variables. This typically
means that the job is designed to be run using an
event handler, and the necessary variable values
will be passed to the job when it is triggered.

e The System Variables section displays the job's
values for various system-defined variables. This
section can help you understand who the owner
of the job is, and how other system variables will
resolve for the job.
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Section Description More Information

Scheduling Rules Scheduling rules to schedule jobs for future Defining scheduling
execution. If the job has an active scheduling rule, rules for a job
the job will be executed according to the rule (one
time or recurring, depending on how the rule is
configured).

e Day of Week, Hours, and Minutes specify when
the job will be executed within the start / end
range of the rule. An asterisk in any of these fields
means "all"—for example, if Hours is set to * then
the job is run every hour.

e Starting On and Ending On determine the start /
end range of the rule. If they are blank, then the
rule has no start or end date.

Event Handlers If the job is designed to be run using an event Viewing event
handler, the event handler name is listed here. The handlers
Execute As property determines whether the job is
run as the requester or the job owner when it is
triggered for execution.

Notifications Notification settings for the job. The job can be Setting up
configured to send email notifications when the job notifications for jobs
completes, or only when the job has errors. Variables
can be used to determine the notification recipients.

Tasks Tasks to be executed by the job, listed by name and Scheduler Task
task type. No other task properties are available in Reference
the Web Client. If you want to see more information
about the task, you must view the job in the Desktop

Client.
Results Detailed results of the previous job executions. Viewing job results in
Results are organized by execution ID and displayed the Web Client

in execution order (the most recent listed first).

» Viewing event handlers

You can view the event handlers that are defined in the system. Event handlers are used to trigger
Scheduler jobs based on an event.

For example, an Axiom form can have a Button component that is configured with the RunEvent
command. When a user clicks the button, the specified event name is passed to Scheduler, and any jobs
associated with that event are triggered to run. Variable values can also be passed from the form to the
Scheduler job as part of this process.
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Event handlers are read-only in the Web Client. If you need to create, edit, or delete an event handler,
this can only be done in the Desktop Client. For more information, see Managing event handlers.

To view Scheduler event handlers:

¢ On the Scheduler page, from the Scheduler panel, select Event Handlers.

AXIOM| System Administration

Scheduler

Scheduled Jobs
Job Explorer
Job Results

Event Handlers

The Event Handlers grid lists all of the event handlers as follows:

e Event Name: Name of the event handler. This is the name used in features such as RunEvent to
trigger execution of a Scheduler job.

¢ Job: Name of the job where the event name is used. When the event is raised by a feature such
as RunEvent, this job will be executed.

e User: The user identity that will be used to execute jobs triggered by the event handler. If the
event handler is configured to run as the requester, then Requester is listed here. If the event
handler is configured to run as the owner, then the owner name is listed here (either a specific
user name, or System).
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Security

Axiom Contract Management security roles

Axiom Contract Management provides four main user security roles. Following are summaries of each
role. For details, refer to the following table.

CMA Admin — User with the CMA Admin security role have Administrative privileges within the
application.

CMA Analyst — Users with the CMA Analyst security role have standard user level permissions within the
application.

CMA User — Users with the CMA User security role have restricted rights.

CMA Scheduler — Users with the CMA Scheduler security role have access to the Axiom Scheduler and
ETL tools within the Axiom.

Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler
Contracts Add, delete, and View only View only No access
modify all
aspects of the
contract
Simulations Add, delete, and View only View only No access
modify all
aspects of a
simulation
Claims View a ¢ View all tabs e View all tabs View only No access
Claim e Add and  Add and modify
modify Claim Claim Tracking
Tracking * View Voucher

* View Voucher
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Access to: CMA Admin CMA Analyst CMA
Scheduler
Claims Re- All features of re-  All features of re- No access No access
calculate calculate calculate
Claims Track / ¢ Create, e Create, delete ¢ View and No access
Assign Claims delete, and and edit user- export Claims
edit user- defined lists
defined categories ¢ Run Reports
categories e Export reports using existing
e Export and claims lists filters
reports e Build filters e Export reports
e Build filters
Import Data View only. We View only View only Create,
recommend delete, edit
contacting Axiom ETLS to
support prior to facilitate
deleting any data loading data
from the system. into Axiom
tables
Reports ¢ Create, view, ¢ Create new e View/run only No access
edit reports o View existing  Export
* Build * Build Advanced Reports
Advanced filters
filters
Axiom No access to No access to No access to Create, edit,
Scheduler Axiom jobs Axiom jobs Axiom jobs delete, and
schedule
Axiom jobs
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